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Shortcuts
You want shortcuts? We've got shortcuts...

Keyboard Shortcuts
Shortcut Menus
Drag and Drop Shortcuts
Other Mouse Shortcuts
                                                         
See also
Tips of the Day



Keyboard Shortcuts
The following sections contain comprehensive lists of keyboard shortcuts available in Sound Forge.

General Keyboard Shortcuts 
Edit Commands 
Misc. View, Option and Special Commands 
Cursor Movement 
Selecting Data 
Navigation and Playback 
Regions List Shortcuts 
Playlist Shortcuts 
                                                         
See also
Shortcuts



General Keyboard Shortcuts
File Commands
Press To
Alt+Enter Show the Properties dialog for the active data window
Control+N Create a new data window
Control+O Open a sound file into a new data window
Control+S Save modified sound data back to the file
Control+W Close the active data window
Alt+F4 Exit Sound Forge

Window Management Commands
Press To
Alt+0 Set input focus to the waveform display in the active window.
Alt+1 Set input focus to the Regions List.
Alt+2 Set input focus to the Playlist.
Alt+3 Set input focus to the MIDI Keyboard window.
Alt+4 Set input focus to the Audio Device Mixer window.
Alt+5 Set focus to the Time Display window
Alt+6 Set focus to the Video Preview window
Alt+7 Set focus to the Play Meter window
Alt+8 Set input focus to the Undo/Redo History window
Alt+F5 Restore the Sound Forge application window.
Alt+F10 Maximize the Sound Forge application window.
Control+F5 Restore the active data window.
Control+F6 Go to the next data window.
Control+F10 Maximize the active data window.
Control+Shift+F6 Go to the previous data window.
Shift+F4 Tile the data windows vertically.
Shift+F5 Cascade the data windows.

                                                         
See also
Shortcuts



Edit Commands
Press To
Control+A Select all data in the active window.
Control+C Copy the selected data onto the clipboard.
Control+E Paste the clipboard contents into a new data window.
Control+F Crossfade data from the clipboard with the active window.
Control+K Preview Cut or Clear in the active window.
Control+Shift+K Play to cursor with pre-roll.
Control+M Mix data from the clipboard with the active window.
Control+T Trim (crop) to the current selection.
Control+U Toggle Undo buffer creation for the active window.
Control+V Paste data from the clipboard into the active window.
Control+X Move (cut) the selected data onto the clipboard.
Control+Y Repeat last process, effect or tool.
Control+Z Undo the last action.
Control+Shift+Z Redo the last undone action
Delete Clear (delete) the selected data; nothing placed on the clipboard.

                                                         
See also
Shortcuts



Misc. View, Option and Special Commands
Press To
S Toggle current selection on and off.
Control+B Toggle Snap to Zero on and off for the active data window.
Control+Enter Maximize the width of the active data window.
Control+D Show the Set Selection dialog.
Control+G Show the Go To dialog.
Control+L Show the Loop Tuner for the active data window.
Control+R Record new data into a data window.
Escape Stop or cancel the current action (including playback).
F1 Open the Sound Forge Help file to the Contents page.
F10 Make the menu bar active.
Shift+F10 Display a shortcut menu.
F6 Toggle playback scrolling on and off
Shift+F6 Toggle smooth playback scrolling on and off
F8 Toggle Drag and Drop Snapping on and off
F7 Turn on MIDI input sync/trigger
Shift+F7 Turn on MIDI output sync

                                                         
See also
Shortcuts



Cursor Movement
Press To move to
Right Arrow The next screen pixel.
Left Arrow The previous screen pixel.
End The last sample visible in the waveform display.
Home The first sample visible in the waveform display.
Control+End The last sample in the data window.
Control+Home The first sample in the data window.
Page Up 10% of the current view past the cursor position.
Page Down 10% of the current view previous to the cursor position.
Control+Right Arrow 2% of the current view past the cursor position.
Control+Left Arrow 2% of the current view previous to the cursor position.
Numpad + The next sample.
Numpad - The previous sample.
Control+Numpad + 10 samples past the current cursor.
Control+Numpad - 10 samples previous to the current cursor.

When Regions, Loops or Markers Exist in the File:
Control+ Left Arrow The previous region, loop or marker boundary.
Control+ Right Arrow The next region, loop or marker boundary.

                                                         
See also
Shortcuts



Selecting Data
Press To select from the cursor to
Shift+Right Arrow The next screen pixel.
Shift+Left Arrow The previous screen pixel.
Shift+End The last sample visible in the waveform display.
Shift+Home The first sample visible in the waveform display.
Control+Shift+End The last sample in the data window.
Control+Shift+Home The first sample in the data window.
Shift+Page Up 10% of the current view past the cursor position.
Shift+Page Down 10% of the current view previous to the cursor position.
Control+Shift+Right Arrow 2% of the current view past the cursor position.
Control+Shift+Left Arrow 2% of the current view previous to the cursor position.
Shift+Numpad + The next sample.
Shift+Numpad - The previous sample.
Control+Shift+Numpad + 10 samples past the current cursor.
Control+Shift+Numpad - 10 samples previous to the current cursor.

When Regions, Loops or Markers Exist in the File:
Control+Shift+Left Arrow The previous region, loop or marker boundary.
Control+Shift+Right Arrow The next region, loop or marker boundary.

                                                         
See also
Shortcuts



Navigation and Playback
Press To
Control+<Number> Save a view in cell <Number> where <Number> ranges from 1 to 8.
<Number> Restore a view using cell <Number> where <Number> ranges from 1 to 8.
Up Arrow Increase time magnification (zoom in closer to data).
Down Arrow Decrease time magnification (zoom out farther from data).
Shift+Up Arrow Increase level magnification
Shift+Down Arrow Decrease level magnification
Control+Up Arrow Zoom Selection if a selection exists, Zoom In Full if no selection.
Control+Down Arrow Zoom Normal (zooms to default zoom ratio set in Preferences).
Control+Shift+Up Arrow Pan data window up if zoomed in vertically.
Control+Shift+Down Arrow Pan data window down if zoomed in vertically.
Numpad 5 or * Switch cursor to opposite end of selection
Tab Cycle stereo selection from left channel to right channel to both channels
Shift+Tab Cycle stereo selection from both channels to right channel to left channel.
[ (open bracket) Set Mark In at the current cursor position.
] (open bracket) Set Mark Out at the current cursor position.
M or \ (backslash) Drop a marker at the current cursor position.
C or . (period) Center the cursor in the waveform display.
Spacebar Play or Stop the current data window in default mode.
Shift+Spacebar Play All or Pause the current data window.
Control+Spacebar Switch playmode between Normal, Looped and As Sample.
Enter Pause playback; keep the cursor at the current position.
Escape Stop playback of the current data window.
Control+K Preview Cut (skip selection on playback with pre-roll).
Control+Shift+K Play to cursor with pre-roll.

                                                         
See also
Shortcuts



Regions List Shortcuts
Press To
Spacebar Play or Stop the active marker or region.
Enter Edit the active marker or region.
Delete Delete the active marker or region.
` (grave accent) Cycle through the Regions List display formats.
R Create region from the current selection
Shift+R Create region without bringing up dialog.
L Create loop from the current selection
Shift+R Create loop without bringing up dialog.

                                                         
See also
Shortcuts



Playlist Shortcuts
Press To
Spacebar Play (stop) from the active Playlist entry.
Enter Edit the active Playlist entry.
Delete Delete the active Playlist entry.
+ (plus sign) Add one to the active Playlist entry play count.
- (minus sign) Subtract one from the active Playlist entry play count.
* (asterisk) Add or remove a Stop Point on the active Playlist entry.
/ (forward slash) Toggle Pre-roll on and off for the Playlist.
` (grave accent) Cycle through the Playlist display formats.

                                                         
See also
Shortcuts



Shortcut Menus
Shortcut menus are menus that appear when you right-click on certain areas of the screen. They allow 
you to quickly access important functions. Try right-clicking on any area in Sound Forge...chances are 
that a Shortcut Menu will appear.

Sound Forge Desktop 
Waveform Display 
Playbar Selection Status 
Regions List 
Playlist 
Time Ruler 
Display Properties 
Level Ruler 
Level Toolbar 
Marker Tag 
Region Tag 
Loop Tag 
Status Bars 
Wave, MIDI, and Auxiliary Mixers 
Keyboard MIDI Out 
Play Meters 
Preview Configuration 
Record Dialog 
Time Display 
Video Strip 
Video Preview 
Summary Information Picture 
Edit Tool Selector 

                                                         
See also
Shortcuts



Sound Forge Desktop Shortcut Menu
This shortcut menu is reached by right-clicking on the desktop workspace of Sound Forge. This menu has
options for sound file management on your workspace. You can open recently used files from the Recent 
Files option. The Preferences dialog can quickly be reached from this menu as well.

                                                         
See also
Shortcut Menus



Waveform Display Shortcut Menu
This shortcut menu is reached by right-clicking on the waveform display of a sound file. It is a way of 
quickly reaching the following commands and dialogs: Zoom In Full/Normal/Out Full, Paste, Crossfade, 
Mix, Cursor Snap to Time/Zero, Cursor Go To, Scroll Playback, Properties.

                                                         
See also
Shortcut Menus



Cursor|Set to Start
Moves the cursor to the start of the selection.

                                                         
See also
Waveform Display Shortcut Menu 



Cursor|Set to End
Moves the cursor to the end of the selection.

                                                         
See also
Waveform Display Shortcut Menu 



Playbar Selection Status Shortcut Menu
This shortcut menu is reached by right-clicking on any of the playbar's selection status fields. It allows you
to set the current status format.

                                                         
See also

Shortcut Menus



Regions List Shortcut Menu
This shortcut menu is reached by right-clicking on the Regions List. It allows you to perform the following 
Regions List operations: Add, Delete, Edit, Replicate, Split, Update, Markers to Regions, Open, Save As, 
Copy onto Clipboard.

                                                         
See also
Shortcut Menus



Playlist Shortcut Menu
This shortcut menu is reached by right-clicking on the Playlist. It allows you to perform the following 
Playlist operations: Add, Delete, Edit, Replicate, Stop Point, Pre-roll Playback, Open, Save As, Copy onto
clipboard, Convert to New.

                                                         
See also
Shortcut Menus



Time Ruler Shortcut Menu
This shortcut menu is reached by right-clicking on the Time Ruler. It allows you to reach the Add 
Marker/Region or Edit Sample dialog for adding regions, markers, and loop points, as well as changing 
the status format.

                                                         
See also
Shortcut Menus



Display Properties Shortcut Menu
This shortcut menu is reached by right-clicking on the Edit Tool selector at the upper left-hand corner of 
the data window. It allows you to set options described under Properties|Display in the File Menu.

                                                         
See also
Shortcut Menus



Level Ruler Shortcut Menu
This shortcut menu is reached by right-clicking on the Level Ruler. It allows you to change the labeling 
used, as well as various level zooming operations.

Zoom Out Full 
Zoom Level|Window 
Zoom Level|Selection 
Label in Percent 
Label in dB 
                                                         
See also
Shortcut Menus



Level Ruler|Label in Percent
When checked, the Level Ruler will be labeled in percent.

                                                         
See also
Level Ruler Shortcut Menu 



Level Ruler|Label in dB
When checked, the Level Ruler will be labeled in decibels.

                                                         
See also
Level Ruler Shortcut Menu 



Level Toolbar Shortcut Menu
This shortcut menu is reached by right-clicking on the Levels toolbar. It sets the status of the display for 
the toolbar. The Levels toolbar can be set to one of these formats:

Integer 
Percent 
dB 
Peak 
RMS 
                                                         
See also
Shortcut Menus



Level Toolbar|Integer
Displays the sample value at the cursor as an integer. The range is from -32768 to 32767 in 16-bit audio 
and -128 and 127 in 8-bit audio.

                                                         
See also
Level Toolbar Shortcut Menu 



Level Toolbar|Percent
Displays the sample value at the cursor as a percentage. The range is from -100 to 100%.

                                                         
See also
Level Toolbar Shortcut Menu 



Level Toolbar|dB
Displays the sample value at the cursor as a dB value. A value of 0 dB corresponds to maximum absolute
amplitude and negative infinity (-Inf.) corresponds to complete silence. In 16-bit audio, -90.3 dB is the 
lowest possible dB value (sample value of 1).

                                                         
See also
Level Toolbar Shortcut Menu 



Level Toolbar|Peak
Displays the peak sample value in the vicinity of the cursor as a dB value. The amount of time which is 
scanned by default is 50 milliseconds. This can be set on the Status page of the Preferences folder.

                                                         
See also
Level Toolbar Shortcut Menu 



Level Toolbar|RMS
Displays the Root Mean Square (RMS) of the sample values in the vicinity of the cursor as a dB value. 
RMS is a more accurate measurement of loudness than the peak value. The amount of time which is 
scanned by default is 50 milliseconds. This can be set on the Status page of the Preferences folder.

The maximum value of 0 dB is only achieved by a square wave (or DC offset) of maximum amplitude. A 
maximum amplitude sine wave reaches only -3 dB. Values below -96 dB can be achieved by combination 
of silence and very low-levels, and only complete silence will register negative infinity.

                                                         
See also
Level Toolbar Shortcut Menu 



Marker Tag Shortcut Menu
This shortcut menu is reached by right-clicking on a marker tag in the ruler.

Go To 
Delete 
Edit 
Update 
                                                         
See also
Shortcut Menus



Region Tag Shortcut Menu
This shortcut menu is reached by right-clicking on a region tag in the ruler.

Edit 
Select 
Delete 
Update 
Split 
                                                         
See also
Shortcut Menus



Loop Tag Shortcut Menu
This shortcut menu is reached by right-clicking on a loop tag in the ruler. 

Update 
Edit 
Delete 
Select 
                                                         
See also
Shortcut Menus



Status Bar Shortcut Menus
These shortcut menus allow you to change the playback rate, sample size, channels (Stereo/Mono), and 
status format by right-clicking on the status bar fields.

Sample Rate 
8-Bit 
16-Bit 
Mono 
Stereo 
Status 
                                                         
See also
Shortcut Menus



Status Bar|Sample Rate
Use this shortcut menu to select the playback rate of the current sound file. Note that if you do not 
Resample the data, the pitch will change also.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|Status
Use this shortcut menu to select the time or sample status format used.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|8-Bit
Use this shortcut menu to change the bits per sample of a sound file to 8.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|16-Bit
Use this shortcut menu to change the bits per sample of a sound file to 16.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|Mono
Use this shortcut menu to make the sound file contain only one channel.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|Stereo
Use this shortcut menu to make the sound file contain two channels.

                                                         
See also
Status Bar Shortcut Menu 



Wave, MIDI, and Auxiliary Mixer Shortcut Menus
This shortcut menu is reached by right or left-clicking on the Wave, MIDI, or Aux headings in the Mixer 
window. They allow you to select the Wave, MIDI, or Auxiliary device that the volume fader controls. Many
sound cards do not allow for fader controls, in which case this feature will not work.

                                                         
See also
Shortcut Menus



Keyboard MIDI Out Shortcut Menu
This shortcut menu is reached by right or left-clicking on the MIDI Out button on the Keyboard. It allows 
you to set the device to which the MIDI Keyboard will transmit.

                                                         
See also
Shortcut Menus



Play Meters Shortcut Menu
Right-click on the Play Meters to reach this menu will allows you to select the Play Meter resolution and 
other options including: Reset Clip, Show Labels, Hold Peaks, Hold Valleys and Always on Top.

Reset clip 
Resolution 
Show Labels 
Show Peaks 
Show Valleys 
Always on Top 
                                                         
See also
Shortcut Menus



Preview Configuration Shortcut Menu
This shortcut menu is reached by right-clicking on any unused area in a dialog which has Preview 
capabilities.

Left    
Right 
All 
Pre-Roll 
Post-Roll 
Reset All
Save
Configure 
                                                         
See also
Shortcut Menus



Preview|Pre-roll
When enabled, sound data preceding the current selection is played before the processed data during 
previews.

                                                         
See also
Preview Configuration Shortcut Menu 



Preview|Post-roll
When enabled, sound data following the current selection is played after the processed data during 
previews.

                                                         
See also
Preview Configuration Shortcut Menu 



Preview|Left
Process left channel only when using a stereo sound file.

                                                         
See also
Preview Configuration Shortcut Menu 



Preview|Right
Process right channel only when using a stereo sound file.

                                                         
See also
Preview Configuration Shortcut Menu 



Preview|Both
Process both channels when using a stereo sound file.

                                                         
See also
Preview Configuration Shortcut Menu 



Preview|Reset All
Resets all of the dialog's parameters to their default values.

                                                         
See also
Preview Configuration Shortcut Menu 



Preview|Save Current
Saves the current dialog settings to the Untitled preset.

                                                         
See also
Preview Configuration Shortcut Menu 



Preview|Configuration
Takes you to the Preview Configuration dialog.

                                                         
See also
Preview Configuration Shortcut Menu 



Record Dialog Shortcut Menu
This shortcut menu is reached by right-clicking anywhere in the Record window. The Remote Record 
shortcut menu is similar, with options not available in the dialog available from the menu.

Reset clip 
Resolution 
Show Labels 
Show Peaks 
Show Valleys 
Calibrate DC Adjust 
Review Pre/Post Roll 
Go to 
Selection 
Window 
New Window 
                                                         
See also
Shortcut Menus



Record Meters|Reset Clip
This function resets the clip indication on the Record Meters. After a clip occurs, the clip indication will 
remain lit until the Reset Clip function is invoked. You can also click on the clip light or levels to clear it.

                                                         
See also
Options Menu



Record Meters|Resolution
These settings display the minimum and maximum readings for the Record Meters. Changing the 
resolution of the meters is helpful for metering sound files of varying dynamism.

-90 to 0 dB 
-78 to 0 dB 
-60 to 0 dB 
-42 to 0 dB 
-24 to 0 dB 
                                                         
See also
Shortcut Menus



Record Meters|-90 to 0 dB
Determines the bottom-most level that will be displayed. A value of -90 dB is the absolute minimum peak 
value in 16-bit audio, corresponding to a sample value of +/- 1.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-78 to 0 dB
Determines the bottom-most level that will be displayed. A value of -78 dB (0.012%) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-60 to 0 dB
Determines the bottom-most level that will be displayed. A value of -60 dB (0.1 %) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-42 to 0 dB
Determines the bottom-most level that will be displayed. A value of -42 dB (0.8 %) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-24 to 0 dB
Determines the bottom-most level that will be displayed. A value of -24 dB (0.6 %) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|Show Labels
This option turns on or off the markings on the Record Meters.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|Hold Peaks
This option turns on or off the markings to indicate the highest peaks in the sound file.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|Hold Valleys
This option turns on or off the markings to indicate the lowest peaks in the sound file.

                                                         
See also
Record Dialog Shortcut Menu 



Gap Detection|Ignore
If a gap is detected while recording, no action is taken.

                                                         
See also
Record Dialog Shortcut Menu 



Gap Detection|Mark
If a gap is detected while recording, a marker is dropped at the estimated location.

                                                         
See also
Record Dialog Shortcut Menu 



Gap Detection|Stop
If a gap is detected while recording, recording is stopped.

                                                         
See also
Record Dialog Shortcut Menu 



Blinking Status
Enables the blinking record status underneath the record meters.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Calibrate DC Adjust
Calculates a new DC Offset to use from the incoming audio.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Review Pre/Post Roll
Enables or disables Pre-Roll and Post-Roll on playback.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Go to
Takes you to the Go To dialog, which allows you to set a Record start time.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Selection
Takes you to the Selection dialog, which allows you to set a Record start and end time.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Window
Takes you to the Record Window dialog, which allows you to set a new Data Window to record to.

                                                         
See also
Record Dialog Shortcut Menu 



Record|New Window
Sets Record to write data to a new sound file.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Aggressive Update
When enabled, the Record meters will respond much more rapidly to incoming audio. However, with 
some sound cards, this can lead in some cases to peaks not being detected. If you want complete 
security that your recording never reached 0 dB, turn this off.

                                                         
See also
Record Dialog Shortcut Menu 



Time Display Shortcut Menu
This shortcut menu is reached by right-clicking on the Time Display window. It allows you to set the 
display format for the Time Display.

Time Display|Playlist Position 
Time Display|Position 
Time Display|Passive Update 
Time Display|Position 
                                                         
See also

Shortcut Menus



Video Strip Shortcut Menu
This shortcut menu is reached by right-clicking on the video strip above the waveform display.



Video Strip|Copy
Copies the selected frame as a bitmap to the clipboard. You could, for example, then paste it into the 
Summary information folder (Properties in the File menu) by right-clicking over the shot you want to copy.

Video Strip|Copy 
Video Strip|Go To 
Video Strip|Animate 
Video Strip|Number Frames 
                                                         
See also
Shortcut Menus



Video Strip|Go To
Moves the cursor to the beginning of the frame.

                                                         
See also
Video Strip Shortcut Menu 



Video Strip|Animate
Displays the frame closest to the current cursor position during editing and playback instead of a static 
overview frame.

                                                         
See also
Video Strip Shortcut Menu 



Video Strip|Number Frames
Displays frame number on each frame.

                                                         
See also
Video Strip Shortcut Menu 



Video Preview Shortcut Menu
This shortcut menu is reached by right-clicking on the Video Preview window. It allow you to set various 
options of the video display. A complete list and explanation of these options is available in the Reference 
section under the Options menu item.

                                                         
See also
Video Strip Shortcut Menu 



Summary Information Picture Shortcut Menu
This shortcut menu is reached by right clicking on the picture area in File|Properties|Summary 
Information. It allows for copy, paste, and clear operations on the image.

                                                         
See also
Shortcut Menus



Summary Information|Copy
Use this to copy the current summary information image onto the clipboard.

                                                         
See also
Summary Information Shortcut Menu 



Summary Information|Paste
Use this to embed a picture in a sound file by pasting a bitmap, cursor, or icon from the clipboard.

                                                         
See also
Summary Information Shortcut Menu 



Summary Information|Clear
Use this to delete a picture from    a sound files embedded summary information.

                                                         
See also
Summary Information Shortcut Menu 



Edit Tool Selector Shortcut Menu
This shortcut menu is reached by right clicking on the Edit Tool Selector. The Edit Tool Selector is the icon
on the upper left hand side of the data window which allows you to switch between the Edit, Magnify, and 
Pencil tools.

The Edit Tool Selector shortcut menu allows you to enable and disable various parts of the Data Window, 
such as scroll bars and rulers.

                                                         
See also
Shortcut Menus



Edit Tool Selector|Status
Use this to show or hide the Playbar in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Time Ruler
Use this to show or hide the Time Ruler in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Time Zoom
Use this to show or hide the Time Zoom spinner in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Overview
Use this to show or hide the Overview bar in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Video
Use this to show or hide the Video Strip in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Level Ruler
Use this to show or hide the Level Ruler in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Level Zoom
Use this to show or hide the Level Zoom spinner in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Scrollbar
Use this to show or hide the Scrollbar in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Data Window Only
When this is checked, only the Waveform Display will be shown in the selected data window. All other 
controls such as rulers and scrollbars will be hidden.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Drag and drop shortcuts
Using drag and drop allows you to quickly perform operations crossing between open data windows, the 
Playlist, the Regions List, and the Time Ruler.

Drag to New 
Drag Mix 
Drag Crossfade 
Drag Paste 
Drag to Regions List 
Drag to Playlist 
Drag to Time Ruler 

                                                         
See also
Shortcuts



Drag to New
To create a new file from the current selection, drag the selection to an open area of the Sound Forge 
desktop. You can also drag regions from the Regions List to the desktop.

                                                         
See also
Drag and Drop Shortcuts 



Drag Mix
To mix a selection into another data window, drag the selection from the source to the destination 
window. Processing begins at the point where you drop the region in the destination file. When mixing a 
mono selection into a stereo file, you can mix the selection to both channels by dropping the selection on 
the destination centerline. Otherwise, the selection will be mixed into either the left or right channel only.

                                                         
See also
Drag and Drop Shortcuts 



Drag Crossfade
To crossfade a selection into another data window, drag the selection from the source to the destination 
window. Processing begins at the point where you drop the region in the destination file. Press the Control
key while in the destination window. When crossfading a mono selection into a stereo file, you can 
crossfade the selection to both channels by dropping the selection on the destination centerline. 
Otherwise, the selection will be crossfaded into either the left or right channel only.

                                                         
See also
Drag and Drop Shortcuts 



Drag Paste
To paste a selection into another data window, drag the selection from the source to the destination 
window. Processing begins at the point where you drop the region in the destination file. Press the Alt key
while in the destination window. When pasting a mono selection into a stereo file, you can paste the 
selection to both channels by dropping the selection on the destination centerline. Otherwise, the sound 
data will be placed in either the left or right channel only, with silence in the other.

                                                         
See also
Drag and Drop Shortcuts 



Drag to Regions List
To add the current selection to the Regions List, drag it to the Regions List. You can also drag regions 
from the Regions List to the Playlist.

                                                         
See also
Drag and Drop Shortcuts 



Drag to Playlist
To add a region in the Regions List to the Playlist, drag it from the waveform display or the Regions List to
the Playlist. You can also drag regions within the Playlist to rearrange the playback order.

                                                         
See also
Drag and Drop Shortcuts 



Drag to Time Ruler
To create a regions, drag the current selection to the Time Ruler.

                                                         
See also
Drag and Drop Shortcuts 



Other Mouse Shortcuts
Select All 
Zoom Both Time and Level 
Magnify Mode 
Return Control Value to Default 
Fine Tune Control Value 
Preview 
Main Status Bar 
Selection Status Bar 
Go To Marker 
Set Selection to Region/Loop 
Edit Region or Marker 
Edit Playlist 
Play Normal Button 
Slow and Fast Selection Scroll Toggle 
Lock Loop/Region length while dragging 
Ruler scrolling speed control 

                                                         
See also
Shortcuts



Select All
Double-click on the waveform display to select the entire sound file. Triple-click when regions, loops or 
markers are present.

                                                         
See also
Other Mouse Shortcuts 



Zoom Both Time and Level
Double-click on the Level Ruler to zoom the current selection both vertically and horizontally. If no 
selection exists, the entire waveform display data is zoomed. Double-click again to Zoom Out Full 
vertically and Zoom Normal horizontally.

                                                         
See also
Other Mouse Shortcuts 



Magnify Mode
To zoom in to a section, select an area while holding the Control key. This will switch Sound Forge to 
Magnify mode, which zooms to fit the selected area.

                                                         
See also
Other Mouse Shortcuts 



Return Control Value to Default
Double-click on a trackbar, fader, or spinner to set it to its default value.

                                                         
See also
Other Mouse Shortcuts 



Fine Tune Control Value
To fine tune a trackbar, fader, or spinner, hold down both right and left mouse buttons when dragging. This
can also be done if you hold down the Control key while dragging.

                                                         
See also
Other Mouse Shortcuts 



Preview
Shift-click on the Preview button to hear the original sound. This is equivalent to checking the Bypass 
check box.

Control-click on the Preview button to reach the Preview Configuration dialog.

                                                         
See also
Other Mouse Shortcuts 



Main Status Bar
Double-click on the Sample Rate, Sample Size, or Channels (Stereo/Mono) field to reach the Properties 
dialog. 

                                                         
See also
Other Mouse Shortcuts 



Selection Status Bar
Double-click on the left-most field to reach the Go To dialog. Double-click on the other two fields to reach 
the Set Selection dialog.

                                                         
See also
Other Mouse Shortcuts 



Go To Marker
Double-click on a marker tag in the ruler to move the cursor to the marker's position.

                                                         
See also
Other Mouse Shortcuts 



Set Selection to Region/Loop
Double-click on a region or loop tag in the ruler to change the current selection to the region or loop end 
points.

                                                         
See also
Other Mouse Shortcuts 



Edit Region or Marker
Double-click on a region or marker in the Regions List to reach the Edit Region/Marker dialog.

                                                         
See also
Other Mouse Shortcuts 



Edit Playlist
Double-click on a Playlist entry to reach the Edit Playlist dialog.

                                                         
See also
Other Mouse Shortcuts 



Play Normal Button
Control-click to Preview Cut (skip selection) on playback. Control+shift-click to play to cursor with pre-roll.

                                                         
See also
Other Mouse Shortcuts 



Slow and Fast Selection Scroll Toggle
When making a selecting past the end or beginning of the waveform display, while holding down the left 
mouse button, click on the right mouse button to toggle between fast scrolling and slow scrolling.

                                                         
See also
Other Mouse Shortcuts 



Lock Loop/Region length while dragging
When dragging a loop or region with the Region or Loop Ruler tags, holding down the Shift key will move 
both start and end points together. This preserves the region or loop duration.

                                                         
See also
Other Mouse Shortcuts 



Ruler scrolling speed control
When dragging the Time Ruler for horizontal scrolling, once you move the mouse outside of the data 
window, the further you move the mouse, the faster the scrolling occurs. The speed can also be controlled
by moving the mouse up and down while scrolling.
                                                         
See also
Other Mouse Shortcuts 



Sound Forge for 32 Bit Windows
This section discusses details specific to the 32 Bit version of Sound Forge 4.0.

Sound Forge for 32 Bit Windows is the first true 32 Bit flat model digital sound editor available for the 
PC. The performance differences from a 16 Bit sound editor are amazing. Processing is often 2 to 3 times
faster with the 32 Bit version of Sound Forge.

Sound Forge for 32 Bit Windows has been designed to run on the following platforms:

- Microsoft Windows 95.

- Microsoft Windows NT 3.5 or later. Alpha AXP, MIPS, PowerPC and x86 processors are supported.

When running Sound Forge for 32 Bit Windows on the Windows NT operating system, some limitations 
may be present. These limitations result from a lack of compatible hardware and software available for 32
Bit Windows or are a direct result of the Windows NT Operating System implementation. These limitations
are summarized below.

Limitations under Microsoft Windows NT
The following is a list of limitations of Sound Forge for 32 Bit Windows when running under Windows NT:

1. The Sonic Foundry Virtual MIDI Router (VMR) is not supported under Windows NT.

2. Not all sound and MIDI cards have drivers available for Windows NT. Contact your manufacturer for 
availability of Windows NT drivers.

3. Synchronization with 16 bit applications (sequencers) running in the Windows on Windows (WOW) 
layer will not perform as well as running the 16 bit version or Sound Forge under Windows 3.x with a 
16 bit sequencer.



What's new in version 4.0
Below are just a few of the new features in Sound Forge 4.0. This is not a comprehensive list of changes 
but simply a few of the key features that you might want to check out. Many of these new features are 
ones that our users have requested. Keep those suggestions coming!

General Features

Direct Mode editing
You can now perform edits directly on the original file, meaning that file opens and saves are almost 
instantaneous. In previous versions of Sound Forge, a backup of the file being opened was always 
created. For very large files, creating a backup could take more than a few minutes. The downside of 
working directly on a file is that the original data is immediately changed whenever you make an edit. This
is why it's so nice to have multiple undo buffers. To work on a file directly, check the Operate directly on 
the sound file option while opening a file in the File Open dialog. If you don't want to work directly on files, 
simply leave the option unchecked.

Multi-level undo/redo
There is now no limit to the number of undo operations available. Use the Undo and Redo options in the 
Edit menu to restore the sound file to any edited stage. The Undo/Redo History window (View menu) 
makes it easy to select from all the previously existing states and in most cases you can even preview 
what the undo or redo will sound like.

AVI file support
To open a Video for Windows AVI file, select AVI as the file type from the File Open dialog. The video 
frames will be shown on top of the Waveform Display in the Video Strip. To view the video during 
playback, open the Video Preview window (View Menu).

Super fast screen redraws
Need we say more?

Auto-Scroll during playback
When this option is turned on, the sound data being played will always be displayed on the screen. If your
computer is not fast enough to redraw the window, you can disable this feature in the Options menu.

Level Zoom (vertical) and scrolling ruler
The Level Ruler on the left hand side of the Waveform Display is useful for estimating sample values in 
percentage or decibels. It is especially useful now that you can zoom and scroll vertically for viewing very 
low level signals. To zoom in vertically, use the Level Zoom spinner on the lower left hand corner of the 
Data Window or hit the Shift-Up Arrow or Shift-Down Arrow keys. Once you're zoomed in, dragging the 
Level Ruler allows you to view different ranges. Double-clicking on the Level Ruler centers the 0 axis.

Drag and Drop Mix/Paste/Crossfade shows destination position
When you drag from one sound file to another, a cursor and region now appear on the destination file that
show where data will be mixed, pasted, or crossfaded. Remember, hold down the Control key before 
dropping to crossfade or the Alt key for pasting, otherwise a Mix will occur.    You can also click with the 
right mouse button during dragging to quickly switch between modes.

Save and Open Workspaces
Any sound files open when you close Sound Forge will be automatically re-opened next time you open 
Sound Forge. This feature can be turned off from the General Preferences page. You can also save and 
load workspaces from the Open and Save Workspace dialogs (File menu). The workspace files (.sfw) 
store the files opened, position, size, and views.

Play meter
A very fast and accurate playback meter is useful for maximizing dynamic range and achieving the hottest



signal possible without distortion. To open the meter, select Play Meters from the View menu. The meter 
will indicate if clipping ever occurs. It even works while previewing effects.

Audio event locator
This feature allows you to find audio events by clicking and dragging the mouse on the Overview (the thin 
strip above the Time Ruler). Similar to a scrub, playback follows mouse movement across the Overview 
and loops when the mouse is still. Releasing the mouse stops playback and centers the cursor on the last
start position in the Waveform Display.

Internet Audio Support (Java and RealAudio)
Updated support has been added for the NeXT/Sun .au format for working with Java scripts. We've also 
added RealAudio support for streaming audio over the Internet.

Send Mail and OLE Drag and Drop
To send a sound file via email to somebody, select Send from the File menu. Dragging a file outside of the
Sound Forge workspace creates a true OLE object which can be embedded on any OLE container (such 
as Wordpad). To do so, you must drag from the OLE button in the lower right corner of the Data Window.

Effects/Processing/Tools

Reactive Previews
While listening to a preview, you can now tweak any parameter and a new preview will be generated 
automatically and played without the need to hit the Preview button again. You can also have a pre-roll 
and post-roll on the preview for listening to transitions. If you're into synchronization the previews now 
also generate MTC while playing.

Paragraphic EQ
The Paragraphic EQ is a new dialog which allows you to do four bands of parametric filtering plus Low 
and High-Pass filtering. It displays a Gain vs. Frequency graph which helps to visualize the final results. It 
also uses a new, fast, and accurate algorithm.

Reverb,Time compression/expansion, and Pitch change use new algorithms
These effects have been tremendously improved.

Crossfade Loop function.
This tool greatly simplifies the process of finding good sample loops.

Phaser and Wah-wah
Check them out along with Flange in the Effects menu.

Graphic Dynamics now uses graph
An input vs. output graph allows for very flexible dynamics processing.

Multi-band Dynamics
A four band dynamic compressor/limiter is indispensable for de-essing, de-popping, and many mastering 
applications.

Dithered/noise shaped fades
By far the most noticeable need for dithering is when fading from or to absolute silence. The Graphic 
Fade function now allows you to perform advanced dithering and noise-shaping for silky smooth fades. Of
course, you can apply dithering to the entire file as well.

Stereo expansion and MS mixing
The Graphic Pan dialog now also allows for stereo expansion of Left/Right recordings and mixing of MS 
recordings.



Normalize 
Normalize now allows you to use Peak or RMS levels and can perform intelligent compression to 
maximize the volume of your sound files.

Smooth/Enhance
Quickly add or remove high frequency content.

DTMF dial tone generator
Generate touch-tone triggers in Sound Forge.

Channel converter 
Use this dialog to convert between mono and stereo formats or to adjust the left/right balance.

Graphic     EQ  .
It's faster and more accurate.

Mix and Crossfade
Both now include the ability to preview their results as well as the ability to fine tune the starting position.

Find
You can now find the maximum sample value in a range or file.

Chorus and Flange
Improvements have been made to apply smoother pitch modulation.

Resample 
Includes a new and improved anti-alias filter as well as the ability to filter after upsampling.

Record

Sync support for Record dialog.
It is now possible to send and receive SMPTE/MTC time code while recording. Also, a SMPTE output 
offset can be set in the MIDI/Sync Preferences.

Auto glitch-detect in record dialog
While recording, if Sound Forge detects a high probability of a glitch having occurred due to your 
computer not keeping up with the incoming data, it either stops recording or drops markers on the 
suspicious spot. These options are selected by right mouse clicking anywhere in the record dialog.

Drop Marker in record dialog
While recording, hitting the M key or pressing the Drop Marker button (next to the play button in the 
Record dialog) can be used to create a marker in the file.

DC Offset auto-correct during record
To calibrate Sound Forge's auto-DC offset correction, press the DC Adjust button in the record dialog 
while monitoring input. From then on, the detected sound card DC offset will be removed from all 
recordings.

Markers and Regions

Markers to Regions function
The Markers to Regions function converts all markers in a file to consecutive regions. This is handy after 
dropping makers while recording or during playback.

Split region function.



You can split a region into to two by first putting the cursor where you wish the split to occur and selecting 
the region in the Regions List. Then, select Region List|Split from the Special menu.

Snap to markers and regions when using drag and drop
When doing drag and drop mix, crossfade, or pasting, if the cursor is near a marker or region in the 
destination file it will snap to it. You can also snap to major ticks on the time ruler as well as to a specific 
frame in the Video Strip.

Markers, Regions, and Loop points annotations
The name of markers, regions, and loops can be displayed right on the Waveform Display.

Miscellaneous Marker and Region List functions
Markers and Regions are now stored in the clipboard for when you Copy, Mix, or Create New.

Double-clicking on the Waveform Display selects from previous to next marker or loop/region.

Shift-Double Click on a marker moves the marker to the current cursor position.

Ctrl-Left or Ctrl-Right keys jump to the next marker, region, or loop if they exist.

Typing 'R' will create a region for the current selection.

Typing 'L' will create a loop for the current selection.

Regions are now named after the start and end position of the region rather than order of creation.

And more...

You can now drag-scroll the Waveform Display by dragging on the ruler, drag speed is determined by how
far the mouse is moved beyond the end of the window horizontally or vertically.

You can drag selection edges with the mouse.

A new Levels toolbar displays Value, Percent, dB, Peak, or RMS Power around the cursor. The scan 
window size used is determined in the Status Preferences.

When playing in Looped Mode, playback always follows selection and cursor changes. 

Support for the InterVoice file format for telephony applications.

Envelope controls now multi-point editing as well as the ability to display the sound data in the envelope 
control.

A free disk space display has been added to the status bar. You can turn this on or off in the Preferences 
section.

We now use the Windows 95 Explorer common dialogs for open and save. We've also added the ability to
auto play files in the Open dialog.

Many new preference options have been added to allow you to customize the way you work.



Help Menu
Contents
Takes you to the on-line help table of contents. Shortcut: F1
Search for Help On
Use this to find help on a particular topic with the on-line help.
Keyboard Shortcuts
Displays a list of shortcuts    and Sound Forge is loaded with them.
Troubleshooting
Use this before calling the Tech Support line.
Tip of the Day
Displays a new Sound Forge tip.
The Sonic Foundry Home Page
Takes you to our little plot in cyberspace.
About Sound Forge
Use this to display pleasantly puzzling information about Sound Forge, such as the software license 
owner, copyright and system information, program version and serial number, and the cool Sound Forge 
logo.



Tip of the Day
This command will bring up the Tip of the Day pages in the help file. These are helpful and handy tips to 
increase your productivity with Sound Forge.



The Sonic Foundry Home Page
This is a direct link to our home page on the World Wide Web. Invoking this command automatically 
launches your default web browser and takes you to the Sonic Foundry Home Page 
(http://www.sfoundry.com). Here you will find Downloadable demos and updates, technical information, 
and news of what's new with the folks at Sonic Foundry.

You can also send us comments, suggestions, questions, sound files, gossip, whatever…via email from 
our web page (or direct to our development team at develop@sfoundry.com). We'd love to hear how 
Sound Forge is being used and your thoughts on how it can be improved.



Search for Help on
Use this to find on-line information on a particular topic.
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Sound Forge Main Screen Basics    Video tutorial
This section will show you around the Sound Forge screen and teach you the most basic operations. We 
will cover:

Using the Mouse 
The Main Screen 
Toolbars 
The Data Window 
ToolTips 
Getting On-line Help 



Using the Mouse
Although using the mouse in Sound Forge is not required, it will make your editing sessions easier. Once 
you become familiar with Sound Forge you will probably want to use some of the built in shortcuts 
provided by the mouse and the keyboard. The following list of terms will help you when reading the 
manual.

Pointing Moving the mouse pointer over an item is called pointing.

Clicking Pointing to an item and quickly pressing and releasing the left or right mouse button 
is called clicking. The manual will let you know whether you need to right-click or 
left-click on an item to execute a specific function. When there is no specification as 
to left or right you can assume we mean left-clicking. Right-clicking is often used to 
reach Shortcut Menus.

Double-Clicking Double-clicking is the same as clicking except instead of pressing and releasing the 
mouse button once you do it twice in quick succession. Double-clicking always 
indicates clicking twice with the left mouse button.

Triple-clicking Triple-clicking is the same as clicking except instead of pressing and releasing the 
mouse button once you do it three times in quick succession. Triple-clicking always 
indicates clicking three times with the left mouse button. In Sound Forge, a triple-
click in the data window selects all data.

Toggle-clicking Toggle-clicking involves clicking the right mouse button while holding the left mouse 
button to toggle through various options. This is a great shortcut for procedures such
as drag and drop and changing the Magnify Tool mode of operation.

Shift Clicking Shift-clicking is holding down the Shift key on the keyboard while clicking the mouse.
Shift clicking is used mainly to skip dialogs so that you can quickly repeat 
operations.

Control Clicking Control -clicking is holding down the Control key on the keyboard while clicking the 
mouse. Control-clicking is used to modify the operation of a normal click.

Dragging Holding down the mouse button while you move the mouse pointer is known as 
dragging. Dragging is used to quickly move sections of data between separate 
windows and to move trackbars, scrollbars, faders.

Slow-dragging Holding down both the right and left mouse buttons while moving trackbars, and 
faders increases the resolution of the movement. This is especially useful when 
making fractional adjustments to parameters in a dialog box.

Dropping After dragging an item, releasing the mouse button on top of another area is known 
as dropping. Dragging and dropping is used to speed up operations like mixing or 
moving regions within the Playlist.



The Main Screen
When you start Sound Forge, you see the main screen, or work space, where you will do all your editing. 
When you first open Sound Forge, no Data Windows are open and you will need to either open an 
existing sound file or create a new one. There are a variety of ways to do this, all of which are explained 
later in the manual. The following list briefly describes each part of the screen.

Program Title Bar Shows the program name and the name of the currently active data window 
(if the data window is maximized within the workspace).

Data Window Each opened sound file has its own data window. Data windows can be 
arranged, resized, or minimized.

Menu Bar Shows the menu headings for the available functions. When no data 
windows are open, the Process, Effects, and Tools menus are not listed 
because these contain functions which require an open data window.

Status Bar On the left, help and processing information is displayed. The fields on the 
right show the playback sample rate, sample size, mono/stereo, total length 
of the active data window, and the total free storage space. These fields can
be edited by double-clicking or right-clicking on them (except for the free 
storage space, of course). When no data windows are open, the fields are 
blank.

Sound Forge Workspace This is the background area behind the data windows. You can drag 
sections here to create new data windows.



Toolbars
The first time you run Sound Forge, two toolbars also appear on the screen: the Standard and Transport 
toolbars. The toolbars contain buttons which are used to quickly execute commands.

Standard Provides quick access to many commonly used Sound Forge File and Edit menu 
options.

Transport Provides the audio transport buttons: Record, Play All, Play Normal, Pause, Stop, 
Go to Start, Rewind, Forward, and Go to End.

These toolbars, like any other toolbar in Sound Forge, can be dragged and dropped to anywhere on the 
screen. Toolbars are also resizable and removable. When a toolbar is dragged to any side of the main 
window, it docks, or attaches to the side. If you drag a toolbar away from a side, it becomes a floating 
toolbar. To hide a floating toolbar, just click on its Close button.

A list of available toolbars can be displayed by selecting the Preferences command under the Options 
menu and looking in the Toolbars folder (or Toolbars in the View menu). To show a toolbar, just check the 
box next to the toolbar you wish to use and then select OK. The number of open toolbars and their 
position on the screen is entirely up to you.



The Data Window
Data Windows are the windows which contain sound data files. These windows contain a number of sub 
windows and controls which you will use in editing and viewing your sound data. Many parts of the Data 
Window lead to Shortcut Menus, dialogs, and other operations.

The following list briefly describes each part and possible mouse operations:

Title Bar Shows the file name or, if present, the title stored in the Summary information 
of .WAV files. Double-click to maximize and restore the window.

Level Ruler Shows the amplitude of the waveform. Right-click to reach the Level Ruler 
shortcut menu. Drag to shift the view up or down when zoomed in vertically.

Time Ruler Shows the current location in the data window as well as ruler tags. Right-click 
to reach the Time Ruler shortcut menu. Drag to scroll the data window.

Ruler Tags Used to indicate the position of region end points, loop end points, and 
markers. Right-click to reach the Ruler Tag shortcut menu. Drag to change 
their locations. Double-click anywhere in the region to select.

Edit Tool Selector Use this button to toggle between the Edit, Magnify, and Pencil Tools. Note: 
The Pencil Tool requires that the zoom ratio be between 1:1 and 1:16.

Playbar On the left side of the playbar are the following audio transport buttons: Go to 
Start, Go to End, Stop, Play Normal, Play Looped, and Play as Sample. To the 
right are the playbar's selection status fields.

Selection Status Fields Show the beginning, end, and length of a selection. If no selection has been 
made, only the cursor position (also known as the insertion point) is displayed. 
Double-click on the left-most field to reach the Go To dialog. Double-click on 
either of the other two fields to reach the Set Selection dialog. Right-click to 
reach the Status Format shortcut menu.

Waveform Display Shows a graphical representation of the sound file. The horizontal axis 
represents time (marked in the Time Ruler) and the vertical axis represents 
amplitude (marked in the Level Ruler). Right-click anywhere on the waveform 
display to reach the Waveform Display shortcut menu.

Position Scroll Bar Use this to scroll the sound file forward and backward in time to see parts of 
the file not currently visible in the waveform display.

Overview Allows for quick navigation and playback of any part of the file. Overview also 
shows the fraction of the waveform being shown on the waveform display, as 
well as the selected region. Left-click to move the cursor. Double-click to center
the cursor in the waveform display. Right-click to start playback or pause. Left-
click and drag to activate the Audio Event Locator. 

Time Zoom Resolution (Also called Zoom Ratio) Specifies the number of samples of data represented 
by each point on the screen horizontally. This determines the length of time 
which is shown in the waveform display. With a small resolution value (1:1, 1:2,
1:4, ...), a shorter length of time is displayed.

Time Zoom In/Out Use this to change the zoom resolution for the time axis. Between these 
buttons is a spinner that allows you to continuously change the time zoom 
resolution.

Level Zoom In/Out Use this to change the zoom resolution for the level (vertical) axis. Between 
these buttons is a spinner that allows you to continuously change the level 
zoom resolution.

Maximize Width Pressing this button stretches the width of the data window to fit within the 



Sound Forge workspace.

OLE Drag Source Drag from this section of the data window into another application such as 
Microsoft Word, to link the sound file to other documents.



ToolTips
If you keep the mouse over a toolbar button or status bar field for more than one second, you will notice a 
small box appear next to the mouse pointer containing some text. This text is a quick description of the 
function of the button or field. Using ToolTips is an easy way to learn your way around the Sound Forge 
screen. If you wish, you can disable this function by selecting Toolbars under the View menu and un-
checking Show ToolTips.

When you press and hold a button in a toolbar or select a menu item, you will see a one line description 
of the command in the left side of the status bar. This gives you a little more descriptive information about 
the function of a button. If you release the mouse button outside of a toolbar or menu item, the toolbar 
command will not be performed.



Getting On-line Help
On-line help is available in a variety of ways. You can:

Go straight to the Help table of contents by selecting Contents under the Help menu, or pressing F1. 
Once there, you can search for your help topic and also get information on using the on-line help.

Press the Help button or the F1 function key in a dialog. This will take you straight to the help 
information on the dialog. 

Press the F1 function key while selecting a menu item to get information on the command.

You will find that on-line help is extremely useful as a quick reference guide. Since many topics are cross 
linked, its easy to navigate through all of the help material available on a topic. Once you have become 
familiar with using Sound Forge, you'll probably never have to refer to this manual to find information. All 
you'll need is the on-line help.



Data Window Basics
With Sound Forge, you can have multiple sound data files open simultaneously on the screen. Each file 
has its own corresponding Data Window which shows you a graphical representation of the waveform 
and other information about the file. This section covers the following topics:

Opening an Existing File 
Playing a File 
Playing a Section 
Using the Transport vs. the Data Window Playbar 
Creating a New Window 
Active Windows vs. Inactive Windows 
Copying Data to a New File 
Saving a File 



Opening an Existing File
To open an existing sound file, do the following:

1. Select the Open command from the File menu. Sound Forge displays the Open dialog.
2. Use the Open dialog to select and open a file. You can preview .WAV files by pressing the Play 

button in the Open dialog. Pressing the Play button once more stops the playback. You can also 
have the files play when selected by checking the Auto play box.

You can use the Files of type list to select different types of data files. If Sound Forge recognizes the type 
of a file when it is highlighted in the files list, it will display its information in the bottom half of the dialog. 

Open the file TUTOR1.WAV now. This file is located in the directory where you installed Sound Forge.

You will now see the data window containing TUTOR1.WAV. This file is a recording of someone saying 
"Wow, sound editing just gets easier and easier."

Notice how even though the file name is TUTOR1.WAV the name of the data window is Wow, sound 
editing... This is because we have stored a title for the file within the .WAV file itself. Sound Forge allows 
you to embed descriptive titles as well as copyright information and other text fields for any .WAV file.

Sound files in Sound Forge can have a title that is different from the file name. To edit the
title, use the Summary page of the Properties command dialog (File menu). You can

quickly get to the Summary dialog by pressing Alt+Enter.



Playing a File
Once you have opened a file, you can hear it by clicking on the Play All button on the Transport toolbar.

While the file is playing, a pointer will move along the data window showing the current position. You will 
also see the current position in the first selection status field in the playbar.

Play the TUTOR1 file now. You will hear the words Wow, sound editing just gets easier and easier.

You can play from any point in the window by simply moving the cursor. Move your mouse pointer to the 
silence section right after the "Wow" portion of the file. Left-click (don't drag, we don't want a selection 
yet), and you will see the flashing cursor in the silence area after the word "Wow." Click the Play button on
the Transport toolbar and now you will only hear the "sound editing just gets easier and easier" part. 

If you don't hear anything you may have made a small selection by accidentally dragging the mouse. To 
tell if you've made a selection just look at the three right hand status fields in the data window status bar. 
If only the first one is filled, then you don't have a selection. If they all have values then you need simply 
click in the data window again to clear the selection.



Playing a Section
You can also play portions of the sound data by making a selection on the waveform display with the 
mouse. To do this, click and drag the left mouse button starting at the section of silence prior to "Wow." 
Drag the mouse until you are in the portion after the "Wow." Notice that as you drag the data, the 
background appears in another color. Let the mouse button up and you will now have a highlighted 
section of data. Again click the Play button. You should now hear just the "Wow" portion of the file.

While making a selection, and after selecting, you will notice that the three selection status fields on the 
right side of the playbar have values. These values show you the start (Selection Left), end (Selection 
Right), and length (Selection Length) of the selection you have made. When no selection has been made,
the cursor position (also called the insertion point) is shown.

Let's clear the selection and put the cursor back at the start of the file. To do this click on the Go to Start 
button in the Transport toolbar (the fourth button from the left).



Using the Transport versus the Data Window Playbar
There are a number of ways to play your sound files within Sound Forge. The most common method is to 
use one of the Play buttons located either on the Transport toolbar or the playbar in the data window. Let's
take a look at both of them.

The Playbar buttons
On the left-side of the playbar at the bottom of every data window are six buttons. These buttons allow 
you to play the sound data in a variety of ways. The first two buttons allow you to set the cursor to the 
start or end of the current file. These are the Go to Start and Go to End buttons. The next button is the 
Stop button which you can use at any time to stop playback.

The last three buttons play the sound in three different ways and also set the default play mode at the 
same time. The first button is the Play Normal button. This button plays the currently selected section of 
data. If there is no selection, pressing the Play Normal button plays from the current cursor position to the 
end of the file. 

The final button is the Play as Sample button. This button is used to play a sound file as if it was present 
in a sampler. This means the file will play from the start until it reaches the sustaining loop defined for the 
file and then will loop in the sustaining loop for the number of loops defined. If there are no loops defined 
the file plays straight through. This is known as a one shot sample.

Whenever you play a file from the playbar, you will notice a small line that appears underneath the play 
arrow in the corresponding Play button. This is the current play mode which will be used whenever you 
select the Play button in the Transport toolbar (or hit the Spacebar). Play Normal is the current play mode 
in the playbar graphic shown above.

To change the current play mode, press the corresponding playbar button or use Control+Spacebar.

The Transport Toolbar
The Transport toolbar has seven buttons.

The Transport toolbar buttons are described below from left to right:

Record Brings up the Record dialog which allows you to record to either a new or
existing window. Shortcut: Control+R

Play All Plays the entire sound file from beginning to end. This allows you to hear
the entire sound even if you have a selection or the cursor positioned 
somewhere other than the start of the data. Shortcut: Shift+Spacebar

Play Plays the file using the current play mode. To set the play mode select 
one of the three play buttons on the playbar as described above. The last
button used becomes the active play mode. Shortcut: Spacebar

Pause Works like the Stop button in that it stops play of the current file. 
However when selecting Pause the cursor is placed at the current play 
position rather than back to where it was when play was selected. 
Shortcut: Enter during playback

Stop Stops play and positions the cursor back to where it was prior to 
selecting play. Shortcut: Spacebar during playback



Go to Start Places the cursor at the beginning of the sound file. Shortcut: 
Control+Home

Rewind Shuttles the cursor backward in the sound file. Shortcut: Control+Left 
Arrow

Forward Shuttles the cursor forward in the sound file. Shortcut: Control+Right 
Arrow

Go to End Places the cursor at the end of the sound file. Shortcut: Control+End



Creating a New Window
To create a new Data Window do the following:

1. Select the New command from the File menu. Sound Forge displays the New Window dialog.
2. Select the new data format in the dialog.

Since we are already working with the TUTOR1 file let's create a new window that has the same data 
format as TUTOR1.

In the New Window dialog set the Sample size to 16-bit, the Channels to Mono, and the Sample rate to 
44,100. When you click the OK button a new window will appear titled Sound2. This is an empty data 
window into which we are going to place data from TUTOR1.



Active Windows vs. Inactive Windows
When you have multiple windows on the screen, only one window is considered the active window. This is
the window on which you are currently working. Any operations you perform will only affect this window.

To make a window the active window click anywhere on the window with the left mouse button. The 
window's title bar will change to the color you have defined as the active window color in Control Panel in 
Windows.



Copying Data to a New File
Make Wow, sound editing... the active window by clicking on its title bar. If you don't still have the word 
Wow selected, select it again as we did above. From the Edit menu, select the Copy command. This will 
copy the sound data for Wow onto the clipboard.

Now make Sound2 the active window by clicking on its title bar (if the title bar is covered by another 
window, you can always use the Window menu to activate a data window). Select the Paste command 
from the Edit menu and the Wow data will appear in the Sound2 window. If you press the Play button, you
can hear how our new file sounds with just the word Wow.

There are faster ways to copy data from one window to another, or from an existing window to a new 
window, but we will cover those in a later section.



Saving a File
To save a data window, you first need to make it the active window. Make sure the Sound2 window is 
active.

1. Select the Save command from the File menu. Since the Sound2 window is a new file, Sound 
Forge displays the Save As dialog. If the file had been opened or previously saved by Sound Forge 
the file would be saved immediately.

2. Type a file name into the File name field in the Save As dialog and select the OK button. Let's save 
the new sound file, Sound2, as MYFIRST    Sound Forge will add the file extension, .WAV, 
automatically.

The Save As dialog also allows you to change file types, data format, and set summary information fields. 
This is covered in a later section.



Simple Editing and Navigation
This section will show you the basic editing operations of Sound Forge.

Common Edit Operations 
Making a selection 
Copy, Paste, Cut, Undo, Redo 
Cropping 
Simple Mixing 
Status Formats 
Magnification and Zooming 



Common Edit Operations
The edit operations used most often include cut, copy, paste, delete, mix, and trim/crop. Most of these 
make use of the Clipboard, which is a temporary storage area which can also be used to move data from 
one window to another. The following list provides a brief description of each operation:

Cut Deletes a selected portion of data and copies it on to the Clipboard.

Copy Copies a selected portion of data on to the Clipboard.

Clear Deletes a selected portion of data but doesn't copy it on to the Clipboard.

Trim/Crop Deletes all data in a window except the selected section.

Paste Inserts the contents of the Clipboard into a Data Window at the current cursor 
position.

Mix Mixes the contents of the Clipboard with the current data in a window starting at the 
current cursor position.

Crossfade Crossfades the contents of the clipboard with the current data in a window starting 
at the current cursor position.

To show how these operations are used, we will once again be using the TUTOR1.WAV file. If it is not 
currently open please open the file now as described in the previous sections.



Making a Selection
If TUTOR1 is not the active window, activate it by clicking on its title bar. To make a selection, you must 
first make sure that you are using the Edit Tool. To get to the Edit Tool, look under the Edit menu for the 
Tool item (it should already be checked) and select Edit. Next, select the word "Wow" with the mouse by 
clicking and dragging like we did in the previous section. You can verify you have the right section of data 
by pressing the Play button to hear it.



Copy, Paste, Cut, Undo, and Redo
Copying Data on to the Clipboard
Once you have a selection, you can use the Copy command from the Edit menu. This will copy the 
selected data onto the clipboard. You will see no change since the Copy command does not change the 
data, it only copies it to the clipboard.

Pasting Data from the Clipboard
Now move the cursor to the beginning of the file by selecting the Go to Start button on the playbar. To 
insert the contents of the clipboard into the file, use the Paste command from the Edit menu. You should 
now see the data for the word "Wow" appear at the beginning of the window. Press the Play button just to 
make sure. You should hear Wow Wow Sound editing just gets easier and easier.

You have just made your first edit in Sound Forge! There are much quicker ways to do what we have just 
done with Sound Forge, but we'll get to that in the Advanced Editing section.

Pasting Data to Another Window
Data on the clipboard remains there until it is replaced by another operation which places data onto the 
clipboard. Therefore, you can continue pasting the data anywhere you want.

To demonstrate this, create a new window as described in the previous section by selecting the New 
option from the File menu. Now, select the Paste command from the Edit menu once more. You should 
now have a new data window with the data for the word Wow. You can also do this by selecting the Paste 
to New function in the Paste Special item of the Edit menu. This creates a new window and fills it with the 
clipboard contents in one easy step.

Cutting Data
To cut data, first you need to select a section of data you want to cut. Select one of the Wow words (you 
should have two if you have been following the examples) from TUTOR1.

Now select the Cut command from the Edit menu. This will remove the selected data and place it on to 
the clipboard.

Undoing an Edit Operation
After any edit operation you can cancel it by selecting the Undo command from the Edit menu.

Let's undo the cut we just made. Select Undo Cut from the Edit menu and you will see the original two 
Wow words in the TUTOR1 window.

Redoing an Edit Operation
If you change your mind again and decide you really liked an edit you undid, simply select Redo from the 
Edit menu. Doing this re-performs the edit operation you last undid. In this case selecting Redo would re-
cut the second Wow from the TUTOR1 window. 

Let's redo the cut. Select Redo Cut from the Edit menu and you will see the second Wow has been cut 
from the file again.

The Undo/Redo History window (View menu) also allows you to restore your sound file to
previous states by undoing or redoing operations. For more information, see the

Reference section.



Trimming edges (crop)
Trim (also called Crop) allows you to single out a section of data and cut everything else out of the 
window except that section. This is a handy feature since you can keep using the Play button to hear 
selections until you have just the right amount and then get rid of everything else with the Trim/Crop 
command in the Edit menu.

By now you should be getting used to selecting data on the screen, so select the "Wow, sound editing just
gets easier" section in the TUTOR1 window, but don't select the second easier. Remember you can use 
the Play button to hear how the selection sounds at any time.

Once you have the selection, select the Trim/Crop item found in the Edit menu. After cropping you will 
have only "Wow, sound editing just gets easier" left in the window. 

At this point let's close the Wow, sound editing... window. Either click on the close box of the TUTOR1 
window, or select the Close command from the File menu. You will be asked whether you want to save 
the changes you have made to TUTOR1. Select the No button since we don't want to keep the changes 
we made to TUTOR1.

Also close any other windows you may have open, like MYFIRST.WAV.



Mixing
Mixing is a powerful and useful edit operation which you will use often. Mixing allows you to combine two 
sounds together into one window so you can create complex sound effects.

This time we are going to open two files, TUTOR1.WAV and TUTOR2.WAV. Open them now as we've 
shown you in the previous sections.

TUTOR2 is a file which contains the sound of a snare drum and crash cymbal. We are going to mix this 
sound with TUTOR1; the "Wow, sound editing..." window.

Before we begin mixing, let's make sure the Status Format is set to Time to make finding the mixing 
points a little easier. To do this select the item Time from Status Format under the Options menu. You will 
need to do this for both data windows since Sound Forge keeps track of the format type for each 
individual window.

To make the windows easier to view during the mix operations you may want to maximize Sound Forge 
by pushing the Maximize Window button in the upper right-hand corner and selecting the Tile Vertically 
item from the Window menu. This will arrange the windows vertically    fully utilizing the Sound Forge 
workspace    and make things easier to see.

If you activate each of the TUTOR windows you will notice that the length of TUTOR1 is 5.0 seconds long 
and TUTOR2 is 3.0 seconds long. For this example, we want the drum hit to occur just before the "Wow." 
We could just copy the drum hit sound on to the clipboard and then paste it before the "Wow", but this 
would increase the length of TUTOR1 to 8.0 seconds. So instead we'll use the Mix command.

Select all the data in Drum Hit by making it the active window and then double-clicking in the waveform 
display with your left mouse button (you could also use the Select All command under the Edit menu). 
Now copy the data onto the clipboard by selecting the Copy command from the Edit menu.

Make TUTOR1 the active window and then select the Go to Start button on the playbar. This will put the 
cursor at the beginning of TUTOR1. Select the Mix command from the Paste Special option in the Edit 
menu.

The Mix dialog now appears. Keep both levels at 0 dB and select OK.

You will see that the drum hit sound has been mixed into the TUTOR1 window and the length of TUTOR1 
is still 5.0 seconds. Press the Play button to hear the results.

Select the Undo Mix command from the Edit menu to put TUTOR1 back to its original state. 

Now let's mix the drum hit sound closer to the Wow portion of TUTOR1. The Wow occurs at about 0.8 
seconds into TUTOR1, so move your cursor in the TUTOR1 window to approximately 0.8 seconds. You 
do this by clicking with the left mouse button in the data window of TUTOR1 and watching the cursor 
position status field on the status bar (the left most field). You don't have to be exact. Once you've 
positioned the cursor, select the Mix command again and then hit Play for the result. Notice how the drum
hit sound and the Wow sound overlap each other.



Status Formats
By right-clicking on the Time Ruler and selection status fields on the playbar, files can be set to different 
formats. You can coordinate sound files with other events, or edit to a timing base you feel most 
comfortable using.

Lengths and positions can be displayed in a variety of formats including Samples, Time, Seconds, 
Frames, Measures and Beats, and SMPTE.

Selecting a Status Format
To select a format choose the Status Format item from the Options menu. This shows the ten different 
formats available. Choosing one of these options sets the status format for the current data window.

The available formats are:

Samples Number of samples

Time Hours, minutes, seconds and milliseconds

Seconds Seconds and fractions there of

Time & Frames Hours, minutes, seconds and frames as defined by the Edit Frame Rate (Special 
Menu )command

Absolute Frames Frames and fractions there of

Measures & Beats Measures, beats and 1/4's of a beat

SMPTE Non-Drop SMPTE at 30 or 29.97 frames per second (fps) non-drop

SMPTE Drop SMPTE at 30 fps with drop frames

SMPTE EBU SMPTE at 25 fps

SMPTE Film Sync SMPTE at 24 fps

Using the current file, TUTOR1, let's take a look at how the status formats affect values in the status 
display fields. First, select the Samples format from the Status Format menu under the Options menu.

Now select all of the data in the TUTOR1 window. To do this choose the Select All option from the Edit 
menu. This will select all data in the window. You can also select all of the data in a window by triple-
clicking the left mouse button anywhere in the waveform display of the data window.

In the selection status fields on the playbar (at the lower right hand side of the data window) you should 
see the values of 0, 240,006, and 240,007. This means that the first selected sample (Selection Left) is 
sample 0, the last selected sample (Selection Right) is 240,006, and the total number of samples in the 
selection (Selection Length) is 240,007.

Now select the Time option from Status Format under the Options menu. You will see that all these values
change to values specified in hours, minutes, and seconds rather than samples. You can see that a sound
containing 240,007 samples with a sample rate of 44,100 Hz will play for 5.000 seconds. You can 
experiment with each of the status formats to see how each format is displayed.

Configuring Frames and Measures & Beats
When setting the status format to Frames or Measures & Beats, there is additional information you can 
provide to Sound Forge to customize how these values are displayed. The Edit Frame Rate dialog in the 
Special menu allows you to change the frames per second. In the Edit Tempo dialog, also in the Special 
menu, you can specify the Beats per minute and Beats per measure values used to calculate measures 
and beats. The default values for Frames and Beats are set on the Status page in the Preferences folder 
(Options menu).





Magnification and Zooming
When sound data is drawn on the screen, it is necessary to represent many samples of data for each 
horizontal point on the screen. There are almost always many more samples in a sound file than there are
horizontal points (pixels) on the screen. Depending on the editing operations you need to use, you may 
want to view the entire file at once, or you may want to look only at a small portion in greater detail. This is
where the magnification, or zoom ratio, comes in.

Time Ruler Zooming 
Level Ruler Zooming 
Using Zoom Selection and Zoom Out 
Magnify Tool 



Time Ruler Zooming
In the bottom right corner of the data window, just above the data window playbar, is the current time 
magnification ratio. The Zoom Ratio defines how many samples of sound data are squeezed into each 
horizontal point on the screen. This setting is shown as a value of 1:XX , where XX is the number of 
samples represented by each horizontal point on the screen.

For example, if the setting is 1:1 then each point on the screen is one sample. With this setting, a very 
short length of time is shown on the waveform display. You might not be able to see the cursor or 
selection because you are seeing it at such close range. If the setting is 1:1,024, then there are 1,024 
samples represented by each point on the screen and a longer length of time can be seen. By dragging 
the Time Ruler right or left, you can easily scroll the data window. The further you drag in either direction, 
the faster the window will scroll.

If you right-click on the waveform display you can quickly select various Zoom
commands from the Data Window shortcut menu.

When Sound Forge opens a file it sets the horizontal magnification to the value specified by the Normal 
zoom ratio set on the Display page in the Preferences folder, unless the file is too small.

To increase or decrease the Zoom Ratio, use the Zoom In/Out spinner control found on each data window
next to the ratio. Clicking on either of the magnifying glasses increases or decreases the zoom ratio by 
single steps. If you drag the small rectangular button between the two magnifying glasses, you can spin 
the zoom ratio by large amounts.



Level Ruler Zooming
In the bottom left corner of the data window, just above the Go To Start button, is the spinner control for 
zooming in and out vertically in the data window. Zooming in along the level axis allows for more precise 
editing at the lower levels (where many edits start and end).

The labels for this axis can be either in decibels or in percent and are switched by right-clicking on the 
ruler. When zoomed in, only the lower level samples can be seen; the peaks of the waveform will have 
moved beyond the scope of the data window. To view these peaks, drag the Level Ruler up or down.

To optimize both the time and level scaling of a selection, double-click on the Level Ruler.
Double-click again to zoom out to the normal level.



Using Zoom Selection and Zoom Out
If you would like to quickly magnify a section of a data window horizontally, the easiest way is to use the 
Zoom Time|Selection command found in the View menu or in the Data Window shortcut menu. To use the
Zoom Time|Selection command you must first select an area which you want to magnify. After selecting 
Zoom Time|Selection, Sound Forge will calculate the minimum zoom ratio which will allow the full 
selection to fit on the screen and then center the selection within the waveform display. 

This will not affect the zoom ratio of the Level Axis. Only the Zoom Selection command in
the Level Ruler shortcut menu will zoom the selection both vertically and horizontally.

To display all data in a window at one time, use the Zoom Time|Out Full command. This command sets 
the Zoom Ratio to the lowest value needed to display all of the data at once in the waveform display.

If you wish to set the zoom factor to its maximum magnification (1:1), use the Zoom Time|In Full 
command also found in the View menu or the Data Window shortcut menu (Zoom In Full). You will then 
be able to see the actual waveform oscillations which correspond to physical sound waves when played 
through your speakers.



Magnify Tool
Another way to zoom in to a particular section of the sound file is to use the Magnify Tool. You can select 
this tool from the Edit menu (Tool|Magnify) or by clicking on the Edit Tool selector (upper left-hand corner 
of data window) until the magnifying glass appears. 

When the Magnify Tool is enabled, instead of making a selection, the mouse cursor will become a 
magnifying glass and a dotted square will appear. The zoom will take place within this dotted square. The 
three different modes of operation for the Magnify Tool can be selected by toggle-clicking (See Using the 
Mouse above). These allow you to time zoom, level zoom or both simultaneously. You must then return to
the Edit Tool mode to do edit operations.

You can also enter this Magnify mode temporarily by holding down the Control key when making a 
selection. If you drag the mouse while still holding the Control key, you can select a region which will then 
be magnified to a best fit ratio within the waveform display.



Advanced Editing and Navigation
This section will show you how to use the advanced editing and navigation operations of Sound Forge:

Making a selection using the Set Selection dialog 
Extending the selection points with the mouse 
Selecting with the keyboard 
The Overview 
Using the Go To dialog 
Using Views 
Drag And Drop Operations 
Advanced Mixing options 
Editing Stereo Files 



Making a selection using the Set Selection dialog
If you need to select data at specific points, the Set Selection dialog allows you to type in selection points 
or choose a selection from a list of regions. To reach the Set Selection dialog, choose the Selection|Set 
command from the Edit menu.

In the Set Selection dialog, you can modify the Start, End, Length, and Channel of the selection. Pre-
determined regions can also be chosen from the Selection drop-down list.

Also, in this dialog you will find Snap Zero and Snap Time buttons. Pressing one of these buttons will 
force the current start and end selection points to their nearest zero-crossings or time increments, 
accordingly. A more thorough explanation of these functions can be found in the Reference chapter under 
Selection in the Edit menu section.

Many commonly used functions in Sound Forge can be performed in a number of different ways. For 
example, you can reach the Set Selection dialog by double-clicking on the playbar field to the left of OLE, 
or you can pick the Selection item from the Waveform Display shortcut menu. Sound Forge has been 
designed to allow you to choose how you want to work. It doesn't force you to work in a certain way. To 
avoid confusion in our demonstrations, we won't always tell you about every method of accomplishing the
same task. Refer to the Sound Forge Reference chapter and the Appendix section on shortcut keys for 
more information on each feature.



Extending a Selection the Mouse
After selecting a section of sound data, you will sometimes find that the start or end points are not exactly 
where you want them to be. You could just re-select the data, but it is often difficult to get the start or end 
points just right. 

Sound Forge allows you to update the selection by grabbing a selection edge and moving it. Once you 
have established a selection, place the mouse over the selection start or end point. You will notice that the
cursor changes to a bi-directional arrow. Once this arrow appears, you can press the left mouse button 
and move the selection to a new position. The new position will be updated once you let up on the mouse 
button.

Snapping a Selection to Zero-crossings
If after making a selection, the end points jump somewhere else automatically, its probably because you 
have Auto Snap to Zero on. You may want to enable Auto Snap to Zero (under the Options menu) so that 
any drag selections start and end points will always reside on a zero-crossing. 

To make a current selection snap to zero-crossings, select Edit|Selection|Snap to Zero (or press Z on the 
keyboard).

If you'd like Auto Snap to Zero disabled only when zoomed in (1:1 or 2:1), select the Disable auto-
snapping below 1:4 zoom ratios option in the Editing page in the Preferences folder.



Selecting with the keyboard
The keyboard selection controls allow you to quickly select data or update a selection accurately. For 
example, say you want to extend the selection end by a small amount. First make sure that the cursor is 
at the end of the selection. You can move the cursor from one end of the selection to another by pressing 
the Home (moves to the start) and End (moves to the end) keys. Use the C key to center the cursor in the
waveform display. You can then use the Shift+Right arrow and Shift+Left arrow combinations to extend 
the selection end point by small increments.

The following list shows the available keyboard commands for selecting data.

Press To select from cursor to…

Shift+Right arrow the next screen pixel.

Shift+Left arrow the previous screen pixel.

Shift+End the last sample visible in the waveform display.

Shift+Home the first sample visible in the waveform display.

Press To select …
Shift+Page Up 10% of the current view past the cursor position.

Shift+Page Down 10% of the current view previous to the cursor position.

Shift+Control+Right arrow 2% of the current view past the cursor position (see below).

Shift+Control+Left Arrow 2% of the current view previous to the cursor position (see below).

Shift+Numpad + the next sample.

Shift+Numpad - the previous sample.

Shift+Control+Numpad + 10 samples past the current position.

Shift+Control+Numpad - 10 samples previous to the current position.

In Windows 95, Shift Numpad + will not work unless the Numlock indicator on the
keyboard is lit.

Also, if there are regions, markers, or loops present in the data window:

Press To select from cursor to…

Shift+Control+Right arrow the next region start/end or marker.

Shift+Control+Left arrow the last region start/end or marker.

As you can see from the above lists, Sound Forge has extensive keyboard support for selecting data. You
will find that almost any operation has an equivalent keyboard shortcut which advanced users find 
invaluable. For a complete listing see Appendix A.

Let's take a quick look at how to use some of these keys. Open the file TUTOR1.WAV as we've done in 
previous sections. First, make sure that you're using the Edit Tool by selecting it in Tool under the Edit 
menu. Now make a selection that encompasses the word Wow with a generous amount of space on each



side of the word. Pressing the Play button you should hear a little bit of silence, Wow, and a little more 
silence.

Choose the Zoom Selection command from either Zoom Level or Zoom Time in the View menu. This will 
fit the selection on the screen with the best possible resolution. Now let's adjust the right side of the 
selection.

Grab the end of the selection with the mouse and drag to the right. Adjust the selection to be close to the 
end of the word Wow and let up on the mouse button. Now let's do the same thing with the keyboard. 
Hold down the Shift key and press the right arrow key. The selection will extend to the right by one screen
pixel. If you hold down the Shift key and press the left arrow key, the selection will decrease by one pixel. 
One screen pixel is equal to the number of samples shown in the Zoom Ratio field. You can move the end
of the selection in this manor until you've got the selection just right.

Now let's adjust the start of the selection. Since the cursor is at the end of the selection, any keys we 
press for selecting will adjust the end. So we need to put the cursor at the front of the selection. To do 
this, press the Home key. You will see the cursor jump to the start point of the selection. Now, use the 
selection keys to adjust the start of the selection.

A selection can also be updated on a per sample basis rather than a pixel basis. If you look in the above 
list you will see that the Shift + Numpad + (plus) and - (minus) keys are used for these operations. This 
allows you to get the exact selection you need without having to change the Zoom Ratio.



The Overview
While making selections and navigating through a sound file, you probably noticed the overview (the thin 
bar directly underneath the title bar) change. The overview represents the length of the entire sound file, 
as if you were zoomed out all the way. From the overview, you can determine what section of the entire 
sound file is being displayed, the selection made, and the cursor location.

Getting the Whole Picture 
Zoom out all the way on the TUTOR1 window (Zoom Out Full in the Data Window shortcut menu) and 
make a selection over the word Wow. Notice that the entire overview has brackets above and below it, 
since the entire sound file is being displayed. Also notice how the selection and the cursor are displayed 
on the overview.

Now press the Zoom In button a few times (the large magnifying glass in the lower right-hand corner of 
the data window) and notice how the brackets become smaller. This corresponds to the smaller fraction of
the entire sound file which you can see when you zoom in on the waveform display. The selection size, 
however, remains the same and does not move. Even when you can't see them on the waveform display, 
you always know where the cursor and the selection are in the sound file by referring to the overview.

You can also change the cursor position by left-clicking anywhere on the overview. As always, when you 
change the cursor, you lose your selection. Remember you can use Toggle Selection if you want to 
restore it.

Fast Navigation and Playback
When you left-click outside the bracketed region in the overview, you will not be able to see the cursor on 
the waveform display. However, double-clicking anywhere on the overview will move the cursor and 
center the waveform display to the selected position in the sound file.

You can also play back the sound file starting from the current cursor position by right-clicking anywhere 
on the overview. Right-clicking again pauses playback. Left-clicking in the overview also moves the cursor
position. Also note that left-clicking on the overview during playback moves the cursor to the point where 
you clicked and continues playback at that point. These navigation tools make it very easy to find sections
in large files.

As an example, say you wanted to move the cursor to the beginning of a phrase in a speech. You can 
right-click on the overview bar to begin playback and then left-click at different positions within the 
overview until you find the right start point. Once you find the start point, you can press the Stop button to 
stop playback. The cursor should now be positioned at the last spot on which you left-clicked in the 
overview; select Center Cursor from the Special menu and you are ready to edit.

Audio Event Locator
Holding down the left mouse button and dragging it in the overview bar will begin playback of small 
looped portions of audio around the cursor position. While this is not technically a scrub function, it serves
a similar purpose i.e., it allows the user to hear brief segments of audio material in order to quickly scan or
locate events within the sound file. The length of the Audio Event Locator loop segment can be adjusted 
in the Preferences dialog.



Using the Go To dialog
To quickly move the cursor to a specific point and center it in the waveform display, use the Go To 
command. You can reach the Go To dialog in a number of different ways:

Use the Go To item in the Edit menu

Right-click on the waveform display and select Cursor|Go To from the shortcut menu

Double-click on the left-most selection status field

Press Control+G

The Go To dialog is much like the Set Selection dialog described below. You can type in the location 
where you want to go or use one of the predetermined locations from the list. To create your own location 
marker, press the M key at any cursor position. You can also drop a marker at any time during playback 
and recording by pressing M. Refer to the Regions List and Playlist sections for more information on using
markers.



Using Views
If you wish to save the selection points you've set, the zoom ratio, or the position of the waveform display, 
you can do so with Views. Sound Forge has the ability to store up to eight views for each data window. 
Each view stores the selection, cursor position, magnification, and position scroll bar placement. A saved 
view can later be instantly restored.

You can store and recall up to eight different views (1-8) in this manner. There is also a Views toolbar you 
can use (look in the Toolbars folder of the Preferences dialog) to set and restore views. When using the 
Views toolbar, all stored views are indicated by an underscore in each View button.

Follow these steps that demonstrate how to use views:

1. Open the file TUTOR1.WAV and select Wow.
2. To store the current view, press Control+1.
3. Now, zoom in and make a different selection anywhere you wish. Store this new view by pressing 

Control+2.
4. To return to the first view you stored, press 1. Notice that the selection and zoom factor are 

restored.
5. To go to the second view you created, press 2.



Drag And Drop Operations
You can perform a mix, paste, or crossfade by dragging a selection from one data window and dropping it
on another.

To drag and drop:

1. Open two sound files and select Tile Vertically from the Window menu just to make them easier to 
work with. One will be called the source window and the other, the destination window. 

2. Press and hold the left mouse button in the selected area of the source data window. While holding 
the mouse button down, move the cursor until it changes to an arrow dragging a little box. 

3. Drag the cursor onto the destination window. You will see a shaded block that represents the range 
of the source material. You will also see that the little box accompanying the cursor now contains an
M(Mix), C (Crossfade), or P (Paste). Position the block at the place in the destination window where
you would like the mix, paste, or crossfade to occur.

4. Let go of the left mouse button. This will bring up the Mix dialog. To perform a crossfade instead of 
a mix, hold the Control key down while letting go of the mouse button. Holding down the Alt key 
when dropping performs a paste. 

Tip: An easier way to select whether you will perform a mix, paste, or crossfade    is to simply drag the 
block to the destination window and then while holding the left mouse button, click the right mouse button 
to toggle between the Mix, Paste, or Crossfade functions. You will see the block change according to the 
method; a mix will look like a solid block, a crossfade will look like an X (or perhaps, a butterfly), and a 
paste will be represented by a segmented vertical line rather than a block. 

As we did in the previous section on mixing, open the two files, TUTOR1.WAV and TUTOR2.WAV. For 
this example, TUTOR1.WAV will be the destination window and TUTOR2.WAV the source window.

To make the windows easier to view while doing the mix operation you may want to select the Tile 
Vertically option from the Window menu.

Highlight all the data in TUTOR2 by making it the active window and triple-clicking in the waveform 
display. Now drag the selected section by pressing and holding the left mouse button in the data window 
of the TUTOR2 window. Notice that the cursor changes to a pointer with a small box when you begin 
dragging. Drag the block to the beginning TUTOR1 data window and let go of the mouse button to drop 
the section.

When you let go of the mouse in the TUTOR1 window, you will see a dialog which shows the 
TUTOR2.WAV window as the source and TUTOR1.WAV as the destination. Leave the levels at 0 dB, and 
select OK. You will see that again the drum hit sound has been mixed into the TUTOR1 window. Press 
the Play button to hear the results.

Drag and Drop Crossfading
Undo the last operation. Now select all of TUTOR2 and drag it toward the end of TUTOR1. Press and 
hold the Control key, you will see the crossfade block and by moving the block back and forth horizontally 
across the end of TUTOR1, you can adjust the crossfade time and see the crossfade expand and 
contract over the end of the destination file. Once you have determined where you would like the 
crossfade to begin, let go of the mouse button. This takes you to the Crossfade dialog. Select the Normal 
crossfade preset from the preset list at the top of the dialog and press OK. You should hear the end of 
TUTOR1 fade out as the beginning of TUTOR2 fades in.

Drag and Drop Pasting
Again, undo the last operation. Select all of TUTOR2 and drag it over to TUTOR1. Hold the Alt key down 
while you position the paste point at the beginning of TUTOR1. Now, let go of the mouse button. If 
everything was done correctly, you should have pasted the data from TUTOR2 at the insert position in 
TUTOR1.



Creating a New Window with Drag and Drop
A very useful feature of drag and drop is the ability to quickly create a new window from a selection. Make
a selection in a data window and drop it on an empty area of the Sound Forge workspace. A new data 
window is automatically created containing the data from the selection.

Snap to Event in Drag and Drop Operations
Another useful feature of drag and drop is the ability to snap to markers, regions, time increments and 
other events in the destination window. All of the drag and drop operations mentioned above will snap (or 
gravitate) to points in the destination file depending on what events have been established in the file. 

The following list shows possible Snap to points in the destination file.

Cursor Start of block snaps to cursor position

Selection Start of block snaps to start or end points of a selection

Start Start of block snaps to start of file

End Start of block snaps to end of file

Markers Start of block snaps to marker

Regions Start and End Markers Start of block snaps to region start or end

Time, Measures, Etc. Start of block snaps to labeled divisions on Time Ruler

Video Frames Start of block snaps to the start of video frames appearing in the 
video strip



Advanced Mixing options
In the Mix dialog, there are several options you can use to perform complex mixes. For example, when 
mixing vocals over music, you can have the music fade out and then fade back in when the vocal part is 
mixed. This is sometimes referred to as ducking. Follow these steps to perform voice-over ducking:

1. Open the file TUTOR1.WAV and select the word Wow.
2. Drag the Wow selection to an open area in the Sound Forge workspace to create a new data 

window.
3. In the Summary dialog within Properties (File menu), name this sound file Wow in the Title field and

press OK.
4. Now, open the file TUTMUSIC.WAV. This file contains a short music clip to which we will mix the 

Wow sound.
5. Place the cursor in TUTMUSIC at about two seconds from the start of the file.
6. Select all of Wow and drag and drop it to the TUTMUSIC window.
7. In the Mix dialog, select the Slow duck preset. Notice that the Destination Volume is set to -6 dB 

and the times in the Pre/Post-fade destination edges are set to 0.5 seconds. This means that before
and after the mix, the music will be faded to -6 over 0.5 seconds. Press OK.

8. Listen to the file, then undo the operation.
9. Once again, drag Wow to TUTMUSIC and select the Slow duck preset. This time, set the 

Destination Volume to -20 dB and press OK. The music will now fade out even lower. Both the 
source and destination volumes can be used to get the right mix of voice and music. The Pre/Post-
fade destination edges control how fast the destination sound is faded out and back in.



Editing Stereo Files
When editing stereo files you have two channels of data on which to work. The upper channel is the left 
channel and the lower channel is the right channel. We will refer to them in both ways left (upper), and 
right (lower).

Selecting Data in Stereo Files
When selecting data in stereo files, Sound Forge allows you to select either the left channel, right channel
or both channels for playing, editing, and effects processing.

When editing a stereo file, the waveform display showing the two channels is split into three logical 
sections for selection with the mouse. The upper quarter of the waveform display is the left channel hit 
section, the lower quarter is the right channel hit section, and the middle half selects both channels. When
selecting data with the mouse, the cursor location determines what channel(s) will be selected.

Open the file TUTOR1.WAV and convert it to stereo by editing the Format under Properties in the File 
menu or by right-clicking on the Channels playbar field and selecting Stereo. Set the Channels to Stereo 
and press OK. Select Both Channels for the destination in the Mono to Stereo dialog. You should now 
have a stereo version of TUTOR1.WAV.

Move the mouse pointer near the top of the left channel and select the word "Wow." Notice the change to 
the left channel selection cursor, and that only the left channel of the data becomes highlighted. Now do 
the same thing but in the middle half of the window near the top of the right channel and the bottom of the
left channel. This time you should see both channels being selected. Do this one more time near the 
bottom of the waveform display and you should see only the right channel being selected.

Cursor when selecting both channels of a stereo file or when in a mono file.
Cursor when selecting the left channel of a stereo file.
Cursor when selecting the right channel of a stereo file.
Cursor when extending a selection.

Toggling Channel Selections
Once you have made a selection in a stereo file you can switch between channel selections by pressing 
the Tab key. The Tab key will cycle between selections of Left Channel, Right Channel, and Both 
Channels. You can also set the channel selection by using the Channel drop-down list in the Set Selection
dialog.

Previewing Channels
Selecting a single channel allows you to hear a preview of a single channel in the stereo file. For example
double-click (triple-click if it contains regions or markers) in the TUTOR1 window to select all the data (or 
use Select All from the Edit menu). Press the Play button and listen to the clip. Next press the Tab key to 
toggle the channel selection into a single channel and press the Play button again. Do this one more time 
to hear the other channel.

Single Channel Editing
Stereo data files are tied together by the nature of their format. In other words, they always play together. 
This means that there are some edit operations, such as Cut and Paste, which you can't use on a single 
channel. It would leave one channel shorter or longer than the other. This is usually not a problem in real 
world editing situations. To shift a single channel in time by small amounts, you can use the Delay/Echo 
function.

You can copy a selection from a single channel to the clipboard by selecting the data in either the left or 
right channel and using the Copy command. This will place a mono clip on the clipboard. You can then 
paste the mono clip to a mono file, both channels of a stereo file, or you can mix it into a single channel or
both channels of a stereo file. When mixing mono clipboard data to a stereo file you will be asked with a 



dialog whether you wish to mix to a single channel or both channels.



Working with .AVI Files
Sound Forge allows you to open and save Microsoft Audio and Video Interleave (.AVI) files. This allows 
you to edit the audio tracks of a video with single frame accuracy. This section covers:

Opening an .AVI File 
Handling Multiple Streams 
Video Strip 
Video Preview 
Attaching a Video to a Sound File 
Saving an .AVI file 
.AVI Video Compression 
Compression Algorithms 
Compression Settings 



Opening an .AVI File
To open an .AVI file, choose Open from the File menu and select Video for Windows (*.avi) from the Files 
of type list. Then, double-click on the file you wish to open. If the .AVI file being opened in Sound Forge 
contains exactly one video stream and one audio stream, it will open these streams automatically. 
However, if no audio is present an audio stream will be created containing only silence for the entire 
length of the video.



Handling Multiple Streams
.AVI files can contain more than one video or audio stream. A stream is not the same as a track in a multi-
track video or audio editor. Multiple streams are most commonly used to contain different versions of a 
video or audio track. For example, you could have an .AVI file with one video stream and multiple audio 
streams in different languages. An .AVI player, such as Microsoft's Media Player, can detect which 
language version of Windows your computer is using and automatically play the correct audio stream for 
that language.

If more than one stream exists you have the option of choosing which one will be opened in Sound Forge.
This is done in the Video Stream dialog. In this dialog, you must select a video and audio stream to open 
by using the Stream Selectors (black diamonds) to the left of each stream. Once you've selected one of 
each, press OK.



Video Strip
When you open an .AVI file, you will notice the video strip on top of the waveform display. When you're 
zoomed out, all of the frames in an .AVI will not be displayed. The left edge of the displayed frames are 
aligned with the audio in time. If you'd like to see the frame numbers on the frames, right-click on the 
video strip and select Number Frames.

To resize the video strip, drag its lower edge up or down.

To enable frame animation in the video strip, select Animate frames from the Video Strip shortcut menu. 
When this option in enabled, moving the cursor will cause the nearest frame to be displayed above it. 
During playback, you will see the active frame window play the video as the cursor moves past it.



Video Preview
The Video Preview window is opened by selecting Video Preview from the View menu. The frame closest 
to the cursor (during editing or playback) will always be displayed in this window.

At the top of the window, the original frame size and current display size (in parenthesis) are displayed, 
along with the frame rate and current frame number. An asterisk (*) by a frame number indicates that the 
frame is a key frame (see the section on compression below).



Attaching a Video to a Sound File
To attach a video to an opened sound file, select Properties from the File Menu and go to the Video folder.
Pressing the Attach button will take you to the Attach Video dialog, where you can select an .AVI file to 
attach a video from. Press OK after selecting an .AVI with a video stream.

The Video Properties will now display the audio and video streams in the .AVI. An .AVI file can contain 
multiple streams, but in most cases you'll have one audio stream and one video stream.

The square checkbox to the left of each stream indicates which streams will be stored when you go to 
save your file. The black diamond next to it is the Stream Selector, which indicates which streams are 
currently being used in Sound Forge.

Press OK again and you should now see the video strip above the waveform display. Once you're done 
editing, you must save the file as an .AVI if you want to store the video.



Saving an .AVI file
To save an opened file in the .AVI file format, follow these steps:

1. In the Save or Save As dialog, select Video for Windows (.avi). After naming the file, etc.., press 
Save.

2. The Video Save Options dialog appears next. In here, you can select which streams to store in 
the .AVI file by checking the square checkbox to the left of each stream. In this dialog, it is also 
possible to edit the titles of the streams.

3. Pressing OK will take you to the Compression Options dialog. Here, you can select a compression 
scheme for each audio and video stream. To change the options for a stream, select it and press 
the Options button. By checking the Interleave every _ Frames option, you can specify how 
frequently the audio chunks are interwoven with the video.

4. If you pressed the Options button, yet another dialog, Video Compression, let's you select from 
different compression algorithms, and even go to another dialog to set specific compression 
configuration parameters. For more information on compression, see the next section. Selecting No
Recompression saves the stream in its original format, which is the Sound Forge default.

5. Once you're done setting compression options, hitting OK several times will complete the process. 
If the video is long and/or the compression scheme selected is slow, saving the file might take a 
while. However, if you didn't change any video compression formats, the save will be much faster, 
since no recompression takes place.



.AVI Video Compression
If you thought audio files chewed up your hard-disk space quickly, wait until you start using video! CD 
quality audio takes up about 10 MB of hard-drive space per minute:
 (60 seconds x 44,100 samples per second x 2 tracks for stereo x 2 bytes per 16-bit sample). On the 
other hand, a typical video for multimedia use will easily contain about 200 MB per minute, and this for a 
small window of video:
(60 seconds x 15 frames per second x 320 x 240 x 3 bytes for 24 bit pixels).
Using uncompressed video as a final distribution format is out of the question for most practical purposes.
Video compression is a necessary evil.



Compression Algorithms
Many different compression algorithms exist and many more will continue to be created in the next 
several years. With all algorithms, trade-offs will have to be made between video quality, size reduction, 
and compression/decompression processing time. Compressing by large amounts quickly will generally 
produce visual artifacts such as jumpy or grainy video.

When saving an .AVI in Sound Forge, you can select from all of the installed compressors installed in 
your system. Included with Windows are Cinepak by Radius (cvid), Intel Indeo (IV32), and Microsoft 
Video 1 (CRAM). These can be selected from the Video Compression dialog (see section above).



Compression Settings
Many compressors use key frames during compression and decompression. A key frame is a frame in the
video stream which is not inter-frame compressed. The following compressed frames are derived from the
closest key frame. Having fewer key frames will make the video size smaller. However, it will take a lot 
more time to display the frames, specially when jumping around the end video.

When editing, .AVI files in Sound Forge, the display speed will suffer greatly if there is
only one key frame in the entire file. In such cases, Sound Forge needs to scan all

preceding data when drawing every single frame.

Also in the Video Compression dialog, you can specify the Data Rate of the video, which relates directly 
to the final size of the file. Different compressors do different things with this value, since its only an 
expected value. In most cases you should leave this unchecked. If you have very limited playback data 
rates, such as in a single-spin CD-ROM, you might then want to set this value. However, note that the 
Compression Quality control setting will also affect the output size.

Use the Preview button to get an idea of the video's output quality and compression
amount.



Editing Audio in .AVI Files
When doing any operations on the soundtrack of an .AVI file, the video stream is always left untouched. 
For example, doing a cut, paste, time compression, ,etc. on a sound file will not change the duration of 
the video stream.

In Sound Forge, the video stream and audio stream will always start together, and you will see the video 
frames only where audio exists. Therefore, if you want to view the entire video stream, you should use 
Insert Silence to add enough audio to run the entire length of the video. You can then later mix in any 
needed sounds into the file.



Using the Playlist with .AVI Files
Once you've created and arranged regions in the Playlist (see a previous section), playing from the 
Playlist will keep the original synchronization between the audio and video. In other words, if you have a 
Playlist that jumps all over the file, both the audio and video will jump around.

In a sense, you can use the Playlist to perform basic video edits. For example, to remove unnecessary 
material from the beginning and end of the video, simply make a region containing only the video that you
need in the Playlist. Playback from the Playlist will play only the selected regions in the specified order.



Creating a New .AVI File from the Playlist
After arranging the Playlist entries, you often want to create a new file containing the final arrangement. 
To do so, select Playlist|Convert to New from the Special menu. This will create a new file, which when 
played back will contain the exact sequence of audio and video that the current Playlist specifies.

When creating a new file, each region's start and end point must line up with a frame boundary. Region 
start points are moved backwards and end points moved forward, with silence being used to fill the frame.
This can cause the output file to be slightly longer than the Playlist playback time.

To ensure that Convert to New works exactly like playing from the Playlist, make sure that all the region 
endpoints are frame aligned. This can be done by enabling Auto Snap to Time (Options menu) and using 
the Time & Frames or Absolute Frames status format before creating regions.



Editing Sound Formats
This section will show you how to deal with the many different sound formats.

Changing sound formats 
Mono to Stereo and Stereo to Mono Conversions 
Converting 16-bit samples to 8-bit samples
Converting files
Embedding Summary Information in WAV files



Changing Sound Formats
When you open a file or create a new window, the format for the window is shown on the first three status 
fields of the main status bar at the bottom of the program window. The format parameters consist of the 
Sample Rate, Sample Size, and number of Channels (Mono or Stereo). The last status fields display the 
Total Length of the sound data, and amount of Free Storage available.

Changing the sample rate will make your sound play faster or slower and with a higher or
lower pitch. If you want the file to sound the same at a different sample rate, use the

Resample function under the Process menu.

When you right-click on any of the three format fields, a shortcut menu will pop up at the current mouse 
location allowing you to change that parameter. You can also change all three parameters at one time by 
selecting Properties|Format under the File menu. The Properties dialog can also be invoked by double-
clicking on any of the format fields, or by right-clicking on the waveform display of the data window and 
selecting Properties in the shortcut menu.



Mono to Stereo and Stereo to Mono Conversions
For demonstration purposes, open the file TUTOR1.WAV located in the directory where Sound Forge 4.0 
was installed (in most cases this will be C:\Forge40). To convert the file from mono to stereo, right-click on
the status field which has the word Mono and select Stereo from the shortcut menu. 

When you do conversions from mono to stereo, you will be presented with a dialog which asks you where
you want to put the data. Your choices are as follows:

Left Channel The mono data is placed in the left channel. The right channel is set to silence.

Right Channel The mono data is placed in the right channel. The left channel is set to silence.

Both Channels The mono data is copied into both channels.

When performing stereo to mono conversions, the following options are available:

Left Channel Mono data is taken only from the left channel of the stereo file.

Right Channel Mono data is taken only from the right channel of the stereo file.

Mix Channels Mono data is created by mixing both channels of the stereo file.

For now let's put the data in the left channel so we can get a feel for how the function works. Click the 
radio button next to Left Channel and select the OK button.

You will now have data in the upper half of the data window (the left channel) and silence in the right 
channel. Press the Play button and you will hear "Wow, sound editing just gets easier and easier" in only 
the left channel. 

If your card supports only mono data you will still be able to play stereo files if you set
your playback device to Sound Mapper in the Wave section of Preferences in the Options

menu.

For now let's go back to a mono sound file, but we'll do it in a different manner. Select the option 
Properties in the shortcut menu that appears when you right-click on the waveform display. In the 
Properties dialog select the Format tab. This page allows you to change all the parameters at once. Set 
the radio button for Channels to Mono and select the OK button. Select the Left Channel for the source 
channel in the Stereo to Mono dialog and we're back where we started. 

The above steps were used for demonstration purposes. Simply using Undo would have
been much more efficient.

Channel Converter
The Channel Converter (Process menu) is also used to convert between mono and stereo formats. It 
allows independent level settings for each channel and can be used to inter-mix the left and right 
channels of a stereo file to create interesting pan effects. For simple conversions, use the included 
presets. See Channel Converter later in this manual in the Process menu section of the Reference 
chapter for more detailed information.



Converting 16-bit samples to 8-bit samples
To save storage space, 16-bit sound files are often converted to 8-bit files. However, when you represent 
a sound file with only 8-bits, an audible distortion referred to as quantization error becomes very 
prominent. To minimize quantization error, there are several things you can do to the 16-bit sound file 
before converting it to 8-bit. You can:

Apply a Noise Gate (Effects menu) to completely mute out the silent parts in a sound file. Often, a low 
level signal in a 16-bit sound file will become noise after the 16- to 8-bit conversion, so it's best to have 
complete silence between the sound parts.

Apply dynamics compression (select Dynamics|Multi-Band in the Effects menu) to the sound file. A 
small amount of compression (2:1 or less    the presets are usually sufficient) will lower the dynamic 
range of a sound, making it easier to represent using 8-bit samples.

Normalize (Process menu) the sound to 0 dB (peak). This ensures that the entire dynamic range 
available in 8-bit samples is used and lowers the signal to noise ratio.

You can apply both dynamic compression and normalization at once by using the
Normalize function with the Average RMS power option. Set Apply dynamic compression

in the If clipping occurs drop-down list.

Once you have performed the above operations, you should use Convert to 8-Bit in the Process menu to 
do the 16 to 8-bit conversion. Sound Forge provides three different 16 to 8-bit conversion options; 
Truncate, Round, and Dither. Truncate simply removes the lower 8 bits and they are lost forever. Round is
similar to Truncate, only some attempt is made to represent the highest of the low bits by rounding up if 
possible. Dithering is used to mask the quantization noise with less obtrusive noise. In the Convert to 8-
Bit dialog, set the Dither bit depth to a low value (like 0.1) and increase the value slowly until you reach an
acceptable sound.

Remember, an 8-bit sound file will always sound noisier than a 16-bit sound file, so whenever possible, 
stick with 16-bit. When trying to save space, it is possible to get better results from lowering the sample 
rate (see Resample under the Process menu covered in the Reference chapter) instead of using 8-bit 
samples.



Converting Files
When producing audio files you may find that you need to provide the file to a client in a variety of 
formats. This could be .WAV files with data formats such as 8-bit mono, 16-bit stereo, or even ADPCM. 
You may need the files converted to Raw data, .VOC, or some other PC format. You may even need to 
convert to a different platform like Macintosh .AIF files or Amiga .SVX.

We have seen in the previous sections that you can quickly convert between mono/stereo, 8/16-bit, and 
change the sample rate in Sound Forge. You can then use the Save As command to save the file to a 
new name, or you can save in a new format within the Save As dialog.

If you don't have TUTOR1.WAV open, open it up now. Select the Save As command from the File menu 
and the dialog for saving will be displayed.

When the Save As dialog is displayed, there are three controls that are used for file conversion; the Save 
as type, Format, and Attributes. The Save as type is the list of all available output file types. The Format 
field sets the format of the data which is saved in the file. The Attributes field controls sample size, sample
rate, and the number of channels.

When you bring up the Save As dialog, the Save as type will be set to the type from which the file was 
opened. The default for new files is Microsoft Wave (.WAV). You can change to the type of file you want to
save by selecting the new type from the Save as type list. Notice that the extension of the file name will 
be changed to reflect the type of file you are saving.

The Format drop-down list shows the format of the data which will be saved in the file. Usually this will be 
PCM which is the standard for most file types. PCM (Pulse Code Modulation) is a standard format for 
normal uncompressed audio. If you are saving a file to a file type which supports other formats, they are 
displayed in the drop-down list. Other formats are typically used when saving audio data in a compressed 
form.

The Attributes drop-down list shows the sample size, channels, and sample rate which will be stored 
when saving this file. Examples include: 11,025 Hz, 8-bit Mono or 44,100 Hz 16-bit stereo. You can 
quickly change the attributes of the data by selecting one of the options available in the drop-down list. 
When you change from a mono file to a stereo file using the Attributes field, that data is copied to both 
channels. If you change a stereo file to a mono file, the data is mixed to one channel.

When you change the Save as type you may notice that the Format and Attributes fields will also change. 
This is because not all file types support the same types of sound data. For example the Dialogic .VOX 
format only supports 16-bit mono Dialogic ADPCM files. This means you can't store stereo 8-bit data in 
this file. Don't worry, in most cases Sound Forge automatically converts any file you save to an 
acceptable format.



Embedding Summary Information in WAV Files
Microsoft .WAV and .AVI files allow you to store over 30 text fields including: Creation Date, Copyright, 
Keywords, and a variety of other informational text data. Sound Forge supports viewing and editing any of
these fields.

Summary Information
When editing .WAV and .AVI files, the Summary tab is available in the Properties section of the File menu.
This allows you to view and/or change basic summary information currently stored in the file.

Extended Summary Information
The Extended Summary dialog consists of a list of available fields, each of which may or may not have 
attached text. The Fields list shows the abbreviation of the field type, a short description, and if the field is 
currently empty, the word (Empty) appears after the short description. Below the list of fields is the 
Contents which shows the contents of that field. At the bottom of the dialog is a longer description of the 
current field.

To the left of each field in the list is a check box which is used to enable or disable fields of this type when 
saving .WAV and .AVI files. The field is enabled or disabled by clicking on the check box. If a field is 
empty, i.e. has no text associated, enabling the check box has no effect on a saved file. Field information 
is only saved if text information exists for that field.

The Save Summary Information in .WAV/.AVI files check box in the Save As dialog is used to quickly 
enable/disable saving of all summary fields to a file during a Save As operation. This allows you to quickly
strip all summary information from a file. 

For a description of the fields available refer to the Properties within the File menu section in the 
Reference chapter later in the manual.

Default
If the Default button is selected, the text in the summary fields is saved with the defaults fields that are 
automatically filled when creating a new .WAV file. The Creation date field (ICRD) is always filled with the 
current date for new files. Saving a custom default setup is handy for saving copyright and engineer 
information for new files created at your site.

Open the file TUTOR1.WAV and select the Summary tab from Properties in the File menu. This will show 
you the Summary dialog. Press the Extended button and notice that the default for saving summary 
information is to have all fields enabled. The fields which have already been filled in for TUTOR1.WAV are
Comments, Copyright, Creation Date, Engineer, Keywords, Name/Title, Product, Subject, Software, and 
Source. Scroll to and select each field. You will see the embedded text for each of these fields.

Additional Embedded Information
The Microsoft .WAV and .AVI file formats allows non-text data to be embedded in the sound file. If you 
open and edit a file which has additional information created by other software, Sound Forge will keep 
track of this data and place it back in the file when you save to the original format. 

If you wish to add or remove additional data (such as embedded bitmaps, metafiles, etc.), you can use 
the Save As item from the File menu. When you save data using the Save As option, Sound Forge will 
ask you if you wish to copy the additional non-audio information to the new file. At this point you can 
answer either Yes to place the additional information in the new file or No to save only audio data and any
additional data types you have selected. 

Sound Forge will only prompt you to save if such data exists. 



Recording Video tutorial

Sound Forge has a variety of sound recording modes and options each of which come in handy for 
different situations. These include recording new data, recording over existing data, commonly known as 
Punch In mode, and Remote Recording.

Recording basics
Recording modes
Record Meters 
Sync While Recording 
Remote recording



Recording basics Video tutorial
To start a record session you can either select Transport then Record from the Special menu or press the 
Record button on the Transport toolbar. The Record button is the first button on the Transport toolbar with 
the red circle on it.

If you experience problems recording, refer to the Troubleshooting chapter for
information on common recording problems.

After pressing the Record button or selecting Transport|Record from the Special menu, you will be 
presented with the Record dialog. Notice that the window into which you will be recording has its title 
displayed in the dialog title.

Warning: The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities.

To prevent accidentally recording over sound data, record into a new or scratch data window and paste 
the takes you want to keep into the desired sound data window. For extra safety Sound Forge 
automatically defaults to record in a new window when the current sound file is opened in direct edit 
mode.

In the upper left corner of the dialog are the Recording attributes. These are the record sample rate, 
sample size, and number of channels which will be used when recording. These attributes are applied to 
the data window into which you will be recording. If you want to change these attributes, exit the Record 
dialog and change them in the data window, record to a new window, or record to another window.

Recording to a New Window
If you want to record to a new window rather than the currently selected record window, select the New 
button found at the upper right of the Record dialog. This brings up the New Window dialog where you 
can specify the Sample rate, Sample size, and Channels for the new data window. These attributes will 
be applied while recording.

Selecting an Alternate Record Window
If you wish to record to a window other than the one currently displayed in the Record dialog title, you can
do so by selecting the Window button. Pick the window you want to record to from the drop-down list in 
the Record Window dialog and select OK. The title of the window you select will now appear in the 
Record dialog title.



Recording Modes Video tutorial
Sound Forge has four different modes of recording. These are Automatic Retake, Multiple Takes with 
Regions, Multiple Takes (no Regions) and Punch In. Each mode is described below.

Automatic Retake
The Automatic Retake mode is the easiest method of recording. Recording starts at the position shown in 
the Start field when you select the Record button and continues until you select the Stop button. Any data 
which is currently after the position in the Start field will be replaced. When recording is stopped, the start 
position is reset to the beginning of the take allowing an immediate review and retake if desired.

Automatic Retake is the default mode when recording into an empty Data Window or when you select the 
record button with no data selected in the current Data Window.

Multiple Takes with Regions
The Multiple Takes with Regions mode allows multiple takes to be recorded and each take with 
automatically have a Region defined in the Regions List. Recording starts at the position shown in the 
Start field when you select the Record button and continues until you select the Stop button. Any data 
which is currently after the position in the Start field will be replaced. When recording is stopped, the start 
position remains at the end of the next take allowing the take to be recorded immediately.

Multiple Takes (no Regions)
The Multiple Takes (no Regions) mode allows multiple takes to be recorded, but no Regions are defined 
in the Regions List. Recording starts at the position shown in the Start field when you select the Record 
button and continues until you select the Stop button. Any data which is currently after the position in the 
Start field will be replaced. When recording is stopped, the start position remains at the end of the take 
allowing the next take to be recorded immediately.

Punch In
Punch In mode is used when you want to record over a region of data in an existing Data Window. 
Recording starts at the position shown in the Start field when you select the Record button and continues 
until you select the Stop button, or the length of the data recorded is equal to the length in the Length 
field. This makes it easy to record over a section of audio without effecting the rest of the file. You can use
the Play button to hear the selected Punch In region at any time.

You may adjust the Punch In region by changing the values in the Start, End, or Length edit fields. You 
may also adjust the format of these fields to a variety of different display status formats by selecting a 
format from the Input format drop down list box.

Punch In mode is the default mode when you select the Record option while you have a region of data 
selected in the current Data Window.

Using Pre/Post-Roll with Punch In Mode
At the bottom of the Record dialog are two edit fields which contain the Pre-Roll and Post-Roll times. 
These can be used when listening to a region in Punch In mode. These times define the amount of audio 
you will hear prior to (Pre-Roll), and after (Post-Roll), the selected region when using the Play button. This
allows you to hear the transitions between the Punch In region and sound before and after the region. If 
you wish to use the Pre/Post-Roll option you must check the Review check box at the bottom of the 
dialog. To disable Pre/Post-Roll uncheck this box.

Using the Prepare Button
The Prepare button is used when you need Sound Forge to begin recording as soon as possible after 
selecting the Record button. The Prepare button opens the wave device and loads all recording buffers in 
order to minimize the time between selecting the Record button and sound actually beginning to be 
recorded.



The Prepare button is optional. It is not necessary to select this button prior to recording, however it does 
allow for more accurate takes in the Punch In mode.

Recording Status
While you are recording, the amount of time recorded will increase and the Time left on drive will 
decrease. Make sure and keep an eye on your Time left on drive if your available record time is limited. 
It's never fun running out of recording time!

Available Recording Time
Near the bottom of the dialog you will see the Time recorded and Time left on drive fields. These two 
boxes show how much time you have recorded and how much time is available on your hard drive for 
additional recording. If your Time left on drive field is displaying a limited amount of available time you 
may want to free up some space on your hard drive or pick an alternate drive where Sound Forge stores 
its temporary files. You can get more information on temporary file usage by referring to the Reference 
chapter on Temporary Storage.

Finishing Recording
When you have finished recording select the Close button to exit the Record dialog and return to normal 
editing mode.

Previewing Recorded Sounds
After recording your material, you can listen to what you have recorded by selecting the Play button. You 
can also listen to the section over which you plan to record in Punch In mode. To stop playing select the 
Stop button at any time.



Record Meters
Like the Sound Forge Play Meters, the Record Meters can be scaled to view differing dynamic ranges by 
right-clicking on the meters and selecting the appropriate range from the shortcut menu. For most 
recording situations it is probably best to select -42 -to 0 dB, as this is the most practical range to view a 
good record signal. To view very low levels, select -90 to 0 dB. This is a good way to measure the amount
of noise you have in your system due to noisy sound sources and/or poor equipment (such as an 
inexpensive sound card).

Also in this shortcut menu, you can set the meters to Hold Peaks and Hold Valleys. It is recommended 
that Hold Peaks be checked, as this is a good way to view the peak levels while setting the record level 
(see below). To reset the current peak, single-click on the meter's text output (just above the meters).

For Windows 95 and NT 4.0 keyboard shortcut lovers, the Play Meter shortcut menu can
be reached by the keyboard shortcut Alt+Spacebar.

Checking Record Levels
Sound Forge allows you to check the level of your input source before recording begins. To view your 
levels engage the Monitor check box. The meters will light up in relation to the level of the incoming 
signal. For best results, the level should be somewhere in the yellow range with an occasional red. Once 
your levels are checked you can immediately begin recording by selecting the Record button. If you do 
not see the meters light up, you may have your mixer levels or input source set incorrectly. You can refer 
to the Troubleshooting chapter for more information on these problems.

Adjusting Levels Using the Peak 
The peak values displayed above the level meters are useful for maximizing your input level without 
clipping. When recording you generally want your input signal to be as hot as possible without clipping. By
this we mean you want your input levels to be as high as possible without exceeding the range of values 
which can be stored digitally when recording. When you clip, the peaks of your waveform become clipped
off resulting in distortion. The peak values show you (in decibels) the highest peak that you have reached 
since hitting the Monitor button.

To adjust your levels, select the Monitor check box so that Sound Forge begins to listen to your recording 
device. This is just like recording except that Sound Forge doesn't store any of the data it receives. Apply 
an input signal by speaking into your microphone, playing your CD, or whatever it is you're trying to 
record. If the peak value stays at a low value, increase the levels of sound you are supplying so that the 
peak value is somewhere in the -6 dB range. If the peak reaches 0 dB then you have clipped and will see 
the word Clip above each meter. Once you lower your input levels, right-click on the meters and select 
Reset Clip to clear the current peak value. Sound Forge always keeps the maximum peak displayed 
above the meters or via Hold Peaks.

Once you have adjusted your levels you can immediately begin recording by selecting the Record button 
or end monitoring the levels by un-checking Monitor below the meters.

It is particularly important to record sounds with the hottest levels possible when you plan
to later convert 16-bit data to 8-bit. This assures that you will use the greatest dynamic

range possible in an 8-bit file (which uses fewer values to represent the waveform).



Sync While Recording
The Record Synchronization dialog is reached by pressing the Sync button. Use this dialog to set sync 
options for recording in conjunction with other devices or applications that respond to MIDI/SMPTE time 
code.

When MTC/SMPTE Output Synchronization is enabled, Sound Forge generates SMPTE/MTC to the 
output device selected in the MIDI/Sync Preferences. When you start recording, SMPTE output begins at 
the Start value. If Pre-roll is selected, SMPTE output will begin before recording by the specified amount. 
For example, if the Start value is 00:00:30:00 and the Pre-roll is 00:00:10:00, SMPTE time code will be 
generated starting at 00:00:20:00. After 10 seconds (at 00:00:30:00) have elapsed, recording will 
commence.

When MTC/SMPTE Input Synchronization is enabled, recording begins (is triggered) when the Start time 
is received from the current MIDI/Sync Input device (see the MIDI/Sync page in the Preferences folder). 
Recording will then stop when the end time is reached. 

The Prepare button must be activated for record to be triggered.

Output Synchronization Start Start time which will be generated when record begins

Output Synchronization Pre-Roll Pre-roll time from the start time at which SMPTE generation will 
begin

Input Synchronization Start Time at which recording will begin

Input Synchronization End Time at which recording will end

Check to make sure that the input and output devices are specified correctly in
MIDI/Sync under Preferences (Options menu). The SMPTE format here is determined by

Status Format in the Options menu.

When recording tracks in from a tape deck that can perform a chase lock, the Synchronization Pre-roll 
can be set to compensate for the time it takes the tape deck to rewind and begin chasing prior to the 
synchronization start time.



Remote Recording Video tutorial
By selecting the Remote button you enter into Remote Recording mode. Remote Recording mode hides 
the main Sound Forge window and puts up the small Record Remote dialog which always stays as the 
top-most window.

The Remote dialog is a fully functional but condensed version of the regular Record dialog. It's particularly
useful when using applications that control your input sources, sound levels, CD audio, or MIDI 
sequencing. To return to normal record mode from the Remote dialog select the Back button. 

You can access all of the same Record dialog features from the Remote Record dialog
(right-click on the title bar).



Applying Sound Processing Functions
The Effects, Process, and Tools menu contains a large number of functions which are used to apply an 
effect on the sound data, display information, or even synthesize new sounds. Each function is 
documented in detail in the Reference section. In this section, we will run through a few of the functions to
help you get a feel for using them.

Applying sound processing effects 
Applying an Effect to a Section of the Sound File 
Canceling a Function in Progress 
Applying Effects to Stereo Files 
Getting Help on a function 
Using Controls 
Presets 
Processing shortcuts 
Changing the selection affected by the function 
Previewing an Operation 



Applying Simple Processes and Effects
To apply an effect, first select a section of data on which you wish to operate. To select the entire file, 
double-click (triple-click if regions or markers are present) on the waveform display.

If you don't have a selection when you perform an effect which requires one, Sound
Forge will apply the effect to the entire file.

To show how effects are used we will once again be using the TUTOR1.WAV file. If it's not currently open,
please open the file now.

Select the Reverse item from the Process menu. The Reverse operation reverses the data selection, 
making it sound like it's playing backwards. Once the operation has finished, press the Play button to hear
how TUTOR1 sounds when played backwards.



Applying an Effect to a Section of the Sound File
Select the Undo Reverse item from the Edit menu to put TUTOR1 back to its original state. Now select 
only the word "Wow" in the window and again select the Reverse item in the Process menu. Play the file 
again and notice how only the word "Wow" is played backwards. After you have listened to the effect, 
undo the reverse again so we can try another effect.

Again, let's select only the word "Wow" in the TUTOR1 window. This time after selecting the data, select 
the Volume item in the Process menu. Use the scale factor fader to set the scaling to -6 dB (50%). 
Clicking on the fader and using the up/down arrows will give you more precision. Now select OK. If you 
press Play you will notice that the volume is now at 1/2 of its original volume. You can undo the last 
operation by selecting Undo from the Edit menu.

The previous two examples show you how easy it is to apply effects to files. Sound Forge has a large 
number of different processes and effects, ranging from simple volume changes to complex multi-tap 
reverb/delays. To learn about a particular effect, please refer to the Effects, Process, or Tools menus 
which are covered in the Sound Forge Reference chapter.



Canceling a Function in Progress
While applying an effect, the progress meter at the lower left-hand side of the main screen shows what 
percentage of a selection has been processed while running a function. You can select the Cancel button 
to stop processing the file. When you cancel an operation in progress, the affected data remains in the 
sound file. Undoing the operation will return the file to its original state.



Applying Effects to Stereo Files
In a stereo file, only the selected region in the channel which you've selected is processed. Most functions
can be applied to the left, right, or both channels. The only functions which cannot be applied to separate 
left and right channels are functions which affect the length of the data, since each track in a stereo file 
must be of the same length. These include Insert Silence, Resample, Time Compress/Expand, 
Gapper/Snipper, Pitch Bend, and Pitch Shift (without preserving duration). 

If you need to run a process like Insert Silence in only one channel, you should divide the stereo file into 
two mono files first, insert the silence, and then join them back together into a stereo file. Separating 
stereo files into two mono files is a good idea if you are going to be changing the duration of each track by
cutting or inserting space to synchronize different events.

Applying a Function to a Single Channel in a Stereo File
Previously, we reversed TUTOR1 so that we could hear how the data sounded when played backwards. 
Now let's try this on a single channel of a stereo file. First convert TUTOR1 to stereo by right-clicking on 
the status field which has the word Mono and select Stereo from the shortcut menu as we did in a 
previous section. Make sure to select the Both Channels option in the dialog so we have data in both 
channels of the new stereo file.

Select the entire left channel by triple-clicking with the mouse in the upper 1/4 of the TUTOR1 waveform 
display. If you select both channels, just use the Tab key to toggle the selection to only one channel. Now 
select the Reverse item from the Process menu. You will notice that only the left channel data is reversed.
Press the Go to Start button on the playbar to clear the selection and place the cursor at the start of the 
file. Press the Play button and you will hear "Wow, Sound editing is easy" backwards in the left channel 
and forward in the right channel. If you only hear one channel then you are in single channel preview 
mode. To hear both channels use the Tab key to toggle the cursor or selection to encompass both 
channels and again press the Play button.

If you want more information on how to use a function, press the F1 function key while
selecting the function title in the menus. Also, you can press the F1 function key or the

Help button in all function dialog.



Getting Help on a function
If you want more information on how to use a function, press the F1 function key while selecting the 
function title in the menus. Also, you can press the F1 function key or the Help button while in the function
dialog of those functions with dialogs.



Using Controls
Before going any further, let's become familiar with all of Sound Forge's different controls used to enter 
function parameters. To do this, open a new file and select the Synthesis|FM item from the Tools menu. 
Don't worry about understanding what all of the parameters mean. Let's just play with the knobs. Here's a 
list of controls used in Sound Forge:

Vertical Fader and Horizontal Trackbars 
Edit Box Spinner Control 
Drop-down List 
Push Button 
Radio Button 
Check Box 
Envelope Graph 



Vertical Fader and Horizontal Trackbars
In the FM Synthesis dialog, the Amplitude is controlled by a fader and the Feedback is controlled by a 
trackbar.

Fader:     Trackbar: 

There is nothing complicated about these controls. To change the parameter values, just left-click and 
hold on top of the trackbar thumb and drag left and right or up and down.

You can fine tune a control's value by holding down both the left and right mouse buttons
at the same time (or holding down Control on the keyboard) 

There are many keyboard shortcuts when using faders and trackbars. You can use the Up, Down, Left 
and Right arrow keys to change the value in small increments or the Page Up and Page Down keys to 
change the value in larger increments. The Home and End keys change the parameter value to its 
maximum or minimum.

If you double-click on a fader or trackbar thumb, it returns to its reset value (usually 0%, 50%, or 100%). 
Left-clicking on the hash marks in a fader also changes the value by very small increments. 



Edit Box Spinner Control

In    the FM Synthesis dialog the Total output waveform length and Frequency parameters are modified 
with edit box spinner controls. The edit box is the box containing text, while the spinner is the small 
control to the right. With this type of control, you have several options for changing a parameter value. 
You can: 

Type in the number by left-clicking on the edit box and then typing in the value.

Increment the value by clicking on the two small up/down buttons.

Use the spinner to change the value. This is done by left-clicking on the center button (between the two 
up/down buttons) and dragging the mouse up or down. Again, holding down both the left and right 
mouse buttons at the same time will cause the values to increment in finer steps. You can also use the 
Up/Down arrows and Page Up/Page Down keys to alter the value.

Adjust the spinner while holding down both mouse buttons to see the finer increment resolution (or hold 
down the Control key).



Drop-down List

To select an item from a drop-down list, click on the drop-down list and select the item. If you have to 
scroll through a large list, click on the scroll buttons or use the arrow keys. The FM Synthesis dialog uses 
a drop-down list to change presets, select waveforms, or change operators.

If you scroll down the drop-down list for a preset, you can see all of the parameters
change for each preset. This is useful for getting a feel for which parameters are used to

create different effects.



Push Button

To use a push button (get ready for this...) left-click on it or press the Spacebar while it is selected. In the 
FM Synthesis dialog, the OK, Cancel, Help, Save As, Delete, Selection, Preview, and Reset controls are 
push buttons.



Radio Button

Radio buttons always come in groups of two or more. They are used like the radio station selector in a car
radio; turn one on and the rest turn off. For example, the Current operator control in the FM Synthesis 
dialog is a group of radio buttons.



Check Box

A check box, as its name implies, is a square box you can check or leave blank. They are used to turn a 
feature on or off. Create Undo in the FM Synthesis dialog is a check box.



Envelope Graph
Envelope graphs are used to draw the shape of a frequency or amplitude envelope that will be applied. 
The horizontal axis represents time, with the left-most point specifying the start of the selection and the 
right-most point specifying the end of the selection. The vertical axis represents either amplitude or 
frequency.

· To create a new knob on the graph, left-click anywhere on the line connecting the envelope points 
and drag the knob in any direction, sort of like pulling a rubber band.

· You can delete a knob by double-clicking or right-clicking within it.

· To reset the graph (delete all knobs) click on the Reset button.

Moving Multiple Envelope Points
It's possible to select and move more than one envelope point at once. Just try:

1. Clicking on an unused section of the Envelope Graph.
2. While holding the mouse button down, drag the mouse. A dotted-line selection square will appear.
3. Move the mouse to surround the needed points with the selection square.
4. Release the mouse button. The selected points will now be colored red.
5. To move all of the selected points, drag any one of the points.

You can also select all points by pressing Control+A when the Envelope Graph is active.

Displaying the Waveform on an Envelope Graph
Some envelope graphs (such as in the Fade|Graphic or the Pitch|Bend dialogs) allow you to view the 
waveform of the selected data region on the graph. If the selection is small, the waveform is automatically
displayed. Otherwise, you must press the Show wave check box. If you have a stereo file, you can 
choose between displaying the Left channel only, Right channel only, or Mix channels in the drop-down 
list.



Presets
Most processing functions allow you to store the current settings for later use. There are also system 
presets for each effect which can be used without having to learn how to use the knobs and tweakers. 
These presets are a good place to start when you're creating your own effects.

Open the file TUTOR1.WAV again. Under the Effects menu, select Noise Gate. The Noise Gate function 
mutes any sounds below a threshold level. Using the drop-down list labeled Name, scroll down the 
presets list. Notice that the all of the controls change automatically. Now select one of the presets and 
select OK. 

If you didn't have a selection when you ran the effect, the entire file was processed.

Creating and Storing Your Own Preset
Now open the file TUTOR2.WAV. Select a large portion of the drum hit and then select the item Pitch|
Bend from the Effects menu. 

The Pitch Bend function changes the pitch of the wave variably over time by using a pitch bend envelope.
Use the following steps to create your own pitch bend effect:

1. Press the Reset Envelope button. This restores the pitch bend envelope to its reset state.
2. Now raise the Range trackbar to 24 Semitones. This affects the range of the pitch change. In this 

setting, the maximum pitch bend is 24 semitones (two octaves).
3. To change the pitch bend envelope, left-click on a point on the envelope. You can move a point 

around by dragging it or you can remove it by double-clicking on it. Create an envelope similar to 
the one shown here.

4. Now, select Save As to store this preset. You can give this preset whatever name you'd like and 
then select OK.

5. Press OK again to run the function. You should be able to hear the drum hit change in pitch relative 
to the envelope you drew.

6. From now on, you have the option of using the effect you just created by selecting it from the drop-
down list. If you decide you don't have use for this effect in the future, you can always delete the 
preset by selecting it in the drop-down list and selecting the Delete button.

To reset all parameters in a dialog to their default setting, select Reset All from the
shortcut menu which comes up when you right-click on any unused part of the dialog.



Previewing an Operation
You can preview how a function will affect a sound file by using the Preview button found in most sound 
processing dialogs. This is useful for fine-tuning parameters without having to leave the dialog.

To A/B test the sound (with and without processing), use the Bypass check box. When the Bypass box is 
checked, selecting the Preview button will play the unprocessed data. Otherwise, you will hear the 
processed sound. 

You can change the state of the Bypass check box while the preview is playing to quickly
switch between A and B. 

Preview Configurations
You can temporarily select the length of data you wish to preview by right-clicking anywhere in the dialog 
and selecting Configuration from the shortcut menu. In the Preview Configuration dialog, enable the Limit 
previews to option and specify the number of seconds from 1 to 30.

You can set a permanent preview configuration by using the Preview folder in the Sound Forge 
Preferences section (or by selecting the Default all previews to the current settings in the Preview 
Configuration dialog).

You'll also see the Reactive previewing check box in the Preview Configuration dialog. When activated, 
this item automatically generates a preview which allows you to hear any change in dialog parameters. 
This function becomes very handy when tweaking the center frequency in the Paragraphic EQ, for 
instance.

When Reactive Preview is active, holding down the Shift key while changing parameters
will suspend the automatic preview generation until the Shift key is released.

Pre-roll and Post-roll times can be set in the Preview Configuration dialog. These determine the amount 
of material that will play before and/or after the selected area in a preview. The Pre-roll and Post-roll can 
be quickly turned on and off by right-clicking anywhere within a    dialog and selecting from the shortcut 
dialog.

Previewing a Cut
To preview a Cut operation, make a selection you wish to cut and select Preview Cut/Cursor from the Edit
menu. Sound Forge will pre-roll and post-roll audio as specified in the Other page of the Preferences 
folder, skipping the selection.

If no selection is made, you can use this feature to listen to sound immediately surrounding the cursor.



Processing shortcuts
To execute a function with the same parameters as the last time the function was used, hold the Shift key 
down while selecting the function. This is known as shift-clicking and works for most operations in Sound 
Forge, not just the effects. Shift-clicking works for toolbar buttons, as well as menu items.

You can also use the Repeat item (Control+Y) under the Edit menu to quickly repeat the last operation 
used. This works for all Process, Effects, and Tools functions in Sound Forge. Holding down the Shift key 
while selecting Repeat takes you to the last function's dialog.

Toolbars
If you like toolbars, there are toolbars for functions under the Process, Effects, and Tools menus. To use 
these toolbars, you must go in the Preferences folder (Options menu) to the Toolbars tab and turn on 
those you wish to appear on your screen.



Changing the selection affected by the function
To apply a function to a region other than the current selection, choose the Selection button in the 
function's dialog (you cannot do this with functions that do not have a dialog, such as the reverse 
function). This causes the Set Selection dialog to appear.

In the Set Selection dialog, you can change the Start, End, Length, and Channels selections which will be
affected by the function. You also have a choice of the format in which you are going to enter these values
or you can even use a preset selection.



Sound Processing Techniques
In this section, we will cover some basic concepts relating to some of Sound Forge's processing functions
used for modifying (or creating) sound. Detailed information about each effect is also available in the 
Reference Section.

Delay
Multi-Tap Delay 
Reverb
Chorus
Flange
Noise Gate
Compression and Limiting
Expansion 
Multi-Band Dynamics 
Changing Pitch and Time Duration
Simple and FM Synthesis
Graphic and Parametric EQ



Simple Delay Video tutorial
Simple Delay/Echo creates copies of the original sound which are then mixed with the sound file to create
simple echo effects.

Open TUTOR1.WAV and select Simple from Delay/Echo in the Effects menu. Choose the Slap-back echo
preset and select Preview. A single copy of the sound is heard 0.4 seconds after the original. Changing 
the Delay time determines the time between the original and echoed sound.

Now, select the Grand Canyon preset. Notice that the Multiple delays/echoes check box is marked. This 
means that instead of just one echo, you will hear multiple decaying echoes of the original sound. The 
Decay time determines how long it takes for these echoes to fade out.

The Pre-delay/echo function creates echoes heard before the original sound. Use this effect while the 
spaceship in your next sci-fi flick travels back in time by means of a wormhole.



Multi-Tap Delay Video tutorial
The Multi-Tap Delay function allows you to specify up to eight delay-taps spaced anywhere within 2.5 
seconds (0.5 seconds in 16-bit Sound Forge) of the original sound. 

Open the file TUTOR1.WAV and select Multi-Tap from Delay/Echo in the Effects menu.

Now, select Tapped delay, stereo pan from the end of the preset list. To hear the effect, select Preview. 
Selecting Bypass allows you to listen to the unprocessed file. Listen to how echoes bounce between left 
and right channels.

This preset uses all eight delay taps. To switch between taps, use the Current Tap function. There is a 
delay time and an amplitude associated with each delay tap which determine when and how loud the 
delay tap is heard after the original sound. In stereo files, each tap can also be panned left or right, to 
simulate sound coming from all directions.

The selected tap is represented as a red vertical line on the echogram. The echogram represents an 
approximation of the impulse response of the current settings and can be used to estimate the decay 
time. Blue lines correspond to other active taps and black lines are feedback echoes.

The horizontal axis of the echogram is time, with the right-most point equal to the Graph resolution scale 
setting. The vertical axis represents the amplitude of the echo. You can change the scale factor between 
500, 1,000, or 5,000 milliseconds for viewing the impulse response over different time ranges.

By changing the Feedback, you can change the decay time of the delay. 

If you set the Feedback too high, the echoes keep adding up until they are clipped (use
the 5000 ms Graph resolution setting). Too much feedback also creates unnatural ringing

of some frequencies.

Select the Default all parameters preset. Here, there is only one tap active, with no feedback. This 
corresponds to a simple delay. Set the Dry out to zero and turn on the Low-pass start frequency. Low-
pass filtering removes high frequencies, in the same way that many building materials absorb high-
frequency sounds. Adding modulation creates slight pitch changes, which can make a delay sound fuller.

Now, switch to the Chorus-reverse verb 1. Here, the delay taps increase in magnitude over time, thereby 
creating a swelling effect. Many other sound effects are possible if you experiment a little with tap 
arrangements.



Reverberation Video tutorial
The Reverb function is used to simulate the acoustics of different environments. When a sound is 
generated inside a room, you first hear the original sound, followed by a quick succession of echoes. 
These echoes are the early reflections. Then, as the echoes accumulate, you hear of thousands of 
echoes combined into a smoothly decaying reverberation.

Open TUTOR1.WAV and select Reverb from the Effects menu. Select the Bright hall preset and hit 
Preview. Notice how the imagined space where the recording took place changes from a small studio to a
large, rich hall. You can adjust the loudness of the reverberation and early reflection by using the Reverb 
out and Early out faders.

To increase the reverberation length, try changing the Decay time from 2.5 to 5.0 seconds. The Pre-delay 
parameter specifies the time between the original sound and the start of the reverberation.

Now, change to the Sewer preset. This preset uses a different Reverberation mode. Notice how its tone 
quality is very different    very metallic. The reverberation modes provided give you many choices.



Chorus Video tutorial
The Chorus function is used to simulate multiple sound sources from a single sound. This is achieved by 
mixing a delayed, pitch-modulated copy of itself to the sound source.

With TUTOR1.WAV open, select the Chorus item from the Effects menu.

Preview the Chorus 2 effect to hear an example of chorusing. Increase the depth to 50% to have a slowly 
de-tuning effect. The rate changes how fast the de-tuning occurs.

Changing the Chorus out delay time affects how much later the modulated sound is heard. Very small 
values usually create interesting filtering effects, such as flanging. With larger values, chorused echoes 
are created.

The Feedback and Chorus size parameters change the strength of the chorus. Large Feedback or 
Chorus size values intensify the chorus. You can use the Low-pass filter to remove unwanted high 
frequencies.



Flange Video tutorial
The Flange/Wah-Wah function is used to create the sweeping effects often heard in 60's guitar recordings
and techno-sounds of today. With this function, you can recreate the sounds that flanger, wah-wah, and 
phaser pedals are famous for.

To hear what flanging sounds like, open TUTOR1.WAV and select Flange/Wah-Wah from the Effects 
menu.

Preview the Slow flange 2 preset. The Rate and Depth parameters are similar to the ones in the Chorus 
effect and can be used to create faster, slower, or stronger flanging.



Noise Gate Video tutorial
When recording a sound, there is often an audible noise floor during silent breaks. Noise is generated by 
many different things, including electrical equipment, machinery, and traffic outside your window. When 
your sound source is much louder than this background noise, it is simple to remove the noise during 
silent breaks, where the noise is most noticeable, with a noise gate.

For example, open TUTOR1.WAV. Move the cursor to a location between Wow and Sound and select 
Insert Silence (Process menu). Specify 1 second of silence to be inserted at the cursor. Next, create a 
new file. In the new file, use Synthesis|Simple (Tools menu) to generate four seconds of noise at -60 dB 
amplitude (keep the frequency around 2,000 Hz). Next, copy all of the noise on to the clipboard and mix it 
to the beginning of TUTOR1. Use 100% for the noise (Source) and 100% for the voice (Destination). You 
should now have a file with voice and a relatively low hissing sound in the background.

To remove the noise during silent breaks, first you should analyze the amplitude of the noise. In TUTOR1,
select a region with only noise (no voice), and run the Statistics function under the Tools menu. Take note 
of the Maximum sample value percentage. If you followed the preceding steps, it should be close to -60 
dB.

Next, select Noise Gate from the Effects menu.

In the Noise Gate dialog, select the Noise gate 1 preset. Slide the threshold level to a bit over the 
Maximum sample value (in percentage). A value of -50 dB should be high enough to differentiate the 
noise from the vocals. Press OK. Notice that the noise during the silent regions should have disappeared 
(total attenuation). If it didn't, try raising the Threshold level until it does.

The other two parameters in the Noise Gate determine how fast the gate will open and close. This will 
affect how the beginning and end of the sound will fade in and out. If the Attack time is too slow, the 
beginning of the vocals might get cut off. Likewise, if the Release time is too fast, the end of the vocals 
will be cut. Experiment with these times until you can remove as much noise as possible without removing
any of the voice.



Compression and Limiting Video tutorial
Compressing and limiting are terms used to indicate effects that lower the dynamic range of a sound. 
When you compress a sound, you lower the volume of loud sections and then raise the overall volume to 
compensate. This is done to keep the volume level from fluctuating too much over time. Limiting works 
exactly like compression, but to a higher degree.

Compression and Normalization can be used together to increase the apparent loudness
of a file. This is currently a popular mastering technique.

Open the file TUTMUSIC.WAV. Make a copy of it by selecting the whole region and dragging it to an open
space in the Sound Forge workspace. Now, with the new file active, select Dynamics from the Effects 
menu and choose Graphic.

The Graphic Dynamics dialog allows you to precisely tailor the gain at all input levels of a signal. The 
Input vs. Output level graph shows you the gain that will be applied to the input signal, depending on its 
level over time. The diagonal line, referred to as the No Gain line, indicates where the input and output 
levels are equal. When an envelope point is below the line, gain reduction occurs.

If you understand the principle of the graph, you can edit its points directly to create your own 
compression, expansion, limiting, or noise gating curves (see the Reference chapter for more details). 
However, you don't need to use the graph at all. Using presets and the threshold and ratio trackbars is 
sufficient for most cases.

Choose the 2:1 Compression starting at -18 dB preset, turn Auto gain compensate off, and select OK. If 
you can see both files at once and are zoomed out, you'll be able to notice how the levels of the new file 
are more constant than the original. Listening should reveal the same thing. 

In this preset, sounds above the Threshold (-18 dB) are attenuated at an input to output ratio of 2:1. 
Sounds below the Threshold are not affected by the compressor. The Auto Gain Compensate check box 
raises the total volume of the file after processing to bring the overall output level back to an acceptable 
level. Turn it on once and you'll see how the overall level is much higher now. This can also be done 
manually with the Output gain fader.

Undo the previous operation and select Dynamics again. Now, increase the Ratio to 7:1 and select OK. 
The sound will be even more compressed, meaning that more attenuation and boosting will be applied to 
compressed signals. 

Too much compression starting at too low of a threshold level will usually lead to a
distorted sound.

Again, undo the operation and select the Limit levels to -6 dB (hard limiter) preset. Now, signals above the
Threshold (-6 dB) will still be attenuated, and with a huge ratio of Infinity:1. Essentially, after processing, 
there will be no levels above -6 dB included.

Limiting is often used to keep signals from going above a certain level, but can also be applied to create 
heavily-compressed effects. Limiting should only be done on peaks; if the Threshold level is set too low, 
heavy distortions will occur.



Expansion
Dynamic expansion is the opposite of compression and limiting. Any signal below the threshold will be 
attenuated by a certain ratio. The most common effect of expansion is to attenuate low-level noise, such 
as a noise gate. However, you can also use expansion to add more dynamic range to a sound.

With the TUTOR1.WAV file open, select Dynamics|Graphic from the Effects menu. Choose the Soft noise 
gate below -36 dB preset and select OK. Notice how very low-level sounds have been attenuated. This is 
useful for removing noise from silent regions in a similar fashion as a noise gate.



Multi-Band Dynamics Video tutorial
The other type of dynamics processing that Sound Forge allows for is Multi-Band Dynamics. Essentially 
this is a compressor that only affects certain frequency bands. The possibilities with this type of 
compressor are endless, but the most common use is for de-essing and de-popping. 

You can also use this function as an advanced EQ for such things as tightening up a
bass line or drums.

Open the file SIBIPLOS.WAV. This file contains both loud sibilants (S's) and plosives (P's). Let's first 
remove the sibilants. Double-click on the region named …and sibilants to select it. Next, select Dynamics|
Multi-Band from the Effects menu and choose the Reduce loud sibilants (de-esser) preset. This preset 
acts upon frequencies around 5,000 Hz. Previewing the effect should make the S sounds less painful.

Next, make a selection on the region named plosives. This can be done by pressing the Selection button 
and choosing Region: …and sibilants. In the Multi-Band Dynamics dialog, choose the Reduce loud 
plosives and hit Preview. The loud P becomes less obtrusive and unlike EQ, this reduction doesn't affect 
the entire sound file. It only acts upon the plosives.

There is also a Multi-Band preset called Reduce plosives and sibilants which you can
use to remove both S's and P's at once. This is basically the same effect as running one

first and then the other.

When applying these presets to your own files, you will most likely need to change the Threshold setting 
until only the unwanted sounds are affected. If the Threshold is too low, too much filtering will occur. 
Setting the filter to -Inf. forces filtering of all the data. Also, you can also boost a band after compression 
by using the Gain control to compensate for any loss during processing.



Changing Pitch and Time Duration
You are probably familiar with how changing the playback rate of a recording affects its pitch. For 
example, playing a 33 1/3 RPM vinyl record at 78 RPM makes the Beatles sound like the Chipmunks. 
Likewise, playing a 78 RPM record at 33 1/3 makes a trumpet sound like a tuba. This concept is used by 
most sampler units to make a single sound file achieve different pitches.

Open the file SAXRIFF.WAV. Under the Effects menu, select Pitch|Shift.

Next, select the Fifth up preset and select OK. Notice that the length of the file is less than its original 
size. Listen to the sound to hear both a higher pitch and a faster rate.

Undo the last operation and return to the Pitch Shift dialog. Now, select Fifth down and select OK. The file
is now larger, slower, and lower in pitch.

Altering Pitch Without Changing the Duration of the Sound
Undo the last operation and return to the Pitch Shift dialog. In the last two examples, the Preserve 
duration check box was left unchecked. When you check this box, a completely different algorithm is used
to change the pitch of the sound.

Select the Third down preset and check the Preserve duration check box. Next, you must select a mode. 
Different algorithms are included for different kinds of sounds. These modes are only suggestions, since 
many will work with different types of sound. It's best to just try a few different ones and choose the one 
that sounds best to you. For this saxophone riff, the mode named A13. Solo instruments 4 does an 
excellent job.

Now, preview the sound. The sound file will now have a higher pitch, but it will not sound as if it's being 
played back faster.

Changing Time Duration Without Changing the Pitch of a Sound
Another Sound Forge process unique to digital processing is the ability to stretch or compress the time 
duration of a sound without altering the pitch. This is useful for lengthening or shortening sounds to meet 
a specific time length.

Open SAXRIFF.WAV and select Time Compress/Expand from the Process menu.

This process is very simple to use. In the dialog, you have the ability to specify the final duration of a 
sound, from 50% to 500% of the original length. Like in the Pitch Shift dialog, you must choose a mode 
from a list depending on the type of material you're processing. The mode named A13. Solo instruments 4
(less echo) does a good job with this sound file. Change the Final length from 2.5 to 2.0 seconds (80% of 
original) and select OK. Press the Play button and you should hear the riff played at a faster tempo.

The A and B modes used in both Time Compression/Expand and Pitch Shift without change of duration 
work in a similar fashion. Modes labeled C are from Sound Forge 3.0. Basically, the reason why there are 
so many options is that compromises must always be made between having excellent time localization 
(no echoes) and accurate frequency reproduction (no low-frequency distortion or flanging).

If you have sounds that have few loud, sustaining low-bass frequencies, you can use modes that will 
result in no echoes. These include the Drum modes and some of the Solo Instrument modes. For 
complex music, you must sacrifice some time localization for the ability to reproduce long bass notes.

Since classifying sounds into strict categories is not possible, different settings are included for each 
sound type. For example, if you have a drum recording with bass drum, snare, and cymbals, you find the 
A17. Drums, unpitched (minimum echo) does an impeccable job. However, once you start adding ringing 
low toms and congas, the A18. Drums (better for toms) preset will work better. Again, experimentation is 
the key.    



Small and Accurate Changes in Time Duration
If you have a sound file that is one minute and three seconds long, but you need it to be exactly one 
minute, there are two ways to go about it. If a very small change in pitch is acceptable, you might try using
the Pitch Shift with no Preserve duration. Keep the Semitones at 0 and adjust the Cents until the required 
Final length is reached. It is sometimes possible for this method to give better sounding results than when
using the Time Compression algorithm.



Synthesis
Simple Synthesis
The Simple Synthesis tool can be used to generate a simple waveform of a given shape, pitch, and 
length. More complex waveforms can be generated with the FM Synthesis tool.

Create a new window by selecting the New item from the File menu and set the data format for the 
window to be 16-bit, 22,050 Hz, Mono. Next select Synthesis|Simple from the Tools menu.

Select the Middle C Reference (3 seconds) preset and press OK to generate a sine wave in the window 
that is 3 seconds long and has a pitch of 261.52 Hz (Middle C). Press the Play button to hear your 
reference tone.

FM Synthesis
Sound Forge's FM Synthesis tool allows you to use frequency modulation (FM) and additive synthesis to 
create complex sounds from simple waveforms. 

In frequency modulation, the frequency of a waveform (the carrier) is modulated by the output of another 
waveform (the modulator) to create a new waveform. If the frequency of the modulator is low, the carrier 
will be slowly de-tuned over time. However, if the frequency of the modulator is high, the carrier will be 
modulated so fast that many additional frequencies, or sidebands, are created.

Sound Forge allows up to four waveforms (operators) to be generated in a variety of configurations. 
Depending on the configuration, an operator can be a carrier, a modulator, or a simple unmodulated 
waveform. Waveforms can also be added together (additive synthesis) to add more complexity to the 
sound.

The best way to become familiar with this module is to start with a single operator configuration and try 
out all the different waveforms by themselves. Experiment using Feedback on each waveform to hear the 
different effects of self-modulation. Feedback adds overtones to the sound by modulating the sound with 
itself. Zero feedback indicates simple synthesis.

In the second configuration, two unmodulated operators are mixed together (horizontal connection) and 
heard simultaneously (additive synthesis).

Now change the Configuration to two stacked operators (vertical connection) and again experiment using 
different waveforms and frequencies on the carrier (bottom operator) and the modulator (top operator). 
With the modulator Frequency set low (1-5 Hz), lower the modulator Amplitude to create slight de-tuning. 
Raising it creates big pitch bends. If the modulator Frequency is set high, many unusual FM sounds can 
be achieved. Make sure that the modulator Amplitude is not too high, otherwise the result will be harsh, 
noise-like sounds.

Setting the modulator Frequency to 0.00 allows absolute control of the carrier's pitch by using the 
modulator's envelope, which you can use for de-tuning over time.

Adding more operators increases the complexity of the waveform. When both FM and additive synthesis 
are combined, an almost endless variety of sounds can be generated.

DTMF Synthesis
The DTMF Synthesis tool is used to generate the dial tones used by telephone companies. These dial 
tones correspond to the numbers in a telephone unit, along with other special codes. 

For example, select the Sonic Foundry, Inc. preset. The dial string shows Sonic Foundry's phone number.
The Amplitude control determines how loud the tones will be. Press OK to generate the tones. Now when 
you play back the sound file, you'll hear the tones which when played over a phone line would trigger a 
call to Sonic Foundry.





Filtering
Filtering Intro 
Paragraphic EQ 
Graphic EQ 
Parametric EQ 



Filtering Intro
What can you do when you have a sound that is not quite perfect, but not bad enough to throw away? 
Sometimes, judicious use of filtering can keep a favorite sound bite from losing favor. Filtering is not a 
cure-all for bad sound, but slight alterations of a sound can bring it back to life.

Sounds are composed of varying amounts of one or more frequencies. For example, a sound with a rich 
timbre will contain many different frequencies. A sine wave sound has only one frequency in it, like 60 or 
440 Hz.

Filters allow the tailoring of the frequency spectrum of a sound. A spectrum is nothing more than a 
representation of how much of each frequency component (from 20 Hz up to one-half the sample rate) is 
present in a signal. Less of any given component means that the given frequency component is not as 
prevalent aurally as another component. Filters pass or reduce (attenuate) frequency components.

Many factors such as the frequency response characteristic of your speakers and sound card can also 
affect which frequencies are more prominent during the playback of a sound. In general, the goal is to 
make a recording sound as close to the original as possible. However, filtering is also commonly used to 
remove unwanted sounds such as noise, or make individual instruments in a recording sound louder.



Paragraphic EQ Video tutorial
The Paragraphic EQ is a set of six very flexible parametric filters. Four independent band filters allow you 
to boost or attenuate specific frequency ranges. Also, two shelving filters let you control the amount of low
and high frequencies in your recordings. A Gain vs. Frequency graph shows the overall effect of the 
combined filters, making it easier to visualize the final sound.

Open TUTMUSIC.WAV and select EQ|Paragraphic from the Process menu. Next, select the 15 dB notch 
centered at 1000 Hz preset. Notice how the graph goes below the centerline at 1000 Hz.

Hit Preview and listen to the very strange, hollow sound caused by the missing mid-range frequencies. 
Moving the Gain fader of the third filter further down from -15 dB to -25 dB will increase the effect. Next, 
move the fader - 25 dB to +9 dB and listen to the drastic tone difference.

Double-clicking on a band's Gain fader resets its value to 0 dB, which disables the band.
To disable all bands, right-click on an unused portion of the dialog and select Reset All

from the shortcut menu.

Each of the four bands has a Center frequency, Gain, and Width control. The Width control determines 
how may octaves above and below the center frequency will be affected by the filtering. For the most part,
try to keep the width around one octave. If the width is small, fewer frequencies will be affected.

Select the Boost bass frequencies below 250 Hz by 4 dB preset and hit Preview. Here, the low-shelf filter 
is used to make low frequencies louder. Change the gain from +4 to -15 dB and check out how most of 
the bass has been drastically reduced, as if being played through a small radio.

Open the file CREEK.WAV. This file contains a recording of a small stream. If you look at the waveform, 
you'll notice that there are some very high level, low frequency waves in this recording, probably caused 
by the wind. They are inaudible, yet if you look at your speaker's woofers during playback, you'll see them
bouncing up and down. This large excursion can damage some speakers and forces both the amplifier 
and woofer to work overtime. Woof!

To remove these frequencies, go to the EQ|Paragraphic dialog and select the preset titled Remove very 
low and inaudible frequencies below 20 Hz. Now hit Preview. Turning the Bypass check box on and off, 
you should notice no audible difference. Hit OK. Notice how the large waves are gone and your woofers 
are no longer crying for help. 

Removing very low and inaudible frequencies after recording is a very good idea. For
one, your waveform will look more natural and the level meters more accurate. Also,

edits and effects will behave more predictably, giving you extra headroom.



Graphic EQ Video tutorial
The Graphic EQ divides all the possible frequencies into ten bands which you can boost or attenuate 
(cut). Each band has a Center frequency related to it. The 125 Hz band, for example, affects frequencies 
between 90 and 190 Hz. The Gain value above each band indicates the amount of cut or boost applied to
the band. When a band is set to zero, it means that the frequencies in the band will not be modified. 
Positive gain values indicate a boost and negative values indicate a cut in amplitude.

Open TUTMUSIC.WAV and select EQ|Graphic from the Process menu.

Select the Cut high frequencies above 4 kHz by 12 dB preset and press OK to remove the high 
frequencies from the music bed file. Press the Play button to hear how the music is much duller.



Parametric EQ Video tutorial
Sound Forge has four basic types of parametric Filter styles: High-pass, Low-pass, Band-pass (peak), 
and Band-reject (notch). A low-pass filter alters frequencies above a certain value, and a high-pass filter 
alters frequencies below a certain value. A band-pass filter alters frequencies outside of a specified range.
A band-reject (or notch filter) alters frequencies inside a specified range. Generally, each filter attenuates 
frequencies in its stopband range(s) and leaves frequencies in its passband range alone.

The rate at which the passband transitions into the stopband is the transition band (or rolloff). When you 
specify the characteristics of a filter in Sound Forge, you will no doubt be tempted to specify that a low-
pass filter will start to transition at, say, 1,000 Hz and finish transitioning by 1,001 Hz. The problem with 
doing so is that there are mathematical limitations to creating such a filter. When you specify a sharp 
transition band, the software will try to design a filter that will take a long time to apply and will 
unnecessarily filter the signal to overly exacting requirements. Razor-sharp filtering can often create 
unwanted side-effects. The more subtly you filter a signal, the more natural it sounds.

When specifying the attenuation amount for your filter, you are selecting how much to de-emphasize the 
frequency components that you do not want to hear. Numbers that are more negative suppress the 
frequency components more heavily. In other words, -6 dB of stopband rejection is going to let more 
unwanted frequencies through than -15 dB will.

So, let's say you just recorded a great hamster sneeze, but there is something not quite right about it 
when you play it back later. What can you do to restore the hamster sneeze to its rightful place as your 
favorite sound in your Windows environment?

Maybe you used a microphone preamp with bad common-mode rejection characteristics, or you set the 
hamster right next to a lamp when you recorded the sneeze? Well, don't panic, because Sound Forge can
fix that sound. Try applying a 60 Hz notch filter to the sound. A notch filter will notch-out the frequencies in
a range about 60 Hz so that they are not as readily heard relative to other frequencies. 

Maybe the hamster sneeze has too much hiss in it? Try applying a low-pass filter and see if that makes it 
better. Remember, a small amount of filtering goes a long way.

Open TUTMUSIC.WAV and select EQ|Parametric from the Process menu.

Select the Phone-line effect preset and press OK to run the filter. Press the Play button to hear how the 
music is much thinner sounding, quite like hearing it over the phone. The Band-pass filter has attenuated 
frequencies below 250 and above 7000 Hz.



The Playlist and Regions List    Video tutorial

In this section, we will go over Sound Forge's ability to create regions and markers in a Data Window and 
how to use the Playlist to arrange them. Each Data Window has its own Regions List and Playlist stored 
along with the sound data when using the .WAV file format.

Uses for the Regions List and Playlist

Creating Regions

Editing Regions

Arranging Regions in the Playlist

Creating a new file from the Playlist

Using Markers



Why use the Regions List and Playlist?
Fast Navigation
The most basic use of the Regions List is for dividing a sound file into separate named regions. These 
regions can then be quickly played or highlighted in the data window. You can also mark important time 
positions with markers so that you can get around large files faster.

Destructive vs. Non-Destructive Editing
When you perform edits on sound files using cut-and-paste operations, Sound Forge must shift the sound
data on your hard drive. When working with large files, this process can take longer than your patience 
may be able to handle. However, when you create regions in the Regions List and then rearrange them in
the Playlist, only the playback (as opposed to the hard-disk storage) order changes. This is called non-
destructive editing since no large chunks of data are moved or deleted in your original file.

With non-destructive edits, as opposed to hard-disk intensive destructive edits, you can listen to your 
changes right away. Once you are done arranging the regions, it is also possible with Sound Forge to 
create a new file containing your final arrangement.

MIDI Synchronization and Triggering
The regions you create can also be triggered using MIDI or SMPTE time code. This is used for 
synchronizing sound files to your sequencer, MIDI controller, or any other time-based media. For 
example, you can assign a MIDI trigger to a voice sound file in Sound Forge and then have your 
sequencer trigger it along with other MIDI instruments. Another use is to assign SMPTE times to special 
effects sound files to match the visual action on a soundtrack. Refer to the MIDI/SMPTE chapter for more 
information on synchronization.



Creating Regions
Creating a Region Using Menu Commands
As with most features in Sound Forge, you can create a region in your sound file in a number of different 
ways. One of the simplest ways is to drag a selection from a data window into the Regions List. 

Let's create a region in the file TUTFILL.WAV. Open the file as explained earlier in the manual and then 
open the Regions List window. This window is opened by selecting Regions List from the View menu or 
by pressing the Regions List button on the Regions/Playlist toolbar. You can also open this window by 
pressing Alt+1.

To create a region, listen to the file by pressing Play and then select the cymbal crash at the end of the 
file. Next, select the Add command from the Regions List shortcut menu in the Special menu. The Add 
Region/Marker dialog will appear.

Name the region Cymbal Crash and then select OK. A region will be created and placed in the Regions 
List. Each region in the Regions List has a Play button which you can use to play that particular region. In 
addition, Region Tags that show the location of the region are created in the Time Ruler.

Other Ways of Creating Regions
There is also a shortcut menu to let you quickly create regions. Select the beginning part of the sound file 
with the drum roll and then right-click on the ruler. From the Ruler shortcut menu, select Add 
Region/Marker and the Add Region/Marker dialog will appear. Name this region Drum Roll. Notice that if 
you click on Drum Roll or Cymbal Crash, in the Regions List window, the region is selected in the data 
window.

The easiest way of creating regions is to drag them from a data window directly into the Regions List 
window. To do this, select the portion of data between the Drum Roll and Cymbal Crash regions and then 
drag it to the Regions List window and release the mouse button. The Add Marker/Region dialog will 
immediately appear upon releasing the mouse button. Name this region Toms and press OK.

Pressing R after a selection is made will create a region as well. This is a very fast method of creating 
regions, however, the Add Regions dialog won't pop up. This means the region will be named 
automatically by its time boundaries. You can change the region name later (see below).

Automatic Creation of Regions
Sound Forge can create regions automatically for you in three different ways. One is to select the Multiple
takes creating Regions mode while recording. This will create a regions every time you hit Record and 
Stop. Another way is to use the Auto Region function (Tools menu). This function analyzes the audio data 
and creates regions based on peaks, or it can create regions based on your Beats per minute settings. 
The other way of automatically creating regions is to use the Regions List|Markers to Regions function in 
the Special Menu, which converts all adjacent markers into regions. See the Reference chapter for more 
information on these functions.



Editing a Region
Changing the end points of a region is as simple as sliding the region tags on the data window ruler 
(above the waveform display). When you left-click on a region tag, the corresponding region end point tag
is also highlighted. Also, the name of the region is displayed in the left side of the status bar. Double-
clicking on a region tag changes the selection points to the region area.

Region edit operations can be performed by right-clicking on the region tags. This brings up the 
Marker/Region shortcut menu. You can then choose from the following options:

Select Modifies the current selection points to be equal to the region end points

Delete Deletes the region, not the sound data, from the Regions List

Split With the cursor between the region boundaries, this command splits the 
region in two using the cursor as the new region boundary

Edit Takes you to the Edit Marker/Region dialog for manually editing region 
attributes

Update Modifies the region end points to be equal to the current selection

Editing Regions in the Regions List
Another way to edit region points is to double-click on a region name in the Regions List. This brings up 
the Edit Marker/Region dialog, which allows you to type in region parameters or select triggers (see the 
MIDI/SMPTE chapter). Also, right-clicking on the Regions List allows you to choose from various 
commands in the Regions List shortcut menu.



Adding Regions to the Playlist
Let's now arrange the regions you've just created in the Playlist. To add regions to the Playlist you can 
either use the menu or you can drag regions from the Regions List into the Playlist.

Since we already have some regions defined, we can just drag the regions from the Regions List into the 
Playlist. First, open the Playlist window by selecting the Playlist item from the View menu or pressing 
Alt+2. Next, drag the Drum Roll region into the Playlist. Repeat this procedure with the other two regions. 
Selecting the play button in front of any region in the Playlist plays the regions sequentially starting at the 
selected region.

The Playlist shows the sequential order that regions will be played back. In front of the name of the 
region, there is a number which indicates the number of times the region will be played before the next 
region is played. After the name is the start time of the region. Several display options are available in the 
Regions List and Playlist folder in the Preferences dialog.



Arranging the Playlist regions
Let's assume that you want the Toms region before the Drum Roll region. Select Drum Roll from the 
Playlist and drag and drop it to below Toms. When you start playback from the beginning region (press 
the Play button in front of the top region) you can hear the new arrangement. To place a region between 
two other regions, drag and drop the region between the two other regions.

Changing the Region Playback Count
Each region in the Playlist can be played (looped) a number of times. To do this, double-click on a region 
in the Playlist and in the Edit Playlist dialog set the Play count to any number between 0 and 999. You can
quickly change the count for any selected region by using the + or - keys rather than bringing up the 
dialog. If you set the Play count for the Drum Roll region to 3 you can hear the drum roll played 3 times in 
a row.

Playing a Region at Different Points in the Playlist
One other advantage of using a playlist is the ability to repeat the same region at different points in time 
without having to copy the sound data in the file. If you want to create another region with the same data, 
select a region and then select Replicate from Playlist in the Special menu or from the Playlist shortcut 
menu. You can also replicate a region by dragging the region and, while holding the Control key, dropping
it at another position in the list.

Removing a Region from the Playlist
To remove a region from the Playlist, select the region and select Delete from Playlist in the Special menu
or from the Playlist shortcut menu.. You can also select a region and press the Delete key. This operation 
does not affect the sound file data.



Creating a new file from the Playlist
Once you've arranged the Playlist regions, Sound Forge allows you to create a completely new file 
containing the sound data in the Playlist regions. For example, say you've created regions in a file and 
then re-ordered them in the Playlist. To make a new file containing the re-ordered regions, select Playlist|
Convert to New from the Special menu or the Playlist shortcut menu.



Using Markers
While regions are used to specify a section in a sound file, a marker is a location in the sound file you 
wish to use as a reference point. Markers make it easier to get around the sound file, as they are often 
used to tag important locations.

Creating a Marker with the Ruler Shortcut Menu
A marker can be created in the same ways discussed earlier for making regions. The quickest way is to 
place the cursor where you want the marker and then right-click anywhere on the ruler. This will bring up 
the Ruler shortcut menu, where you then select the Marker/Region option. In the Add Region/Marker 
dialog, type in a name for the marker and select OK. If you had no selection in the data window, Sound 
Forge will automatically create a marker at the cursor position. If you have a selection, Sound Forge 
defaults the Type to Region in the Add Marker/Region dialog.

Editing Markers
Markers can be edited in the same way as regions. The marker tags in the ruler can be moved back and 
forth, and shortcut menus appear when you right-click on the tag.

Starting Playback from a Marker Location
To play the sound file beginning at a marker location, press the small Play button to the left of the marker 
name in the Regions List window.

Dropping Markers While Playing or Recording
Another useful feature in Sound Forge is the ability to create markers as you listen to the sound file. To do
so, first start playback on any sound file. A marker will be created each time you press the M key or the 
Mark-In toolbar button. When finished, you can then rename each marker to whatever you wish. The most
accurate method for creating markers during playback is to use the M key.

While recording, you can press the Drop Marker button (to the right of the Play button) in the Record 
dialog. Once focus is on this button, pressing the Spacebar will create other markers.



Sampler Tools
Sound Forge has been designed to allow for integration with samplers, MIDI, and SMPTE devices in your 
studio.    In this section, we will cover how you can use Sound Forge along with other music hardware or 
software.

The MIDI Keyboard
Creating and editing loops
Editing a loop without the Loop tuner
Looping Techniques
The Loop Tuner
Using the Sampler Tool to download and upload samples



The Sound Forge MIDI Keyboard
With the Sound Forge MIDI keyboard, you can control internal or external synthesizers and samplers from
Sound Forge. For example, you might want to test a sound in a sampler after sending (downloading) it 
from Sound Forge. You can also use the MIDI keyboard to listen to the different sounds on a synthesizer, 
in the synthesis section of your sound card, or to practice your mouse-keyboard chops.

Opening the MIDI Keyboard
First, open the MIDI Keyboard window by selecting Keyboard from the View menu. Like any other toolbar 
or pop-up window in Sound Forge, you can resize it, move it around, or dock it to any side of the Sound 
Forge window. Depending on how you resize the keyboard, the keys will be arranged horizontally or 
vertically.

When you left-click on any of its keys, the keyboard automatically turns on if it is not already on. If you 
don't hear anything, its probably because its output has not been connected to a MIDI output device.

Configuring the MIDI keyboard output port and channel
To select a MIDI device, left-click on the MIDI OUT button. A Shortcut Menu will appear listing all the 
devices available for output, like your sound card or other MIDI port. Select the desired device. At the 
bottom of the list is an option to have the MIDI Keyboard send program changes or not. Check it if you 
want to be able to select instruments in the device from the keyboard.

Next, you must select the MIDI channel to be used on the chosen device. Most MIDI devices are 
configurable to accept MIDI commands on any channel.

Still don't hear anything?
If after selecting the correct device, you still can't hear anything when you play on the keyboard, check the
following things:

Set the MIDI Output Velocity of the keyboard to a high value (above 100).

Set MIDI input channel in sound module to the same channel as the Keyboard channel. Also, make 
sure the device is set to receive MIDI input.

Check the device output volume level (is the mixer level for your sound card or the output volume of the
sampler and speakers at a high enough setting?)

For external devices, check your MIDI cables.

Selecting Instruments
To change to a different voice in the synthesizer, select the instrument name from the Instrument List. 
Patch names are arranged as specified in the General MIDI standard (with synthesizers not using the 
General MIDI convention, use the patch number instead of the instrument name). Make sure that you 
have the Send Program Changes option under the MIDI Out Shortcut Menu checked, otherwise you won't
be able to switch between patches.

You can also have Sound Forge generate chords instead of single notes by selecting a chord structure 
from the Chord Structure drop-down list. A chord is then generated using the pressed note as the root of 
the selected chord or interval.

A loop is a region in your sound file which is repeated on playback. In most samplers, since samples are 
not infinite in length, loops are used to create sounds which sustain for a long time. For example, when a 
sampler is told to sustain a flute sound for a long period of time, it loops a short section of the sample over
and over. Loops are also used to repeat sections of music, although for these purposes it is 
recommended that you use the Playlist.





Creating and editing loops
A loop is a region in your sound file which is repeated on playback. Since samples are not infinite in 
length, in most samplers loops are used to create sounds which sustain for a long time. For example, 
when a sampler is told to sustain a flute sound for a long period of time, it loops a short section of the 
sample over and over. Loops are also used to repeat sections of music, although for these purposes it is 
recommended that you use the Playlist.

Ways to Create Loops
To create a loop, first select a section of the sound file. You can hear how this section will sound in looped
mode by selecting the Play Looped button on the playbar. Next, select the Edit Sample item from the 
Special menu. In the Edit Sample dialog, set the Sample type to Sustaining and switch the Loop count 
from Infinite Loop to three and select OK. You could have also created the loop by right-clicking on the 
ruler and selecting Edit Sample or hitting L on the keyboard.

The data window now has tags in the ruler specifying the loop end points. You can play the sound file with
the loop counts by selecting the Play as Sample button on the playbar. This plays the entire file, with the 
looped section repeated three times.



Editing a loop without the Loop Tuner
Once you've created a loop, you can change its length, start, or end-points by sliding the loop markers in 
the Ruler. Left-click on the loop-start marker. While holding the left-button down, slide the marker to a new
location and then release the button. It's as simple as that. You can accomplish the same thing by right-
clicking on the marker and selecting Edit from the Shortcut Menu. In the Edit Sample dialog, you can then
enter manually start and end-points for the sample.

Other options available when right-clicking on a loop point marker are:

Select: Modifies the current selection to be equal to the loop end-points.

Delete: Deletes the loop markers.

Update: Modifies the loop end-points to be equal to the current selection.



Looping Techniques
Have you ever tried to create loops on an external sampler using the sampler's microscopic LCD display?
Only then will you fully appreciate the ease of use of Sound Forge's Loop Tuner. With it, you can create 
loop-points visually and avoid obvious sound wave glitches which result in annoying pops.

Creating a natural sounding loop is not something that comes naturally. There are many factors involved 
that can cause annoying pops and glitches. While experimentation is always required, here are a few 
basic guidelines to follow:

Match end-point amplitudes. It's most common to select the end-points with amplitude of zero (Zero 
crossings).

Match end-point waveform slope. If the waveform changes slope drastically, a pop will be heard.

Match end-point sound level. What this means is that the overall loudness near (~ 100 ms) the end-
points should be equal. It is often very difficult to avoid this with quickly decaying sounds, since the start
point will always be greater than the end-point sound level.

Avoid very short loops. If the loop is smaller than ~50 ms (1/20 Hz), you will most likely create a loop 
with a pitch not equal to the sample pitch. You can experiment with pitch-tuning a loop by creating short 
loops with a length equal to 1/Frequency. For example, if you had a sample of pitch 440 Hz which 
corresponds to A5 on the keyboard, you can try making the loop 2.27 ms. Pitched loops, however, tend 
to not sound like the original sample.



Using the Loop Tuner
Before opening the Loop Tuner window, you must have created a loop in the sound file. For this 
demonstration, open the file TUTORSMP.WAV. This file has a sustain loop already specified in it.

Under the View Menu, select Loop Tuner. 

The Loop Tuner allows you to view both loop end-points at once. The left-hand side of the Loop Tuner 
window shows the end of the loop while the right hand side shows the start of the loop. A seamless loop 
will not have any discontinuities; in other words, the waveform should look smooth as it goes from the end
of the loop back to the start.

Playing from the Loop Tuner
There are three playback buttons in the Loop Tuner, the Play Before Loop , Play Loop, and Play After 
Loop. You can also still use the Play Sample button in the Data Window to hear the entire sample with 
repeated loops.

Switching between Sustain and Release Loops
To switch between sustain and release loops, press the left-most button in the Loop Tuner. An S indicates 
Sustain, while an R indicates Release. Keep this on Sustain for now (the S should be showing).

Fine-tuning loop end-points with the Loop Tuner
If you want to change the loop end-points by a small amount, you can use the Start Point and End-point 
Edit Box spinners. To increment the loop start point by one sample, click on the Start Point Edit Box 
spinner up arrow.

If you left-click on the center button of the spinner, you can increment or decrement the start point by 
larger amounts by sliding the mouse up and down while holding the left-button down. Notice how the start
point waveform (right side of the Loop Tuner display) and the Loop Marker in the Data Window slide along
horizontally in time.

On the lower right hand side of the Loop Window, the sample amplitude at the loop end-points is 
displayed. Although it is highly dependent on the waveform, a good rule of thumb is that the closer these 
two values are to each other the better.

Zero Crossing Finder
As we mentioned earlier, loop end-points should match amplitude and slope. The Zero Crossing Finder 
accomplishes this by finding the next zero crossing of the waveform with a positive slope (you can select 
the slope in the Editing folder in the Preferences dialog).

There are two Zero Crossing Finders for each loop end. One for finding the next zero crossing and one 
for finding the previous zero crossing. To use the finders, just left-click on one of the buttons. By trying out
different locations, moving the start and end-points forward and backward you should be able to quickly 
find loop ends that meet smoothly.

Press on the Play Loop button in the Loop Tuner to hear the current loop. If the loop still clicks when 
played, try moving to different zero-crossings. Remember, you can also use the Loop Point spinners to 
fine tune the end-point location.

Lock Loop Length
Let's assume that you want to shift a loop's position without changing its length. Pressing the Lock Loop 
Length button (Options menu) allows you to do so. When on, any operation you use to change a loop 
point affects both the start and end of the loop, therefore keeping the loop length constant.

For example, with the Lock Loop Length button down, drag the Loop Start Marker in the Data Window 
Ruler to the left. The start and end markers will slide together. Turning the Lock Loop Length off allows 



you to shift each end-point individually. The Lock Loop Length button works the same as the Lock 
Loop/Region Length item in the View menu.

Real Time Loop Tuning
The tools mentioned above for changing the loop end-points can be used while the loop is being played. 
This allows for instant feedback on how the loop sounds. To do so, start playback of the loop by selecting 
the Play Loop button and proceed to use any method to change the loop length. Sound Forge will play the
modified loop points.

Saving Loop Points
Loop points are automatically saved when you save your sound file in WAV, VOC, SDS, SMP, DIG, PAT, 
and AIF file formats. You are allowed to disable the saving of loop points when saving to the WAV format.



MIDI and SMPTE Synchronization
In this section, we will cover how you can synchronize Sound Forge with devices generating SMPTE Time
Code or use a MIDI sequencer or MIDI controller to trigger audio playback.

What is MIDI?
The Sonic Foundry Virtual Router
Using MIDI Triggers
MIDI/MTC synchronization



What is MIDI?
The Musical Instrument Digital Interface (MIDI) is a set of commands that many pieces of music software 
and hardware use to speak to each other. MIDI is most often used for sending commands such as Play 
Middle C Now but can also be used to send information like Current Time is: 00:00:01:23 SMPTE or even 
digital sound data (see Sampler Tools section).

The most common way to use MIDI is to have a Master device (such as a MIDI sequencer) to generate 
MIDI commands to a Slave device (such as a synthesizer which plays a note when instructed). If both 
were in separate hardware boxes, you would run a MIDI cable from the sequencer's MIDI OUT port to the
synthesizer's MIDI IN port.



Sonic Foundry Virtual MIDI Router
NOTE: If you have not installed the Sonic Foundry Virtual MIDI Router (VMR) driver yet, we recommend 
that you do so at this point. Refer to the Appendix labeled Sonic Foundry Virtual MIDI Router    for 
installation instructions.

The VMR allows you to route MIDI signals between software programs such as a MIDI sequencer and 
Sound Forge in much the same way that you would run MIDI cables between MIDI hardware devices. 
The only difference is that there's no need for patch cords or extra hardware.



Sound Forge and MIDI Triggers    Video tutorial
There are many different ways to generate MIDI commands, including MIDI sequencers, MIDI keyboards,
MIDI guitars, and there's probably MIDI maracas out there somewhere. Whatever their source may be, 
MIDI commands can be used to trigger audio playback in Sound Forge.

Triggering file playback from the Sonic Foundry MIDI keyboard
To demonstrate how to use MIDI Triggers, we will first show you how to control Sound Forge using the 
internal MIDI keyboard. This might not be the most useful way of using MIDI triggers, but since everybody
using Sound Forge will have access to the Sonic Foundry MIDI keyboard, this will be a good 
demonstration of using triggers and the VMR. We are assuming that you have the driver installed.

First, open the Keyboard Window by selecting Keyboard under the View menu or by pressing Alt+3. Even
though the Keyboard Window is intended for controlling MIDI devices like sound cards or samplers, it can 
also be used to trigger Sound Forge itself. Next, open a sound file that you wish to trigger.

The first step in setting up MIDI triggering is to make sure that the output of the Master goes to the input 
of the Slave. In this case, the Sound Forge MIDI Keyboard is the master and Sound Forge is the slave. 
Left-clicking on the MIDI Out button in the Keyboard allows you to set were the Keyboard will send its 
MIDI commands. For this example, set it to 1 Sonic Foundry MIDI Router. Also, make sure that the output
channel is set to Channel 1. You won't be able to hear anything at this point when you press on the 
keyboard because nothing is connected to the other end of the VMR.

Now, go into the MIDI/Sync folder under Preferences in the Options menu. For Sound Forge's MIDI In, 
also select 1 Sonic Foundry MIDI Router. At this point, we've connected the two devices, much like 
running a MIDI cable between them.

Next, you must select MIDI Triggers under the Options menu to determine what you want to trigger in 
Sound Forge. For this example, select Play All from the Event list box. In the Trigger section, select Note. 
Type in the note C4 and set the channel to 1. What this does is tells Sound Forge to play the current 
sound file when it receives a C4 Note-On command on MIDI channel 1.

Finally, you must tell Sound Forge to begin waiting for MIDI commands. In the Regions/Playlist Toolbar, 
select the MIDI Input Sync/Trigger button to enable synchronization to MIDI input. (If the toolbar is not 
open, go to the Toolbars folder under Preferences in the Options menu and check the Regions/Playlist 
option). The MIDI Input Sync/Trigger button will remain pressed down and Waiting... will appear in the left-
hand status box. Sound Forge is now ready to accept MIDI commands. 

To test triggering, press the C4 key in the MIDI keyboard (the key with the number 4 on it). The sound file 
should start playback and play all the way through. Notice that when you press C4, the status box 
displays that it has received a C4 Note On message on channel 1. 

Its important to understand the difference between triggering playback with the MIDI keyboard and 
selecting the play button in Sound Forge. When you press a note in the MIDI keyboard, MIDI commands 
are sent from Sound Forge to an external device (in this case the VMR) and then back to Sound Forge's 
MIDI input port. The MIDI commands which arrive at the Sound Forge MIDI input port could be coming 
from any software or hardware device that generates MIDI.

There are a few other commands in the MIDI Triggers dialog you can experiment with. They are explained
in more detailed in the Sound Forge Reference Section.

Triggering region playback from the Sonic Foundry MIDI keyboard
Let's now trigger regions from the Regions List. First, go to the MIDI Triggers dialog (Options menu) and 
set all the triggers to NONE by selecting the All triggers off Preset. If you have triggers in both the MIDI 
Triggers dialog and the Regions List, make sure that they correspond to different MIDI notes if you don't 
want unexpected results to occur. Next, open a file which has regions specified in the Regions List. 



Double-click on the first region in the Regions List and select MIDI Note-On Play. Also, set the note to C4.

Make sure that the output of the MIDI keyboard and the MIDI Input of Sound Forge are set to Virtual MIDI 
1 and all channels set to 1 as in the previous section. Press down the MIDI Input Sync/Trigger toolbar 
button to Synchronize MIDI Input (you can also do this in the Options Menu).

If everything has been done correctly, when you press C4 in the keyboard the first region will be played.

By repeating the previous steps, you can give each region a MIDI trigger. Set the MIDI notes to different 
values, like C3 and C5 so that notes on the keyboard correspond to different regions. Note: Sound Forge 
can play only one region at a time. Overlapping causes the earlier region to cut-off and the new region to 
be played back.

Triggering from internal sequencers
The basic concepts of MIDI In and MIDI Out routing used in triggering from the internal MIDI keyboard 
apply to any hardware or software device which can generate MIDI commands. You should be able to 
follow the instructions for triggering with the MIDI keyboard and substitute your device's output port and 
channel number.

Suppose you have a MIDI sequence in you sequencer to which you wish to add a vocal track starting at a
set time. You could accomplish this most easily by attaching a MIDI Trigger note to the sound file in 
Sound Forge and having the sequencer play the trigger note at the correct starting time. You can also 
accomplish this using SMPTE times as shown in the next section.

Triggering from external devices
The same procedure applies for triggering with external devices. You will have to set Sound Forge's MIDI 
input port (under MIDI/Sync Preferences) to the external device output port.



Sound Forge and MIDI Time Code synchronization Video tutorial
MIDI Time Code (MTC) is a way to transmit SMPTE timing signals between devices for synchronization. 
For an overview of SMPTE , check out Appendix E which explains the differences in 29.97 FPS, 30 FPS , 
Drop and Non-Drop, and other confusions. Although MIDI Time Code is most often used to sync audio 
tracks to visual action on video, it can also be used to synchronize other playback devices, like a MIDI 
sequencer, to Sound Forge. 

Sound Forge has the ability to synchronize to external MTC or generate MTC for other devices to follow.

Playing regions using MIDI Time Code from a software MIDI sequencer
It is possible to specify start times for each region in your Regions List for synchronizing digital sounds 
with other timed events. For example, if your MIDI sequencer or other device generates SMPTE Time 
Code, Sound Forge can make its SMPTE time accurately follow the device's SMPTE time and play the 
regions at the specified times. 

Synchronizing to MTC is very similar to synchronizing to other MIDI events. However, if you just want to 
trigger a few sounds in Sound Forge from your sequencer, it might be easier to use Note-On MIDI 
Triggering and not worry about MTC or SMPTE synchronization (refer to the section on Triggering from 
internal sequencers). MTC synchronization uses up more of your computer's processing power, yet its the
only way to go if you don't want to (or can't) generate MIDI triggers. Also, MTC synchronization allows you
to specify accurate SMPTE start times in Sound Forge instead of in other software or hardware devices.

Here are the basic steps to follow when triggering a sound region in Sound Forge from a sequencer using
MTC:

1. In Sound Forge, open a file and create a region in both the Regions List and the Playlist.
2. Double-click on the region in the Playlist. Select Play at SMPTE Time from the Trigger drop down 

list.
3. Set the SMPTE start time for the Region. Sound Forge displays SMPTE time as 

Hours:Minutes:Seconds:Frames. Make sure that you are using the same SMPTE Time format and 
frames per second in both Sound Forge and the sequencer. Refer to Status Format and Status 
Preferences

4. Now, in the MIDI/Sync folder under Preferences, make sure that the Sound Forge MIDI input port is 
set to the same port as the output of the sequencer. For example, set both ports to 1 Sonic Foundry
MIDI Router. 

5. Verify that in the MIDI Triggers dialog (Options Menu) all the triggers are set to None. This prevents 
other MIDI commands from also creating triggers.

6. Enable MIDI Input Sync/Trigger mode by either pressing the MIDI Input Sync/Trigger toolbar button 
or selecting MIDI Input Sync/Trigger from the Options menu. Now, Sound Forge is ready and 
waiting for synchronization to MTC.

7. Switch to your sequencer. Set the MIDI Out port to be the same as Sound Forge's MIDI Input port. 
Refer to the sequencer's manual for information on setting MIDI ports.

8. Enable MTC output in your sequencer. (Refer to the sequencer's manual for information on how to 
do this.) If your sequencer supports generating MTC you should now be ready to sync.

9. Press play in the sequencer. In Sound Forge, you should see the MIDI In status box display the 
same SMPTE Time as the sequencer's time. At the set SMPTE time, Sound Forge should play the 
region without interrupting your sequencer's output to any other devices.

Playing regions using MIDI Time Code from an external device
If you have a hardware device (i.e. SMPTE Time Code to MTC card) that generates MTC, the procedure 
is basically the same as outlined above. In Sound Forge's MIDI/Sync Preferences folder, you should be 
able to directly select the device's MTC output driver as Sound Forge's MIDI input port.

Using Sound Forge to generate MTC for a MIDI sequencer



Follow these step if you want Sound Forge to generate MTC for other devices to follow.

1. Open a large sound file. Sound Forge only generates MTC while playing a sound file or the Playlist.
2. Now, in the MIDI/Sync folder under Preferences, make sure that the Sound Forge MIDI output port 

is set to the same port as the output of the sequencer. For example, set both ports to 1 Sonic 
Foundry MIDI Router. 

3. Verify that in the MIDI Triggers dialog (Options menu) all triggers are set to None. This prevents 
other MIDI commands from also creating triggers, which might create unexpected results.

4. Enable MIDI Output Sync mode by either selecting the MIDI Output Sync toolbar button or selecting
MIDI Output Sync from the Options menu. Now, Sound Forge will output MTC whenever you start 
playback.

5. Switch to your sequencer. Set the sequencer's MIDI In port to be the same as Sound Forge's MIDI 
Output port. (Refer to the sequencer's manual.)

6. Set the sequencer's SMPTE Offset Time as required. Sound Forge always uses 00:00:00:00 as its 
output start point. For some sequencers, it is suggested that the SMPTE Offset Time be set to at 
least four seconds to ensure correct synchronization.

7. Enable MTC input (again, check the sequencer's manual). This usually entails switching the timing 
generator in the sequencer from Internal to MTC. You should now be ready to sync.

8. Press play in the sequencer (some sequencers don't require you to do this). The sequencer should 
not start playback. Instead it should switch to a Waiting for MTC mode.

9. In Sound Forge, start playback in the Data Window or Playlist. The sequencer should start following
Sound Forge's SMPTE Time when the SMPTE Offset Time is reached.

Using Sound Forge to generate MTC for an external device
If you want Sound Forge to send MTC to an external device, follow the previous instructions for sending 
MTC to a sequencer with a few changes. Instead of sending to the VMR, have Sound Forge's MIDI output
port send directly to the device's MIDI driver. Check the device's manual for more detailed information on 
using MTC.



Optimizing Sound Forge
This chapter contains information on how to configure your system to maximize Sound Forge's 
performance.

Hard-Drive Use
Editing in Direct Mode 
Fast File Saving 
Playback Cursor and Record Counter 
Meters 
Passive Updating for Video and Time Displays 
Audio and Video Synchronization 
Setting up Wave Devices
Background Processing
Crash Recovery



Hard Drive Use
Sound Forge is a disk-based sound editor which means that all editing operations are performed on your 
hard drive rather than in your computer's memory. This allows Sound Forge to edit sound files of almost 
unlimited size. Sound Forge also stores undo/redo information and clipboard data on the hard drive.

The drive you specify for Temporary storage (on the Performance page of the Preference folder) must 
have enough free space to store the data for each opened sound file, as well as undo/redo information, 
and the clipboard. Although this can use a lot of disk space, it allows you to edit long sound files that 
could never fit into your computer's memory (RAM). And hard drives are typically much cheaper than 
memory.

Since Sound Forge is hard-drive intensive, the faster your disk access, the faster Sound Forge will be. 
The easiest thing to do to improve your performance without buying new hardware is to defragment your 
hard drive. Over time, and especially with heavy use, a hard drive can become fragmented. This means 
the data stored on the hard drive gets scattered across the surface of the disk making your files 
discontiguous. When files are discontiguous, the hard drive must jump around to retrieve the data. This 
jumping around can slow down access to your files and can be very noticeable on older hard drives. DOS
6.0 and above come with a program called Defrag that will defragment your hard drive. Windows 95 
comes with a Disk Defragmenter utility which can be found in the System Tools folder in your Accessories
folder. 

The following guidelines will help you optimize your hard drive depending on which operating system you 
are running.

Windows 95
Windows 95 Default Configuration
Choosing system configuration settings other than the default Windows 95 settings can result in reduced 
performance from Sound Forge, as well as Windows 95. To check these settings go to System under 
Control Panel and click the Performance tab. File System and Virtual Memory should both be set to 32-
bit. In the advanced settings area of the window, click on File System. In the File System Properties 
dialog, the Hard Disk tab setting for Read-ahead optimization should be set to Full and the 
Troubleshooting tab should have all of the options unchecked. 

Now, click on Graphics in the Advanced Graphics Settings dialog. In most cases this setting should be set
to Full. If you are experiencing unexplained glitching in your audio playback, try different settings. 
However, if changing these settings doesn't clear up the problem, change them back. Finally, click on the 
Virtual Memory button under the Advanced settings of the Performance page. In most cases, you should 
choose to let Windows 95 handle your virtual memory.

Windows NT
Windows NT Default Configuration
There are no special considerations for Windows NT.

Windows 3.x
Use 32-Bit Disk Access
When running Windows in Enhanced mode, most PCs can be configured to use 32-bit disk access for 
virtual memory in Windows. Enabling this option can dramatically improve overall system 
performanceespecially if you have less than 8 megabytes of RAM. This option can be found in the 
Enhanced option of the Windows Control Panel. Select the Virtual Memory button and enable Use 32-bit 



Disk Access (if it is not already enabled). 

Note: You will need to select the Change button before you can see this option. Windows
will inform you if 32-bit disk access cannot be used on your computer.

Windows 3.x for Workgroups
Use 32-Bit File Access
Windows for Workgroups 3.x provides greatly enhanced file access performance. Enabling this option can
dramatically decrease the time it takes to access data in a file. This option can be found in the Enhanced 
option of the Windows Control Panel. Select the Virtual Memory button and enable Use 32-Bit File Access
(if it is not already enabled). 

Note: You will need to select the Change button before you can see this option. The
default Cache Size should be sufficient. Refer to your Windows for Workgroups 3.x

documentation for more information on selecting a cache size.



Editing in Direct Mode
Whenever you open a file in Sound Forge, a backup copy is created so that the original file is not affected
until you select to save your work. However, when you open a file as read-only or direct (specified in the 
Open dialog), Sound Forge will not create a backup copy of the file, which makes opening files quicker 
and uses less disk space. In fact, editing in direct mode can make opening a file almost instantaneous. 
Direct mode can only be used on files which are 16-bit and stored in the Microsoft Wave format.

The first time you open a file in direct mode Sound Forge will scan the file to create a peak file. This 
allows Sound Forge to display the data in the file extremely fast as well. This peak file is stored in the 
same location as the wave file with the same name as the wave file but with the extension .sfk. After a 
peak file is created Sound Forge automatically keeps it updated when you edit the file. The only time the 
peak file may need to be regenerated is if you modify the file with an application other than Sound Forge. 
This allows Sound Forge to instantaneously load the file next time you open it.

The only drawback to editing a file in direct mode is that you no longer have the security of a backup file. 
In most cases this is not a problem, since all changes can be undone (with ample disk space). But if, for 
some reason, Sound Forge terminates improperly, the file would remain in its edited state.



Fast File Saving
When creating a new file Sound Forge creates a temporary file that contains all of your new sound data. 
When you are ready to save the file, Sound Forge must copy this data into the file you specify in the Save
As dialog. If you are saving the sound data as a 16-bit Microsoft Wave file, Sound Forge can make this 
process almost instantaneous by quickly moving the file rather than copying the data to a new file. In 
order for this to work, the new file into which you are saving your data must be on the same drive as your 
temporary storage folder. Thus it is recommended that you keep your temporary storage folder on the 
same drive where you keep most of your sound files. You can set your Temporary storage folder on the 
Performance page in the Preferences folder.



Playback Cursor and Record Counter
The playback cursor and record counter options in the Preferences|Performance folder allow you to 
configure whether or not the numeric counters (position information displayed in status fields) will be 
updated during playing and recording. If you are recording or playing at high sample rates (44,100 or 
48,000 Hz) and are experiencing gapping or skipping problems in the data, try disabling the playback 
cursor and/or record counters to decrease overhead.



Meters
The Play and Record Meters in Sound Forge take a small amount of processing overhead during 
playback and record. If you are experiencing gapping during playback and you have the Play Meters 
showing, try turning off the Play Meters by selecting the Play Meters option in the View menu. If you are 
experiencing gapping during record and you have the Monitor option enabled in the Record dialog, try 
turning off the Record Meters by un-checking the Monitor option.



Passive Updating for Video and Time Displays
Selecting Passive Update for Video and Time Display from the Options menu, will lower the priority of the 
repainting for these displays during playback. If your computer is relatively slow and you are experiencing 
gapping during playback, or the your machine just seems to be bogging down during playback, try turning
on Passive Update. This will force the repaints for the Video and Time Display to only update if there is 
time to do so. In most cases you won't even be able to tell if it is missing some updates, so turning these 
options on can decrease the amount of overhead during playback with little inconvenience.



Audio and Video Synchronization
If you are having trouble synchronizing the audio with your video, there are a few points to keep in mind. If
your video has been opened from a slow device, such as a CD-ROM or network drive, then Sound Forge 
may have trouble accurately playing back the audio and video in sync. This happens because video 
information is streamed at all times from the original .AVI file. You should always copy the videos you are 
working with to a fast hard drive.

After you open an .AVI file you may be notified that your video has very few key frames. This is generally 
representative of tutorial videos captured with a program that saves the video as a Run Length Encoded 
(RLE) stream with a single key frame. Due to non-linear access requirements of    Sound Forge this may 
result    in difficulty with audio synchronization.    It is recommended, that you save your file with more key 
frames and re-open it for better performance during digital editing.

Here are a few other    tips that can help when trying to synchronize the audio and video:

After assembling or editing the audio you wish to use with your video, place markers during video 
playback to correspond to any major synchronization points. You can locate a particular frame by 
dragging the cursor along the audio    provided the Video Preview window is open or the Animate Video 
Strip option is enabled. After primary locations have been located, double-click and drag your audio to 
these markers bringing up corresponding dialogs for mixes, pastes, and crossfades.

Features like Insert Silence, Clear/Delete, and Time Compress/Expand are commonly used to tighten 
synchronization. Another useful trick is to create a region representing the delta between a video frame 
and audio event. Then you can enable the Lock Loop/Region Length and drag the delta region to a 
preceding silent section. Use the region as a template for adjusting the audio stream length    either 
copying and pasting to insert time or deleting to remove time.

When cropping beginning and end silence for your .AVI file, drag your finalized selection to the Playlist. 
Choosing Convert to New will generate a new file depicting your selected region.



Setting up Wave Devices
The Sound Mapper/Wave Mapper
Sound Forge allows you to choose any installed Windows compatible sound card for playback and 
recording. It also provides one more option for playback and record called the Sound Mapper (depending 
on your configuration, this may be called the Wave Mapper). The Sound Mapper is a special device which
attempts to select the most appropriate sound card (map) on which to play a sound, or it will translate the 
sound into a format that can be played on your sound card.

If you are having problems with breakups this may be caused by the overhead introduced when the 
Sound Mapper does format conversions. To check this, make sure that your sound card supports the data
format you are playing or recording. The easiest way to do this is to choose a playback and record device 
that is not the Sound Mapper. If Sound Forge is able to play and record the sound using the actual sound 
card's Wave driver, then the Sound Mapper is not causing the breakups.

However, if the Sound Mapper must be selected to play or record the format that you are having trouble 
with, then you should convert your sound data to a format that is directly supported by your sound card. 
This will remove all overhead required to translate the sound data for your sound card.

There is nothing wrong with using the Sound Mapper when the sound data format is directly supported by
your sound card. The Sound Mapper will simply pass the data through to your sound card which requires 
negligible overhead. For more information on the Sound Mapper, refer to the Appendix called Sound 
Forge and The Microsoft Audio Compression Manager. The Sound Mapper is a component of the Audio 
Compression Manager (ACM).

Total Buffer Size
The Total buffer size option, found in the Wave folder of the Preferences dialog, specifies the total amount
of RAM that should be used for buffering when recording to or playing from the hard drive. For most 
systems 512 kb is a good number. If you are still experiencing gaps during playback you may want to use 
more buffering or record at a lower sample rate.

There are some drawbacks to increasing the Total buffer size. It requires more of your computer's 
memory and, if you have set a large Preload size, there can be small delays when starting and stopping 
playback.

Preload Size
The Preload size option in the Preferences|Wave folder tells Sound Forge how much sound data it should
prepare and load into your sound card driver before starting playback. This preloading is performed 
between the time you press the Play button and the time you hear the sound play.

Turning this option on may help skipping (audible gaps) on initial playback of a sound. These gaps are 
normally observed by people with slow or fragmented hard drives. The trade-off for enabling this option is 
a slight delay before play begins; the delay time is greater for larger preload sizes. This option does not 
affect operations other than playing.

Some Windows sound drivers do not support this option correctly. If you are experiencing noise or 
dropouts at the very start of playback, try disabling this option.



Background Processing
When Sound Forge is performing operations that take a long time, such as opening a file or performing 
audio processing, a Progress Meter is displayed on the status bar. While this Progress Meter is visible, 
Sound Forge is doing its work. You can cancel the operation at any time by pressing the Cancel button to 
the left of the Progress Meter, or you can press the Escape key.

All processing performed by Sound Forge is done in the background. What this means is you do not have
to wait for Sound Forge to finish its work before you can use other applications. If an operation is taking a 
long time in Sound Forge, simply switch to another application and work on something else. Sound Forge 
will continue processing while you work in another application.

If you minimize Sound Forge while it is processing, the percentage processed will update in the title of the
Sound Forge icon. This allows you to keep an eye on Sound Forge's progress while using other 
applications.

You may have noticed that Sound Forge displays the amount of processing time an operation required in 
the status bar when it is completed. This processing time is intended for entertainment purposes onlythis 
value is not intended for accurate profiling. The accuracy of this processing time value is heavily 
dependent on what other activity is being performed by your computer while Sound Forge is working. 
Using other applications while Sound Forge is working can cause the processing time to increase 
substantially.



Crash Recovery
If for some reason Sound Forge is terminated improperly    when Sound Forge or, most likely, another 
program crashes      all of the opened and unsaved sound files can be recovered excluding those opened 
in direct and read-only modes. Unless a file is opened in direct or read-only modes, a temporary file is 
created and any edits made are stored in this file. When an improper termination of the program occurs, 
these temporary files remain on your hard drive and can be reopened to recover any work done to the 
sound files before crashing. Also, the original sound files will remain unchanged until you save your work.

Crash Recovery
When starting the program, any temporary files detected in your temporary file directory will indicate that 
something went wrong. You have the option to delete these files if no important work has been done, or to
just ignore these files. Ignoring the files leaves them intact on your hard drive.

Recover
Use this to change the ending of all file names from FORGExxx.TMP to FORGExxx.WAV. You can then 
open these .WAV files using the File Open dialog. The files will be placed in the directory specified on the 
Storage page of the Preferences folder.

Delete
This command deletes all the temporary files regardless of selection in the drop-down list. Use this only 
when you are sure that no important work is in the file.

Ignore
If you don't want to deal with the temporary files left over from an improper termination at this moment, 
use this command. However, it is recommended that you either rename the files and check their contents 
or delete them, since they are taking up valuable disk space.



Object Linking and Embedding (OLE)
32 Bit Only: OLE support is only available in the 32 Bit version of Sound Forge.

Sound Forge for 32 Bit Windows supports Microsoft's Object Linking and Embedding (OLE) technology 
for improved integration with other applications. This section discussing the implementation details and 
different uses for the OLE technology supported by Sound Forge. The following topics are covered:

Introduction to Object Linking and Embedding (OLE).

Using OLE with Sound Forge.

Tips, Limitations, etc.

Introduction to Object Linking and Embedding (OLE)
Object Linking and Embedding (OLE) is a technology developed by Microsoft to allow independent 
applications to behave as though they are tightly integrated. Note that this is not an all encompassing 
definition, but it will work for the implementation provided by Sound Forge. If you would like a more in 
depth look at OLE, there are many references available at most book stores that discuss the technology.

By using the OLE support in Sound Forge, you can embed digital audio files used by Sound Forge into 
documents used by other applications (such as Write, Microsoft Word and Excel). Once a digital audio file
is embedded into a document, you can then edit the audio with Sound Forge at any time by activating the 
embedded object (usually by double clicking on it with the mouse).

Using OLE with Sound Forge
Sound Forge is an OLE server. What this means is Sound Forge can create OLE objects (serve them up 
if you will) that can be embedded (inserted) into applications that are OLE containers (the consumers of 
objects supplied by servers). Don't let the terms scare you. We'll go through some examples that will 
make everything clear as mud shortly.

The OLE objects that are created by Sound Forge are called Sound Forge Audio objects. These objects 
are really just links (oh no, another term!) to a sound file on your hard disk or network server. Therefore, 
when you embed a Sound Forge Audio object into Write, you are really only inserting a link (a directory 
and file name) to the actual sound file. We will explain why this is important to know in the Tips, 
Limitations, etc. section.

There are three methods that can be used to create Sound Forge Audio objects. When we mention an 
OLE container, we simply mean an application that can contain OLE objects (like Microsoft Word and 
Excel). The three methods are as follows:

1. Dragging and Dropping a link from the OLE Drag Source control in Sound Forge to an OLE container.

2. Using the Copy Object Link command in the Edit menu of Sound Forge to place an Object Link onto 
the Clipboard. This Object Link can then be Pasted into an OLE container.

3. Invoking the Insert Object command from an OLE container and selecting the Sound Forge Audio 
object from the list.

Drag and Drop
The most convenient method of embedding a Sound Forge Audio object into a document is to Drag a link 
from the OLE Drag Source control in Sound Forge and Drop the link on the document that you desire. 
Note that the application that you drop the OLE object on must be OLE 2.0 compatible. Because of this, 
you cannot drop Sound Forge Audio objects on Write so the example below uses Microsoft Word for 



Windows 95 when running on Windows NT.

Follow these steps to embed a Sound Forge Audio object into WordPad (Windows 95) or Microsoft Word 
for Windows 95 (Windows NT) using Drag and Drop:

1. Run WordPad (Windows 95) or Word 7.0 (Windows NT).

2. Now run Sound Forge and open a sound file (TUTOR1.WAV in your Sound Forge directory will 
suffice).

3. Ensure that at least a portion of WordPad or Word 7.0 is visible while Sound Forge is open (if either 
application is maximized, you will need to restore them and re-size them accordingly).

4. Locate the OLE Drag Source control in the upper right corner of the Data Window. It is on the right 
end of the ruler and contains the letters OLE.

5. Click and hold the left mouse button on the OLE Drag Source control and then Drag the mouse cursor
while holding the mouse button down.

6. Now Simply Drag the mouse over the top of WordPad or Word 7.0 and Drop it (release the mouse 
button). If you did everything correctly, a Sound Forge Audio object will now be embedded in your 
document.

A newly created sound file must first be saved before you can drag and drop the object into an OLE 
container. If the sound file in question needs to be saved, you will be prompted to do so when you click on
the OLE Drag Source control.

There is an option in the More page of the Preferences dialog to turn off the OLE Drag Source control 
(hide it). It may be desirable to turn this control off if you do not plan to use the OLE Drag and Drop 
support of Sound Forge.

Copy Object Link
Another method for creating a Sound Forge Audio object is to invoke the Copy Object Link command 
under the Edit menu in Sound Forge. This method is sometimes preferable to the Drag and Drop method 
because you do not need a mouse.

Follow these steps to embed a Sound Forge Audio object into WordPad (Windows 95) or Write (Windows 
NT) using the Copy Object Link command:

1. Run Sound Forge and open a sound file (TUTOR1.WAV in your Sound Forge directory will suffice).

2. Select the Copy Object Link command under the Edit menu of Sound Forge. If the sound file needs to
be saved, you will be prompted to do so.

3. At this point, a Sound Forge Audio object is on the Clipboard and ready to be Pasted into a document.

4. Run WordPad (Windows 95) or Write (Windows NT) and select the Paste command from the Edit 
menu. If you did everything correctly, a Sound Forge Audio object will now be embedded in your 
document.



Insert Object
The last method for creating a Sound Forge Audio object is to use the Insert Object command from 
another application. This method provides a convenient way to get a new Sound Forge Audio object 
embedded into a document without having to first create it in Sound Forge and copy it into the document.

Follow these steps to embed a Sound Forge Audio object into WordPad (Windows 95) or Write (Windows 
NT) using the Insert Object command:

1. Run WordPad (Windows 95) or Write (Windows NT).

2. Select the Insert Object command. For WordPad, use the Object option under the Insert menu. For 
Write, use the Insert Object command under the Edit menu.

3. From the Object Type list, select the Sound Forge Audio item and click OK. Note that WordPad has 
two options: Create New and Create From File. You will need to select the Create New option.

4. At this time, Sound Forge will be run automatically to create the new object. A new window is 
automatically opened allowing you to copy or create any new sound data you wish. Note that you 
must create the sound data in the window supplied.

5. After creating any desired sound data, simply save the modifications and close Sound Forge. If you 
did everything correctly, a Sound Forge Audio object will now be embedded in your document.

After the Sound Forge Audio object has been created and embedded into the document, you can edit it at
any time using Sound Forge by double clicking on the object in your document.

Tips, Limitations, etc.
As stated earlier, Sound Forge Audio objects are implemented as links to existing sound files on your hard
disk or network server. Because of this, there are some limitations you should be aware of before using 
the OLE support in Sound Forge.

Links can be broken, but not mended
The most important rule to bare in mind when using OLE with Sound Forge is that links can be broken, 
but not mended. When you create a Sound Forge Audio object, it stores only a link (which is simply a 
directory path) to the sound file. Sound Forge uses links because sound files tend to be very large and 
would usually not be acceptable to store along with your documents.

Because Sound Forge uses Object Links, moving, renaming or deleting the sound file associated with a 
Sound Forge Audio object will break the link. Attempting to edit the object in your document will fail 
because Sound Forge will not be able to locate the correct sound file.

To fix a broken link, simply delete the Sound Forge Audio object from the document and create a new one
using the correct sound file.

If you need to move a sound file that is linked to a document, you can use Sound Forge to save the file to 
a different location and the object link will automatically be updated. However, you must open the sound 
file that you want to move as an object for this feature to work. To open a sound file as an object, simply 
double click on the Sound Forge Audio object in your document; do not open the sound file directly. You 
can then use Save As to move the sound file. Sound Forge will prompt you about updating the object link 
after saving the new file.

Sound files do not travel with your documents
When you copy a document that contains one or more Sound Forge Audio objects to another computer, 
the sound files that are linked to the objects are not copied with the document. If you need to copy a 



document to another computer, you will need to copy all sound files associated with it as well. However, 
you must also ensure that the sound files have the exact same path on the new computer as they did on 
the old computer.

Using a Network Server
To ease the problems associated with moving or sharing documents between computers, it is suggested 
that you use a network server to store all sound files that are embedded in the documents. If you do this, 
all computers that have access to the network server will be able to open and edit the Sound Forge Audio 
objects.

There are two methods of ensuring a common network server will work with shared documents. The first 
is to make sure you use the same drive letter when connecting to the network server on all machines. 
Remember that the full path must remain constant between computers.

The second and more preferable method is to use Universal Naming Convention (UNC) paths when 
embedding Sound Forge Audio objects into your documents. A UNC name looks like this:

\\server\share\<directory and file name>

Therefore, if your sound files are stored on \\myserver\sounds, then open them in Sound Forge using 
UNC path names rather than a drive letter. You can then create the Sound Forge Audio object using either
the Copy Object Link command or the OLE Drag Source control and embed the sound files into your 
documents. By using UNC names, you eliminate the need to use a common drive letter on all computers 
that share the document.

If you are running Windows 95, UNC path names are extremely simple to use. Instead of using a drive 
letter when browsing in the File Open dialog, select Network Neighborhood in the Look In field and 
browse to the appropriate network server and share containing your sound files. This method of browsing 
uses UNC names exclusively.

Sound Forge is not an OLE Container
Although Sound Forge can create OLE objects to embed in other applications, the inverse is not true. 
Therefore, OLE objects created by applications such as Microsoft Word or Excel cannot be embedded 
into sound files open in Sound Forge.

 



Process Menu
Auto Trim/Crop 
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Crossfade Loop
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Fade In 
Fade Out 
Insert Silence 
Invert/Flip 
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Auto Trim/Crop Video tutorial
The Auto Trim/Crop function is useful for removing unnecessary silence in a sound file and automatically 
fading in and out the end-points of a phrase.

Function
The Function allows you to select the mode in which the preset will run.

Keep Edges Outside of the Selection
Silence between the selection points and the sound material is deleted. Use this to remove silence from
the edges of a selection. Data outside of the selection is not deleted.

Remove Edges Outside of the Selection
Silence between the selection points and the sound material is deleted. Anything outside of the 
selection is also deleted. Use this to trim a sound from a larger file.

Remove Data Beyond Loop Points
All data after the selected loop is deleted. Since most samplers never play audio beyond a loop, data 
beyond the loop is unnecessary.

Remove Silence Between Phrases (creates regions)
All silence between phrases inside of the selection is deleted. Regions are created between phrases. 
Use this to delete the silence between sound effects and automatically create regions in the Regions 
List.

Minimum Inter-phrase Silence (0.1 to 3.0 seconds)
Minimum amount of silence which must exist between phrases before a new region is created.
Minimum Length Following Loop End (0 to 48,000 samples)
When using the Remove data beyond loop points option, this number specifies the number of 
samples which must exist after the loop. This is used to ensure that a sampler can loop properly, 
since some samplers don't use the exact loop points supplied.

Attack Threshold (-Inf. to 0 dB)
Instantaneous threshold level used for the detection of the trim/crop start point. -Inf. is complete silence,
0 dB is a maximum amplitude level.

Release Threshold (-Inf. to 0 dB)
Instantaneous threshold level used for the detection of the trim/crop end point. -Inf. is complete silence, 
0 dB is a maximum amplitude level.

Fade In (0 to 100 ms)
After the trim/crop start point is detected, this is the length of fade in applied to the sound file. This is 
useful for preventing glitches at end points.

Fade Out (0 to 100 ms)
The length of the fade out applied to the sound file after the detected trim/crop end point.

                                                         
See also
Process Menu
Sound Processing and Other Tools



Channel Converter Video tutorial
The Channel Converter is used to convert between mono and stereo formats. It can also be used to inter-
mix the left and right channels of a stereo file to create interesting pan effects. 

Output Channels (Mono/Stereo)
Determines the number of channels that the output sound file will have.

New Left Channel
Left (-200% to 200%)
Determines the amount of the original left channel that will be mixed onto the new left channel.

Right (-200% to 200%)
Determines the amount of the original right channel that will be mixed onto the new left channel.

Invert Left Channel Mix (On/Off)
When checked, the new left channel mix will be inverted (polarity reversed).

New Right Channel
Left (-200% to 200%)
Determines the amount of the original left channel that will be mixed onto the new right channel.

Right (-200% to 200%)
Determines the amount of the original right channel that will be mixed onto the new right channel.

Invert Right Channel Mix (On/Off)
When checked, the new right channel mix will be inverted (polarity reversed).

Convert to specified output channels only (no custom mixing) (On/Off)
When checked, the fader mix levels are ignored. When converting from stereo to mono, both channels 
are mixed together at 50%. When converting from mono to stereo, the mono channel is placed in both 
channels at 100%.

                                                         
See also
Process Menu
Sound Processing and Other Tools



Convert to 8 Bit Video tutorial
Use this function to convert 16-bit sound files to an 8-bit format. Because the signal-to-noise ratio of 8-bit 
audio is so small (42 instead of 96 dB), it is suggested that the volume of the sound file be maximized by 
using the Volume or Normalize functions before performing the conversion.

Truncate
This method of 16 to 8-bit conversion simply removes the least significant bits of a 16-bit sample. It is 
the least desirable of the three. 

Round
When rounding, 8-bit values are mapped to the nearest 16-bit value, thereby slightly reducing the 
quantization noise. 

Dither (0.01 to 2.00 bits)
Dithering is used to reduce the audible effects of quantization noise which are most audible in 8-bit 
samples. This is accomplished by adding a small amount of Gaussian noise to the signal to mask the 
more obtrusive 8-bit quantization distortion. 

The dither depth is the amplitude of the added noise in terms of the least significant bits of the sound 
file. For most cases, a value between 0.5 and 1.2 is sufficient.

Tip: Use very small amounts of dithering and listen to whether to quantization noise is
less obtrusive. Increase the dither amount until the dither noise is louder than the

quantization noise.

                                                         
See also
Sound Processing and Other Tools
Converting_16_to_8_bit



DC Offset Video tutorial
Use this command to change the baseline of a sound file. A recorded wave that is not centered around 
the zero baseline in the waveform display is said to have a DC offset. To correct for offsets, a constant 
value is added to each sample.

DC offsets are usually caused by electrical mismatches between your sound card and microphone. 
Glitches and other unexpected results can occur when sound effects are applied to files which contain DC
offsets.

Automatically Detect and Remove
When this option is checked, the DC offset is calculated for each channel individually and then 
automatically corrected.

Adjust DC Offset By (-32,768 to 32,767)
Enter the offset value. The offset can be from -32768 to 32,767 for 16-bit data and from -128 to 127 for 
8-bit data.

Tips: An easy way to spot DC offset is to zoom close up to a spot in the sound file
containing only silence and see if the silence waveform matches the centerline in the

waveform display.

An approximation of the DC offset of the waveform can be obtained by running the Statistics function 
under the Tools menu. For example, if a DC offset of 100 exists, then you should apply a -100 DC offset
to cancel out the existing offset.

Compute DC Offset From First 5 Seconds Only (On/Off)
When this option is enabled, only the first 5 seconds of a sound file are analyzed when measuring the 
DC offset. The only time that 5 seconds is not sufficient is if a long fade-in or mute has been applied at 
the beginning of the file.

                                                         
See also
Process Menu
Sound Processing and Other Tools



Graphic EQ Video tutorial
The graphic equalizer can boost or attenuate selected frequency bands to correct or enhance a signal's 
frequency spectrum.

Band Attenuation/Gain Faders (-60 dB to 15 dB)
Each of the nine sliders corresponds to the gain or attenuation factor that will be applied to the specified
frequency region.

The frequency on the bottom of the fader is the center frequency of the frequency band affected by the 
fader.

The value of the fader affects the frequency band as follows:

+15 dBMaximum boost
0 dB No effect

-15 dB Maximum attenuation
Accuracy  (Low, Medium, High)
Determines a compromise between filter precision and processing speed. Low precision is not 
recommended for performing very sharp filtering, when filtering very low frequencies, or when using a 
high sample rate.

                                                         
See also
Process Menu
Sound Processing and Other Tools
Using Filtering



Paragraphic EQ Video tutorial
The Paragraphic Equalizer is a parametric EQ with a graphical display. It consists of four fully parametric 
peak filters, a high-shelf and a low-shelf filter.

Dry Out (-Inf. to 25 dB)
Amount of unprocessed signal mixed into the output.

Wet Out (-25 to 25 dB)
Amount of processed signal mixed into the output.

EQ Graph
The EQ graph displays the amplitude vs. frequency curve generated from the current settings.

Band Filter:
Gain (-25 to 25 dB)
Determines the amount of boost or cut for the band. To quickly disable a band, set the Gain to 0.0 dB
by double-clicking on the fader handle.
Width (0.3 to 2.5 Oct.)
The bandwidth determines the number of octaves (centered on the selected frequency) which will be
affected by the filtering, i.e. sets the size of the band. Use a high value to affect a greater range of 
frequencies and a low value for a more selective filter.
Center Frequency (20 to 15,000 Hz)
Determines the center frequency for the band.

Enable Low-shelf (On/Off)
When on, frequencies below the low-shelf cutoff frequency will be attenuated or boosted by the amount 
specified.

Enable High-shelf (On/Off)
When on, frequencies above the high-shelf cutoff frequency will be attenuated or boosted by the 
amount specified.

                                                         
See also
Process Menu
Sound Processing and Other Tools
Using Filtering



Parametric EQ Video tutorial
The Parametric Equalizer is a set of four frequency selective filters which allow for very precise changes 
in the frequency content of a sound signal. 

Filter Type (Low Pass, High Pass, Band Pass, Band Reject)
Frequency response characteristic of the filter.

High-pass
Frequencies below f1 are attenuated by the reject ratio. A high-pass filter removes the low 
frequencies of a channel and can be used to remove low-frequency rumbles such as wind, electrical 
hum, or traffic noise.
This High-pass filter works best with frequencies above 150 Hz.
Band-pass (peak)
Frequencies below f1 and above f4 are attenuated by the reject ratio. A band-pass filter restricts 
frequencies higher and lower than a specified band and is useful when trying to isolate or boost a 
particular frequency range of, for example, voice.
The Band pass filter works best when the frequencies are very close together. When they are far 
apart, ringing can occur.
Band-reject (notch)
Frequencies between f1 and f2 are attenuated by the reject ratio. A band-reject filter attenuates a 
selected frequency band and is often used to remove narrow-bandwidth noise such as 
amplifier/microphone feedback or 60 Hz electrical hum.
The Band-reject filter works best with frequencies above 150 Hz.

f1 - f4 (1 - Nyquist frequency)
Cutoff frequencies for each filter type corresponding to the graph.

Graph
A visual representation of the frequency response curve of the filter is displayed. The virtual horizontal 
and vertical axis correspond to frequency and gain.

Reject (-60 to 0 dB)
Amount of attenuation applied to the region specified by the filter type and cutoff frequencies. (0 dB is 
no attenuation, -60 dB is maximum attenuation)

Total Gain (-60 dB to 20 dB)
Amount of gain applied to the signal after processing. (-15 dB is maximum attenuation, 15 dB is 
maximum boost)

Accuracy  (Low, Medium, High)
Determines a compromise between filter precision and processing speed. Low precision is not 
recommended for performing very sharp filtering, when filtering very low frequencies, or when using a 
high sample rate.

Tips
A low pass filter is used to restrict the high frequencies of a channel. Possible uses are electrical noise or 
hiss reduction. Lowpass filters are also used for anti-aliasing a sample before downsampling.
A high pass filter removes the low frequencies of a channel. This can be used to remove low-frequency 
rumbles such as wind, electrical hum, or traffic noise.
A band pass filter restricts frequencies higher and lower than a specified band. This is useful when trying 
to isolate or boost a particular frequency range of, for example, voice.
A band reject filter attenuates a selected frequency band and is often used to remove narrow-bandwidth 
noise such as amplifier/microphone feedback or 60 Hz electrical hum.
By running a filter several times, you can create sharper cutoff curves.
A zero-phase filter can be created by using the following procedure: Run a filter on a file.    Reverse the 
file by using the Reverse function. Run the same filter on the reversed file.    Reverse the file once again. 
By running a filter in both time directions, filter phase shifts are canceled.

Note: The filters designed are FIR Chebychev linear phase filters with 15 to 512 coefficients (the number 



of coefficients determines both the accuracy and processing time of the filter).
In some circumstances, the specified filter parameters will be too stringent for the filter design algorithm. 
This occurs when: filter frequencies are set too close together or too far apart; reject attenuation is set too
low; or the total gain is set too high or low.

                                                         
See also
Process Menu
Sound Processing and Other Tools
Using Filtering



Fade Graphic Video tutorial
The Graphic Fade dialog allows you to draw a fade envelope which will be applied across the current data
selection. Up to 16 envelope points are allowed.

Draw the envelope by pulling the small square boxes (drag points) up or down. You can create a new 
drag point by left-clicking on any point of the fade envelope. To delete a drag point, single-click on it with 
the right mouse button, or double-click on it with the left mouse button. Once you have finished with the 
envelope, press the OK button to apply the fade.

Dither and Noise-shape to Minimize 16-Bit Quantization Noise  (On\Off)
When turned on, noise-shaping is applied to the sound file during processing to minimize quantization 
noise. This effect is most noticeable when the signal is at very low levels, such as near the tails of a 
fade-in or fade-out.

During a fade-out performed without dithering, sinusoidal waves become very blocky and eventually 
become square waves. You really have to crank up the volume to hear this, but if you do a fade-out on 
a 440 Hz sine wave, you'll eventually hear all the overtones associated with a square wave of varying 
pulse widths. This is most apparent when the sine wave drops from -60 to below -80 dB (try it on a 15 
second sine wave that drops from -50 to -Inf. dB).

Noise-shaping works by adding a very small dither signal to the audio. The signal is combined with the 
existing audio in such a way that the noise that is normally generated from quantization is greatly 
shifted towards the Nyquist frequency. In a 44,100 Hz sampled file, noise is transferred to around 
22,000 Hz. Unless you have canine hearing, audibility of such frequencies is naturally attenuated by a 
tremendous amount. In a way then, the noise floor of 16-bit audio is lowered.

Since quantization noise is transferred to near the Nyquist Frequency, it is strongly advised that noise-
shaping not be used with sample rates below 32,000 Hz. Also, it is not recommended that you perform 
noise-shaping more than once on a given selection, i.e. save the dithering until the very end. However, 
noise-shaping is not nearly as effective when performed after a fade instead of during a fade, which is 
why the option to do so is in this dialog.

Show Wave
Press this check box to draw the current selection's waveform on the envelope graph. This is done 
automatically if the selection is small. For stereo files, you also have the option of displaying the left, 
right, or a mix of the two channels.

                                                         
See also
Process Menu
Video tutorial
Sound Processing and Other Tools



Fade In Video tutorial
Use this command to linearly fade a selection from a volume of 0 to a volume of 100%. 

                                                         
See also
Process Menu
Sound Processing and Other Tools



Fade Out Video tutorial
Use this command to linearly fade a selection from a volume of 100% to a volume of 0. 

                                                         
See also
Process Menu
Sound Processing and Other Tools



Insert Silence Video tutorial
Use this command to insert a section of silence into a sample.

Silence Length
Enter the length of the silence block in seconds.

Insert at
Start of Sample
Inserts the silence at the beginning of the file.
End of Sample
Inserts the silence at the end of the file.
Cursor
Inserts the silence at the current insertion point.

You cannot insert silence to a single channel of a stereo file since the length of each channel must always
remain equal. If you wish to insert silence into a single channel you can use the Delay/Echo function to 
delay one channel forwards or backwards in time.

                                                         
See also
Process Menu
Sound Processing and Other Tools



Invert/Flip Video tutorial
Use this command to invert the sample about the base line. Although this does not make an audible 
difference, it can be useful for matching a sample transition when executing certain pastes, mixes, or 
loops.

                                                         
See also
Process Menu
Sound Processing and Other Tools



Mute Video tutorial
Use this command to set a selection to a volume of 0 (silence).

                                                         
See also
Process Menu
Sound Processing and Other Tools



Normalize Video tutorial
Use this command to maximize the volume of a selection without clipping. The Normalize function scans 
the audio and applies a gain to raise its level to a specified (often very high) value.

Normalize Using Peak Level
Checking this option will normalize the sound file using the maximum (instantaneous) sample values 
detected. A constant gain is then applied to the sound.

Normalize Using Average RMS Power (loudness)
Checking this option will normalize the sound file using the detected average RMS value of the sound 
file. This is helpful for matching the apparent loudness of different recordings.

Normalize to (-60 to 0 dB)
This value indicates the level to which the sound file will be normalized. For example, when using 
peaks, if the peak level is -10 dB, and the Normalize to setting is set to -3 dB, a constant boost of 7 dB 
will be applied to the entire file.

When using RMS levels, normalizing to 0 dB means boosting the signal so that it has the same 
apparent loudness as a 0 dB square wave, meaning incredibly loud. If you were to do so, all of the 
dynamic range of the signal would be squashed and all the peaks would either be clipped or seriously 
compressed (see below). The lesson is, normalizing a peak to 0 dB is OK, but normalizing RMS to 
anything above -6 dB is playing with fire.

Scan Settings
These settings determine the response of the RMS power scan to the dynamics in the sound file.

Ignore below (-Inf. to 0 dB)
Using this control, you can determine the level of material you want to include in the RMS calculation. 
Any sound material below the threshold will be ignored in the calculation. This is useful to eliminate any 
silent sections from the RMS calculation. You should set this parameter a few dB above what you 
consider to be silence.

If you set this value to minus infinity, all sound data will be used. If the value is set too high (above -10 
dB), there is a good change that the RMS value is always below the threshold. In this case, no 
normalization will occur. Therefore, it is good to test the threshold by using the Scan Levels button.

Attack Time (1 to 500 ms)
This control determines how fast the scan should respond to transient peaks in the sound file. A slower 
attack time will tend to ignore fast peaking material.

Release Time (1 to 500 ms)
This control determines how fast the scan should stop using transient peak material after it has begun 
to drop in level. A slower release time will increase the amount of material included in the RMS 
calculation.

Use Equal Loudness Contour (On/Off)
Checking this option causes the scan to take into effect the Fletcher-Munson Equal Loudness Contours.
Essentially, very low and high frequency material is less audible than mid-range audio. This option 
forces the scan to weigh this factor into the RMS calculation.

Scan Levels
This button runs the Peak and RMS scan function on the selection and displays an RMS level as well 
as the highest peak level found. Use this information to set the Normalize to level.

An asterisk (*) following a level indicates that the values displayed are not current. This occurs when 
you first open the dialog or if you change the selection. To update the values, press the Scan Levels 
button.

When previewing a Normalize, the entire file must be scanned even when previewing a 
small selection. Pressing the Scan Levels button stores the current Peak and RMS 
values. This allows you to preview different Normalize to level settings without re-



scanning the entire file.

If the RMS level never reaches the Ignore below threshold, a value of -96 dB will be displayed. You 
must then lower the Ignore below threshold level before processing.

Use Current Scan Levels (do not scan selection) (On/Off)
When this option is turned on, no scan is performed. Instead, the current scan levels shown are used 
(which persist when you close the dialog). This is useful if you want to use the scan levels from a 
different selection or file on the current selection. This allows the same gain to be applied to different 
files (the gain used is based on the Scan Level and the Normalize to setting).

One possible use is to scan a small selection of a track that has the loudest material or most constant 
levels and then using that scan to Normalize the entire file or different tracks.

If Clipping Occurs
These options allow you to choose how you want the Normalize function to handle any clipping that 
could occurs as the sound file is processed when using the RMS option.

Apply Dynamic Compression
With this option selected, any peaks that would clip are limited to below 0 dB using non-zero attack 
and release times to minimize distortion. In other words, a time-varying gain is used to ensure that 
no hard clipping occurs.
This option is useful for getting very loud (it is common knowledge that louder is better, right?), yet 
clear sound during the mastering process.
Also, you achieve best results when converting 16-bit audio to 8-bit or other compressed formats if 
the audio has been maximized before the conversions occur.
Normalize Peak Value to 0 dB
With this option selected, the selection's peak amplitude level is normalized to 0 dB. This applies the 
maximum possible constant gain which doesn't clip to the selection. Less gain is applied than would 
be necessary to achieve the Normalize to RMS level.
Ignore (saturate)
With this option selected any sound data that would clip is allowed to clip. This may not be a problem
if the clipping samples are very short and infrequent, but will sound horrendous if much clipping 
occurs.
Stop Processing
With this option selected any sound data that would clip cause the Normalize function to stop 
processing and display a message to that effect.

Note: When using Normalize on stereo data, if the selection includes both channels,
normalization is computed on the loudest sample value found in either channel and the

same gain is applied to both. If a single channel is selected in a stereo file then
Normalization will effect only that channel.

                                                         
See also
Process Menu
Sound Processing and Other Tools



Pan/Expand Video tutorial
The Pan/Expand window allows you to draw a pan, stereo expansion, or MS mix envelope which will be 
applied across the current data selection. You can create up to 16 envelope points.

Process Mode
Pan (preserve stereo separation)
Allows you to perform right and left channel panning effects without mixing the channels together. This 
is used to simulate left/right positioning of stereo recordings.

Pan (mix channels before panning)
Allows you to perform right and left channel panning effects by first mixing the two channels and then 
changing the volume between channels.

Stereo Expand
In this mode, you can contract or expand the stereo image of a stereo recording, from dead center 
(mono), to completely panned wide (no center channel). For realistic effects, you should not venture too
far from Normal, but do experiment.

To move both endpoints at once, you can select all points be pressing Control+A while focus is on the 
envelope. Dragging one of the points then moves all of the points.

This effect works best with true stereo recordings and will not work with mono material.

Mix Mid-Side (MS) Recording to Left and Right Channels
Mid-Side recording (MS) is a microphone technique where one mic is used to record the center, or mid, 
channel (pointed directly towards the source) and the other mic records the stereo image (pointed 90 
degrees away from the source). For proper playback on most systems, MS recordings must be 
converted to your standard left/right (also called AB) track.

In Sound Forge, to convert an MS-recorded track to a left/right track, you must first ensure that the Mid 
track is in the left track and the Side track on the right. The MS mix function then allows you to set the 
width of the stereo image for the converted track.

Output Gain
The gain applied to the signal after processing.

Show Wave
Press this check box to draw the current selection's waveform on the envelope graph. This is done 
automatically if the selection is small. For stereo files, you also have the option of displaying the left, 
right, or a mix of the two channels.

                                                         
See also
Video tutorial
Process Menu
Sound Processing and Other Tools



Resample Video tutorial
Use this function to change the sampling rate of an existing sound file.

New Sample Rate (2,000 to 60,000 Hz)
Sample rate to which the sound file will be converted.

Apply an Anti-alias Filter During Resample (On/Off)
Apply an anti-aliasing low-pass filter to the sound file before resampling when changing to a lower 
sampling rate. Since the maximum frequency that can be represented by a particular sample rate is 
one-half of the sampling rate (the Nyquist frequency), high frequencies in a sound file cannot be 
represented if the sound file is resampled to a lower sampling rate. Therefore, when changing to a 
lower sampling rate, if the sound file has a strong high-frequency content, anti-aliasing should be used 
to prevent these high frequencies from becoming low-frequency distortion.

Set the Sample Rate Only (do not resample) (On/Off)
If this option is checked the playback rate is changed without resampling the data. This means that the 
original pitch of the file is not preserved. When converting between two very close sample rates and 
speed is of the essence, this option can be turned on.

Resampling data consists of changing the number of recorded samples per second.
When changing to a higher sample rate, extra samples are interpolated and the file size
increases. When changing to a lower sample rate, some samples are removed and the

file size decreases.

                                                         
See also
Process Menu
Sound Processing and Other Tools



Reverse Video tutorial
Use this command to reverse a selection. 

                                                         
See also
Process Menu
Sound Processing and Other Tools



Smooth/Enhance Video tutorial
Use this command to add or remove high frequency content in a sound file selection.

The Smooth function will smooth out fast-changing transients in a sound and is useful for removing 
glitches.

The Enhance function boosts the very highest frequencies (close to the Nyquist rate) in the sound file, 
making the sound file sound more vivid. It is useful for compensating for the effects of downsampling or 
for bringing out very fast transients in a sound file

Operation (-5 to 5)
Determines the amount of smoothing (high frequency attenuation) or enhancement (high frequency 
boost) is applied to the sound file.

For a very drastic high frequency boost or cut, repeat the effect 2 or 3 times with the
amount set to either limit.

Note that since the enhance function boosts frequencies near the Nyquist rate, the current sample rate 
will determine what frequencies will be affected. At 44,100 Hz, the effect can be very subtle (unless you 
repeat it a few times until your ears ring).

                                                         
See also
Process Menu
Sound Processing and Other Tools



Time Compress/Expand Video tutorial
The Time Compress/Expand function changes the duration of a sound file without altering the pitch.

Mode
Selects the algorithm used to process the sound. The modes have been labeled for suggested uses, 
but do not assume that one mode will not work well with a certain type of sound. The A, B, and C 
modes use different algorithms, with the numbers indicating different internal parameters. Depending on
the source sound, different modes can vary the resulting quality drastically, so experimenting with all 
modes is suggested.

You should be able to achieve excellent results for ratios between 75% and 115%. Beyond this range, 
you will start to hear artifacts such as echoes, flanging, or drop-outs. The different modes are supplied 
so that you can determine what works best for your case.

In many cases, many of the modes will work well, but in some instances (such as complex, multi-
instrument music or pitched drums) you'll have to try out all of the modes. In general, the settings 
designed for music will work with the largest variety of material.

Also, running the process a number of times using small increments (like 105%) will create different 
effects that processing all at once with a large time change.

Final Length (50% to 500% of original length)
Desired length of the selection. Note that only the A modes allow for expansion above 150%.

Blend Edges with Adjoining Data (On\Off)
When this option is turned on, the beginning and end of the selections will be crossfaded with the 
original sound data. This is used to minimize glitching.

To change the Original tempo displayed at the bottom of the dialog, you must go to the
Edit Tempo dialog (Special menu).

                                                         
See also
Process Menu
Sound Processing and Other Tools
Changing Pitch and Time Duration



Volume Video tutorial
Use this command to change the volume of a selection.

Gain (-Inf. to 20 dB)
Select a Gain amount from -Inf. to +20 dB. A value of negative infinity corresponds to a mute (0 %). 
Negative decibel values lower the volume (attenuation). Positive values are used to raise the volume 
(boost).

See also
Process Menu
Sound Processing and Other Tools

 



Effects Menu
ACM Filter 
Amplitude Modulation 
Chorus 
Delay/Echo|Simple 
Delay/Echo|Multi-Tap 
Distortion 
Dynamics|Graphic 
Dynamics|Multi-Band 
Envelope 
Flange 
Gapper/Snipper 
Noise Gate 
Pitch|Bend 
Pitch|Shift 
Reverb 
Vibrato 



ACM Filter
Sound Forge has the ability to use Audio Compression Manager (ACM) filters to process sound data. No 
ACM filters come installed with Sound Forge, but ACM filters could potentially be obtained from various 
manufacturers. The word filter in this case does not necessarily mean sound frequency filtering. ACM 
filters can perform most DSP-related functions like delay, volume, reverb, and time change.

This menu item appears only if any ACM filters are installed in your computer. No ACM
filters are included and none are available from Sonic Foundry, so don't think you're

missing out on anything. Several ACM filters are included with Windows 95 and Windows
NT 3.51

Filter
Any installed ACM filters will be displayed here.
Attributes
If the selected filter has predefined parameters, they will be displayed here.

Because Microsoft fully documents the Audio Compression Manager Filter architecture,
anyone who wishes to write a DSP function for use with Sound Forge may do so.
However, writing ACM filters is not for faint at heart; it requires a strong computer
programming background in C/C++ as well as knowledge of audio-related DSP.

The Audio Compression Manager Development Kit can be obtained from Microsoft (please do not call 
Sonic Foundry). It is available on the Video for Windows 1.1 Development Kit as well as the Developer 
Network Platform Level 2.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Installing the ACM
The Audio Compression Manager



Amplitude Modulation Video tutorial
The Amplitude Modulation effect applies a sinusoidal or square shaped periodic gain to the input signal. 
The frequency of the gain waveform can be specified to create effects varying from a slow tremolo to 
unusual sound distortions.

Dry Out (0-100%)
Amount of unprocessed signal mixed into the output.
Modulated Out (0-100%)
Amount of processed signal mixed into the output.
Frequency (0.1-5,000 Hz)
Frequency of the gain waveform to be applied to the input signal. To achieve a slow tremolo, use a low 
frequency (Period = 1/Frequency). With faster frequencies, the amplitude modulation is audible not as a
change in amplitude, but as additional frequency side bands.
Shape (Sine or Square)
Shape of the gain waveform. Sine wave amplitude modulation is smooth, while square wave 
modulation creates drastic on/off changes.
Stereo Pan (On/Off)
When on, the two channels' amplitude gain envelopes are out of phase. This creates the effect of 
panning back and forth between the two channels. Panning is only available for stereo files.

                                                         
See also
Effects Menu
Sound Processing and Other Tools



Chorus Video tutorial
The Chorus effect creates the illusion of two or more sound sources playing together. This is done by 
adding a pitch-modulated and delayed version of the input signal to the unprocessed input signal. The 
effect simulates the variances in pitch and timing that occur naturally when two or more people try to play 
or sing the same thing at the same time.

Input Gain (-Inf. to 0 dB)
Gain applied to the signal before processing.
Dry Out (-Inf. to 0 dB)
Amount of unprocessed signal mixed into the output.
Chorus Out (-Inf. to 0 dB)
Amount of processed signal mixed into the output.
Chorus Size (1 to 3)
Number of times the selection is processed with the chorus algorithm. Larger numbers create a fuller 
sound.
Feedback (0 to 100%)
Percentage of the processed signal which is fed back for re-processing.
Invert the Chorus Phase (On/Off)
When this option is checked, the processed output will be inverted (180 degree phase) before mixing 
with the Dry out. This can sometimes have a large effect on the final sound.
Chorus Out Delay (0.1 to 100 ms)
Time, in milliseconds, that the chorused signal is delayed from the input signal.
Modulation Rate (0.1 to 20.0 Hz)
Frequency, in Hertz, of the modulating signal.
Modulation Depth (1 to 100%)
Amount of frequency modulation applied to the signal.
Attenuate Frequencies Above (100 to 10,000 Hz/Off)
Cut-off frequency, in Hertz, of the low-pass filter used on the processed signal. Setting to off means no 
low-pass filtering occurs.

A wide variety of non-chorus-like effects can be created with this function. If the
modulation depth is high, a vibrato effect will occur. If the delay is small, flanging occurs.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Chorus



Simple Delay/Echo Video tutorial
The Delay/Echo effect adds a delayed copy of the sound signal to the file. A single delay or decaying 
multiple delays can be added before or after the sound signal.

Dry Out (-Inf. to 0 dB)
Amount of unprocessed signal mixed into the output.
Delay Out (-Inf. to 0 dB)
Amount of delayed signal mixed into the output.
Multiple Echo (On/Off)
When Off, a single delayed copy is added to the file.
When On, multiple delayed copies are added by using feedback (delaying the delayed signal, and so 
on...), which creates a decaying echo effect.
Pre-Delay/Echo (ON/OFF)
When Off, the delayed copy is added after the sound, as heard in everyday life echoes.
When On, the delayed copy is added before the sound, as heard in the twilight zone.
Delay Time (0.0000 - 5.0000 Seconds)
Determines the time after or before which the delayed copy of the sound is added to the file. Also, if 
Multiple Echo is turned On, subsequent echoes occur at intervals specified by the Delay Time.
Decay Time (0.000 - 20.000 Seconds)
Determines the time it takes the multiple echoes to become nearly inaudible. Technically speaking, this 
is the time it takes an echo to decrease in amplitude by a factor of 30 dB.
If the Decay Time is less than the Delay Time, no echo will be created.

Tips
You can also use the Delay/Echo function to shift one channel of a stereo file backward or forward in time.
For example, if you have a file with music in the right channel and voice in the left, make a selection in 
only the left channel around the voice. Set the following parameters: Dry out level at 0%, Delay out 100%,
no Multiple delays/echoes, no Pre-delay/echo. You can then use the Delay time parameter to determine 
the time shift. If you want to shift the vocals backwards in time, check the Pre-delay check box.
To simulate a stereo sound from a mono file, copy the sound to both left and right channels of a stereo file
and then do a very small time delay of a single channel (Dry out level at 0%, Delay out level at 100%, no 
Multiple delays/echoes, no Pre-delay/echo). This simple technique often works in making the sound have 
a more realistic stereo image. When a sound wave comes from your side, your right and left ears receive 
sounds at different times, which is what this effect simulates.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Delay



Multi-Tap Delay Video tutorial
The Multi-Tap Delay effect is used to simulate multiple echoes, reverberation and other delay-related 
effects. It accomplishes this with multiple delay taps, pitch modulation, and filtering.

You can use up to eight independent delay taps. Each delay tap consists of a delay time and amplitude 
specification for a particular echo of the original sound. These are used to simulate the early reflection 
echoes which are the result of the first sound reflections in a room. Feedback, in combination with filtering
and modulation, is then used to simulate the thousands of other reflections that combine to form what we 
hear as reverberation.

Echogram
The Echogram represents the amplitude of sound reflections over time (impulse response) as 
determined by the current settings. Each vertical line represents an echo of the original sound. The 
length of each line corresponds to its amplitude (as a percentage of the original sound), while its 
horizontal distance from the left edge represents the time elapsed after the original sound. The red line 
is the currently selected tap, blue lines are the other active taps, and black lines are echoes resulting 
from feedback.
The Echogram can be used to get an estimate of the overall decay time. The right-most horizontal point
corresponds to a delay time equal to the graph resolution. This value can be changed between 500, 
1,000, 3,000, and 5,000 milliseconds.
Input Gain (-Inf. to 0 dB)
Gain applied to the signal before processing.
Dry Out (-Inf. to 0 dB)
Amount of unprocessed signal mixed into the output.
Wet Out (-Inf. to 0 dB)
Amount of processed signal mixed into the output.
Modulator Rate (0.1-10 Hz)
Frequency, in hertz, of the modulating signal. 0.1 Hz is slow while 10 Hz is very fast modulation.
Modulator Depth (0-100%)
Amount of frequency modulation applied to the reverberation. Zero signifies no modulation, and 100% 
is a large amount of modulation. Modulation is used to create a fuller sound or chorusing effects.
Feedback (0-150%)
Percentage of the processed signal which is fed back for re-processing and thus creating more echoes.
Large feedback values allow for longer decay times but can cause ringing.
Low-pass Start Frequency (100-10,000 Hz/ Off)
Cut-off frequency, in Hertz, of the low-pass filter (high frequency damping) used on the processed 
signal. Setting to Off means no low-pass filtering occurs. A high frequency setting (or Off) will result in 
live room reverberation, while lower settings will deaden the sound by simulating the high-frequency 
damping which many materials impart on sound.
Most building materials and air itself absorb more high frequencies then low frequencies, so using a 
low-pass filter is often necessary to prevent the reverberation from sounding too live.
Number of Taps (1-8)
Number of delay taps used to create the reverberation.
Current Tap (1-8)
Use to select the delay tap to be modified.
For each active tap there is a corresponding:

Delay (1-2500 ms)
Delay time of the tap. Since sound travels close to 1 foot per millisecond, you can simulate a given 
room size by setting delays to match reflections from all walls in the room. In a large room, sound 
must travel further to reach the reflection surfaces. Therefore, setting the echoes further apart 
creates a sense of being in a larger space. 
Gain (-100 to 100%)
Loudness level of the echo.



Pan (-100 to 100%)
Channel placement of the echo, with -100% being hard left and 100% being hard right. Panning 
echoes to different channels creates the illusion of reverberation coming from all directions in stereo 
files.

Graph Resolution (Delay ms) (500, 1000, 3000, 5000)
Determines the maximum time in milliseconds displayed on the graph.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Multi-tap delay



Distortion Video tutorial
The Distortion effect can simulate the overloading of an amplifier or mangle a waveform into submission.

Dry Out (-Inf. to 0 dB)
Amount of unprocessed signal mixed into the output.
Distorted Out (-Inf. to 40 dB)
Amount of distorted signal mixed into the output.
Threshold Level (-Inf. to 0 dB)
Signals above this level will be distorted.
Clamp level (-Inf. to 0 dB)
Signals over the Threshold level are set or clamped to this level. For normal limiting, set the Clamp 
level to be equal to the Threshold level. Setting this level anywhere else will make your speakers do 
things they've never done before.
Curvature (-Inf. to 0 dB)
Determines the curvature of the limiting above the Threshold level. Minus infinity corresponds to hard 
clipping (no curvature) while zero decibels corresponds to a very smooth curve, with little distortion.
Hard Clip for Maximum Speaker Thrashing (On/Off)
When On, signals over the Threshold level will be set to the Clamp level. When Off, signals over the 
Threshold level will be soft clipped according to the Curvature.

                                                         
See also
Effects Menu
Sound Processing and Other Tools



Graphic Dynamics Video tutorial
Compression, expansion, and limiting affect the dynamic range of the sound file by varying the gain as a 
function of the input sound level.

A compressor lowers the dynamic range of a signal by reducing the level of high volume signals and 
applying an overall gain to raise the level up again. Compression is often used in vocals and music to get 
even volume levels which often results in a smoother, fuller sound.

A limiter is a compressor with a greater ratio of dynamic range reduction. Limiters are used in 
broadcasting for making sure that the volume level does not go over a certain threshold which overdrives 
electrical equipment. Limiters are also used by guitarists to create a distorted, sustaining tone.

An expander increases the dynamic range of a signal by decreasing the level of low volume signals. 
Expanders are commonly used for noise reduction or for emphasizing the dynamics of a piece.

Dynamics Input/Output Graph
This graph maps each possible input level to an output level. The No Gain diagonal line shows where 
the input and output are equal. When the envelope is below the No Gain line, signals of the 
corresponding input level are attenuated (gain is less than 0). On the other hand, when the envelope is 
above the No Gain line, the signal is boosted (gain is greater than 0).
With this in mind, it is possible to draw graphs to generate compression, limiting, noise gating, and 
expansion effects by moving the envelope points manually or by using the Threshold and Ratio 
controls. 
Output Gain (-25 to 25 dB)
The gain applied to the signal after processing. If Auto Gain compensate is turned on, the output gain is
still applied afterwards.
Reset Graph
Press this to reset all envelope points.
Sync Stereo Gain (On/Off)
When on, the gain of the left and right channel will always be the same. This prevents a loss of stereo 
imaging that can occur if both channels where to be processed independently.
Auto Gain Compensate (On/Off)
When on, a gain is applied during processing to try to keep the maximum input and output levels 
constant. In general, this gain will be equal to the highest envelope point in the graph. You can still use 
the Output gain control to fine tune the overall gain.
Attack Time (0 to 500 ms)
Time, in milliseconds, required for the gain to change from a pre-threshold level to a post-threshold 
level.
Release Time (0 to 2,000 ms)
Time, in milliseconds, required for the gain to change from a post-threshold level to a pre-threshold 
level.
Threshold (-80 to -0.1 dB)
Signal level which differentiates the Attack and Release modes. In a simple compressor or gate, the 
threshold is the level at which the gain begins to deviate from 1.
When changing the threshold, all points slide diagonal up and down the No Gain line.
Ratio (1.0:1 to Inf.:1)
Ratio of input to output levels above the Threshold. This Ratio determines how much a signal above the
Threshold will be boosted or faded as a function of its level.
When changing the Ratio, all points above the Threshold move closer or further away from the No Gain
line.

For best results, very low frequencies (below 20 Hz) present in a sound file should be
removed before applying the Graphic or Multi-Band Dynamics functions. This makes it

easier to monitor audible frequencies while compressing.



                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Compression and Limiting
Using Expansion



Multi-Band Dynamics Video tutorial
The Multi-Band Dynamics dialog allows you to apply compression and limiting to up to four different 
frequency bands. Band limiting is used to keep a set of frequencies from being too loud. The most 
common use for band limiting is the de-esser. In this case, the frequencies associated with sibilant 
sounds (S's) are limited to a set level, without affecting other frequencies.

Because there are so many different parameters available, getting the best results requires a bit of 
experimentation. For most situations, you will only need to use a single band. Each band can either be a 
low-shelf, band-notch, or high-shelf. After you've selected the frequency range that will be affected, you 
must set a compression Amount. A value less than 10:1 is considered compression while greater values 
will create harsher limiting.

The Threshold level determines at what point will compression begin. You can find your required 
Threshold level by first setting it a high level (such as -6 dB) and slowly lowering it while previewing until 
you can hear the band-limiting effect.

You can also get an estimate of the Threshold level necessary by first selecting the portion of sound 
which contains the offending frequencies, bring up the dialog, and after selecting the frequency range 
pressing the Get Threshold button. The Threshold setting will change to 6 dB below the detected peak of 
the current frequency band. You'll probably need to then lower it slightly to increase the effect.

To reset all bands, right-click anywhere on the dialog and select Reset All. This can be
used in most function dialogs.

Graph
The Multi-Band Dynamics Graph gives you an idea of where the active bands are located in the 
frequency spectrum and the relative threshold and amount levels. The horizontal lines indicate the 
threshold settings of the active bands, the current band being red. The amount of compression is 
indicated by how far down the dark gray curve goes down. Therefore, the amount of dark gray is 
representative of the amount of gain reduction that can occur.

It is recommended that the bands not overlap. When the bands overlap the results are
not easily visualized.

Output Gain (- 25 to 25 dB)
The gain applied to the signal after processing.
Sync Stereo Channels (On/Off)
When on, the gain of the left and right channel will always be the same. This prevents a loss of stereo 
imaging that can occur if both channels where to be processed independently.
Number of bands (1 to 4)
Determines the number of active, independent bands. For most cases, only a single band is necessary.
Current band (1 to number of bands)
Since each band has an independent mode, threshold, amount, attack and release times, you must use
this control to switch between all active bands.

Threshold (-Inf. to 0 dB)
When a frequency band level is above the threshold, it will be compressed. A lower threshold will 
cause more of the signal to be compressed. If the threshold is too low, to much of the sound data will
be filtered. If its too high, not enough processing will occur.
Get Threshold
When you press this button, the current selection is analyzed to get an estimate of the necessary 
threshold. After analyzing, the Threshold will be set to 6 dB below the peak level found for the 
current band.
Amount (1:1 to 50:1)
Compression ratio applied to a band when it is above the threshold level. A high compression ratio 
means more gain reduction will be applied.



Attack Time (0 to 500 ms)
Time, in milliseconds, required for the gain to change from a pre-threshold level to a post-threshold 
level.
Release Time (0 to 2,000 ms)
Time, in milliseconds, required for the gain to change from a post-threshold level to a pre-threshold 
level.
Type
Determines the frequency band type.

Low-shelf
Frequencies below the cut-off frequency will be compressed.
Band-notch
Frequencies surrounding the center frequency will be compressed.
High-shelf
Frequencies above the cut-off frequency will be compressed.

Gain (-25 to 25 dB)
Gain applied to a band after it has been compressed. This is used for compensating for the gain lost 
from the compression.
Width (0.3 to 3.0 octaves)
Determines the frequency range which will be compressed when using Band-notch mode.
Frequency (Below, Center, Above) (50 to 15,000 Hz)
If the band mode is a low- or high-shelf, this parameter determines the cut-off frequency for which 
the filter starts processing. Otherwise, it is the center frequency of the band.

                                                      
See also
Effects Menu
Sound Processing and Other Tools
Using Compression and Limiting
Using Expansion



Envelope Video tutorial
With the Envelope effect, the amplitude envelope of a waveform can be forced to match a specified 
envelope shape. Unlike the Graphic Fade, which simply fades a waveform by a specific amount over 
time, the gain at each point is dynamically calculated to achieve the exact specified envelope.

Envelope Graph (2 to 16 points, 0 to 100%)
Specifies the amplitude envelope over time. Click the left mouse button to define a point and drag to 
change its position. Click the right mouse button over an existing point to remove the point. You can 
create up to 16 envelope points.
Reset Envelope 
Press this button to reset the graph to a simple ADSR (Attack, Decay, Sustain, Release) curve. 
Smooth Gain (On/Off)
to Minimize Distortion on Steep Slopes
When on, prevents the gain from changing too fast, which might result in unwanted distortion. Also, 
when this option is on the gain will always begin at 0%.
Show Wave
Select this check box to draw the waveform of the current selection on the envelope graph. This is done
automatically if the selection is small. For stereo files, you also have the option of displaying the left, 
right, or a mix of the two channels.

                                                         
See also
Effects Menu
Sound Processing and Other Tools



Flange/Wah-Wah Video tutorial
Flange
The flanging effect is heard in many 60s and 70s recordings. It is the result of mixing a modulated delay 
signal with the original signal to create a sweeping sound much like an airplane taking off.

Phaser
A phase is similar to a flange, except that instead of using a simple delay, frequencies are phase-shifted 
over time. When used on stereo files, strange effects on the stereo image are created.

Wah-Wah
The wah-wah effect was popularized by many a rock/blues guitarists favorite toy, the wah-wah pedal. It 
consists of a band-pass filter which attenuates low and high frequencies in varying amounts over time.

Dry Out (-Inf. to 12 dB)
Amount of unprocessed signal mixed into the output. A negative percentage means that the signal is 
also inverted.
Wet Out (-Inf. to 12 dB)
Amount of processed signal mixed into the output. A negative percentage means that the signal is also 
inverted.
Rate (0.1 to 20 Hz)
Frequency, in Hertz, of the modulating signal, which determines the period of the flange. Low 
frequencies create a slow, sweeping flange while higher frequencies create fast flanging.
Depth (1 to 100%)
In the Flange, this determines the amount of frequency modulation applied to the signal.
In the Phaser, this determines the range of frequencies which experience phase shifting.
In the Wah-Wah, this determines the sweep range of the band-pass filter.
Center Frequency (100 to 5,000 Hz)
Frequency around which the sweep of the Phaser and Wah-Wah is centered.
Resonance (1 to 100%)
Amount of band-pass filtering (in Wah-Wah) or phase shifting (in Phaser) which takes place. When the 
resonance is high, the range of frequencies processed is smaller, yet more pronounced.

Flange, Phaser, and Wah-Wah are best heard with long, sustaining sounds so that the
entire sweep can be heard.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
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Gapper/Snipper Video tutorial
The Gapper/Snipper cuts chunks from the sample or inserts silence in the sample periodically at a set 
frequency to create unusual (if not useful) effects.

Insert/Cut
In Cut mode, chunks are removed from the sample. In Insert mode, chunks of silence are inserted into 
the sample.
Frequency (0.1-1,000 Hz)
Times per second a chunk is inserted or cut from the sample.
Size (1-1,000 ms)
Size of the chunk to be inserted or cut.
Fade (0-50%)
Percentage of the chunk not cut or between inserts that is faded in and out. Zero percent corresponds 
to no fade, while 50% is maximum fade. Use fading to prevent glitches.

Tips 
This process changes the size of the original file. Be aware of the final size indicated, since it is easy to 
set the parameters to create a very large output.

                                                         
See also
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Sound Processing and Other Tools



Noise Gate Video tutorial
A noise gate removes signals below a set threshold. It is used to remove noise from silent breaks in a 
sample.

Threshold (0 to -40 dB)
Signals below this level will be removed from the sample. Zero dB is a very high level, while -70 dB is 
very low. Noise levels are usually around -40 dB, but will vary widely. To get an estimate of the noise 
level, select a region of silence (which also contains noise) and run the Statistics tool. The maximum 
value (positive or negative) shown is a good estimate of the threshold noise level required. For 
example, if the maximum positive value is -40 dB (1.0%) and the maximum negative value is -36 dB (-
1.5%), use a number a bit higher than -36 dB (maybe -32 dB) as the noise threshold level.
Attack Time (1-500 ms)
Time it takes the gain of the gate to change from zero to one once the level rises above the threshold. 
The attack time is best kept to a minimum if percussive attacks are to be preserved. Higher attack times
make sounds slowly swell up in volume.
Release Time (1-2000 ms)
Time it takes the gain of the gate to change from one to zero once the level falls below the threshold. 
The release time is usually kept high to allow for natural sounding decays, otherwise long decays will 
be cut off.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Noise Gate



Pitch Bend Video tutorial
Pitch Bend is used to draw an envelope which corresponds to increasing or decreasing the pitch of a 
sample over time.

Pitch Bend
Pitch Bend is used to draw an envelope which corresponds to increasing or decreasing the pitch of a 
sound file over time.
Envelope (2 to 16 points, -Range to +Range)
Specifies Pitch Bend over time. The vertical axis represents pitch change, with zero being no change. 
The horizontal axis represents the length of the selected region.
Click the left mouse button to define a point and drag to change its position. Click the right mouse 
button over an existing point to remove the point. You can create up to 16 envelope points.
Reset Envelope 
This button removes all points except the outermost two.
Range (-24 to 24 Semitones)
Maximum and minimum pitch change in Semitones (half-steps). Example: A range of twelve half-steps 
(one octave) allows an increase or decrease of the pitch by an octave.
Show Wave
Select this check box to draw the waveform of the current selection on the envelope graph. This is done
automatically if the selection is small. For stereo files, you also have the option of displaying the left, 
right, or a mix of the two channels.

Pitch Bend is accomplished in the same manner as changing the playback speed on a
tape deck. Therefore, the length of the file will be changed.

                                                         
See also
Effects Menu
Sound Processing and Other Tools



Pitch Shift Video tutorial
This effect changes the pitch of a sample with or without preserving the duration of the sample.

Semitones To Shift Pitch By (-50 to 50)
Number of semitones (half-steps) to raise or lower the pitch. When using Preserve duration, the range 
is limited to -12 to 12 semitones.
Cents To Shift Pitch By (-100.0 to 100.0)
Fine tune above and below a semitone. One hundred cents is equal to one semitone.
Apply An Anti-alias Filter During Pitch Shift (On/Off)
Changing the pitch of a file requires a form of resampling. When shifting by large amounts, an anti-alias
filter will minimize distortions due to aliasing.
Preserve Duration (On/Off)
If on, the sound file length will remain the same; otherwise, the length of the selection will change by 
1/transposition ratio. 
Mode
The Mode determines what algorithm is used to do the pitch shifting. There are three different 
algorithms, A, B, and C, each with different modes tuned for different sound material. It is best to 
experiment with different modes since the names for these modes are only suggestions.
Blend Edges with Adjoining Data (On/Off)
When this option is turned on, the beginning and end of the selections will be crossfaded with the 
original sound data. This is used to minimize glitching.
Transposition Ratio
Fraction by which all frequencies will be multiplied. If the Preserve duration check box is off, the length 
of the file will be multiplied by 1/transposition ratio.

Pitch change without preserving duration is accomplished in the same manner as changing the playback 
speed on a tape deck. Therefore, the length of the file will be changed. A pitch change can be used to 
accurately change the time duration of a selection if the change in pitch is not audible or important. This is
useful if a very small change in time duration is necessary, for example, to correct for playback/record 
speed discrepancies on a tape deck.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
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Reverb Video tutorial
Reverb is an effect to simulate various acoustic spaces. It consists of early reflections, which are the first 
reflections that arrive back to your ear, and the reverb itself.

Reverberation Mode
The Reverberation mode affects the quality of the reverberation tail. Each mode has slightly a different 
frequency response, ringiness, echo density, and delay time to simulate different environments.
Dry Out (-Inf. to 0 dB)
Amount of unprocessed signal mixed into the output.
Reverb Out (-Inf. to 0 dB)
Amount of processed reverberated signal mixed into the output.
Early Out (-Inf. to 0 dB)
Amount of processed early reflections mixed into the output.
Early Reflections Style
The Early reflections style affects the first few echoes heard immediately following the dry source and 
have a strong influence on the size of the perceived space.
Decay Time (0.5 to 5.0 seconds)
This is the time it takes for the reverb to decrease in level by 60 dB. Or, in other words, this is how long 
your reverb will last.
Pre-delay (Off to 200 ms)
This is the time it takes from the initial sound until the onset of reverb. This setting helps control the 
perceived size of the room. A longer Pre-delay time will imply a larger room.
Attenuate Bass Frequencies Below (10 to 500 Hz)
Use this option to remove low frequencies in the reverberation. Too much low bass in a reverb will 
result in a muddy sound.
Attenuate High Frequencies Above (500 to 15,000 Hz)
Selecting high frequencies filters the reverb above the set frequency. This setting has a lot to do with 
the perceived liveliness of the room. In a very lively room, high frequencies are not attenuated when 
they bounce off of the walls. 

Any generated reverberation will not extend the sound file. To ensure that the
reverberation tail does not get truncated at the end of the sound file, there should be

enough silence following the last sound. You can extend the file by using Insert Silence
(Process menu) at the end of the file before applying Reverb.
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Vibrato Video tutorial
Vibrato is the periodic pitch modulation often used by vocalists and instrumentalists. Very fast pitch 
modulation creates wacky FM effects unlike any vibrato.

Modulation Rate (0.1 to 1,000 Hz)
Frequency, in Hertz, of the modulating signal. Determines the period of the vibrato. 
Low frequencies (0.1 to 2 Hz) create a slow vibrato while higher frequencies (2 Hz to 15 Hz) create fast 
pitch bends. Even higher frequencies (15 Hz and up) modulate the selection so fast that instead of 
hearing pitch changes, new sideband frequencies are heard. 
Modulation Depth (0.1 to 100.0%)
Amount of pitch change applied to the selection.
Trim the End if a Change of Duration Occurs (On/Off)
When on, if the output selection length is shorter than the input length, the selection end is trimmed. 
This is used to prevent glitches when using a slow vibrato inside a selection.
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Auto Region Video tutorial
The Auto Region function automatically creates regions in a sound file for the Regions List and Playlist. 
These regions are defined according to fast sound attacks (like drum beats or words) or a selected 
musical time interval.

Attack Sensitivity (1 to 100%)
Determines how sensitive the attack-detection algorithm is to fast increases in volume. With a high 
setting, regions are created when the sound level increases by very small amounts and more regions 
are created. With a low setting, the sound level must increase by a large amount before a new region is
created and fewer regions are created.
Release Sensitivity (0.1 to 100.0%)
Determines the minimum decrease in sound level which must occur before a region end is created. 
High values indicate that the sound level does not have to decrease very much before a region end is 
created, and therefore more regions will be found. When set low, the sound level must decrease to a 
greater extent before a region end is found. A low setting is useful if you only want a region to be 
created after very silent breaks.
Minimum Level (0.1 to 100.0%)
Threshold sound level which must be found before a new region is created. With a high setting, only 
high-level sounds will trigger the creation of a new region. This is useful if you want only the loud 
instrument attacks in a song (like the bass drum) to be at the beginning of a region, since they often 
correspond to the beginning of a measure or beat. Low threshold settings will also allow low-level 
sound attacks to create new regions.
Minimum Beat Duration (.01 to 3.00 Seconds)
Specifies the minimum length in seconds that must elapse before a new region can be created. A low 
setting will allow very short regions to be created if sound attacks occur in fast succession. This is 
useful for fast tempo music. A higher setting will prevent quick sound attacks from being separated into 
different regions.
Use Release Point for End of Region (On/Off)
When on, a region will end when the sound level drops by a factor determined by the Release 
sensitivity. This is useful if you don't want the silence in between sounds or phrases to be included in 
the regions.
When off, region ends are only created when attacks are detected.
Build Regions Using the Current Tempo (On/Off)
When on, regions are created according to the current Beats per minute (see Edit Tempo function 
under the Special menu to change this value) Otherwise, regions are created by using an algorithm that
finds sound level changes to determine where a sound attack or release occurs.
Measures, Beats (0 to 100)
Determines the musical time interval between regions according to the specified number of beats in a 
measure. For example, if you want a region to be created at every beat, set Beats to 1 and Measures to
0. To have a region created at every measure, set Measures to 1 and Beats to 0. If you wanted to have 
a section at every 7 beats, you could set Beats to 7 and Measures to 0, or set Beats to 3 and Measures
to 1, if you have defined a measure to be 4 beats. You can set the number of beats per measure using 
the Edit Tempo command.

When using the attack-detection algorithm, more beats will be detected if you raise the
Attack sensitivity, raise the Release sensitivity, lower the Minimum level, or lower the

Minimum beat duration. The opposite is true for detecting fewer beats.

                                                         
See also
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Crossfade Loop Video tutorial
The Crossfade Loop function is designed to help create loops in material that otherwise might not be 
loopable. It does so by mixing sound occurring before the loop start point into the end of the loop. This 
can make the transition from the end to the beginning of the loop much smoother.
You may also wish to crossfade the region following the loop (Crossfade Post-Loop) with the beginning 
of the loop to make the transition from looping to playing the post loop smoother. Often times this is 
done to compensate for a crossfade inside the loop.

Tip: Although it depends on your application and personal preferences, most musicians
agree that the Crossfade Loop function is a last resort. It is suggested that the Loop

Tuner be used before applying the Crossfade Loop function to get the loop ends to match
as well as possible.

Graph
The Crossfade Loop graph shows you where in the selection the crossfade will occur. The three areas 
(from left to right) which represent sound before, inside, and following the loop points, are shown with 
different sloped lines. For example, when doing a Sustaining loop crossfade with no Post-Loop, you can
see the loop data fade out as data from the Pre-Loop is mixed in to form a crossfade.
Loop to Crossfade
Selects the sample loop that will be affected by the crossfade. Most samples only have one loop which 
is the Sustaining loop. If a sample contains two loops, the second loop is called the Release loop.
Loop (1 to 100 %)
Determines how much of the selected sample loop will be crossfaded. When checked, the end of the 
sample loop is crossfaded with the end of the region before the loop start. This is used for making the 
end of the loop blend smoothly with the beginning of the loop.
Post-Loop (1 to 100 %)
When checked, the region following the loop end is crossfaded with the beginning of the sample loop. 
This is used for making the transition from the end of the loop to the rest of the sample following the 
loop smoother (i.e. when done looping and playback continues).
Post-Loop crossfading is only necessary if the sampler is every going to play beyond the loop points.
Preview Mode
These modes determine how the Preview button will work.

Loop the Loop
Plays the loop area only.
Play Loop through Post-Loop
Plays the loop once and then the Post-Loop.
Play as One Shot
Plays from the beginning of the file and uses the loop settings to determine how many times to loop 
each loop.
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Statistics Video tutorial
This tool displays statistical information about the selected sound file region.

Cursor Position 
This indicates the cursor position in samples from the start of the sound file.
Sample Value at Cursor
This value represents the instantaneous amplitude at this position.

For 16-bit sound files, the range of values is -32,768 to 32,767. For 8-bit sound files, the
range of values is -128 to 127.

Maximum/Minimum Position and Sample Value
Maximum and minimum sample values and the location, in samples, where they occur. 
This is useful for determining if any clipping occurs in the sound file. It can also be used to determine 
the noise level of a signal for use on the Noise Gate effect. For example, to find the noise amplitude, 
run the Statistics function on a region of noisy silence.
RMS Power
Root Mean Square of the sample values relative to the RMS value of a maximum-amplitude square 
wave (the loudest possible recording). 
When used on short intervals relates to the volume level of the sound file. However, if used on a large 
selection with large volume variation, this value becomes less meaningful. For another way to measure 
loudness, use the Scan Levels button in the Normalize dialog.
The calculation used in Sound Forge 4.0 is slightly different than in Sound Forge 3.0. The value of 0 dB 
corresponds to a maximum amplitude square, not sine wave. A maximum value sine wave will read at -
3.0 dB.
Average Value (DC Offset)
This is a sum of all of the sample values in the selected region divided by the number of samples. If 
non-zero, this usually indicates that there is a DC offset in the recording process.
Zero Crossings
Times per second that the waveform changes from a negative value to a positive value. This value can 
be used as a rough estimate of the frequency of the sound data for very simple waveforms.
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DTMF Tones Synthesis Video tutorial
Use this to generate the standard dial tones used by the telephone companies.

Dial String
Use this to enter the phone number to be generated along with any necessary pause characters. 
Unknown characters will be ignored.
Amplitude (-Inf. to 0 dB)
Peak level of the waveform.
Tone Style to Generate

DTMF 
Dual Tone Multi-Frequency signals are used by the standard push-button phones. It uses 
combinations of 679, 770, 852, 941, 1209, 1336, 1477, and 1633 Hz sine waves.
MF 
CCITT R1 signals are used internally by the telephone networks. They are generated by a 
combination of 700, 900, 1100, 1300, 1500, and 1700 Hz sine waves.

Single Tone Length (0.001 to 2 seconds)
Output length of individual tones.
Break Length (0.001 to 2 seconds)
Length of the silence between tones.
Pause Length (0.001 to 5 seconds)
Length of silence to insert when the pause character is found.
Fade The Edges of Each Tone
When on, the tones are faded in and out a few milliseconds to prevent glitching.
Pause Character
Character which when present in the dial string will cause a pause between successive tones.
Insert New Tone Sequence At (Cursor, Start of file, End of file,)
Point where the generated waveform will be placed within the existing sound file.
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FM Synthesis Video tutorial
FM Synthesis uses frequency modulation (FM) to create complex sounds from simple waveforms. 
Frequency modulation is the varying of the frequency of a waveform (the carrier) as a function of the 
output amplitude of another waveform (the modulator). If the frequency of the modulator is low, the 
carrier will be slowly detuned over time. However, if the frequency of the modulator is high, the carrier 
will be modulated so fast that many additional frequencies, or sidebands, are created.
In Sound Forge, up to four waveforms (operators) can be used in a variety of configurations. Depending
on the configuration, an operator can be a carrier, a modulator, or a simple, unmodulated waveform. 
Total Output Waveform Length (0.001 to 60.000 seconds)
Output length of the generated waveform.
Current Operator (1 to Number of Operators)
Determines the active operator being modified.
Envelope Graph
Amplitude envelope of the active operator over time. Click the left mouse button to define a point and 
drag to change its position. Click the right mouse button over an existing point to remove the point. You 
can create up to 8 envelope points for each operator.
Reset 
The Reset envelope button removes all points except the outermost two.
Amplitude (-Inf. to 0 dB)
Output gain of operator after amplitude envelope. If the operator is a modulator, this control, along with 
the envelope, determines the amount of frequency modulation applied to the carrier. If the amplitude of 
a modulator is high, very harsh sounds can result.
Operator Shape (Sine, Square, Saw, Triangle, Noise, Absolute Sine)
Shape of a single period of the waveform.
Frequency (0.01 to Sampling Rate/2)
Frequency of the waveform. This parameter does not affect the noise waveform.
If the frequency is set to 0.00, a DC (zero frequency) waveform is produced regardless of the waveform
specified.
When using Noise, the frequency determines the high frequency content of the noise. For full 
bandwidth (white) noise, set the frequency to its highest possible settings.
Feedback (0 to 100%)
Amount of the output of the operator which is used to modulate itself. If the operator is also being 
modulated by another waveform, the feedback path and the modulator output are mixed together to 
modulate the carrier.
Insert Waveform At (Cursor, Start of file, End of file)
Point where the generated waveform will be placed within the existing sound file.
Configuration Figure
Determines the arrangement and number of operators to be used.
The output of operators joined horizontally are simply mixed together. The output of the bottom 
operators are mixed together to form the final output. Mixing together different simple waveforms is 
called additive synthesis.
Two operators joined vertically are FM carrier-modulator pairs. Operators which have another operator 
stacked above them are carriers, with the operator directly above being the modulator. 
Operators which have no other operator directly above are simple waveform generators.
When three or more operators are stacked, this means that the highest operator modulates the 
operator below it, which then in turn modulates the following operator below, and so on.

Start out with the simplest, single operator configuration and try out all the waveforms at different 
frequencies, with the feedback factor set at zero. Experiment using feedback on each waveform to hear 
the different effects of self-modulation. Move to the next configuration, with two unmodulated operators 
mixed together (horizontal connection) to hear two operators simultaneously (additive synthesis).



Change the configuration to two stacked operators (vertical connection) and again experiment using 
different waveforms and frequencies on the carrier (bottom operator) and the modulator (top operator). 
With the modulator frequency set low (1 to 5 Hz), lower the modulator amplitude to create slight detuning. 
Raising it creates big pitch bends.

If the modulator frequency is set high, many unusual sounds can be achieved.

Setting the modulator frequency to 0.00 (DC) allows for direct control of the carrier's pitch by using the 
modulator's amplitude envelope.

Adding more operators increases the complexity of the waveform. Both FM and additive synthesis can be 
combined to generate an endless variety of sounds.

                                                         
See also
Tools Menu
Sound Processing and Other Tools
Using Synthesis
MIDI Notes and Frequencies



Simple Synthesis Video tutorial
Simple Synthesis can be used to generate a simple waveform of a given shape, pitch, and length.

Amplitude (-Inf. to 0 dB)
Peak level of the waveform to be generated. When generating Noise, the amplitude is affected by the 
cutoff frequency selected.
Waveform Shape (Sine, Square, Saw, Triangle, Noise, Absolute Sine)
Shape of a single period of the waveform.
Length (0.001 to 60.0 seconds)
Output length of the generated waveform.
Frequency (0.01 Hz to Sampling Rate/2)
Frequency of the waveform.
When creating noise, the frequency specifies the low-pass cut-off frequency. For white noise, the 
frequency must be set to its maximum available setting.
Note that aliasing occurs with many of these waveforms when using high frequencies because they are 
not band-limited.
Insert New Waveform At (Cursor, Start of file, End of file)
Point where the generated waveform will be placed within the existing sound file.

                                                         
See also
Tools Menu
Sound Processing and Other Tools
Using Synthesis
MIDI Notes and Frequencies



Find Video tutorial
The Find tool searches for clicks and pops, volume levels, or silence breaks in a sound signal. 

Glitch
Clicks and pops are unwanted sounds often found in vinyl recordings or from bad splice-editing, and are 
seen as sharp glitches in the normal curve of a waveform.

The Glitch search algorithm looks at a waveform, starting at the cursor position, moving forward in time, 
and determines when a glitch occurs depending on the threshold and sensitivity settings. Then, the cursor
position is moved to the detected glitch to allow for further editing. In Pencil Tool mode (Edit menu), you 
can draw a smooth curve over the glitch to remove it.

Threshold Slope (-60 to 0 dB)
Minimum slope (steepness) of the glitch. A high setting will only detect glitches with a high slope, while 
a low setting will detect both low and high-sloped glitches.
Sensitivity (0 to 100)
With a high setting, the glitch finder will detect as a glitch any part of the waveform with a slope above 
the Threshold slope. 
A lower setting forces the Glitch finder to further verify that the high-sloped waveform is in fact a glitch 
and not part of the original, smooth waveform.

If no glitches are detected, but you can hear clicks or pops, try lowering the Threshold slope and/or 
raising the Sensitivity.

If the Glitch search algorithm is falsely detecting glitches, lower the Sensitivity and/or raise the Threshold 
slope.

To find the next glitch, you can use the Control+Y shortcut key to repeat the last operation.

Level Equal To or Above
Use this to find the next point in time after the cursor position when the waveform reaches a particular 
level.

Threshold Level (-96 to -6 dB)
Determines the sound level to search for.

End of Silent Region
Use this to move the cursor to the end of the next silence break.

Threshold Level (-96 to -10 dB)
Determines the silence sound level. The Silence search will move the cursor to the next position where 
the level goes below and then back above the silence threshold level. 

Largest Peak
Use this to move the cursor to the next largest peak amplitude.

Searches progress from the current cursor position forward, not the entire file. To find the
largest peak in the entire file, set the cursor to the beginning of the sound file or select all

before processing.

                                                         
See also
Tools Menu
Sound Processing and Other Tools



Sampler Video tutorial
The Sampler dialog (Tools menu) allows you to send and receive data to and from a sampler. To set up 
sampler/computer communications, press the Configure button.

Configuration
This drop-down list contains Preset Sampler setups (saved in the Sampler Configuration dialog). Once 
you save different configurations, the settings can be conveniently selected from this list.
Logical send/receive sample number (0 - 16,383)
This is the number your sampler uses as its location reference for samples sent or received. This 
number can be biased for specific samplers with the Sampler Bias option in the Sampler Configuration 
dialog.
Actual send sample number
This text field contains the actual sample number to be used by your sampler to store the sample. This 
number is based on the Logical sample number combined with the Sample Bias for sending, set in the 
Sampler Configuration dialog.
Actual receive sample number
This text field contains the actual sample number to be retrieved from your sampler into the current data
window. This number is based on the Logical sample number combined with the Sample Bias for 
receiving set in the Sampler Configuration dialog.
Send Sample
Press this button to begin transmitting the active Data Window's sample to the sampler.
Get Sample
Press this button to begin receiving a sample from the sampler. A new window is created prior to 
reading the data from the sampler.
Configure
Opens the Sampler Configuration dialog where you can determine the settings for communications with
your samplers.

Sampler Configuration Dialog
The Sampler Configuration dialog is used to create and save sampler communications configurations.

Name
The name of the sampler configuration that is saved as a Preset.
Send to
Lists supported samplers and methods of communication for sending samples. If your sampler is not 
listed here, try Generic MIDI/SDS or Generic SCSI/SMDI.

MIDI output (MIDI/SDS)
Select the MIDI interface connected to the input of the sampler to which you wish to send 
samples.
MIDI input (MIDI/SDS)
Select the MIDI interface connected to the output of the sampler to which you wish to send 
samples.
SCSI Host (SCSI/SMDI)
Select the SCSI card used to send data between the computer and sampler.
SCSI Sampler (SCSI/SMDI)
Select the SCSI compatible sampler which will receive the data.
Sample Bias (-16,383 - 16,383)
This is a numbering offset that allows you to add or subtract a value to the Logical sample 
number to compensate for differing sampler storage schemes. It is often easiest to set the 
Sample Bias so a Logical sample number of zero corresponds to the first available sample 
storage number in your sampler.
MIDI Channel (MIDI/SDS) (1-16)
The MIDI channel the sample data will be sent on when using SDS.



Wait for request (MIDI/SDS)
Selecting this option tells the Sampler Tool to wait for a request (handshake) from the sampler 
before beginning an SDS sample transfer.
Open loop (MIDI/SDS)
Selecting this option will cause the Sampler Tool to send SDS sample data immediately upon 
clicking the Send Sample button. This is an unconditional transfer of sample data (no 
handshake). When using Open Loop for send, the sampler's MIDI Out does not have to be 
connected to your computer's MIDI In. However, open loop decreases sample dump 
performance..

Receive from
Lists supported samplers and methods of communication for receiving samples. If your sampler is not 
listed here, try Generic MIDI/SDS or Generic SCSI/SMDI.

MIDI output (MIDI/SDS)
Select the MIDI interface connected to the input of the sampler from which you wish to receive 
samples.
MIDI input (MIDI/SDS)
Select the MIDI interface connected to the output of the sampler from which you wish to receive 
samples.
SCSI Host (SCSI/SMDI)
Select the SCSI card used to receive data from your sampler.
SCSI Sampler (SCSI/SMDI)
Select the SCSI compatible sampler which will send the data.
Sample Bias (-16,383 - 16,383)
This is a numbering offset that allows you to add or subtract a value to the Logical sample 
number to compensate for differing sampler storage schemes. It is often easiest to set the 
Sample Bias so a Logical sample number of zero corresponds to the first available sample 
storage number in your sampler.
MIDI Channel (MIDI/SDS) (1-16)
Select the MIDI channel on which the sample data will be received when using SDS.
Send request (MIDI/SDS)
Selecting this option tells the Sampler Tool to send a request to your sampler asking for a sample 
when you press the Get Sample button. If you turn this option off, you will always have to initiate 
transfers to the Sampler Tool from your sampler after pressing the Get Sample button. In other 
words, you will have to press a button on your sampler to start the actual transfer.
Open loop (MIDI/SDS)
Selecting this option will cause the Sampler Tool to wait for sample data after pressing the Get 
Sample button. You must initiate all sample transfers from your sampler. This is an unconditional 
transfer of sample data (no handshake). When using Open Loop for receive, the sampler's MIDI 
In does not have to be connected to your computer's MIDI Out. However, open loop decreases 
sample dump performance.

                                                         
See also
Tools Menu
Using the Sampler Tool
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Sound File Formats
The file formats recognized by Sound Forge are listed below along with the extension used to identify 
them to the user. An arbitrary extension has been assigned for each of the formats used by computers 
other than the PC. Many of these formats when found on another type of computer will tend to use the 
extension .SND. Thus, even if a file has the .SND extension it may not be a Sounder/ SoundTool file. 
Ad Lib Sample (.SMP)
This format is used by the Ad Lib Gold card, for its sampled instruments. It supports, 8-/16- bit, 
stereo/mono, and 4-bit Yamaha ADPCM compression.
Amiga SVX File (.SVX/.IFF)
This file type is found on the Commodore Amiga and is similar in substance to the Microsoft .RIFF Wave 
format.
Covox 8-Bit File (.V8)
This format is used with Covox software. It is an 8-bit mono uncompressed file format.
Creative Labs VOC File (.VOC)
This is one of the more commonly found sample sound formats found on PC-compatible computers. 
The .VOC format supports packed data which Sound Forge will unpack prior to importing the file. 
The .VOC format also supports information for silence, looping, and varying sample rates. When Sound 
Forge imports a .VOC file it uses the first sample rate found and ignores such information as looping and 
silence. Sound Forge will save .VOC files as unpacked data with none of the additional information such 
as looping or silence. Sound Forge gives you the ability to save .VOC files in either the old or new .VOC 
standard. The new .VOC standard supports 16-bit data. Refer to the Preferences section in the Reference
chapter for information on configuring Sound Forge to always use the new .VOC standard.
Dialogic VOX File (.VOX)
This format is used with specialized voice data boards. It is a 4-bit mono ADPCM file format which 
expands to 16-bit data.

 Indicates this file format supports the saving of sample looping information.
Gravis Patch File    (.PAT)
This format is used by the Gravis UltraSound Card. Sound Forge can only read and write Gravis Patch 
files which have single samples stored in them. Patch files with multiple samples are not recognized. 
Sound Forge recognizes Gravis Patch files which are of version 1.10. Older versions, such as 1.00, are 
not supported.
Intervoice (.IVC)
This file format is for use with Intervoice telephony systems. It is a mono format with a variety of 
compression schemes available.
Macintosh AIFF    (.AIF/ .SND)
This format is used on the Apple Macintosh to save sound data files. An .AIFF file is best when 
transferring files between the PC and the Mac using a network, since most network software will delete 
any resource information in a Macintosh file. Sound Forge can also read an .AIFF with a Mac binary 
header attached but will identify the file as a Macintosh Resource instead.
Macintosh Resource (.SND)
This format is used on the Apple Macintosh to save sound resources. When reading a file of this type it 
must have a Mac-Binary header. This header is attached to binary files transferred with common 
Macintosh file transfer programs. Sound Forge does not save to this file format.
MIDI SDS File    (.SDS)
This format is a file which contains the exact data that would be transferred to a sampler when using the 
MIDI Sample Dump Standard (SDS) protocol. It is a series of MIDI SysEx messages. MIDI SDS supports 
mono files only.
NeXT / Sun (Java) File (.AU/.SND)
This is the standard format of sound files found on the NeXT and Sun Sparc station computers. This 
format has a large number of sub types of file data. Sound Forge reads and writes the most common data
formats for these files, 8-bit linear, 16-bit linear, and u-Law.
RealAudio (.RA)



This format is a compressed format designed for real time streaming over the Internet. It is a mono format
and can be compressed for 14.4 and 28.8 kilobaud transfers.
SampleVision File    (.SMP)
This format is used with Turtle Beach's SampleVision software. It is a 16-bit mono file format. The .SMP 
format is meant to be used with sampling keyboards.

 Indicates this file format supports the saving of sample looping information.
Sonic Foundry Sample Resource (.SFR)
This format is an old format defined by Sonic Foundry and is supplied for compatibility. It is not 
recommended for use in saving files.
Sound Designer 1    (.DIG/ .SD)
This format is used by Sound Designer 1.
Sounder/SoundTool File (.SND)
This format is used with the shareware applications Sounder and Sound Tool. It is very popular on bulletin
boards and various online services.
Video for Windows (.AVI)
This is a Microsoft digital video file format. It supports multiple channel audio, but Sound Forge will only 
allow you to open one audio and one video stream at a time. When saving as an .AVI, many compression
schemes are available for both the video and audio streams.
Wave (Microsoft) File    (.WAV)
This is the format for sampled sounds defined by Microsoft for use with Windows. It is an expandable 
format which supports multiple data formats and compression schemes.
Raw Files (.*)
Raw files can be composed of any sound data. If the data is any form of 8- or 16-bit PCM 
(uncompressed) or G.711 A-Law or u-Law (a form of companded compression), then Sound Forge can 
open and save the file.

 Indicates this file format supports the saving of sample looping information.



Summary Information Fields
IARL Archival Location
Indicates where the subject of the file is archived.
IART Artist
Lists the artist of the original subject of the file. For example, "Bach."
ICMS Commissioned
Lists the name of the person or organization that commissioned the subject of the file. For example, 
"XYZZY Records."
ICMT Comments
Provides general comments about the file or the subject of the file. If the comment is several sentences 
long, end each sentence with a period. Do not include newline characters.
ICOP Copyright
Records the copyright information for the file. For example, "© Copyright Sonic Foundry, Inc. 1996." If 
there are multiple copyrights, separate them by a semicolon followed by a space.
ICRD Creation Date
Specifies the date the subject of the file was created. List dates in year-month-day format, padding one-
digit months and days with a zero on the left. For example, "1964-03-02" for March 2, 1964.
ICRP Cropped
Describes whether an image or sound has been cropped and, if so, how it was cropped. For example, 
"third movement, first through fourth bars."
IDIM Dimensions
Specifies the size of the original subject of the file. For example, "8.5 in h, 11 in w."
IDPI Dots Per Inch
Stores dots per inch setting of the digitizer used to produce the file, such as "300."
IENG Engineer
Stores the name of the engineer who worked on the file. If there are multiple engineers, separate the 
names by a semicolon and a blank. For example, "Sayre, Jack; Feith, John."
IGNR Genre
Describes the original work, such as, "landscape," "portrait," "still life," etc.
IKEY Keywords
Provides a list of keywords that refer to the file or subject of the file. Separate multiple keywords with a 
semicolon and a blank. For example, "Madison; aerial view; scenery."
ILGT Lightness
Describes the changes in lightness settings on the digitizer required to produce the file. Note that the 
format of this information depends on hardware used.
IMED Medium
Describes the original subject of the file, such as, "computer image," "drawing," "lithograph," and so forth.
INAM Name
Stores the title of the subject of the file, such as, "Madison From Above."
IPLT Palette Setting
Specifies the number of colors requested when digitizing an image, such as "256."
IPRD Product
Specifies the name of the title the file was originally intended for, such as "Encyclopedia of Midwest 
Geography."
ISBJ Subject
Describes the contents of the file, such as "Aerial view of Madison."
ISFT Software
Identifies the name of the software package used to create the file, such as "Sound Forge."
ISHP Sharpness
Identifies the changes in sharpness for the digitizer required to produce the file (the format depends on 



the hardware used).
ISRC Source
Identifies the name of the person or organization who supplied the original subject of the file. For 
example, "Sonic Foundry, Inc."
ISRF Source Form
Identifies the original form of the material that was digitized, such as "slide," "paper," "map," and so forth. 
This is not necessarily the same as IMED.
ITCH Technician
Identifies the technician who digitized the file. For example, "Palmer, Curt."



Sound Forge and the Microsoft Audio Compression Manager

Sound Forge for 32 Bit Windows Note: The Microsoft Audio Compression Manager
(ACM) is currently not available under Win32s. This is a limitation of Win32s, not Sound

Forge for 32 Bit Windows.

The Microsoft Audio Compression Manager (more commonly referred to as the ACM) is a standard 
interface for Audio Compression and Filtering in Windows and Windows NT. This interface allows 
applications like Sound Forge to use compression and filtering algorithms provided by other companies.
Sound Forge fully supports audio compression and filtering through the ACM. This enables you to use 
any ACM compatible compression and filter driver with Sound Forge. The best part of this support is you 
don't have to learn anything new to use it! Sound Forge transparently opens compressed WAV files and 
provides all available compression formats for WAV files in the Save As dialog. There are no silly Import 
and Export commands. 
There are roughly three pieces to the ACM (though these pieces are tightly coupled). It is not necessary 
for you to know any details about these pieces to use the ACM from Sound Forge, so this information is 
supplied for those who want to know more. That being said, the three pieces of the ACM are:
Audio data compression and decompression
Audio data filtering
Transparent Playback and Recording of non-hardware supported audio files
                                                         
See also
Setting up the ACM



Audio data compression and decompression
The first piece of the ACM allows you to compress and decompress audio data. Audio compression is 
used to decrease the amount of data required to represent a sound; this ultimately results in smaller 
sound files. However, there are drawbacks to using audio compression on your sound files:

1. - Most audio compression algorithms will degrade the quality of the sound. This is referred to as 
lossy compression since information contained in the sound is lost when it is compressed. The 
amount of sound degradation is entirely dependent on the algorithm.

2. - Audio compression requires more processing time than uncompressed data. The amount of 
processing time is dependent on the algorithm, as well as your hardware setup. The result is 
opening and saving compressed files will usually take longer than uncompressed files.

3. - Compressed files are not as portable as uncompressed files. If you are distributing .WAV files in a 
compressed format, you must make sure the person receiving the files can use them. Also, not all 
audio software can use compressed .WAV files, which could make using other programs with 
Sound Forge inconvenient.

In Sound Forge, any compressed .WAV file can be opened as long as a compatible ACM driver is 
installed and enabled. If there is no compatible ACM driver available for a compressed .WAV file, Sound 
Forge will inform you of the problem when you try to open it.
Saving compressed .WAV files is as simple as choosing the compression algorithm in the Format drop-
down list of the Save As dialog. Once a file has been saved as compressed, Sound Forge will always 
save changes to the file using the selected compression algorithm; you do not need to re-select the 
compression format each time you save. Of course you can change the compression format at any time 
with the Save As dialog. You can also revert to an uncompressed format.
Experimentation is probably the most important step in deciding whether or not to use audio compression 
for your projects.



Audio data filtering (Digital Signal Processing)
The second piece of the ACM provides access to Digital Signal Processing (DSP) algorithms. The ACM 
refers to these DSP algorithms as Filter drivers. Though the term Filter in this context is more generic 
than just frequency filtering (like Parametric or Graphic EQ). An ACM filter can implement almost any type
of audio DSP algorithm. Reverb, distortion, and time change are just a few of several possibilities.
Sound Forge does not come with any ACM filters. You must obtain ACM filters from other sources. 
However, since the ACM filter architecture is fully documented by Microsoft, it is possible that many types 
of filters will become available on BBBs and other places for use with Sound Forge. If any ACM filters are 
installed in your computer, you will see the ACM Filter menu item under the Tools menu.
Sound Forge allows you to use any ACM filter installed and enabled on your computer to process sound 
files. Simply select the ACM filter option under the Tools menu to choose the filter and its attributes that 
you wish to apply to your sound data. The ACM Filter tool works exactly like all other Sound Forge DSP 
functions including the option to save presets and set custom selections.



Transparent Playback and Recording of non-hardware supported audio files
The third part of the ACM is probably the most significant (or at least the coolest). It is called the Sound 
Mapper and allows audio data formats that are not directly supported by your sound card to be played 
and recorded. Sound Forge lets you use the Sound Mapper by selecting it for Playback and Record in the
Wave folder of the Preferences dialog. Additional configuration of the Sound Mapper for your system can 
be done using the Windows Control Panel.
If the ACM is not installed on your computer, the Sound Mapper option will be called the Wave Mapper 
instead. The Wave Mapper and Sound Mapper can be thought of as the same device (to a computer 
program, they are one and the same). However, the Sound Mapper, which requires the ACM to be 
installed, is much more powerful than the Wave Mapper. Keep this in mind when you hear people talk 
about the Wave Mapper and Sound Mapper.
Lets go through some examples of what the Sound Mapper can do. If you have a sound file that is 
recorded at a bizarre sample rate like 22,257 Hz (perhaps a file that came from an external sampler), and 
the closest sample rate that your sound card supports is 22,050 Hz, then the sound file normally cannot 
be played. You would have to change the sample rate of the file to 22,050 Hz before you could play it. 
However, changing the sample rate (without resampling) would cause the sound to play at a lower pitch.
The Sound Mapper can play this sound file correctly without forcing you to resample the file first. The 
Sound Mapper will map the sound to the best format possible and perform the resampling in real time. 
Yes Virginia, there is a Santa Claus!
Other examples include the ability to play 16-bit sounds on an 8-bit-only sound card. Or playing stereo 
sounds on a mono-only sound card. And believe it or not, you can record stereo files on a mono-only 
sound card. However, this last example is essentially useless because the Sound Mapper will simply 
duplicate the mono input of your sound card in both channels. So keep in mind that the Sound Mapper 
cannot create something that is better than what the sound card can supply.
The usefulness of the Sound Mapper for non-compressed sound files can be summarized as 
convenience. You dont have to convert the sound to a supported format before you listen to it. Some of 
the tasks that the Sound Mapper can perform (like format conversions while recording) are available not 
because they are useful in real world situations, but because the developers of the ACM knew it could be 
done. Much like climbing a mountain for no better reason than its there.
So what about compressed sound files? Yes, the Sound Mapper allows you to play (and sometimes 
record) compressed sound files. Even on sound cards that do not support compression directly. So you 
can play a sound file that is compressed with Microsoft ADPCM or The DSP Groups TrueSpeech on any 
sound card without decompressing the sound file first. Many multimedia and entertainment software titles 
use compressed sound files to save disk space. The software then plays the files through the Sound 
Mapper.
We stated above that the Sound Mapper can sometimes record compressed sound files. The reason for 
not always being able to record compressed files (even when the compressed file can be played) is 
simple. Compressing sound data can be very computationally expensive (it takes a long time); the 
amount of time required is completely dependent on the compression algorithm and how it is 
implemented. Decompressing sound data is almost always faster than compressing the same sound data
which makes it possible to play it back in real time.
It should be noted that Sound Forge does not play and record compressed sound files directly. Rather, all 
compression and decompression is performed while opening and saving the sound files. This limitation is 
actually insignificant; Sound Forge is the perfect tool for authoring compressed sound files for the ACM 
and many software authors are using Sound Forge for exactly this. Sound Forge saves compressed 
sound files using the best quality possible    something that cannot always be done in real time. So saving 
compressed sound files with Sound Forge will usually sound better than those recorded with audio 
compression.



Notes on Sound Forges sound file compression support:
· The Open dialog allows you to preview compressed .WAV files if you have an appropriate ACM driver 

is installed. However, you must have your Playback device set to the Sound Mapper for this to work 
(Preferences|Wave in the Options menu).

· When saving uncompressed audio data to a compressed format with the Save As dialog, it is a good 
idea to close the file and re-open it after saving. Since Sound Forge does the compression and 
decompression during saving and loading you will not be able to hear what the file sounds like with 
compression until after youve saved and reloaded the file.



Setting up the Microsoft Audio Compression Manager
The Microsoft Audio Compression Manager is part of Windows 95 and NT. If you are running Windows 
3.x, Sound Forge will install Video for Windows in your computer, which also installs the ACM.
In Windows 95, to view the installed audio compression and decompression drivers, go to Control Panel|
Multimedia|Advanced|Audio Compression Codecs. Double-clicking on any of the codecs allows you to 
enable or disable each one.



The Sonic Foundry Virtual MIDI Router (VMR)
The Sonic Foundry Virtual MIDI Router (VMR) is a software-only driver that allows you to control Sound 
Forge from other MIDI-capable applications and vice versa under Windows 95 and Windows 3.x without 
using MIDI hardware. 
A MIDI Router simply transfers MIDI data from one port to another. The Sonic Foundry VMR driver does 
exactly this but requires no hardware. The driver provides up to four devices for MIDI output and input. 
Each of the output devices sends all MIDI data to its corresponding input device.
If one application sends MIDI data through the #3 Sonic Foundry MIDI Router output device, another 
application can receive this MIDI data as input from the #3 Sonic Foundry MIDI Router input device. 

The first character of the device name is a device number from 1 to 4. The device
number is placed at the beginning of the name for compatibility with sequencer software

that tries to display device names in very small places.
The Sonic Foundry VMR can be very useful for synchronizing two MIDI capable applications. You can 
trigger Sound Forge from your MIDI sequencer, or you can drive your MIDI sequencer from Sound Forge 
using SMPTE/MTC. This and more can be accomplished without using MIDI hardware for routing.
                                                         
See also
Installing the Sonic Foundry Virtual MIDI Router 
Configuring the Sonic Foundry Virtual MIDI Router 



Installing the Sonic Foundry Virtual MIDI Router

Note: A Virtual MIDI Router    is applicable to Windows 95 and Windows 3.x only, not
Windows NT.

The    Sonic Foundry Virtual MIDI Router is included on the Sound Forge CD. To install the Sonic Foundry 
Virtual MIDI Router, follow the instructions below for the operating system you are running.    

Windows 95
1. Open Control Panel from the Settings menu in the Start menu.
2. Open the Add New Hardware Item in the Control Panel. 
3. Click the Next> button in the first page of the Add New Hardware Wizard. 
4. In the Detect New Hardware page of the Wizard set the Detect New Hardware option to No. 
5. Click the Next> button. 
6. In the Select type of hardware page select Sound, video, and game controllers. 
7. Click the Next> button. 
8. In the Manufacturer and model page click the Have Disk... button. 
9. Insert the Sound Forge CD into your CD-ROM drive. 
10. In the path list box, type in E:\extras\sfvmid (when E is your CD-ROM drive) and click OK.
11. Select the Sonic Foundry Virtual MIDI Router from the models list and click OK. 
12. Click the Finish button in the final Add New Hardware page. 
13. Once you have restarted Windows, all programs that support MIDI (including Sound Forge) can use

the Virtual MIDI Router.

Windows 3.x 
1. Open Control Panel and double-click the Drivers icon.
2. Click the Add button.
3. Select Unlisted/Updated driver and click OK.
4. You can now insert the Sound Forge CD. Click the Browse button and select the drive in which you 

inserted the CD. Double click the Extras directory, then the Win16 directory, then the VMR directory.
Click OK.

5. The driver should now be listed as Sonic Foundry Virtual MIDI Router. Click once on the driver to 
select it and click OK.

6. Windows will now install the driver. When it is finished you will be prompted to restart Windows to 
complete the driver installation. There are no further setup procedures.

7. Once you have restarted Windows, all programs that support MIDI (including Sound Forge) can use
the Virtual MIDI Router.



Configuring the Sonic Foundry Virtual MIDI Router
After installing the Sonic Foundry Virtual MIDI Router (VMR), a new MIDI device is created with the name 
Sonic Foundry MIDI Router. If you want to install additional devices for MIDI routing (the VMR supports 
up to four) you need to configure the VMR .

Note: When only one routing device is used, the name of the driver is displayed as Sonic
Foundry MIDI Router. When multiple ports are used each port is labeled starting with a

number (1 - the number of ports) to identify each connection.
The following procedures describe configuring the number of VMR devices for Windows 95 and Windows 
3.x.

Windows 95

Warning: If you have a large number of MIDI devices in your system, or a multi-port MIDI
board such as an eight port MIDI interface, you may have problems installing additional

VMR MIDI interface ports. Windows 95 will crash on startup if more than 11 MIDI devices
are installed. If you have trouble with MIDI devices causing system errors after installing
the VMR, you should either reduce the number of ports in use by the VMR, remove the

VMR, or reduce the number of MIDI devices in your system.
1. Double-click on My Computer.
2. Open the Control Panel folder.
3. Double click on the Multimedia icon.
4. Select the Advanced Properties page.
5. Expand the MIDI Devices and Instruments list by selecting it and double-clicking.
6. Select the Sonic Foundry MIDI Router device and click the Properties button.
7. In the General page of the Properties for the Sonic Foundry MIDI Router click the Settings button.
8. In the Configure Sonic Foundry VMR dialog select the number of ports you would like to enable from 

the Ports combo list.
9. Click OK in the dialog.
10. Click OK in the Sonic Foundry MIDI Router Properties dialog.
11. Click OK in the Multimedia Properties dialog.
12. Restart Windows for the new number of devices to take effect

Windows 3.x 
1. Open the Program Manager group main.
2. Double-click on the Control Panel icon to open the Control Panel.
3. Double click on the Drivers icon to open the Drivers dialog.
4. Select the Sonic Foundry Virtual MIDI Router from the list of displayed drivers.
5. Click the Setup button.
6. In the Configure Sonic Foundry VMR dialog, select the number of ports you would like to enable from 

the Ports combo list.
7. Click OK in the dialog.
8. Press the Restart Now button to restart Windows and to have the settings take effect.



SMPTE Time Code
The Society of Motion Picture and Television Engineers (SMPTE) time code may be one of the most 
misunderstood concepts among individuals within the music industry. After working with SMPTE time 
code for years, many people are still confused by the concept, so don't feel bad if you haven't got it all 
figured out. Hopefully this discussion will clear the mud.
The biggest problem with SMPTE time code is that, depending on whether you sit on the video or audio 
side of the fence, SMPTE time codes may mean different things to you. When dealing with SMPTE you 
will probably see five, perhaps six, different types of time codes formats (six is for the people who are 
really confused).
Here is a description of each SMPTE time code format:
SMPTE 25 EBU
This SMPTE code runs at 25 frames per second and is also know as SMPTE EBU (European 
Broadcasting Union). The reason for having this rate is that European television systems run at exactly 25
frames per second.
SMPTE 24 Film Sync
This SMPTE code runs at 24 frames per second and is also know as SMPTE Film Sync. This rate 
matches a nominal film rate of 24 frames per second (the slowest speed possible for apparent continuous
motion).
OK, those two are easy. Now things start to get a little crazy.
SMPTE 30 Non-Drop (as used in the audio world)
In the US, the 60 Hz power system makes it easy to generate a time code rate of 30 frames per second. 
This rate is commonly used in audio environments and is typically known as 30 Non-Drop. You will 
probably use this rate when synchronizing audio applications like a multi-track recorder or your MIDI 
sequencer.
If all you care about is working with audio and not dealing with video, stop reading right here. We 
mean it! All you really need to know is that there are three different SMPTE rates you might want to use: 
SMPTE 24, SMPTE 25, and SMPTE 30 Non-Drop. However, be aware that SMPTE 30 Non-Drop in the 
video world runs at 29.97 frames per second.
True SMPTE 30 Drop and SMPTE 30 Non-Drop (as used in the video world)
If you are planning to work with video, the frame rate of exactly 30 frames per second is never used. 
When NTSC color systems were developed, the frame rate was changed by a tiny amount to eliminate 
the possibility of crosstalk between the audio and color information. Even though it is still referred to as 
SMPTE 30 Drop or Non-Drop, the actual frame rate that is used is exactly 29.97 frames per second. This 
poses a problem since this small difference will cause SMPTE time and real time (what your clock reads) 
to be different over long periods. Because of this, two methods are used to generate SMPTE time code in
the video world: Drop and Non-Drop.
In SMPTE Non-Drop, the time code frames are always incremented by one in exact synchronization to 
the frames of your video. However, since the video actually plays at only 29.97 frames per second (rather 
than 30 frames per second), SMPTE time will increment at a slower rate than real world time. This will 
lead to a SMPTE time versus real time discrepancy. Thus, after a while, we could look at the clock on the 
wall and notice it is farther ahead than the SMPTE time displayed in our application.
SMPTE Drop time code (which also runs at 29.97 frames per second ) attempts to compensate for the 
discrepancy between real world time and SMPTE time by dropping frames from the sequence of SMPTE 
frames in order to catch up with real world time. What this means is that occasionally in the SMPTE 
sequence of time, the SMPTE time will jump forward by more than one frame. The time is adjusted 
forward by two frames on every minute boundary except 00, 10, 20, 30, 40 , and 50. Thus when SMPTE 
Drop time increments from 00:00:59:29, the next value will be 00:01:00:02 in SMPTE Drop rather than 
00:01:00:00 in SMPTE Non-Drop. In SMPTE Drop, it must be remembered that certain codes no longer 
exist. For instance, there is no such time as 00:01:00:00 in SMPTE Drop. The time code is actually 
00:01:00:02.



When synchronizing audio to video, it is crucial that the SMPTE time code (30 Drop or Non-Drop) used in 
your sequencer or digital audio workstation is the same as the SMPTE time code striped onto the video. 
Only then will the SMPTE times on the video screen and computer monitor match exactly during 
playback.
In the audio world, people have started to call 30 Non-Drop (which runs at 29.97 frames per second) 
29.97-Non-Drop to distinguish it from the 30 Non-Drop used between audio applications (which runs at a 
true 30 frames per second). SMPTE 30 Drop (as used in video) may also be referred to as SMPTE 29.97 
Drop just to reiterate that the frame rate is actually 29.97 frames per second. It just depends on who you 
talk to.
However, you must remember that there is no difference between 30 Drop and 29.97 Drop time code. 
There are those who have tried to say that there is such a thing as a SMPTE time code which actually 
runs at 30 frames per second and generates drop frames, but such a time code would not show real 
world time and would also be incompatible with the 29.97 NTSC frame, so its use is unclear.
How Sound Forge deals with the issue
For SMPTE 24, SMPTE 25, and SMPTE 30 Drop time codes, Sound Forge behaves as you would 
expect. The 24, 25 and 30 Drop frame rates are calculated and generated at exactly 24, 25, and 29.97 
frames per second respectively. In 30 Drop rate, the dropped frames are inserted to make up for the time 
discrepancies with real world time.
For SMPTE 30 Non-Drop, the default method for Sound Forge is to calculate all SMPTE values at exactly
30 frames per second. If you are working with video and need SMPTE Non-Drop running at 29.97 frames 
per second, you can turn off the Use 30 frames per second for SMPTE Non-Drop option in the 
MIDI/Sync Preferences folder. This will cause Sound Forge to use 29.97 frames per second instead of 
30 frames per second for SMPTE 30 Non-Drop.
Some calculations for your benefit:
SMPTE 30 fr = 33.3333 ms per frame; SMPTE 29.97 fr = 33.3667 ms per frame
1 minute = 60 seconds * 30 = 1,800 frames per minute
1 minute = 60 seconds * 29.97 = 1,798.2 frames per minute
Difference per minute = 1.8 frames.
1 hour = 3,600 seconds * 30 = 108,000 frames per hour
1 hour = 3,600 seconds * 29.97 = 107,892 frames per hour
Difference per hour = 108 frames.
Thus in drop frame we need to catch up by 108 frames per hour
For example, in Non-Drop mode the SMPTE time code of 01:00:00:00 will equate to a real world time of 
01:00:03:18. Therefore, there is a lag behind real world time of 3 seconds and 18 frames after 1 hour.
Here is a nifty chart to show how SMPTE Drop works. As time progresses, two frames are dropped each 
minute except at the 00, 10, 20, 30, 40 , and 50 minute points. Notice that after one hour, 108 frames 
have been dropped. This number corresponds to the number of drop frames we calculated above needed
to match SMPTE 30 (29.97 fps) time to real time.

Number of dropped frames versus minutes elapsed over one hour
Minutes 00 10 20 30 40 50

xx:00:00:00 xx:10:00:00 xx:20:00:00 xx:30:00:00 xx:40:00:00 xx:50:00:00
0 0 frames 18 frames 36 frames 54 frames 72 frames 90 frames
1 2 20 38 56 74 92
2 4 22 40 58 76 94
3 6 24 42 60 78 96
4 8 26 44 62 80 98
5 10 28 46 64 82 100
6 12 30 48 66 84 102
7 14 32 50 68 86 104
8 16 34 52 70 88 106
9 18 36 54 72 90 108

General MIDI Patch Map



1-8
PIANO 

9-16
CHROM PERCUSSION 

17-24
ORGAN 

1              Acoustic Grand Piano 9                Celesta 17            Drawbar Organ
2              Bright Acoustic Piano 10            Glockenspiel 18            Percussive Organ
3              Electric Grand Piano 11            Music Box 19            Rock Organ
4              Honky-tonk Piano 12            Vibraphone 20            Church Organ
5              Electric Piano 1    13            Marimba 21            Reed Organ
6              Electric Piano 2    14            Xylophone 22            Accordion
7              Harpsichord 15            Tubular Bells 23            Harmonica
8              Clav    16            Dulcimer 24            Tango Accordion

25-32
GUITAR    

33-40
BASS 

41-48
STRINGS

25            Acoustic Guitar 
(nylon)    

33                Acoustic Bass    41                Violin

26            Acoustic Guitar 
(steel)

34                Electric Bass 
(finger)

42                Viola          

27            Electric Guitar (jazz) 35                Electric Bass (pick) 43                Cello 
28            Electric Guitar 
(clean)

36                Fretless Bass    44                Contrabass

29            Electric Guitar 
(muted)

37                Slap Bass 1        45                Tremolo Strings

30            Overdriven Guitar 38                Slap Bass 2    46                Pizzicato Strings
31            Distortion Guitar 39                Synth Bass 1    47                Orchestral Strings
32            Guitar Harmonics 40                Synth Bass 2 48                Timpani 

49-56
ENSEMBLE 

57-64
BRASS

65-72
REED

49                String Ensemble 1 57                Trumpet      65            Soprano Sax
50                String Ensemble 2 58                Trombone    66            Alto Sax
51                Synth Strings 1 59                Tuba 67            Tenor Sax 
52                Synth Strings 2 60                Muted Trumpet 68            Baritone Sax 
53                Choir Aahs 61                French Horn 69            Oboe
54                Voice Oohs 62                Brass Section 70            English Horn 
55                Synth Voice 63                Synth Brass 1 71            Bassoon
56                Orchestra Hit 64                Synth Brass 2 72            Clarinet    

73-80
PIPE 

81-88
SYNTH LEAD    

89-96
SYNTH PAD

73            Piccolo 81            Lead 1 (square) 89            Pad 1 (new age)
74            Flute 82            Lead 2 (sawtooth) 90            Pad 2 (warm) 
75            Recorder 83            Lead 3 (calliope) 91            Pad 3 (polysynth)
76            Pan Flute 84            Lead 4 (chiff)    92            Pad 4 (choir) 
77            Blown Bottle 85            Lead 5 (charang) 93            Pad 5 (bowed) 
78            Shakuhachi 86            Lead 6 (voice)    94            Pad 6 (metallic) 
79            Whistle    87            Lead 7 (fifths) 95            Pad 7 (halo)
80            Ocarina 88            Lead 8 (bass+lead) 96            Pad 8 (sweep) 

97-104
SYNTH EFFECTS

105-112
ETHNIC

113-124
PERCUSSIVE

97                FX 1 (rain) 105              Sitar 113              Tinkle Bell
98                FX 2 (soundtrack) 106              Banjo 114              Agogo
99                FX 3 (crystal) 107              Shamisen 115              Steel Drums
100            FX 4 (atmosphere) 108              Koto 116              Woodblock
101            FX 5 (brightness) 109              Kalimba 117              Taiko Drum



102            FX 6 (goblins) 110              Bagpipe 118              Melodic Tom
103            FX 7 (echoes) 111              Fiddle 119              Synth Drum
104            FX 8 (sci-fi) 112              Shanai 120              Reverse Cymbal

121-128
SOUND EFFECTS
121              Guitar Fret Noise 124              Bird Tweet 127              Applause
122              Breath Noise 125              Telephone Ring 128              Gunshot      
123              Seashore 126              Helicopter

PERCUSSIVE Channel 10 Note Values and Patches

35      Acoustic Bass Drum 51      Ride Cymbal 1 67      High Agogo
36      Bass Drum 1 52      Chinese Cymbal 68      Low Agogo
37      Side Stick 53      Ride Bell 69      Cabasa
38      Acoustic Snare 54      Tambourine 70      Maracas
39      Hand Clap        55      Splash Cymbal 71      Short Whistle
40      Electric Snare 56      Cowbell 72      Long Whistle
41      Low Floor Tom 57      Crash Cymbal 2 73      Short Guiro
42      Closed Hi Hat 58      Vibraslap 74      Long Guiro 
43      High Floor Tom 59      Ride Cymbal 2    75      Claves          
44      Pedal Hi-Hat 60      Hi Bongo 76      Hi Wood Block
45      Low Tom 61      Low Bongo 77      Low Wood Block
46      Open Hi-Hat 62      Mute Hi Conga 78      Mute Cuica
47      Low-Mid Tom 63      Open Hi Conga 79      Open Cuica
48      Hi-Mid Tom    64      Low Conga 8O      Mute Triangle
49      Crash Cymbal 1 65      High Timbale 81      Open Triangle
50      High Tom        66      Low Timbale

MIDI Notes and Frequencies
Note MIDI Hz Note MIDI Hz

C-1 0 8.176 E 4 64 329.63
C#-1 1 8.662 F 4 65 349.23
D-1 2 9.177 F# 4 66 369.99
D#-1 3 9.723 G 4 67 391.99
E-1 4 10.301 G# 4 68 415.31
F-1 5 10.913 A 4 69 440.00
F#-1 6 11.562 A# 4 70 466.16
G-1 7 12.250 B 4 71 439.88
G#-1 8 12.978 C 5 72 523.25
A-1 9 13.750 C# 5 73 554.37
A#-1 10 14.568 D 5 74 587.33
B-1 11 15.434 D# 5 75 622.25
C 0 12 16.352 E 5 76 659.26
C# 0 13 17.324 F 5 77 698.46
D 0 14 18.354 F# 5 78 739.99
D# 0 15 19.445 G 5 79 783.99
E 0 16 20.601 G# 5 80 830.61
F 0 17 21.826 A 5 81 880.00
F# 0 18 23.124 A# 5 82 932.32
G 0 19 24.499 B 5 83 987.77
G# 0 20 25.956 C 6 84 1046.5
A 0 21 27.50 C# 6 85 1108.7
A# 0 22 29.135 D 6 86 1174.7



B 0 23 30.867 D# 6 87 1244.5
C 1 24 32.703 E 6 88 1318.5
C# 1 25 34.648 F 6 89 1396.9
D 1 26 36.708 F# 6 90 1480.0
D# 1 27 38.890 G 6 91 1568.0
E 1 28 41.203 G# 6 92 1661.2
F 1 29 43.653 A 6 93 1760.0
F# 1 30 46.249 A# 6 94 1864.7
G 1 31 48.999 B 6 95 1975.5
G# 1 32 51.913 C 7 96 2093.0
A 1 33 55.000 C# 7 97 2217.5
A# 1 34 58.270 D 7 98 2349.3
B 1 35 61.735 D# 7 99 2489.0
C 2 36 65.406 E 7 100 2637.0
C# 2 37 69.295 F 7 101 2793.8
D 2 38 73.416 F# 7 102 2960.0
D# 2 39 77.781 G 7 103 3136.0
E 2 40 82.406 G# 7 104 3322.4
F 2 41 87.307 A 7 105 3520.0
F# 2 42 92.499 A# 7 106 3729.3
G 2 43 97.998 B 7 107 3951.1
G# 2 44 103.82 C 8 108 4186.0
A 2 45 110.00 C# 8 109 4434.9
A# 2 46 116.54 D 8 110 4698.6
B 2 47 123.47 D# 8 111 4978.0
C 3 48 130.81 E 8 112 5274.0
C# 3 49 138.59 F 8 113 5587.7
D 3 50 146.83 F# 8 114 5919.9
D# 3 51 155.56 G 8 115 6271.9
E 3 52 164.81 G# 8 116 6644.9
F 3 53 174.61 A 8 117 7040.0
F# 3 54 184.99 A# 8 118 7458.6
G 3 55 195.99 B 8 119 7902.1
G# 3 56 207.65 C 9 120 8372.0
A 3 57 220.00 C# 9 121 8869.8
A# 3 58 233.08 D 9 122 9397.3
B 3 59 246.94 D# 9 123 9956.1
C 4 60 261.63 E 9 124 10548.1
C# 4 61 277.18 F 9 125 11175.3
D 4 62 293.66 F# 9 126 11839.8
D# 4 63 311.13 G 9 127 12543.9

Note: The chart shows the musical pitch and frequency associated to each MIDI Note in Sound Forge. A4
is at 440 Hz and middle C is C4 at 261.63 Hz. These values can differ, often by one octave, from values 
used by other manufacturers. To avoid having negative values, some MIDI sequencers and sound 
modules use C0 as MIDI Key 0, which then makes middle C C3 instead of the more standard C4. The 
frequencies below are based    on equal temperament tuning.



RIFF Wave Chunks
The following is an overview of the defined RIFF Wave File chunks which Sound Forge 3.0 stores and 
recognizes. Although Microsoft recommends that the audio data be stored after all other chunks, the only 
chunks stored by Sound Forge prior to the data are the fmt, fact, and PAD chunks. 
The reasoning proposed for storing the data after all other chunks is if the data is modified, the other 
chunks do not have to be rewritten to disk. However, since the auxiliary chunks are usually much smaller 
than the data, the associated time to rewrite them is usually negligible. For example if a play list chunk is 
modified to add a new region we have to rewrite the complete contents of the data to insert the new 
Playlist chunk. However if it is stored at the end of the data only the play list chunk and any chunks 
following it need to be rewritten. If we were operating with 3 minutes of 44k stereo data then we would 
need to rewrite 30 megabytes of data to insert 1 region change. The auxiliary chunks typically are less 
than 100k so we only have to move 100k with changes to the audio data itself.
Another reason for storing additional chunks after the data is that some non-robust software packages 
assume that all that will be found in a WAV file prior to the data is the fmt chunk. This allows you to still 
read WAV files to some degree with these packages.
Chunk Use
PAD This chunk is used by Sound Forge to align the DATA chunk on a 

sector boundary for use with products like Digidesign's Session 8.
fact Used to specify the length of audio data in samples when data is 

stored in a format other than PCM.
cue Used to specify the start of Markers and Regions.
plst Used to specify a Playlist within a single wave file.
adtl Used to specify region lengths and to provide text names for regions 

and markers.
smpl Used to specify information for files used with samplers. Includes 

information on release and sustain loops.
tlst Used to specify external trigger events for regions and Playlist entries.
inst Unsupported, but documented for consistency.
For more information on the above chunks, refer to the RIFF specification available from Microsoft.
The following chunk has been proposed by Sonic Foundry but has not been registered with Microsoft. 
This chunk is used to save trigger information in WAVE files created by Sound Forge.
tlst (Trigger List) Chunk

Added: ??
Author: Sonic Foundry
Defined for : WAVE form

The <tlst-ck> trigger list chunk specifies a list of triggers which can be used to trigger playback 
of a series of cue points or play list entries. The <tlst-ck> is defined as follows:

|<tlst-ck>| () tlst(
<dwTriggers:DWORD> // count of triggers
<trigger(s)>...) // trigger table

<trigger> struct
{
FOURCC fccListReference;



DWORD dwName;
DWORD dwType;
DWORD dwTriggerOn;
DWORD dwFunction;
DWORD cbExtra;
}

The <trigger> chunk:

fccListReference Specifies the list which this entry references. A trigger 
can reference either the <cue-ck> or the <plst-ck>.

dwName When the trigger references the <cue-ck> this field 
specifies the cue point name. This value must match one
of the names listed in the <cue-ck> cue-point table. 
When the trigger references the <plst-ck> this field 
references a play list entry by index. This value must be 
less than the total count of <plst-ck> entries.

dwType Specifies the type of trigger.
0 - SMPTE Trigger
1 - MIDI Command Trigger.
2 - MIDI SysEx Trigger. (SysEx message)

dwTriggerOn Specifies the value which will cause a trigger to be 
generated. This value will change value depending on 
the type of trigger.

For triggers of type SMPTE (0)
Specifies a SMPTE time offset for the cue. The 
format of this value is 0xhhmmssff. hh is an 
unsigned Hours value [0..23]. mm is an 
unsigned Minutes value [0..59]. ss is an 
unsigned Seconds value [0..59]. ff is an 
unsigned Frames value [0..numFrames].

For triggers of type MIDI Command (1)
Specifies a MIDI Command.

Specified as :
Channel Command Param1 Param2
Byte 0 Byte 1 Byte 2 Byte 3

Where Byte 0 is the MSB and Byte 3 is the 
LSB.

For channels a value of FF signals trigger on all
channels.
For any other param other than the MIDI 
command byte FF signals a don't care value.

For triggers of type MIDI Sysex (2)
Unused, should be set to 0.

dwFunction Specifies the function of this trigger.



0 - Play
1 - Stop
2 - Queue

Trigger functions which are unsupported or unknown 
should be ignored.

cbExtra Specifies the size in bytes of additional trigger information. For 
the case of a MIDI Sysex Trigger, this is the size of the 
matching MIDI sysex command immediately following the 
structure. 
Any value within a sysex that is set to FF is treated as a 
don't care. This allows response on multiple channels, 
values, etc.

Examples:
Play when any MIDI note on is received:

FF 90 FF FF
Play when MIDI note 60 is received on channel 1.

00 90 3C FF
Play when MIDI note 60 is received on channel 1, stop when note off received for same note

00 90 3C FF
00 80 3C FF

Queue when MIDI note 60 is received on channel 2, Play when note off received for same note
01 90 3C FF
01 80 3C FF

Markers, Regions, and Playlist Entries as used by Sound Forge 3.0 
When creating or reading markers, regions and playlist entries in WAV files, the RIFF documentation can 
be a little confusing. We have added this section to give software developers a better idea of how to deal 
with these chunks.
Markers
Markers are a position within a wave file which can also have an associated text name. Each marker in 
Sound Forge is stored as an entry within the <cue> chunk. The entry within the <cue> chunk stores the 
position as well as a DWORD name field. The name field is used to reference the text name entry which 
can be found within the <adtl> chunk. For instance if we had a Marker at 0 which had a name of Start 
there would be an entry within the <cue> chunk with a Sample Offset of 0 and a Name entry of 0x0001 
(we have chosen 0x0001 for the example. The Name entry can be any value from 0x00000000 to 
0xFFFFFFFF) Within the <adtl> chunk we would have an entry of type <labl> (label chunk) with a name 
of 0x0001 and a text field of Start.
Regions
Regions are much like a marker but they also include an associated length as well as a start position and 
text name. Each region is stored as an entry within the <cue> chunk which stores the position as well as a
DWORD name field. The name field is again used to reference the text name entry which can be found 
within the <adtl> chunk. The difference between the marker and the region is that instead of using a 
<labl> chunk in the <adtl> chunk we use a <ltxt> chunk which allows us to store a length as well as a text 
name. For instance if we had a region at 0 with a length of 1000 samples and a name of Beat 1 there 
would be an entry within the <cue> chunk with a sample offset of 0 and a name entry of 0x0001. (Again 
we are using the name value of 0x0001 as an example.) Within the <adtl> chunk we would have an entry 
of type <ltxt> with a name of 0x0001, a text field of Beat 1, and a length of 1,000. Within the <ltxt> chunk 
there is also a field of type FOURCC which specifies the purpose of this entry. For all regions in Sound 
Forge the FOURCC type is set to rgn .
Playlist Entries



Playlist regions are stored a little differently. They specify a reference to a <cue> for the start of each play 
list region and a length and number of loops for each entry. Thus, our play list entries can actually have 
lengths that are different than those stored within the region list. To handle this, for every playlist entry 
there will exist a corresponding region of the exact same length when a wave file is created by Sound 
Forge. This is to simplify the overall use and interface to the user. If we were to have a playlist which 
contained our previous example of a region of Beat 1 playing 4 times, it would be stored in the play list 
with a Name field of 0x0001, a length of 1,000 samples, and a loop count of 4.



Tips and Ideas
Pseudo-quantizing digital audio with MIDI sequencers
Realistic MIDI drum parts with MIDI triggering
Randomizing a Drum Loop



Pseudo quantizing digital audio with MIDI sequencers
There are many ways to use Sound Forge with MIDI sequencers. The following two tips deal with drum 
patterns , though any type of material could be adapted to these techniques. These examples are some 
of many possible uses for the MTC sync and MIDI triggering capabilities of Sound Forge and MIDI 
sequencers. For information on setting up the Sync/triggers with specific sequencers, see Appendix M: 
Using Sound Forge with MIDI Sequencers.
Using MIDI note triggering to pseudo-quantize a Regions.

1. 1. Record some drum tracks into Sound Forge that are in a consistent tempo and measure scheme.
2. 2. Split up the sound file into regions that are a measure in length. In the Regions List, assign a 

different MIDI Note On trigger to each region.
3. 3. Select a region and open the Edit Tempo dialog in Sound Forge's Special menu. By selecting 

Measure, you can now see what the approximate tempo (BPM) is according to the number of beats
you have entered and the length of the selection. Examine a number of different regions in this way 
and take an average BPM.

4. 4. Now, set the sequencer's tempo to match the BPM found in Sound Forge's Edit Tempo. 
5. 5. Next, create a MIDI track with whole notes that correspond to the note numbers selected in the 

Sound Forge Regions List for each separate region. These notes should fall on downbeats of the 
measures so there is one note per measure. It is a good idea to make their lengths a few clock 
pulses shy of the next downbeat. Also, it may be necessary to set a negative time offset for the 
whole track to allow for any slight delay that MIDI note triggering is prone to have.

6. 6. Now, playing back the track in the sequencer while triggering Sound Forge should give you a 
pseudo-quantized version of the sound file. Each new measure in the sequencer should trigger a 
measure of audio material in Sound Forge. Although this method has potential for less accurate 
start points than MTC SMPTE triggering, it will allow for easier tweaking and alignment within the 
sequencer.

Using MTC synchronization to pseudo-quantize the Playlist.
1. Record some drum tracks into Sound Forge that are in a consistent tempo and measure scheme. 
2. Split up the sound file into regions in the Regions List and Playlist that are a measure in length.
3. Select a region and open the Edit Tempo dialog in from the    Special menu. By selecting Measure 

you can now see what the approximate tempo (BPM) is according to the number of beats you have 
entered and the length of the selection. Check a number of different regions in this way to find an 
average BPM.

4. Now, in the sequencer, set the tempo to match the tempo found in Sound Forge. Next, there should 
be a way (in the sequencer) to see what SMPTE time will correspond to whatever measure 
downbeat you choose. These times can be entered as the Sound Forge Playlist regions SMPTE 
start times. This procedure will allow the Playlist regions to start at the downbeat of the sequencer 
measures when Sound Forge is set to follow MTC. You will undoubtedly need to tweak the start 
times and possibly the sequencer tempo, but should be able to get it all to sound correct.

5. This method of triggering is quite accurate, since Sound Forge knows what region is to be triggered 
next and can pre-load the data accordingly. It is a little precarious, though, to have to adjust the 
SMPTE start times every time the sequencer tempo is changed due to tweaking.



Realistic MIDI drum parts with MIDI triggering
If you do a lot of MIDI sequencing, you know how unconvincing and static MIDI drum parts can be, 
especially if you're not a drummer. Good results can be achieved through the use of triggering Sound 
Forge regions from a MIDI sequencer to go along with drum parts that have been created in the 
sequencer. If you have a sampler, here is a procedure that yields quite convincing drum tracks.

1. First, record into Sound Forge some drum tracks/sounds from an audio source that has an 
abundance of drums alone material.

2. Run Auto Region on the sound file to automatically breakup the events into easily manipulated 
regions. To audition each region, open the Regions List and click on the play button for each entry.

3. Create some MIDI drum tracks in your sequencer without worrying too much about fills, flams, etc. 
These things will be added by MIDI triggering Sound Forge.

4. Now that you have a basic drum track in the sequencer, go to Sound Forge and choose events that 
are distinctly Drummer-esque from your Regions List (you might need to edit the lengths and 
positions of the regions). These are the types of events that in themselves do not make good single 
drum samples or are too long to reasonably use with a sampler with limited amounts of RAM (for 
example, drum fills, flams, long crash cymbals and events that have a certain amount of Human 
variation).

5. For each region you want to use, select a MIDI Trigger event in the Edit Marker/Region dialog. It is 
recommended that you use MIDI: Note On - Queue / Note Off - Play as this will ensure that the 
timing will be accurate. The only drawback to this method of triggering is that the actual the start of 
the region playback will occur on the release of the MIDI note in the sequencer. That is, the place in
time the triggered region should start playing will have to line up to the end of the MIDI event. In 
some sequencers, this is a little easier to deal with than others. This is a way for Sound Forge to 
pre-load the region data for accurate playback at the trigger point. See the Using Sound Forge 
section on MIDI triggering for a detailed explanation of setting up Sound Forge MIDI triggers.

6. Now, in your sequencer, assign a new track with the same MIDI channel as specified in the MIDI 
Triggers for the regions. At this point each of your drum regions in Sound Forge can be triggered 
from your sequencer with MIDI notes. You can decorate your drum parts with these events to add 
variation and Drummer-isms that are not possible with single drum samples and MIDI alone.



Randomizing Playlist regions
Some very interesting rhythmic patterns can be "discovered" by using the Region Scrambler (a.k.a. the 
Egg Beater) technique on a drum track outlined below:

1. Open a file with a drum pattern. Run the Auto Region tool using the "Drum Beats" Preset (minor 
tweaks may be necessary).

2. In the Playlist window, randomly rearrange the regions. The fastest (and most fun) way to do this is 
to randomly drag and drop each region up and down the Playlist. Do this for about 10 seconds or 
until the regions are completely scrambled.

3. Now, listen to the rearranged regions in the Playlist.
4. Another thing you can do is to raise or lower the play count in some regions. You can do so by 

using the Numpad + and Numpad - key.
5. Repeat steps 2-4 until you're positive you've created the most complex rhythmic pattern known to 

man.
6. Create a new file from the playlist by using the Convert to New function. Now, play your new drum 

loop in Looped mode. Tap along to your new groove and try to figure out its time signature.
7. Cool, eh?



Using CSOUND, MTU, IRCAM, BICSF and EBICSF Files
This section discusses how to open and save files of the type CSOUND, MTU, IRCAM, BICSF, EBICSF 
with Sound Forge.
Introduction
Although Sound Forge supports a large number of sound file formats directly, it does not support the 
CSOUND, MTU, IRCAM, BICSF or EBICSF file types. However, by using the Raw File Type capabilities 
of Sound Forge, sound data from these file types can be extracted.
The IRCAM or IRCAM-Gross format consists of a 1024 byte header prior to the audio data. This header 
contains standard information like the number of channels, sampling rate, and data format. It also can 
contain information such as the name of the sample and comments on what is included in the file. This is 
the format used by the MTU system and is often referred to as MTU files. IRCAM files support two types 
of data formats: 16-bit linear PCM and floating point data.
BICSF or EBICSF files (Berkeley/IRCAM/CARL Sound File or Extended BICSF) are an extension of the 
IRCAM format. The difference being that instead of using the standard IRCAM header they replace the 
first 28 bytes of the header with a standard NeXT/Sun header. This allows the IRCAM format to continue 
to hold additional information in its 1024 byte header and still allow the files to be read by software that 
supports the NeXT/Sun file format (such as Sound Forge).
Opening and Saving files
BICSF and EBICSF files
When reading BICSF or EBICSF Sound Forge will identify them as NeXT/Sun files. This is due to the fact 
that the header of the BICSF file has been modified to allow it to be read as a NeXT/Sun File. Sound 
Forge has no difficulty reading these files as long as they are in one of the supported NeXT/Sun data 
formats.
IRCAM, CSOUND and MTU files
When reading any of these types you must import the files as a Raw data file. The best way to do this is 
to set up the correct parameters in the Sound Forge Raw File Type dialog box and then save presets 
labeled accordingly. Sound Forge's Raw File import will allows you to read these files as long as they are 
mono or stereo and are stored in 16-bit linear format. Sound Forge will not allow you to read the floating 
point format IRCAM files.
Opening an IRCAM file
To open an IRCAM sound file in Sound Forge, follow these steps:

1. Open the File Open dialog box.
2. Select the Raw File type.
3. Select an IRCAM file to load.
4. Press the OK button in the File Open dialog. This will bring up the Raw File Type dialog box.
5. Select the following parameters:

Sample rate: Set the most common sample rate you use (typically 44,100).
Sample type: 16-bit PCM
Format: Signed
Channels: Mono or Stereo (depends on the file)
Byte order: Big endian or Little endian (depends on where the file was generated).
Header: 1,024 bytes
Trailer: 0 bytes

6. Before selecting OK to load the file press the Save As button to create a preset. Type in an 
appropriate preset name and press OK.

Now whenever you wish to load an IRCAM file, you can load it as Raw File Type and then select the 
preset you saved to set all the necessary parameters to load the file. Note that if any of the files are not 
the same as your preset, you should change them in the raw dialog box. You may even want to create 
multiple presets.
It is important to note that the Byte order of files is not always the same for files generated by CSOUND. 
The CSOUND executables for the PC generate files which use Little Endian byte ordering. CSOUND for 
other platforms tends to generate files with Big Endian ordering. MTU files also use Big Endian ordering. 



The best policy is to try a file first in Big Endian. If the sound data seems to be garbage, then try loading 
the file using Little Endian. Again you may want to save presets for byte ordering, as well as mono/stereo,
if you are receiving CSOUND files from a variety of other computers.
Saving files with Sound Forge
When saving files of the above types you will not be able to save them as IRCAM, CSOUND or MTU. You
will have to save any files of these types as one of the file formats supported by Sound Forge.
If you wish to save a file for use with software which supports the BICSF/EBICSF format you should save 
the file as a NeXT/Sun file which will not save any of the additional information found in a BICSF/EBICSF 
file but should allow the software to read the data as a NeXT/Sun file.



Troubleshooting

1. When playing files from my SCSI drive, why does the sound have a warbling effect? ANSWER 

2. When saving files as Macintosh AIFF and transferring them to my Macintosh, why does the Macintosh 
not recognize them as sound files? ANSWER

3. After running an effect on a file, why is there a loss in volume level?    ANSWER

4. Why do some effects take so long to process a file? ANSWER

5. When I start Sound Forge my Play and/or Record buttons/options are grayed out. Why can I not play or
record? ANSWER

6. Why can I not get Sound Forge to respond to levels from my Microphone or my CD Player? ANSWER

7. I have sound files that don't want to play on my system. Sound Forge loads them fine, why will it not 
play them? ANSWER

8. Why will Sound Forge not open my compressed files like Microsoft ADPCM? ANSWER

9. Why is it when I play my sound files the play pointer that Sound Forge displays seems to be off from 
what I am hearing? ANSWER

10. When I record or play back files I hear what sounds like small clicks in the sound. ANSWER

11. When I record (or play) data at high sample rates, I cannot get Sound Forge to stop by pressing the 
Stop button. ANSWER

12. When using SMPTE/MTC to drive my sequencer, my sequencer sometimes loses sync. ANSWER

13. After converting WAV files to Redbook audio using the software which came with my Compact Disc 
recorder, there are audible clicks at the end of the track. ANSWER

14. My Compact Disc recorder uses a file type with an RBK extension. What is an RBK file and can I 
open it with Sound Forge? ANSWER

15. When playing Sound Files with rates above 44,100 Hz on my Turtle Beach Multisound or Tahiti, my 
system crashes. ANSWER

16. When playing Sound files at 8,000 Hz on my Turtle Beach Multisound, the play pointer moves but I do
not hear any output. ANSWER

17. When playing Sound Files at rates other than 11, 22, or 44 kHz the files sound wrong (the pitch is 
wrong). ANSWER

18. When making a selection with the mouse, why does the selection change to another location? 
ANSWER

19. Microsoft ADPCM files created using Sound Forge crash when I play them in Media Player on my 
Turtle Beach sound card. Why? ANSWER

20. When opening an AVI file, if the audio stream format is 44.1 kHz stereo file Microsoft or IMA ADPCM, 
the audio track does not    open correctly. ANSWER



21. After installing the Sonic Foundry Virtual MIDI Router in Windows 95, my system is having trouble with
MIDI devices or the VMR. ANSWER

22. When I play a sound file, I sometimes hear a click at the beginning or end of the selection. ANSWER

22. While drawing the Waveform Display, my system locks up completely. ANSWER



Q: When playing files from my SCSI drive, why does the sound have a warbling effect? 

A: When playing files from a SCSI drive that is connect to a SCSI adapter that utilizes a DMA channel 
(such as most Adaptec adapters) you may experience a warbling effect in the sound playback. This 
can occur if your sound card uses DMA and its DMA channel is set to a higher number than your 
SCSI adapter.

To fix this problem, set the DMA channel used by your sound card is a lower number than that used 
by your SCSI adapter. So, if your SCSI adapter is set to DMA channel 5 and your sound card is set to 
DMA channel 7, try reconfiguring them so the sound card uses DMA channel 5 and your SCSI 
adapter uses DMA channel 7.

                                                         
See also
Troubleshooting 



Q: When saving files as Macintosh AIFF and transferring them to my Macintosh, why does the 
Macintosh not recognize them as sound files?

A: The Macintosh uses special information within it's operating system to keep track of the types of files 
to which it has access. Sound Forge for Windows can save the audio data in the correct file format, 
but it cannot tell the Macintosh what type it is. To do this you must use a program on the Macintosh, 
like ResEdit, which allows you to change the Type of the file. You simply need to set the Type field to 
AIFF for the Macintosh to recognize the file as a sound file.

                                                         
See also
Troubleshooting 



Q: After running an effect on a file, why is there a loss in volume level?

A: Most effects that can alter the volume level of a file have two fader controls, Dry Out and Effect Out 
(where Effect is the name of the function, like Reverb). These controls should be adjusted to get the 
proper balance between processed and non-processed sound and also    determine the combined 
volume level. For example, if you run an effect with both controls set at 40% and the level after 
processing is too low, simply raise both the Dry and Effect Out faders an equal amount to raise the 
final level.    However, take care to keep the output signal from clipping .

                                                         
See also
Troubleshooting 



Q: Why do some effects take so long to process a file?

A: Some processing functions used by Sound Forge are very math intensive. Examples include EQ, 
pitch change without change of duration, and the reverb effect. This means that millions of integer 
and floating-point arithmetic operations must be performed for each second of sampled data. If your 
computer's CPU does not have a math co-processor (in the Intel architecture that means if you have 
an i486 SX instead of an i486 DX or Pentium), floating-point operations will drastically slow you down 
and there is not much you can do except save up for a faster processor.

Of course, running effects on stereo, 44,100 Hz, hour long files will slow you down no matter what 
machine you are using. If you are going to be deleting or inserting space into these huge files, we 
recommend that you break the files into smaller ones and then mix the smaller files together once you
are done processing them. This is especially painful when you insert or delete from the beginning of a
large file, since Sound Forge must then shift the rest of the file over.

One way the get around disk related editing delays is to use the Regions List and Playlist to make all 
arrangements non-destructively and then use the Convert to New function on your Playlist. Another 
useful feature in Sound Forge is the Preview Cut/Cursor function under the Edit Menu--use this 
function to verify your Cut and Clear operations before actually changing the file.

                                                         
See also
Troubleshooting 



Q: When I start Sound Forge my Play and/or Record buttons/options are grayed out. Why can I 
not play or record?

A: When Sound Forge starts, it checks to see if you have a wave playback and record device installed in
your system. If you do not then it disables the appropriate operations. If you are sure that you have a 
sound card installed in your system, yet Sound Forge does not recognize this, you need to check a 
couple of things. First check the Wave folder in the Preferences dialog. The two settings of 
importance are the Playback and Record drop-down list boxes. These options determine the wave 
playback and record devices which will be used by Sound Forge. By default Sound Forge uses the 
Wave Mapper (may also be called the Sound Mapper) device which should automatically pick an 
appropriate device for use by Sound Forge. If either the Playback or Record device is set to (None) 
then Sound Forge can not execute the corresponding operation. To learn more about configuring your
wave devices refer to the Wave Preference folder in the Reference section.

                                                         
See also
Troubleshooting 



Q: Why can I not get Sound Forge to respond to levels from my Microphone or my CD Player?

A: Most sound cards come with multiple inputs which you can record sound from. These may include 
microphone, CD, auxiliary, MIDI and line inputs. Although some cards record from all of these inputs 
at the same time, many cards make you choose which device is currently your record device (also 
known as the input source). These cards come with software which allows you to pick which device is
the input source. You will need to refer to your sound card manual to determine how to set the input
source.

Most sound cards also come with some kind of application which controls the input level of the 
recording device. You may need to increase the level of your input sources in order to record from 
them. Again, you will need to refer to your sound card manual to learn how to adjust these levels.

                                                         
See also
Troubleshooting 



Q: I have sound files that do not want to play on my system. Sound Forge loads them fine, why 
will it not play them?

A: Sound Forge allows you to load many different types of sound files, including ones that your system 
may not be capable of playing. There are a variety of reasons that your sound card may not be 
capable of playing a file.

Some sound cards only allow playback and recording at specific sample rates. Typically these rates 
are limited to 11,025, 22,050, and 44,100 Hz. If you try to play a file that is 32,000 Hz the sound card 
will not allow you to play it.

If you have an older sound card it may only support Mono playback. If this is the case simply convert 
any Stereo files to Mono and you will be able to play them.

If you have an older sound card it may only support 8 bit playback. If this is the case simply change 
the sample size of the file from 16 to 8 bits.

                                                         
See also
Troubleshooting 



Q: Why will Sound Forge not open my compressed files like Microsoft ADPCM?

A: Sound Forge has built in support for the Microsoft Audio Compression Manager (ACM). This allows 
you to open files that are compressed with a variety of algorithms including Microsoft ADPCM, IMA 
ADPCM, and other third party compression schemes like True Speech from The DSP Group.

If you cannot open a Microsoft ADPCM file, you may not have the Microsoft ACM installed in your 
system or you do not have the Microsoft ADPCM driver installed and enabled for the ACM. Please 
refer to the Appendix's on Installing the Microsoft Audio Compression Manager and Sound Forge and 
The Microsoft Audio Compression Manager for more information on how to install and use the ACM 
with Sound Forge.

                                                         
See also
Troubleshooting 
The Audio Compression Manager
Installing the ACM



Q: Why is it when I play my sound files the play pointer that Sound Forge displays seems to be 
off from what I am hearing?

A: For Sound Forge to display the current position of the pointer relative to playback of audio data it 
must rely on your sound card driver to provide the correct position. Many sound card drivers do not do
a very good job of this. Typically the position these cards provide is both off by a fixed amount as well 
as reported only in large discrete steps. Sound Forge provides a way to compensate for this by 
setting various options in the Wave Preferences folder (File menu). Refer to the Wave Preferences 
folder in the Reference section for more information.

                                                         
See also
Troubleshooting 



Q: When I record or play back files I hear what sounds like small clicks in the sound.

A: When Sound Forge is recording or playing audio data it needs to move large amounts of data 
between your hard drive and your sound card. This can be a tremendous amount of work for your 
computer depending on the kind of system you have. If Sound Forge can not move the data fast 
enough then you will hear small gaps between blocks of data which typically sound like clicks or 
puttering. There are a number of things you can do to reduce the overhead during the time Sound 
Forge is moving sound data, all of which are covered in the Using Sound Forge section called 
Optimizing Sound Forge.

                                                         
See also
Troubleshooting 
Clicks at start or end of playback, Q&A 



Q: When I record (or play) data at high sample rates, I cannot get Sound Forge to stop by 
pressing the Stop button.

A: Sound Forge tries very hard to keep recording and playback of audio smooth (no gaps in your sound).
So there may be delays between the time that you press the Stop button and the time that Sound 
Forge actually stops. Note that you can always press and hold the Escape key to stop record or 
playback no matter how bad the situation is. Just be a little patient and wait a few seconds. These 
delays are usually only observed when one or more components of your system can not keep up with
the data rate. Typical faults are:

1. Very slow (older) hard drives.

2. Poorly written Sound Card Drivers.

3. Setting your Storage directory to a slow device like a Network drive or a Compressed Hard drive.

If at all possible, use the fastest uncompressed storage device available with Sound Forge. For 
more information on configuring your system, see the section on Optimizing Sound Forge.

                                                         
See also
Troubleshooting 



Q: When using SMPTE/MTC to drive my sequencer, my sequencer sometimes loses sync.

A: Depending on the performance of your system (and your sequencer) you may experience SMPTE 
sync drop-out problems. This is typically due to too many things going on at once (i.e. more than your 
computer is capable of maintaining). For example, if you have wave playback, synchronization 
messages, sequencing, and perhaps more going on at the same time, you may experience sync 
drop-out.

To compensate for this, many sequencers allow you to set a freewheel time, which is a slack time 
between SMPTE messages during which the sequencer will continue to play even if SMPTE/MTC 
messages are being missed. By increasing this freewheel time you allow Sound Forge and your 
sequencer to be less tightly dependent on SMPTE messages, but this may also decrease your 
synchronization accuracy. The best recommendation is to start with a small freewheel time and, if you
experience sync drop-out problems, increase the freewheel time until the drop-outs go away.

                                                         
See also
Troubleshooting 



Q: After converting WAV files to Redbook audio using the software which came with my Compact
Disc recorder, there are audible clicks at the end of the track.

A: Not all software for converting WAV files to Redbook audio handles the WAV file structure correctly. 
The software simply skips the first 44 bytes of data in the WAV file and then considers everything else
in the file to be audio data. This means that if you have saved Summary Information, Sampler 
Information, or Regions and Playlist data in the WAV file it will be interpreted as audio data.

If you are experiencing this problem simply, use the Save As command in Sound Forge to save a 
new WAV file with the Save Summary Information, Save Sampler Information, and Save 
Regions/Playlists check boxes unchecked. This tells Sound Forge to save only the minimum amount 
of information needed for a WAV file. Also saving a file with Sector aligned data for Digidesigns 
Session 8 (File Preferences) turned on can cause a glitch at the start of the sound file in other 
software.

                                                         
See also
Troubleshooting 



Q: My Compact Disc recorder uses a file type with an RBK extension. What is an RBK file and can
I open it with Sound Forge?

A: RBK files are simply Raw PCM sound data files. These files are used by some Compact Disc 
recorders. These files are used to store Redbook audio onto a Compact Disc. RBK files are data only 
and contain no other information. They are stored as 16 bit, stereo data with a sample rate of 44.1 
kHz. There are a number of things that make them different than a normal 16 bit raw file:

1. The channels are stored in reverse order.

2. The data is stored in Big Endian format (Motorola).

3. The data length of the file has to be a multiple of 2352 bytes (1 CD sector). The size of a CD sector
is calculated as follows;

1 second of 44.1k, 16 bit, stereo Audio = 176,400 bytes.
CD audio has 75 sectors of data for each 1 second of audio.
Sector size = 176,400/75 = 2352 bytes.

To open an existing RBK file, simply use the RAW file option in Sound Forge's Open dialog box and 
select the RBK preset. Remember that you will have to swap the channels if you want to maintain the 
correct left/right channel settings.

                                                         
See also
Troubleshooting 



Q: When playing Sound Files with rates above 44,100 Hz on my Turtle Beach Multisound or Tahiti,
my system crashes.

A: This is caused by a severe bug in the Turtle Beach Multisound and Tahiti sound card drivers. You will 
experience the same crash no matter what software you use to play sample rates above 44,100 Hz--
including Media Player and even Turtle Beach's own Wave application.

Contact Turtle Beach for updated drivers.

                                                         
See also
Troubleshooting 



Q: When playing Sound files at 8,000 Hz on my Turtle Beach Multisound, the play pointer moves 
but I do not hear any output.

A: This is caused by a bug in the Turtle Beach Multisound driver.

Contact Turtle Beach for updated drivers.

                                                         
See also
Troubleshooting 



Q: When playing Sound Files at rates other than 11, 22, or 44 kHz the files sound wrong (the pitch
is wrong).

A: This is due to poorly written sound drivers that incorrectly play sounds with sample rates that are not 
supported by the sound card hardware. For example, a sound that is supposed to play at 13,000 Hz 
might get played at 11,025 Hz instead. This will cause the pitch to be lower and the playback time 
slower than it should be. The Microsoft Windows Sound System Version 2.0 and many 'compatible' 
sound cards contain this unfortunate bug.

Contact your sound card manufacturer for updated drivers.

                                                         
See also
Troubleshooting 



Q: When making a selection with the mouse, why does it change to another location?

A: If you have the Snap to Zero Crossings    or Snap to Time  option on (Options menu), the selection 
points will be automatically moved to the nearest zero crossing or time unit.    If you turn both of these 
options off, selections made will not be modified by Sound Forge.

                                                         
See also
Troubleshooting 



Q: Microsoft ADPCM files created using Sound Forge crash when I play them in Media Player on 
my Turtle Beach sound card. Why?

A: Turtle Beach has implemented the Microsoft ADPCM format in the DSP of their audio cards. 
Depending on the version of the drivers you are using, you may crash when playing files created in 
Sound Forge on these cards.

This is a bug in the Turtle Beach drivers. Contact Turtle Beach for updated drivers.

                                                         
See also
Troubleshooting 



Q: When opening an AVI file, if the audio stream format is 44.1 kHz stereo file Microsoft or IMA 
ADPCM, the audio track does not    open correctly.

A: This is due to a known bug in Video for Windows. It only happens if the file is both 44.1 kHz, stereo, 
and compressed using Microsoft ADPCM. To get around this problem, resample the audio to 22 kHz 
before saving.

                                                         
See also
Troubleshooting 



Q: After installing the Sonic Foundry Virtual MIDI Router in Windows 95, my system is having 
trouble with MIDI devices or the VMR.

A: If you have a large number of MIDI devices in your system or a multi-port MIDI board, such as an 
eight port MIDI interface, you may have problems installing additional VMR MIDI interface ports. 
Windows 95 has a limit on the number of MIDI devices which it can support. If you have 12 or more 
MIDI ports, you will likely crash while booting up Windows 95. If you have trouble with MIDI devices 
causing system errors after installing the VMR, you should either reduce the number of ports in use 
by the VMR, remove the VMR, or reduce the number of MIDI devices in your system.

                                                         
See also
Troubleshooting 



Q: When I play a sound file, I sometimes hear a click at the beginning or end of the selection.

A: If you hear a click during playback start or stop, the first thing to check is whether there is a waveform 
glitch or sudden spike at either end of your selection (or file). Zoom In Full and ensure that the 
selection start and end points are located in complete silence and no glitches exist.

If you're certain that the selection endpoints contain no audio but still hear a pop, the most likely 
culprit is your sound card's software driver. We have found that some versions of several sound 
card's drivers cause random glitching when starting or stopping playback.

Sound Forge has been tested with many different sound cards by thousands of users, and we are 
very confident in its correct implementation of standard Windows audio functions. Almost all of the 
technical support calls we receive are due to hardware conflicts or poorly written sound card drivers. If
you experience any sound recording or playback problems, follow these steps:

1. Ensure that you are using unique interrupts (IRQs) and DMA channels between all of your 
hardware.
2. Try playing the sound file with Media Player (mplayer.exe or mplayer32.exe), which is included with
Windows 3.x, 95 and NT. If the playback glitching exists with Media Player also, there is definitely a 
problem with the sound card hardware or driver.
3. Contact your sound card manufacturer and request for the latest drivers for your sound card.

                                                         
See also
Troubleshooting 
Hear clicks during playback, Q&A 



Q: While drawing the Waveform Display, my system locks up completely.
A: If you experience a system lockup frequently in Sound Forge, it is likely that your video card is 

causing this problem. This problem is known to happen with ATI's Mach64 card when using High 
Color (16-bit) in Windows 95.

Because Sound Forge's drawing routines are highly optimized, they increase the chance of causing 
little-known video card problems to arise. To solve this problem, turn on Compatible Draw Mode (for 
Broken Video Drivers) under the General Preferences (Options menu).

                                                         
See also
Troubleshooting 
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ADPCM
Adaptive Delta Pulse Code Modulation (ADPCM) is a method of compression audio data. Although the 
theory for compression using ADPCM is standard, there are many different algorithms employed. As an 
example, Microsofts ADPCM algorithm is not compatible with the International Multimedia Associations 
(IMA) approved ADPCM.



A-Law
A-Law is a companded compression algorithm for voice signals defined by the Geneva 
Recommendations (G.711). The G.711 recommendation defines A-Law as a method of encoding 16-bit 
PCM signals into a non-linear 8-bit format. The algorithm is commonly used in United States 
telecommunications. A-Law is very similar to µ-Law, however, each uses a slightly different coder and 
decoder.



Aliasing
Aliasing is a type of distortion that occurs when digitally recording high frequencies with a low sample 
rate. For example, in a motion picture, when a car's wheels appear to slowly spin backwards while the car
is quickly moving forward you are seeing the effects of aliasing. Similarly when you try to record a 
frequency greater than one half of the sampling rate (the Nyquist Frequency), instead of hearing a high 
pitch you may hear a low frequency rumble.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the 
sound has been recorded, aliasing distortion is impossible to remove without also removing other 
frequencies from the sound.



Amplitude Modulation
Amplitude Modulation (AM) is a process whereby the amplitude (loudness) of a sound is varied over time.
When varied slowly, a tremolo effect occurs. If the frequency of modulation is high, many side frequencies
are created which can strongly alter the timbre of a sound.



Attack
The attack of a sound is the initial portion of the sound. Percussive sounds (like drums, piano, guitar 
plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a 
very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a 
slow attack.



Audio Compression Manager (ACM)
The Audio Compression Manager (ACM) from Microsoft is a standard interface for audio compression 
and signal processing for Windows. The ACM can be used by Windows programs to compress and 
decompress WAV files, as well as apply DSP algorithms to audio data.



Audio Event Locator
The Audio Event Locator is similar to a scrub function. However, rather than playing the sound file at a 
slow speed, it loops playback around the cursor position. This position can be selected by dragging the 
cursor around in the Sound Forge overview window.



Bit
A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a 
voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an 
example, the 8 bit binary number 10011010 represents the unsigned value of 154 in the decimal system. 
In digital sampling, a binary number is used to store individual sound levels, called samples.



Bit Depth
Bit Depth refers to the number of bits used to represent a sample. For example 8 bit and 16 bit are two 
common Bit Depths. Sound Forge uses the term Sample Size when referring to Bit Depth.



Byte
A byte refers to a set of 8 bits. An 8 bit sample requires one byte of memory to store, while a 16 bit 
sample takes two bytes of memory to store.



Channel Converter
The Channel Converter is a function in Sound Forge that converts files from mono to stereo and stereo to 
mono with independent level control of the new channels. This function can also create interesting effects 
by converting stereo files to stereo with various levels and inversion of channels.



Chorus
Chorusing is an effect created by combining a signal with a modulating delayed copy of itself. This effect 
creates the illusion of multiple sources creating the same sound. 



Clipboard
The clipboard is where sample data is saved when you cut it from a sample so that you may past it or mix
it into another sample.    Sound Forge maintains it's own clipboard for cutting and pasting sample data 
allowing you to keep memory usage to a minimum.    However, this does not change the normal operation 
of the clipboard and you can still cut and paste between Sound Forge and other Windows applications.



Clipping
Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In 
digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16 bit 
data. Clipping causes sound to distort.



Cutoff-frequency
The cutoff-frequency of a filter is the frequency at which the filter changes its response. For example, in a 
lowpass filter, frequencies greater than the cutoff frequency are attenuated while frequencies less than 
the cutoff frequency are not affected.



CODEC
Acronym for Coder/Decoder. Commonly used when working with data compression.



Crossfade Loop
Sometimes a sample loop cannot be easily created from the given source material. In these instances a 
crossfade can be applied to the beginning and end of the loop to aid in the smooth transition between the 
two. The Crossfade Loop function provides a method of creating sampling loops in material that is 
otherwise difficult to loop.



Data Window
Each opened sound file in Sound Forge has its own Data Window. On top of each Data Window is a Title 
Bar displaying either the title of the sample or the name of the file. Also in each Data Window are the 
Waveform Display, Ruler, Playbar and other tools that give you information and allow you to navigate 
throughout the entire sound file.



DC Offset
DC Offset is phenomenon that occurs when hardware such as a sound card adds DC current to a 
recorded audio signal. This current causes the audio signal to alternate around a point above or below the
normal -infinity dB (center) line in the sound file. To visually see if you have a DC offset present you can 
zoom all the way into a sound file and see if it appears to be floating over the center line. Sound Forge 
can compensate for this DC offset by adding a constant value to the samples in the sound file.



Decibel
The decibel (abbreviated as dB) is a unit used to represent a ratio between two numbers using a 
logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times 
greater than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we pull that 
6 dB from? Engineers use the equation dB = 20 x log (V1/V2) when comparing two instantaneous values.
Decibels are commonly used when dealing with sound because the ear perceives loudness in a 
logarithmic scale.
In Sound Forge, most measurements are given in decibels. For example, if you want to double the 
amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value 
for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a sample value of 16,384 can be 
referred to having a value of -6 dB.



Destructive Editing
Destructive editing is the type of editing whereby all cuts, deletes, mixes and other processes are actually 
processed to the sound file. Anytime you delete a section of a sound file in Sound Forge the sound file on 
disk is actually re-written without the deleted section. This is different than non-destructive editing. See 
Non-destructive Editing.



Direct Edit Mode
Opening a file from the Open dialog with the Operate directly on the sound file box checked, opens the 
file in direct edit mode. This simply means that no temporary file is created for the file. The first time you 
open a file in direct edit mode, a peak data file will be created and stored in the directory that the file 
resides. From then on opening and saving the file will be almost instantaneous regardless of the size of 
the file. Please note, however, that any edits you make to the file are actually changing the file. With the 
unlimited Undo capability of Sound Forge this shouldnt be a problem, but keep in mind that if the system 
crashes for any reason, the file will be saved in the state that it is in when it crashes and no undo will be 
available.



Device Driver
A Device Driver is a program that allows Windows or DOS to connect different hardware and software 
together. For example, a sound card device driver is used by Windows software to control sound card 
recording and playback.



Digital Signal Processing
Digital Signal Processing (DSP) is a very general term describing anything that alters digital data. Signal 
processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the 
analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a 
combination of programming and mathematical techniques. DSP techniques are used to perform many 
effects such as equalization and reverb simulation.

Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your 
computer's processor and specialized DSP chips can be used to perform any DSP operation. The 
difference is that DSP chips are optimized specifically for mathematical functions while your computer's 
microprocessor is not. This results in a difference in processing speed.



Drag-and-Drop
Drag-and-Drop is a quick way to perform certain operations using the mouse in Sound Forge. To Drag-
and-Drop, you click and hold a highlighted selection, drag it (hold the left-mouse button down and move 
the mouse) and drop it (let go of the mouse button) at another position on the screen. For more 
information on where you can use Drag-and-Drop, look in Appendix A: Shortcuts.



Dynamic Range
Dynamic Range is the difference between the maximum and minimum signal levels. It can refer to a 
musical performance (high volume vs. low volume signals) or to electrical equipment (peak level before 
distortion vs. noise floor). For example, orchestral music has a wide dynamic range while thrash metal 
has a very small (always loud) range.



Equalization (EQ)
Equalizing a sound file is a process by which certain frequency bands are raised or lowered in level. EQ 
has various uses. The most common use for Sound Forge users is to simply adjust the subjective timbre 
of a sound.



File Associations
This dialog allows you to associate sound file extensions (such as .wav, .au, .snd, etc.) with Sound Forge.
This dialog is opened from the File page of the Preferences dialog.



File Format
A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows, the 
most common file format is the Microsoft WAV format. However, Sound Forge can read and write to many
other file formats so you can maintain compatibility with other software and hardware configurations.



Frequency Modulation
Frequency Modulation (FM) is a process whereby the frequency (pitch) of a sound is varied over time. 
Slow frequency modulation results in pitch-bending effects. Fast frequency modulation creates many 
different side-band frequencies.



Frequency Spectrum
The Frequency Spectrum of a signal refers to its range of frequencies. In audio, the frequency range is 
basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these 
frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz - 200
Hz) of the spectrum.



Insertion Point
The Insertion Point is like the cursor in a word processor.    It is where pasted data will be placed or other 
data may be inserted depending on the operation.    The Insertion Point appears as a vertical flashing 
black line and can be moved by clicking the left mouse button any where in the data window.



MCI
The Media Control Interface (MCI) is a standard way for Windows programs to communicate with 
multimedia devices like sound cards and CD players. If a device has a MCI device driver, it can be easily 
controlled by most multimedia Windows software.



Media Player
Media Player is a Windows 3.1 program that can play digital sounds or videos using MCI devices. Media 
Player is useful for testing your sound card setup. For example, if you can't hear a sound play through 
your sound card in Sound Forge, try using Media Player. If you can't play the sound using Media Player, 
check the sound card's manual (do not call Sonic Foundry's Technical Support until you've called the 
sound card manufacturer).



MIDI
Musical Instrument Device Interface (MIDI) is a standardized way for music equipment to communicate. 
Technically, it is a serial communications protocol using a 31.25 kHz baud rate.    MIDI is used to send 
control, timing, and data information between devices for things like triggering notes, time 
synchronization, and sample dumps.



Noise-shaping
Noise-shaping is a technique which can minimize the audibility of quantization noise by shifting its 
frequency spectrum. For example, in 44,100 Hz audio quantization noise is shifted towards the Nyquist 
Frequency of 22,050 Hz.



Non-Destructive Editing
This type of editing involves a pointer-based system of keeping track of edits. When you delete a section 
of audio in a non-destructive system the audio on disk is not actually deleted. Instead, a set of pointers is 
established to tell the program to skip the deleted section during playback. Sound Forge is a destructive 
editor except for when using the playlist.



Normalize
To normalize a file means to raise its volume so that the highest level sample in the file reaches a user 
defined level. Use this function to make sure you are fully utilizing the dynamic range available to you. 
Sound Forge also allows normalization to RMS power. This means that a scan will be done on the sound 
file and it will be raised in level so its RMS power will be equal to the normalization level. This is helpful for
making multiple files perceptually as loud as each other.



MTC
MIDI Time Code (MTC) is an addendum to the MIDI 1.0 Specification and provides a way to specify 
absolute time for synchronizing MIDI capable applications.



Nyquist Frequency
The Nyquist Frequency (or Nyquist Rate) is one half of the sample rate and represents the highest 
frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist 
Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz will produce aliasing 
distortion in the sample if no anti-aliasing filter is used while recording.



Overview
The Overview is the area on the Data Window directly under the Title Bar. The entire length of the 
Overview represents the entire sound file. Cursor, selection, and position information is shown relative to 
the entire length of the sound file.



Peak Data File
A peak data file is what is created by Sound Forge when a file is opened in direct edit mode for the first 
time. This file stores the information regarding the graphic display of the waveform so that opening a file is
almost instantaneous in direct edit mode. This file is stored in the directory that the file resides in and has 
a .sfk extension. If this file is not in the same directory as the file, or is deleted, it will be recalculated the 
next time you open the file in direct mode.



Playbar
The Playbar is the bar at the bottom of each Data Window.    On the left of the Playbar are the following 
buttons: Go To Start, Go To End, Stop, Play Normal, Play Loop, Play Sample.    On the right are the 
Selection Status Fields which display the selection start, end, and length.



Quantization
Quantization is the process by which measurements are rounded to discrete values. Specifically with 
respect to audio, quantization is a function of the analog to digital conversion process. The continuous 
variation of the voltages of a analog audio signal are quantized to discrete amplitude values represented 
by digital, binary numbers. The number of bits available to describe these values determines the 
resolution or accuracy of quantization. For example, if you have 8-bit analog to digital converters, the 
varying analog voltage must be quantized to 1 of 256 discrete values; a 16-bit converter has 65,536 
values.



Quantization Noise
Quantization noise is a result of describing an analog signal in discrete digital terms (see quantization). 
This noise is most easily heard in low resolution digital sounds that have low bit depths and sounds like a 
shhhhh type sound while the audio is playing. It becomes more apparent when the signal is at low levels, 
such as when doing a fade out.



Reactive Preview
Reactive Previews allow for the tweaking of parameters in a function dialog while the preview is playing. 
When a parameter is changed the preview will automatically rebuild and continue playback.



Region
A region in Sound Forge is a subsection of a sound file. You can define any number of regions in a sound 
file which are stored in the Regions List.



Regions List
The Regions List is simply the list containing all of the regions and markers defined within the sound file. 
From this list you can preview and edit the regions as well as drag them to the Playlist or to the desktop to
create new files from them.



Resample
To resample means to recalculate samples in a sound file at a different rate than the file was originally 
recorded. If a sample is resampled at a lower rate, sample points are removed from the sound file 
decreasing its size, but also decreasing its available frequency range. Resampling to a higher sample 
rate, Sound Forge will interpolate extra sample points in the sound file. This increases the size of the 
sound file but does not increase the quality. When down-sampling one must be aware of aliasing. See 
Aliasing. 



Root Mean Square
The Root Mean Square (RMS) of a sound is a measurement of the intensity of the sound over a period of 
time. The RMS power of a sound corresponds to the loudness perceived by a listener when measured 
over small chunks of time.



Ruler, Time
The Time Ruler is the area on a data window above the waveform display. It shows the horizontal axis 
units as well as marker, region, and loop tags.



Ruler, Level
The Level Ruler is the area on a data window to the left of the waveform display. It shows the vertical axis
units as either percents or dBs.



Ruler Tags
Ruler Tags are the icons on the Ruler which represent the location of Markers, Regions, and Loop points 
in the Waveform Display.



Sample Dump
A Sample Dump is the process of transferring sample data between music equipment. Because of the 
large amounts of data required to store digital sound, sample dumps may take a very long time when 
using the MIDI Sample Dump Standard (SDS). However, when using the faster SCSI MIDI Device 
Interface (SMDI) protocol, sample dumps can be performed many times faster.



SDS
The MIDI Sample Dump Standard (SDS) is a way to transfer samples between music equipment. 
Samples transferred with SDS are sent across MIDI cables at the MIDI data rate of 31.25 kHz baud. The 
slow data rate of MIDI makes SDS a painful experience when transferring large samples. SMDI is a much
preferred sample transfer method for musicians.



Sample
The word sample is used in many different (and often confusing) ways when talking about digital sound. 
Here are some of the different meanings:

¨ A discrete point in time which a sound signal is divided into when digitizing. For example, an audio 
CD-ROM contains 44,100 samples per second. Each sample is really only a number which contains
the amplitude value of a waveform measured over time.

¨ A sound which has been recorded in a digital format; used by musicians who make short recordings
of musical instruments to be used for composition and performance of music or sound effects. 
These recordings are called samples. In this manual, we try to use sound file instead of sample 
whenever referring to a digital recording.

¨ The act of recording sound digitally, i.e. to sample an instrument means to digitize and store it.



Sampled Sound
Sampled sounds are sounds which have been recorded in a digital format and saved on your system for 
playback through a sound board. A sampled sound is sometimes referred to as a sample. However, a 
sample can also refer to a single point in a sampled sound.



Sampler
A sampler is a device that records sounds digitally. Although, in theory, your sound card is a sampler, the 
term usually refers to a device used to trigger and playback samples while changing the sample pitch.



Sample Rate
The Sample Rate (also referred to as the Sampling Rate or Sampling Frequency) is the number of 
samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity 
than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher
sample rates.



Sample Size
The Sample Size, or Bit Depth,    refers to the number of bits used to represent a single sample. Sound 
Forge uses either 8 or 16 bit samples. While 8 bit samples take up less memory (and hard disk space), 
they are inherently noisier than 16 bit samples.



Shortcut Menu
A Shortcut menu, also called a Shortcut menu, is a context sensitive menu which appears when you click 
on certain areas of the screen. The functions available in the Shortcut menu depend on the object being 
clicked on as well as the state of the program. As with any menu, you can select an item from the 
Shortcut menu to perform an operation. Shortcut menus are used frequently in Sound Forge for quick 
access to many commands. An example of a Shortcut menu can be found by right clicking on any 
Waveform Display in a Data Window.



Sign-Bit
Data that has positive and negative values and uses zero to represent silence. Unlike the Signed format, 
twos complement is not used. Instead, negative values are represented by setting the highest bit of the 
binary number to one without complementing all other bits. This is a format option when opening and 
saving RAW sound files.



Signed
Data that has positive and negative values and uses zero to represent silence. This is a format option 
when opening and saving RAW sound files.



SMDI
SCSI MIDI Device Interface (SMDI) is a standardized protocol for music equipment to communicate. 
Instead of using the slower standard MIDI serial protocol, it uses a SCSI bus for transferring information. 
Because of its speed, SMDI is often used for sample dumps.



SMPTE
The Society of Motion Picture and Television Engineers time code.    This code is used to synchronize 
time between devices.    The time code is calculated in Hours:Minutes:Second:Frames, where Frames are
1/30 of a second.



Status Bar
The Status Bar is the bar at the bottom of the Sound Forge main screen.    The Status Bar fields on the 
right of the Status Bar contain information about the active Data Window (Sample Rate, Sample Size, 
Stereo/Mono, Total Size).    On the right side of the Status Bar, help and processing information is 
displayed.



Tempo
Tempo is the rhythmic rate of a musical composition, usually specified in Beats Per Minute (BPM).



u-Law
u-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva 
Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit 
PCM signals into a non-linear 8-bit format. The algorithm is commonly used in European and Asian 
telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and 
decoder.



Unsigned
Data that has only positive values and uses half the maximum value to represent silence. This is a format 
option when opening and saving RAW sound files.



Video for Windows (AVI)
AVI files are a format of digital video for Windows. Sound Forge allows you to open these files and edit 
the audio embedded within them.



Virtual MIDI Router (VMR)
A Virtual MIDI Router (VMR) is a software only router for MIDI data between programs. No MIDI hardware
or cables are required for a VMR, so routing can only be performed between programs running on the 
same PC. A VMR is normally used to synchronize two MIDI capable programs (for example, a VMR 
allows Sound Forge to drive a sequencer with SMPTE/MTC). Sonic Foundry supplies a VMR with Sound 
Forge called the Sonic Foundry Virtual MIDI Router.



Waveform
A Waveform is the visual representation of wave-like phenomena, such as sound or light. For example, 
when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth 
waveform. The Waveform Display in each Data Window represents exactly this.



Waveform Display
The Waveform Display is the part of the Data Window which shows a graph of the sound data waveform. 
The vertical axis corresponds to the amplitude of the wave. For 16 bit sounds, the amplitude range is -
32,768 to +32,767. For 8 bit sounds, the range is -128 to +127. The horizontal axis corresponds to time, 
with the left most point being the start of the waveform. In memory, the horizontal axis corresponds to the 
number of samples from the start of the sound file.



Zero Crossing
A Zero-Crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits 
at zero crossings with the same slope, the chance of creating glitches is minimized.



Zipper noise
Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain 
does not change in small enough increments, zipper noise can become very noticeable. Sound Forge's 
fades are accomplished using 64-bit arithmetic, thereby creating no audible zipper noise.
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Introduction
Without the convenience of a large computer monitor, an advanced operating system like Windows, and 
an intuitive interface, working with samples can be a nightmare. With the Sampler Tool, you can use 
Sound Forge's powerful and easy-to-use sample editing capabilities to create and edit samples and then 
transfer them to your external and internal samplers.
This chapter provides all the information you need to transfer (dump) samples between your computer 
and sampler using the Sound Forge Sampler Tool. In addition, we have included a section titled Tips and 
Ideas that may stir up some new, and perhaps unconventional, ways of using your sampler.
The documentation that came with your sampler undoubtedly has insights on sampling and loop tuning as
well, so you might want to find it, dust it off, and browse through it. Many of these manuals can be very 
useful when you read them. 
External Samplers
The MIDI SDS is used to send and receive digital samples with your normal MIDI hardware and cable 
connections. Because of the limited bandwidth of the MIDI protocol and the large amounts of data needed
to store digital samples, performing a sample dump using the normal MIDI SDS can be slow, often taking 
minutes to transfer short samples. SDS is also limited to mono-only samples, though some samplers 
allow you to combine two mono samples to create a single stereo sample.
¨ MIDI Sample Dump Standard (SDS): The MIDI Sample Dump Standard (SDS) is used to send and 

receive digital samples with your normal MIDI hardware and cable connections. Because of the 
limited bandwidth of the MIDI protocol and the large amounts of data needed to store digital samples, 
performing a sample dump using the normal MIDI Sample Dump Standard (SDS) can be    slow, often
taking minutes to transfer short samples. SDS is also limited to mono only samples, though some 
samplers allow you to combine two mono samples to create a single stereo sample.

¨ SCSI MIDI Device Interface (SMDI): The SCSI MIDI Device Interface (SMDI) is a relatively new 
standard for music hardware and software to communicate using SCSI hardware and cables. 
Because SCSI hardware has a much larger bandwidth than MIDI, SMDI sample dumps are many 
times faster than SDS dumps. Another advantage to using SMDI is that it supports mono and stereo 
sample dumps (unlike SDS).

Internal Samplers
Internal samplers are cards that are installed inside of your computer. Unlike most sound cards, internal 
samplers allow you to download your own sounds into the card's memory. These sounds can then be 
played at different pitches for use as a musical instrument, just like an external sampler.
The Sampler Tool currently supports only one internal sampler, the Digidesign SampleCell II. Refer to the 
SampleCell II documentation for installation instructions. Once installed, use the procedures outlined in 
the section labeled Digidesign SampleCell II - Sample transfer procedures.
Internal samplers that are not directly supported by the Sampler Tool could use the MIDI Sample Dump 
Standard (SDS). Though no Windows compatible samplers support SDS (that we know of), it would be 
very simple for a manufacturer to implement this feature. If nothing else, SDS could be supported using 
an Open Loop transfer which would eliminate the complexity of supplying an input device. Open Loop 
would also make it possible for an internal sampler to accept data at far greater speeds than MIDI 
normally allows.
If you own a Windows compatible internal sampler, you may want to contact the manufacturer about 
supporting SDS in their Windows drivers. SDS may not be the best solution, but it is far better than no 
solution.
Sampler Hardware Setup
If you do not have your sampler and MIDI or SCSI card set up for transferring samples, you should refer 
to the MIDI/SDS Setup and Troubleshooting or SCSI/SMDI Setup and Troubleshooting chapters in 
this manual. These chapters will help you install the necessary components for transferring samples using
the Sample Tool. There are also suggestions for trouble shooting problematic hardware configurations.
                                                         
See also
Using the Sampler Tool





Configuring the Sampler Tool
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See also
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Creating a Sampler configuration
After you have your sampler hardware installed and functioning correctly, you must configure the Sampler
Tool for sending and receiving samples from your sampler. 

If you do not have your sampler and MIDI or SCSI card set up for transferring samples,
you should refer to the MIDI/SDS Setup and Troubleshooting or SCSI/SMDI Setup and
Troubleshooting later in this chapter. This information will help you install the necessary

components for transferring samples using the Sampler Tool. There are also suggestions
for troubleshooting problematic hardware configurations.

Select Sampler from the Tools menu and click the Configure button. Note that you must have at least one 
data window open to access the Tools menu. The Sampler Configuration dialog lets you select your 
sampler and sample transfer mode for both sending and receiving. The most common configuration is to 
have both the send and receive sampler and transfer mode the same. This is not a requirement, however,
and there are situations where differing send and receive setups can be useful. One example of this might
be if you want to transfer samples from one sampler to another with editing in between. Multiple 
configurations can be saved as presets to match different scenarios.
The first step to configuring your sampler setup is to choose the sampler and transfer mode (MIDI/SDS or
SCSI/SMDI) from the Send to and Receive from drop-down lists. Several samplers and transfer modes 
are listed by name in these lists. For example, Peavey SP (SCSI/SMDI) specifies a Peavey SP 
SCSI/SMDI transfer protocol. If your sampler is listed, select it from the list.
If your sampler is not listed in the Send to and Receive from drop-down lists, try using the Generic 
(SCSI/SMDI) or Generic (MIDI/SDS) options. As long as your sampler properly supports the transfer 
mode (protocol) you select, the Sampler Tool should be able to work with your sampler. If you have 
trouble and you are certain your sampler is properly set to send or receive samples, contact your 
sampler's manufacturer. They may have an updated ROM available to correct the problem.
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Internal sampler configuration options
Currently, only the Digidesign SampleCell II internal sampler is directly supported by the Sampler Tool. If 
you have a SampleCell II and you have selected it as the Send to sampler, then there are no further 
configuration options. A complete discussion on the SampleCell II can be found in the Appendix section 
on Sample Transfer Procedures for Digidesign SampleCell II.

The SampleCell II is only available for the Send to option; you cannot receive samples
from the SampleCell II. 
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MIDI/SDS configuration options
If you choose a sampler that uses the MIDI/SDS transfer protocol in the Send to or Receive from drop-
down lists, then you need to specify a few more options. These options include the MIDI input and MIDI 
output ports, the MIDI channel to transfer on, and whether handshaking should be used. You can also 
configure how a transfer will be initiated if handshaking is enabled. These options are discussed in detail 
below.
MIDI Input and Output Ports
Select the MIDI input and MIDI output ports that are connected to your sampler from the drop-down lists. 
If Open loop (discussed later) is being used for sending samples, then the MIDI input port can optionally 
be set to (None). If Open loop is being used for receiving samples, then the MIDI output port can 
optionally be set to (None). If Open loop is not being used, then you must supply both a MIDI input and 
MIDI output port.
The MIDI Channel
Now select the MIDI channel to use when transferring samples. This channel must match the channel 
configured in your sampler for SDS transfers. 

A channel must be specified even if the sampler is set to Omni (any channel) mode.
Handshaking
The last few options determine how the sampler and the Sampler Tool interact while transferring samples.
These options are Wait for request (send) and Open loop or Send request (receive) and Open Loop.
Open loop is a term used to describe a unidirectional communication protocol      much like a one-sided 
conversation. When the Open loop option is enabled, the data source will send all data to the destination 
without listening for directions from the destination. The destination has no control over how the data is 
sent and cannot ask for information to be repeated. This lack of communication makes open loop 
transfers prone to errors.
If the Open loop option is not enabled, we refer to the communication protocol as closed loop. A closed 
loop allows information to flow in both directions; the two communicators are said to be handshaking 
because they both agree on how and when data is transferred. When using closed loop transfers, the 
data is sent from the source in small packets (one packet at a time). The destination receives the packet 
and keeps the data if it is valid or discards the packet and asks for the data to be re-sent. The source will 
not send the next packet until the destination asks for it. This form of communication makes closed loop 
transfers much more reliable than open loop transfers.
It should be noted that open loop transfers are not only more prone to errors, but they can be slower than 
closed loop transfers, especially when sending samples with the Sampler Tool. The reason for this is due 
to intentional delays placed between data packets. These small delays allow slow samplers to keep up 
with the data being sent, and since these delays are not fine-tuned to exact requirements for the sampler, 
idle time is bound to occur. A closed loop transfer guarantees the most efficient timing between packets 
making transfers faster than open loop transfers.

Beware of using the Open loop option to receive samples from a sampler. Since the
Sampler Tool cannot control the flow of data packets being sent, there is a high

probability that data will be missed. Using Closed Loop transfers guarantees that no
packets will be missed.

You may be asking why Open loop is an option if it is so unreliable. Good question. The answer is that 
there are cases when using Open loop is either necessary or more convenient than using closed loop. If a
sampler does not support closed loop (handshaking), then you must use Open loop for transfers. You 
may also want to enable Open loop if you are out of MIDI cables or are having problems with a MIDI port. 
See the section titled MIDI/SDS Requirements and Troubleshooting for further details on open loop 
transfers.
If you choose to use the recommended closed loop transfer, then you also have the option of determining 
how a sample transfer is initiated. For sending samples, you can specify that the Sampler Tool should 
wait for the sampler to request the sample transfer before sending the sample by enabling the Wait for 
request option. This means that the Sampler Tool will not send the sample (after you press Send Sample)



until the sampler requests the sample to be sent. This usually requires you to press a button on the 
sampler to start the transfer.
For receiving samples, you can specify that the Sampler Tool should send a request to the sampler 
asking for a sample to be sent by enabling the Send request option. This means that the Sampler Tool will
send a request for the specified sample to the sampler as soon as you press Get Sample. If you do not 
enable the Send request option, you must initiate the sample transfer from the sampler after you press 
Get Sample.
Typical Setup for MIDI/SDS Transfers
Send to Configuration (typical)
Connect and select a MIDI input and MIDI output device. Use your preferred MIDI channel. Disable Open 
loop. Disable Wait for request.
Receive from Configuration (typical)
Connect and select a MIDI input and MIDI output device. Use your preferred MIDI channel. Disable Open 
loop. Enable Send request.
The Sample bias fields will be discussed in the Selecting a Sample Bias for your Sampler section later in 
this chapter.
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SCSI/SMDI configuration options
If you choose a sampler that uses the SCSI/SMDI transfer protocol in the Send to or Receive from drop-
down lists, then you need to specify two other options. These options are the SCSI host and SCSI 
sampler.
The SCSI host drop-down list contains all Sampler Tool compatible SCSI cards found on your computer. 
You need to select the SCSI card that is connected to your sampler from this list. Note that most 
computers will have only one SCSI card listed.
Once you have selected the SCSI host, the SCSI sampler list will contain all SCSI devices connected to 
that host. Select your sampler from this list (the number preceding the device name is its SCSI ID). 
Depending on your SCSI setup, you may notice that hard drives, CD-ROM's and other SCSI devices are 
listed along with your sampler. This is to help troubleshoot SCSI ID conflicts should one occur. If you 
accidentally select a device other than a sampler, no harm is done. However, a message box will be 
displayed stating the problem if you try to send or receive samples from any device other than a sampler.
If your SCSI card or sampler does not show up in the SCSI host or SCSI sampler drop-down lists, refer to
the section titled SCSI/SMDI Requirements and Troubleshooting to determine the cause. The problem 
may be as simple as turning on your computer and sampler in the wrong order. It may also be that your 
SCSI card is not compatible with the Sampler Tool or your SCSI card and sampler are installed 
incorrectly.
The above picture shows a typical configuration for the Kurzweil K2000 (SCSI/SMDI) transfers. The fields 
that are grayed are for MIDI/SDS transfers only.

See also
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Selecting a Sample Bias for your Sampler
Those of you that have worked with samplers from different manufacturers know that the sample 
numbering scheme can vary dramatically between samplers. In an effort to simplify the confusion caused 
by working with different samplers, the Sampler Tool lets you specify a sample bias. A sample bias is 
simply a value that gets added to the logical sample number to derive the actual sample number used for 
sending or receiving. Don't panic, we'll explain everything.
When you want to send or receive a sample from a sampler, you must specify a sample number which is 
the location that the sample is stored within the sampler. This is pretty simple. However, not all samplers 
allow you to use any sample number for storing and retrieving samples. 
Samplers that have factory-defined samples burned into their ROMs usually define a range of sample 
numbers for these samples. This range cannot be used to store and retrieve your own samples. These 
samplers will define one or more sample number ranges that are available for your own samples. For 
example, the Kurzweil K2000 uses sample numbers 1 though 199 as factory-defined samples and does 
not allow access to sample number zero. Sample numbers 200 through 999 are available for user-defined
samples. Also note that a sample number of 200 specified in the Sampler Tool actually addresses sample
number 201 on the Kurzweil K2000. (Confusing, isn't it?)
The Akai S1000, on the other hand, uses sample numbers 0 through 3 to store its factory-defined 
samples. Sample numbers above 3 are available for user-defined samples. And the list of inconsistencies 
goes on and on.
Wouldn't it be nice if you could simply use sample numbers 0 through n for your samples no matter what 
sampler you are using? This is what the Sample bias allows you to do. Once you figure out what sample 
number range is available for your custom samples, and determine whether the sampler counts in the 
same manner as the Sampler Tool, you can enter the sample bias and forget about it.
For the above examples, a sample bias of 199 works perfectly for the Kurzweil K2000 (remember it adds 
one, so sample number 199 actually addresses sample number 200), and a sample bias of 4 makes the 
Akai S1000 a bit easier to manage. Once you have entered the sample bias for your sampler, you can 
use sample numbers 0 through n as the Logical    send/receive sample number and the Sampler Tool will 
convert it to the Actual send/receive sample number automatically.
You can also use the sample bias to define different bases for multiple projects on which you are working.
For example, if you are composing two different pieces that use different samples, you might want to 
create a sampler configuration for each of these projects (see the Saving Sampler Configurations section 
below). Within each configuration, you can define a different sample bias to keep your samples separated
in the same sampler.
If you are still a little fuzzy on how the Sample bias option works, don't sweat it. As soon as you use it 
once or twice, it'll become old hat. Try different bias values to see what happens (do this before you start 
working on a critical project). The worst that can happen is you will overwrite a sample that you didn't 
mean to, and all writeable samples should be restorable from your disks. The section titled Sending and 
Receiving Samples also contains more information on using the Sample bias.
                                                         
See also
Using the Sampler Tool



Saving Sampler configurations
After filling in all options for a sampler configuration, you can save it as a preset by selecting the Save As 
button in the Sampler Configuration dialog. Type a descriptive name into the Save Preset dialog and 
press OK. Once a sampler configuration preset is saved, you can choose the configuration by name from 
the Sampler dialog.
The following picture shows a configuration being saved for the Kurzweil K2000 (SCSI/SMDI). Note that a
preset name can be anything you want, so use whatever names with which you are most comfortable.
You can create and save as many sampler configuration presets as you want. You might want to create 
configurations for all of your samplers and presets for specific projects you are working on. Having 
presets for each of your samplers and projects allows you to quickly switch back and forth without 
reconfiguring the Sampler Tool.
If you want to get rid of a preset, select it from the Name drop-down list at the top of the Sampler 
Configuration dialog and press the Delete button.
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Sending and Receiving Samples
Once your sampler setup is configured, you should be able to send and receive samples by using the 
Send Sample and Get Sample buttons in the Sampler dialog. Select the sampler you want to Send to or 
Receive from in the Configuration drop-down list, enter the sample number you want to transfer in the 
Logical send/receive sample number field, and press the Send Sample or Get Sample button.
Note that the Actual send sample number and Actual receive sample number are equal to the Logical 
send/receive sample number. This is because no sample bias is being used for this particular 
configuration.
Other areas of interest are the Send to and Receive from descriptions where all information relevant to 
the sampler configuration is printed. The fields on the bottom called MIDI unity note and Fine tune display 
the current values for the active sample. The C5 (60) displayed for the MIDI unity note represents that the
sample is tuned for Middle C. The Fine tune value is set to 0.0 cents, so no minor tuning differences exist.
These values are set using the Edit Sample command under the Special menu and may be used by 
samplers that support tuning information for samples. It is important to note that Sound Forge does not 
use this information, it is for samplers only.
As another example, the following picture shows a setup ready to send or receive sample number 199 
(which is really 200) from a Kurzweil K2000 using SCSI/SMDI through an Adaptec AHA SCSI card.
The most notable difference between this example and the previous one is the use of a Sample bias of 
199 for the send and receive sample numbers.
To send or receive a sample after selecting the sampler setup from the Configuration drop-down list, you 
need only press the Send Sample or Get Sample button. The transfer will begin and a Progress Meter will
be displayed in the status bar of Sound Forge. You can cancel a transfer at any time by pressing the 
Close button to the left of the Progress Meter or by pressing the Escape key.
Sending a sample will always send the entire contents of the active data window. Any selection contained 
in the waveform display is ignored. When receiving a sample, the entire contents of the active data 
window are replaced with the new sample data (a warning will be displayed before any data is replaced).
If you're having trouble, verify that the sampler is set up correctly for sending or receiving samples by 
referring to the sampler's documentation on sample dumps. For further information on using your sampler
with the Sampler Tool, refer to the Appendix at the end of this manual. These sections contain detailed 
information about several samplers that have been used successfully with the Sampler Tool. You may 
want to read some or all of these sections even if your sampler is not mentioned. There are tips you may 
find helpful when working with your sampler.
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MIDI/SDS hardware requirements and setup
To use the MIDI/SDS protocol with an external sampler that supports the MIDI Sample Dump Standard 
(SDS), you need a MIDI card (with MIDI input and output ports) installed in your computer.
Using MIDI cables, connect the MIDI out port of your sampler to the MIDI in port of the card and the MIDI 
in port of the sampler to the MIDI out port of the card. This is the same configuration you would use to 
connect a MIDI keyboard to your computer for sequencing.
Internal samplers do not require a MIDI card and MIDI cables. However, you may need to use open loop 
protocol when sending samples to an internal sampler. The documentation that comes with your sampler 
should specify the requirements for performing SDS transfers if it is supported.



MIDI/SDS troubleshooting
When using MIDI/SDS to send or receive samples, it is usually in your best interest to not use the Open 
loop option. The Open loop transfer is slower and has a much greater chance of sending or receiving 
incorrect data. Reasons for using Open loop are:

- Your sampler does not support closed loop transfers (handshaking).
- You don't have enough cables to connect both the MIDI in and MIDI out ports.
- Open loop can also help with troubleshooting SDS hardware setup problems. If you can't get the 
Sampler Tool to transfer data to (or from) your sampler, it may be helpful to try turning on the Open 
loop option to see if single cable transfers work. If open loop works but closed loop does not, you 
probably have one of the following problems.
- Your sampler does not support closed loop transfers (handshaking).
- Your MIDI cable or connection for MIDI input (send) or MIDI output (receive) to your computer is 
bad.
- Your MIDI card is not receiving MIDI input (send) or sending MIDI output (receive). Interrupt conflicts
are a common problem for MIDI input.
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SCSI/SMDI hardware requirements and setup
To use the SCSI/SMDI protocol with an external sampler that supports the SCSI MIDI Device Interface 
(SMDI) under Windows 3.x, you must have an ASPI compatible SCSI card for your machine as well as 
the WINASPI software provided by Adaptec. The best way to acquire this setup is to buy an Adaptec 
SCSI controller with the EZ-SCSI software. The EZ-SCSI software is required by the Sampler Tool for 
accessing your Adaptec SCSI card.

Windows 95 includes ASPI drivers, therefore you will only need a compatible SCSI
adapter.

If you own an older Adaptec card and it did not come with EZ-SCSI, you will need to contact your Adaptec
dealer for information on purchasing EZ-SCSI. You may also contact Adaptec Pre-Sales directly at 1 (800)
959-7274.
If you do not own a SCSI card and are looking for an inexpensive solution for transferring samples to your
SMDI compatible external sampler, the Adaptec AVA-1505 TotalCD kit is an excellent choice. This kit 
comes with EZ-SCSI Lite which provides everything you need for using the Sampler Tool with an external 
sampler (except a SCSI cable).
Cabling
To connect your SCSI card to your external sampler, you will need to use a SCSI cable. There are several
types of SCSI cables, so make sure you get the right one for your SCSI card and sampler.
There are three types of connectors found commonly on external SCSI cables. One type is the Centronics
50 pin. This connector is the beast of connectors and if you own an Adaptec card other than an AVA-1505 
or AVA-1515, this is probably the connector you will need to connect to your SCSI card. If you own an 
AVA-1505 or AVA-1515, the connector on your SCSI card is a DB-25 connector. This connector is a 25-
pin connector and looks like the connector found on serial and parallel cables. The DB-25 connector is 
most likely used by your sampler as well. The third type of connector is the SCSI-2 type connector that is 
used with the popular Adaptec 2940 series of PCI SCSI adapters. This connector looks similar to a DB-
25, but has smaller pins and many more of them.
If you are buying a cable to connect your sampler to your system, it is important that you get the 
terminology right when ordering. You will need to know the type of connector found on your SCSI adapter,
as well as the connector on the sampler itself. Most samplers have DB-25 connectors and most SCSI 
adapters these days use Centronics or SCSI-2 connectors. Determine what your system uses and order 
appropriately. 

Warning: Do not use a serial, modem, or printer cables to connect your SCSI devices.
You may damage your equipment by using these cables.

Once you have a SCSI card installed (refer to the card's manual for installation instructions), connect the 
card and the sampler's SCSI ports with a SCSI cable. Both your computer and your sampler must have 
the power turned off before connecting or disconnecting SCSI cables! Failing to turn the power off before 
connecting and disconnecting SCSI cables can damage your computer and/or hardware. SCSI 
connections are much more fragile than MIDI connections.
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SCSI/SMDI troubleshooting
The following is a list of common problems encountered with SCSI and samplers
Conflicting SCSI IDs
Occasional Transfer failures
Sampler is recognized but transfers are unreliable
Adaptec 1540/1542CF Doesn't Recognize a Sampler
SCSI/SMDI Menu Doesnt Show Under Windows 95 
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Conflicting SCSI ID's.
When connecting devices on a SCSI chain, each device must have a unique device identifier (ID). SCSI 
allows you to set up to eight unique ID values from 0 to 7. Typically device ID 7 is used for the internal 
SCSI controller card which leaves ID's 0 through 6 available for other devices. Also, if you have a 
bootable SCSI hard drive its ID must be set to 0.
Typical SCSI configuration:

ID Device
0 Hard Drive

1 CD-ROM Drive

2-6 Available for use by samplers

7 SCSI Controller Card
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Occasional Transfer Failures.
If you occasionally receive messages such as, The SCSI Device is not responding or A problem was 
encountered while transferring the sample, you may just have an upset SCSI bus. Try bringing up the 
Sampler Configuration dialog and reselecting your SCSI host from the drop-down list. Doing this causes a
series of SCSI commands to be executed that in many cases will settle an upset SCSI bus. If this fails to 
work, power down and restart all equipment (computer, samplers, etc.).
If the above mentioned messages are encountered frequently, you may have a more serious problem. 
The following section discusses several possibilities.
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The sampler is recognized but doesn't transfer reliably.
The following is a list of causes for unreliable SCSI transfers.
Synchronous Transfer Mode
Some samplers (like the Kurzweil K2000) do not operate properly if there is a SCSI device set to 
synchronous transfer mode on the same SCSI chain. SCSI hard drives and CD-ROMs often have the 
option of using a synchronous transfer mode. If there is a host vs. device synchronous transfer option, 
make sure you select host. Refer to your SCSI device manuals for more information.
SCSI Termination
If your SCSI chain is not properly terminated, you may experience unreliable SCSI transfers. Refer to 
your SCSI card and SCSI device manuals for more information.
Long or Cheap SCSI Cables
SCSI cables that are very long or not properly shielded can cause unreliable operation. Keep in mind that 
SCSI cables are not as forgiving as MIDI cables and overly long cables will not work reliably. Also beware 
of using cables that are not certified SCSI cables (such as tantalizingly cheap parallel printer cables); the 
extra money spent on a true shielded SCSI cable can save you endless hours of frustration.
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Adaptec 1540/1542CF Doesn't Recognize a Sampler
If you own the Adaptec 1540/1542CF (not the C version, the newer CF version) and it won't recognize 
your sampler you may need to make a change in the configuration of your Adaptec controller.
Some samplers do not want to operate when the Reset SCSI Bus at Power-On option of the Adaptec 
controller is enabled. This is the default operation for the 1540/1542CF and you will have to disable this 
option to allow your system to work with your sampler.
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Disabling the Reset SCSI Bus option

You should review your 1540/1542CF owners manual before proceeding with this
change.

1. Reset your machine by pressing the hardware reset button or turning the machine off and then 
back on.
2. While your system is booting it will display the message, Press Control+ A for the SCSISelect 
Utility. Press Control+A when this message appears.
3. The screen will display the main screen of the SCSISelect utility and show the current IO port in 
use by the SCSI card. Press Enter to proceed to the Options menu.
4. In the Options menu press Enter on the Configure/View Host Adapter Settings option to proceed to 
the Settings screen.
5. Move the cursor using the arrow keys until the Advanced Configurations Options item is selected. 
Press the Enter key to proceed to the Advanced Options screen.
6. Move the cursor using the arrow keys until the Reset SCSI Bus at Power-On option is selected. 
Press Enter to change this option.
7. Select the Disabled setting by moving the selection with the arrow keys, and then press Enter.
8. Press the Escape key twice to return to the previous screens.
9. Answer Yes to the Save Changes Made? prompt.
10. Press the Escape key again to exit the SCSISelect utility and answer Yes when the Exit Utility 
prompt is displayed.
11. SCSISelect will reboot your machine after you have made the changes.

Note: Disabling the Reset SCSI Bus at Power-On option may keep other devices on the
SCSI chain from resetting correctly when using the Soft Boot feature of your machine
(i.e. pressing Control+Alt+Del). On some systems this will cause the system to hang

when pressing Control+Alt+Del. To guarantee that devices are reset when rebooting with
this option disabled, you should use the Reset button on your computer or turn the power

off and back on to reset the machine.
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SCSI/SMDI Menu Doesn't Show Under Windows 95
The first thing to do is to check for correct SCSI termination and multiple devices on the SCSI chain using 
the same SCSI ID. If you've already done this and have an Adaptec SCSI card it is possible that you need
to update the mini-port drivers in your system.
Adaptec has a series of updated mini-port drivers available for Windows 95 on both CompuServe and on 
the world wide web.
To Find the Drivers on CompuServe

1. Log on to CompuServe and type in GO ADAPTEC. (With WinCIM press the GO button and type in 
ADAPTEC.)

2. In the library section labeled Windows 95 download the file WIN95MPD.EXE
To Find the Drivers on the Web

1. Go to the Adaptec site at http://www.adaptec.com.
2. Navigate to the support section which contains updated drivers or you can go directly to the files 
page at the web address http://www.adaptec.com/techsupp/BBS_95.html
3. Click on the file name WIN95MPD.EXE to download the updated driver package.
Updating Your Drivers
After you have downloaded the file WIN95MPD.EXE you need to create a temporary directory or folder on
your system and run the WIN95MPD.EXE program. This program is a self-extracting archive which 
creates a series of mini-port drivers (all identified by the extension .mpd) and a readme.txt file which 
explains how to install the new drivers.
Follow the directions in the readme.txt file to update your drivers for your Adaptec SCSI card.
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Sampler Tips and Ideas
Using FM synthesis with your sampler
Change the games but not the rules
Back-up and catalog your samples
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Using FM synthesis with your sampler
One nice use for the FM Synthesis Tool in Sound Forge is to Turn your sampler into an FM Synth! Well, 
not quite. This procedure will not turn your sampler into a true FM synthesizer, or at least the types that 
have become most familiar. While Sound Forge will produce four operator sounds, this is still sampling. To
get different pitches across the keyboard, the sampler will vary the sample rate of the original sample 
rather than produce a unique timbre based on the frequencies dictated by that pitch (key).
Also, any dynamic envelope and/or velocity control of the FM is not variable like that of true FM 
synthesizers. Nonetheless, sending samples to your sampler that were produced using the FM Synthesis
tool of Sound Forge can yield some very cool results. If you have a sampler with synthesis capabilities, 
this technique becomes quite powerful.

1. First, create a sample using the FM Synthesis tool found in the Tools menu. The sample can be 
rather short (0.2 - 1.0 sec) and it is probably a good idea to make sure that some portion of the 
envelope is static so that a good loop is easy to attain.

2. Once you have created the sample, create a sustaining loop and edit it with the Loop Tuner.
3. When you have your sample the way you want it, follow the sampler tool procedure to transfer 
the sample to your sampler.
4. From there any further manipulation will need to take place inside your sampler. That's about it! 
Simple but effective.
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Change the game but not the rules
It's easy to see that you can expand the processing power of a sampler by using Get Sample to retrieve 
a sample from the sampler, processing it with Sound Forge, and then using Send Sample to send the 
sample back to the same location in the sampler. This in itself is no mind blowing discovery. However, 
there may be some inspiring side effects waiting to be uncovered.
Most samplers will replace samples already in memory locations with new samples received from Sound 
Forge if the Logical send/receive sample number matches the original location. Other samplers will 
automatically put a received sample in an empty location regardless of the sampler number. The following
idea is only possible with a sampler that replaces a sample.
When the Kurzweil K2000 receives a sample via SCSI/SMDI, it will replace samples that have the same 
incoming send sample number (this is not true if you are using MIDI/SDS with the K2000). The interesting
part of this is all Keymaps that reference that sample location will remain intact even if the sample has 
been replaced with an entirely different one. This can lead to some very unique and sometimes spine 
tingling sounds.
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Back up and catalog your samples on your computer
Using the Sampler Tool, you can use your computer to store and catalog samples. Saving your samples 
as WAV files on your computer's hard drive or normal floppy disks allows you to store detailed Summary 
Information with each sample. Summary Information can include descriptive titles, subject details, general
comments, and more.
Unfortunately, Keymaps and other sampler specific information are not transferred from the sampler to 
the Sampler Tool, so none of it gets saved with WAV files. If this is the case with your sampler and you 
still want to save your samples as WAV files, you might be able to save Keymaps and other information 
without the sample data on a floppy disk. By saving this special information without the sample data (or a 
very small sample if the sampler requires it), you could store quite a few on a singly floppy disk. Later, the 
Keymaps can be recombined with the sample data stored on your computer.
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Akai S1000 - MIDI/SDS procedure
The S1000 is capable of sending and receiving samples via MIDI/SDS in all methods implemented by 
Sound Forge. Provided that your MIDI connections are correct, the S1000 is basically ready to receive or 
send a sample.
A few things to keep in mind:
¨ The S1000 structures its sample memory in such a way that the Logical send/receive sample 

number in Sound Forge can be a little confusing. The problem is that the S1000 will name the newly 
received sample according to the Logical send number specified in Sound Forge. However, in the 
S1000, a new sample is placed into the next available memory location, not the Logical send 
location.

¨ For example, if you send the S1000 a sample with a Logical send number of 0, send another 
with the Logical send number of 2, and then send yet another with the Logical send number of 1, the 
S1000 will now have three samples next to each other in memory, one named MIDI 0 another named 
MIDI 2 and another named MIDI 1. Now, if you wanted to use Sound Forge's Get Sample to retrieve 
these from the S1000, MIDI 0 would have to be referred to as Logical receive number 4, MIDI 2 would 
be Logical receive 5, and MIDI 1 would be referred to as Logical receive number 6. What's going on 
here?
¨ First of all, the S1000 has four waveforms permanently stored in memory location 0-3; sine, 
square, sawtooth, and pulse. The S1000 doesn't necessarily refer to these waveforms as being at these 
locations. We are referring to them as such because if you wanted to Get sample from Sound Forge, 
these are the Logical receive numbers you would use to get these waveforms. The S1000 is simply 
taking the Logical send number and using it as a naming convention for received samples. However, the 
Logical send number has no bearing on where it puts the sample.

When the S1000 receives a new sample from Sound Forge, it puts it into its next available memory 
location, deriving its name from the Logical send number. In our example, it put our first sample sent 
in location number 4 and named it MIDI 0, the next one in location number 5 and named it MIDI 2, 
and finally put MIDI 1 in location number 6. So bear in mind that when invoking Get Sample in Sound
Forge, the Logical receive sample number does not necessarily correspond to the name of the 
sample in the S1000.

¨ The S1000 will replace any sample in its memory with an incoming sample of the same name. That 
is, if you have sent a sample into the S1000 with Logical send number 2 and the S1000 has named 
this MIDI 2, then if you send another sample and do not change the Logical send number, the original 
MIDI 2 will be replaced with a new MIDI 2.

¨ In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to go the S1000 EDIT SAMPLE page and select the sample that you want to hear. You will
need to be on this page in order to audition a sample that has not yet been incorporated into a 
program.

¨ While the S1000 is receiving the sample, the MIDI LED will flicker indicating that the transfer is in 
process.

¨ The S1000 supports SDS handshaking. Therefore, any method of MIDI/SDS transfer will work. It is 
recommended that you turn Open Loop off and Send request on. Be sure that the MIDI IN and OUT 
are connected between the S1000 and Sound Forge to use handshaking (Closed loop).

¨ On the S1000's MIDI EXCL page, set the type of transmission to SINGLE SAMPLE and sample 
protocol to STANDARD.

To transfer MIDI/SDS to the S1000 from Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 

Sampler from the Tools menu.
2. Select Configure.
3. In the Send to section, select Akai S1000 (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected the S1000's MIDI input.
5. Now select the MIDI Channel. (This should match the MIDI channel found in the S1000's 

MIDI/EXCL page).



6. Hit OK.
7. Hit Send Sample. The S1000 should now receive the sample.

To transfer MIDI/SDS to Sound Forge From the S1000
1.Having set the necessary Start/Sustain loop/Release loop points within the S1000. Select Sampler 

from the Tools menu.
2. Select Configure.
3. In the Receive from section, select Akai S1000 (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected to the S1000's MIDI input.
5. In the MIDI input section choose the MIDI driver that is connected to the S1000 MIDI output.
6. We recommend that you select Send request (MIDI/SDS).
7. Now select the MIDI Channel. (This should match the MIDI channel found in the S1000's 

MIDI/EXCL page).
8. Hit OK.
9. Hit Get Sample. Sound Forge should now receive the sample.

                                                         
See also
Using the Sampler Tool



Digidesign SampleCell II - Sample transfer procedures
The SampleCell II is capable of receiving samples via internal interaction between Sound Forge and the 
SampleCell software.
A few things to keep in mind:
¨ You must have SampleCell software version 1.02 or above to transfer samples from Sound 

Forge to your SampleCell II card. If you have an earlier version contact Digidesign to acquire an 
update.

¨ At present, Digidesign does not provide Windows NT compatible software. Transferring samples to 
the SampleCell II is therefore not supported in Windows NT.

¨ The SampleCell can only receive samples from Sound Forge. You can not retrieve samples from the 
internal memory of the SampleCell. This is usually not a problem since the SampleCell does not allow
you to record new samples. All samples in its memory are supplied from files you already have on 
your computer

¨ Sending a sample to the SampleCell from Sound Forge will replace any previous samples sent by 
Sound Forge.

¨ In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to set the MIDI output device to SampleCell 1. If you have more than one SampleCell the 
number will be adjusted accordingly for each card in your system.

¨ You must be running the SampleCell application software to transfer samples from Sound Forge to 
the SampleCell.

¨ All samples sent to the SampleCell from Sound Forge have the name FRGSCNEW.
¨ The SampleCell ignores the Sample Number and Bias fields used by Sound Forge.
To transfer samples to the SampleCell from Sound Forge

1.Start the SampleCell software by double clicking on the Sample Cell icon.
2. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 

Sampler from the Tools menu.
3. Select Configure.
4. In the Send to section, select Digidesign SampleCell II. You do not have to set any other options 

in the dialog. They are ignored by the SampleCell.
5. Hit OK.
6. Hit Send Sample. The SampleCell should now receive the sample.

When transferring samples to the SampleCell, a temporary WAV patch file is created prior to sending the 
data to the SampleCell. You should not save instruments or patches based on files transferred from 
Sound Forge to the SampleCell, as the SampleCell bases its instruments on the original WAV file name. 
The downloading of samples from Sound Forge is meant to be used to create and tune single WAV 
sounds within an instrument. If you save an instrument based on a temporary file created by Sound 
Forge, when you attempt to reload the instrument at a later time the SampleCell software will not be able 
to find the temporary file.
When creating samples for the SampleCell, do as much work as you can in Sound Forge. Download the 
sample to the SampleCell to listen to how it sounds on the SampleCell. If you are happy with your 
work ,save the file using the Save As item from the File menu and then load the new WAV file from 
SampleCell software to create new instruments.
                                                         
See also
Using the Sampler Tool



Kurzweil K2000 - MIDI/SDS procedure
The K2000 is capable of receiving a sample via MIDI/SDS. The K2000 will not send a sample via 
MIDI/SDS. In its manual there is mention of the K2000 bulk dump. This protocol is not supported by 
Sound Forge. Therefore, the Sound Forge Get Sample procedure does not work with the K2000 for 
MIDI/SDS transfers.
Sending samples to the K2000 via MIDI/SDS is really quite simple. Provided that your MIDI connections 
are correct, the K2000 is basically ready to receive a new sample. The K2000 can be sitting on any 
screen and will actually operate normally while the transfer is going on In the background.
A few things to keep in mind:
¨ The K2000 will automatically assign the incoming sample to the next available - Sample/RAM location

if the Logical Send/Receive sample number is left at 0. This location is most likely going to be in the 
200-299 range (unless these are already filled). If you choose a Logical Send/Receive sample 
number of 0-199, the K2000 will automatically add 200 to the selected number (plus any necessary to
reach the next available sample number). If you choose a number of 200 or more, the K2000 will add 
1 (again, plus any necessary to reach the next available sample number).

¨ In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to create a Keymap within the K2000. This is done by hitting Preview in the Master/Sample
page or by calling up the sample within the Keymap section of a pre-existing program.

¨ While the K2000 is receiving the sample, the MIDI LED will flicker indicating that the transfer is in 
process.

To transfer MIDI/SDS to the K2000 from Sound Forge
1.Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select Sampler

from the Tools menu.
2. Select Configure.
3. In the Send to section, select Kurzweil K2000 (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected the K2000's MIDI input.
5. Now select the MIDI Channel. (This should match the Basic MIDI channel found in the K2000's 

MIDI/RECV page).
6. Hit OK. 
7. If you now hit Send Sample, the K2000 will start receiving the data.
8. To examine the new sample within the K2000, simply go to the Master/Sample page of the K2000. 

The sample that appears there as a default should be your newly received sample. Hit EDIT, and 
look to see that the waveform appears in the K2000's screen. Hitting preview from the 
Master/Sample page will create a new program based on this sample and will allow you to audition 
the sample from an external MIDI source.

                                                         
See also
Using the Sampler Tool



Kurzweil K2000 - SCSI/SMDI procedure
Sound Forge is capable of sending and receiving samples via SCSI/SMDI to the Kurzweil K2000. This 
method is very fast and very simple once you have configured the SCSI hardware properly. 
A few things to keep in mind:
¨ Unlike in MIDI/SDS sample transfers, the K2000 will not automatically adjust for sample number 

locations (adding 200, etc.). There are two ways of handling this fact;
1. You can select the specific Logical send/receive sample number as you would like it to appear 

in the K2000. Since the K2000 will add 1 to whatever number you have entered here, set the 
Sample bias in the Configure menu to -1.

2. If you set the Sample bias to 199, you can then refer to the Logical send receive sample 
number as 0 through x. This will make the Sound Forge send of sample number 0 locate to the 
K2000 at 200, sample number 1 locates to 201 and so on.

¨ When sending a sample to a K2000 RAM location that is already filled, the K2000 will not warn you 
that the location is already filled. Instead, it will replace the sample with the new one being sent. Be 
very careful when doing a lot of sample transfers (SCSI/SMDI), so that you do not wipe out your hard 
work by neglecting to select a new Logical send/receive sample number for each separate sample.

¨ When Choosing SCSI/SMDI in the Sampler dialog or if it was last set to SCSI/SMDI, Sound Forge will
verify that the SCSI bus is operational and may therefore take a second or two to respond to any user
interaction.

¨ When the SCSI/SMDI method is selected in the Configuration dialog, you only need to be concerned 
with setting the SCSI host and SCSI sampler. Any SCSI device that appears in these lists, is being 
recognized by Sound Forge and should work correctly.

¨ Make sure that your SCSI adapter is supported by Sound Forge for sample transfer procedures. If 
you are unsure as to whether your adapter is supported for SMDI transfers with Sound Forge, see 
SCSI/SMDI Setup and Troubleshooting at the beginning of this section.

¨ The K2000's SCSI ID is set in its MIDI/RECV page.
To transfer SCSI/SMDI to the K2000 from Sound Forge

1.Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select Sampler
from the Tools menu.

2. Select Configure.
3. In the Send to section, select Kurzweil K2000 (SCSI/SMDI).
4. In the SCSI host section, select your SCSI adapter.
5. In the SCSI sampler section, choose the K2000 connected to your computer's SCSI bus.
6. Save your configuration if you like and/or hit OK.
7. Check to see that your Configuration settings are confirmed without error and now hit Send Sample.

The K2000 will receive the sample very quickly. 
8. To examine the new sample within the K2000, go to the Master/Sample page of the K2000. The 

sample that appears there as a default should be your newly received sample. Hit EDIT, and look to
see that the waveform appears in the K2000's screen. Hitting preview from the Master/Sample 
page will create a new program based on this sample and will allow you to audition the sample from
an external MIDI source.

To transfer SCSI/SMDI from the K2000 to Sound Forge
1.Having set the necessary Start/Sustain loop/Release loop points within the K2000. Select Sampler 

from the Tools menu.
2. Select Configure.
3. In the Receive from section, select Kurzweil K2000 (SCSI/SMDI).
4. In the SCSI host section, select your SCSI adapter.
5. In the SCSI sampler section, choose the K2000 connected to your computer's SCSI bus.
6. Save your configuration if you like and/or hit OK.



7. Check to see that your Configuration settings are confirmed without error and now hit Get Sample 
(remember to select the specific Logical send/receive sample number minus 1, unless you have 
adjusted the Sample bias). Sound Forge will receive the sample very quickly. 

8. When the transfer is complete, the sample will appear in the active sample window.
Known problems with the K2000
The following is a list of known problems with transferring samples to K2000:
¨ The K2000 reboots when in the Master/Sample page: This is a bug in the K2000's ROM. The 

K2000 will reboot if you transfer a sample to the same sample number twice in a row while the K2000 
is on the Master/Sample page. The best way to get around this problem is to not transfer samples 
while you are using the Master/Sample page of the K2000.

                                                         
See also
Using the Sampler Tool



Peavey SP - MIDI/SDS procedure
The Peavey SP is capable of sending and receiving samples via MIDI/SDS in all configuration methods 
implemented by Sound Forge.
Provided that your MIDI connections are correct, the SP is basically ready to receive a new sample. The 
SP can be sitting on any screen and will begin to receive the sample upon initiating the transfer from 
Sound Forge.
A few things to keep in mind:
¨ Make sure the SP's Get slave samp# is using: midi (sds) - this is located in the SP's Util menu.
¨ If you have set up the transfer configuration as a Wait for request, you will need to go to the SP's Util 

menu and instigate the request for sample dump. This is done by hitting Exec twice from the Util 
menu on the SP after telling Sound Forge to Send Sample. 

¨ In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to go to the wave menu on the SP and select the appropriate wave number that you are 
trying to audition (the last received sample should appear on this screen).

¨ If you are sending a sample Open loop, it is not required that the sampler's MIDI out be connected to 
Sound Forge. However, it is recommended that you use handshaking (no Open loop) for faster and 
more reliable communications.

To transfer MIDI/SDS to the Peavey SP from Sound Forge
1.Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select Sampler

from the Tools menu.
2. Select Configure.
3. In the Send to section, select Peavey SP (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected to the SP's MIDI input.
5. Select the MIDI Channel (this should match the omni/poly channel found in the SP's Global menu, 

unless the SP is set to omni mode).
6. In Sound Forge hit the Send Sample button. The transfer will begin and both Sound Forge and the 

SP will display the amount of data left to go until the procedure is complete.
7. When the transfer is complete, you can hit the wave button on the SP and immediately audition the 

sample from the Sound Forge keyboard or whatever MIDI source is connected to the SP.
To transfer MIDI/SDS from the Peavey SP to Sound Forge

1.Having set the necessary Start/Sustain loop/Release loop points within the Peavey SP. Select 
Sampler from the Tools menu.

2. Select Configure.
3. In the Receive from section, select Peavey SP (MIDI/SDS).
4. In the MIDI input section choose the MIDI driver that is connected to the SP's MIDI output.
5. In the MIDI output section choose the MIDI driver that is connected to the SP's MIDI input.
6. Select the MIDI Channel (this should match the omni/poly channel found in the SP's Globl menu, 

unless the SP is set to omni mode).
7. In order for Sound Forge to automatically get the sample without invoking the transfer from the SP's

front panel, it is necessary to turn Wait for request on in the Receive section of the Sampler 
Configure dialog. Otherwise, you will have to hit exec on the SP after hitting the Get Sample button
in Sound Forge.

8. In Sound Forge, hit the Get Sample button. The transfer will begin and both Sound Forge and the 
SP will display the amount of data left to go until the procedure is complete.

9. When the transfer is complete, the sample will appear in the active Data Window.
                                                         
See also
Using the Sampler Tool



Peavey SP - SCSI/SMDI procedure
Sound Forge is capable of sending and receiving samples via SCSI/SMDI to the Peavey SP. This method
is very fast and simple once you have configured the SCSI hardware properly. 
A few things to keep in mind:
¨ Make sure the SP's Get slave samp# is using: SCSI (SMDI). This is located in the SP's Util menu. 

Though the SP is capable of detecting what method is used with the incoming sample, it is highly 
recommended that the user select this manually as crashes can occur when first sending MIDI/SDS 
followed immediately by SCSI/SMDI.

¨ The SCSI cable from your computer must be connected to the SP's SCSI B port.
¨ When Choosing SCSI/SMDI in the Sampler dialog or if it was last set to SCSI/SMDI, Sound Forge will

verify that the SCSI bus is operational and may therefore take a second or two to respond to any user
interaction.

¨ When SCSI/SMDI method is selected, you only need to be concerned with setting the SCSI host and 
SCSI sampler in the Configuration dialog. Any SCSI device that appears in these lists, is being 
recognized by Sound Forge and should work correctly.

¨ Make sure that your SCSI adapter is supported by Sound Forge for sample transfer procedures. If 
you are unsure as to whether your adapter is supported for SMDI transfers with Sound Forge, see 
SCSI/SMDI Setup and Troubleshooting at the beginning of this section.

¨ The Peavey SP's SCSI ID is set by default to Device 0. This setting is made by means of jumpers 
within the unit itself. Every time the SP is powered on, it will reset itself to this setting. You can 
temporarily change the SCSI ID to another number from the SP's UTIL menu and will remain until the 
unit is powered off. If you find that you consistently want a SCSI ID other than 0, you should change 
the jumper settings inside the unit according to the directions in the Peavey SP manual. If you have a
bootable SCSI hard drive its ID will also be 0 so you must change the ID of the SP for proper 
operation.

To transfer SCSI/SMDI to the Peavey SP from Sound Forge
1.Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select Sampler

from the Tools menu.
2. Select Configure.
3. In the Send to section, select Peavey SP (SCSI/SMDI).
4. In the SCSI host section, select your SCSI adapter.
5. In the SCSI Sampler section, choose the Peavey SP connected to your computer's SCSI bus.
6. Save your configuration if you like and/or hit OK.
7. Check to see that your Configuration settings are confirmed without error and hit Send Sample. The

Peavey SP will receive the sample very quickly. 
8. When the transfer is complete, you can hit the wave button on the SP and immediately audition the 

sample from the Sound Forge keyboard or whatever MIDI source is connected to the SP.
To transfer SCSI/SMDI from the Peavey SP to Sound Forge
Having set the necessary Start/Sustain loop/Release loop points within the Peavey SP. Select Sampler 
from the Tools menu.

1.Select Configure.
2. In the Receive from section, select Peavey SP (SCSI/SMDI).
3. In the SCSI host section, select your SCSI adapter.
4. In the SCSI Sampler section, choose the Peavey SP connected to your computer's SCSI bus.
5. Save your configuration if you like and/or hit OK.
6. Check to see that your Configuration settings are confirmed without error and hit Get Sample. 

Sound Forge will receive the sample very quickly. 
7. When the transfer is complete, the sample will appear in the active sample window.

                                                         



See also
Using the Sampler Tool

 



File Menu
New 
Open 
Close 
Open Workspace 
Save Workspace 
Save 
Save As 
Save All
Delete 
Properties 
Send
Exit



New
The New command creates a new sound data window.

Sample Rate
Select a standard sample rate from the drop-down list or type in a custom rate.
Sample Size
Check the button to select whether the new data will be 8-bit or 16-bit.
Channels
Check the button to select whether the new data will be mono or stereo.
Maximum Editing Time
Shows the maximum time currently available on the hard drive for editing a file of the specified type. 
Note that files open in Sound Forge are edited in 16-bit format and are only converted to 8-bit or 
compressed audio when closing the file.

Using the New toolbar button (or holding the Shift key down while selecting New from the
menu) will skip the New dialog and use the previously selected Mono/Stereo, 8-bit/16-bit,

and Sample Rate settings.

Shortcut
Control+N
Drag and drop a selection to the Sound Forge desktop to create a new file from the selection.
Selecting a portion of the Sound Forge desktop will create a new file with the most recently used 
attributes.

                                                         
See also
File Menu
Creating a New Window
Drag and Drop Operations



Open
Use this command to load a sound file into Sound Forge in Windows 95 or NT 4.0. If you are running 
Windows 3.x, go here.

Look In
Lists available drives and directories.
File Name
Type the File name you want to open or a *. and an extension to see a list of files with the 
corresponding extension in the current directory.
Files of Type
Shows the type of files displayed. Choose a type from the drop-down list. If you select All types (*.*), 
Sound Forge will try to auto-detect the file format.
If you know that the file format is unsupported, select Raw File (*.*). Hitting OK, will take you to the 
Open raw data file dialog where you'll be able to specify format parameters.
MRU Folders
Lists the most recently used directories. Use to speed the opening of regularly used files in different 
folders.
Open as Read-only
When checked, the sound file will be opened but you will not be able to alter the sound data in the file. 
This feature is useful if you only need to play the file or copy sections from the file. You can still change 
the Regions List, Playlist, and Summary information for the file, but these changes must be saved to a 
new file.

When you open a sound file, Sound Forge defaults to whichever edit mode you last
selected (either Open as read-only or Operate directly on the sound file). You can change

modes in the Open dialog.

Operate Directly on the Sound File
When checked, the sound file will be opened for editing but with no temporary file created. This greatly 
speeds the opening process but doesn't give you the security of a backup file. In most cases this is not 
a problem since all changes can be undone (if you have enough disk space), but if, for some reason, 
Sound Forge terminated improperly the file would remain in its edited state.

Whenever you open a file in Sound Forge, a backup copy is created so that the original
file is not affected until you elect to save your work. When you open a file as read-only or
direct, Sound Forge will not create a backup copy of the file, which makes opening files

quicker and uses less disk space.

AutoPlay
When checked, a file selected in the window will automatically begin playback without opening it in 
Sound Forge.
Play
Auditions the sound file without opening it in Sound Forge. If playing a file from a slow network or CD-
ROM, some skipping might occur. This feature is only available for .WAV files.

Shortcut
Control+O
Control+F12
Control+Alt+F2

                                                         
See also
File Menu



Opening an Existing File
Open raw data file



Open (Windows 3.x and NT 3.51)
Use this command to load a sound file into Sound Forge in Windows 3.x. If you are running Windows 95 
or NT 4.0, go here.

Drives
Lists available drives. Select a new drive from this drop-down list.
Directories
Lists available directories. Select a new directory from this drop-down list.
List Files of Type
Select the type of file you want to open. If you select All Types, Sound Forge will automatically identify 
the format of a sound file if it can.
File Name
Type the file name you want to open or a *. and an extension to see a list of files with the corresponding
extension in the current directory.
MRU Folders
Lists recently used folders. Use to speed the opening of regularly used files.
Read-only
When checked, the sound file will be opened but you will not be able to alter the sound data in the file. 
This feature is useful if you only need to play the file or copy sections from the file. You can still change 
the Regions List, Playlist, and Summary information for the file, but these changes must be saved to a 
new file.

When you open a sound file, Sound Forge defaults to whichever edit mode you last
selected (either Open as read-only or Operate directly on the sound file). You can change

modes in the Open dialog.

Direct
When checked, the sound file will be opened for editing but with no temporary file created. This greatly 
speeds the opening process but doesn't give you the security of a backup file. In most cases this is not 
a problem since all changes can be undone (if you have enough disk space), but if, for some reason, 
Sound Forge terminated improperly the file would be remain in its edited state.

Whenever you open a file in Sound Forge, a backup copy is created so that the original
file is not affected until you elect to save your work. When you open a file as read-only or
direct, Sound Forge will not create a backup copy of the file, which makes opening files

quicker and uses less disk space.

AutoPlay
When checked, a file selected in the window will automatically begin playback without opening it in 
Sound Forge.
Play
Auditions the sound file without opening it in Sound Forge. If playing a file from a slow network or CD-
ROM, some skipping might occur. This feature is only available for .WAV files.

Shortcut
Control+O
Control+F12
Control+Alt+F2

                                                         
See also
File Menu
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Open raw data file
Installing the ACM



Open raw data file
This dialog box is reached when you select Raw from the List of File Types in the Open dialog. Use this 
to open a file that is not stored in one of the standard sound file formats supported by Sound Forge.

Name
List of preset formats available. To create your own format from the selected parameters, press Save 
As.
Sample Rate (2,000-60,000 Hz)
Sample playback rate which will be used by Sound Forge when playing the file.
Sample Type
Format used to store each sample.

8 Bit PCM
Uncompressed linear format.
16 Bit PCM
Uncompressed linear format.
G.711 u-Law
Compressed format commonly used for telecommunications in the United States.
G.711 A-Law
Compressed format commonly used for telecommunications in Europe.

Format (Unsigned, signed, sign bit)
Shows the sample format that the data is stored as. Samples are most often saved in the PCM format.
Channels (Mono/Stereo)
Number of channels, or tracks, stored in the file.
Byte Order (Little or Big Endian)
Order in which the high and low bytes of a 16-bit sample are stored. Little Endian is used by Intel 
microprocessors, while Big Endian is used by Motorola microprocessors.
Header Bytes
Number of bytes stored in the file before the sound data.
Trailer Bytes
Number of bytes stored in the file after the sound data.

                                                         
See also
File Menu 



Open Video Stream
This dialog is reached when you select an .AVI file that has multiple audio or video streams. It allows you 
to select a particular video stream and an audio stream to open in Sound Forge. Most .AVI files have just 
one video stream and one audio stream, in which case this dialog doesn't appear.

Stream
The black diamond on the left side of a stream indicates that it has been selected to be open. If you 
have more than one audio stream or video stream, click on the left of the stream to select it for opening.
Additional information about each stream is available by clicking on the + area to expand the list.

                                                         
See also
File Menu 



Close
Use this command to close the current sample data window. If the data has not been saved since the last 
edit you will be asked if you wish to save your changes.

                                                         
See also
File Menu
Saving a File
Close All



Open Workspace
Use this command to open a Sound Forge workspace. A workspace contains a list of all the files open in 
a session along with their position and zoom ratios.

File Name
Type the file name of the workspace (.sfw) you wish to open. 

                                                         
See also
File Menu



Save Workspace
Use this command to save a Sound Forge workspace. The workspace will contain a list of all the files 
open in the current session along with their position and zoom ratios.

File Name
Type the file name of the workspace (.sfw) you wish to save the current session as. 

                                                         
See also
File Menu



Save
Use this command to save the current sound data. If the data is new data which was not retrieved from a 
previous file or was loaded from a format which is not supported for saving, you will be prompted with the 
Save As dialog. The Macintosh Resource (SND) format is not supported for saving. If you need to export 
sound files to a Macintosh, use the Macintosh AIFF format.

Shortcut
Control+S
Shift+F12
Alt+Shift+F2

                                                         
See also
File Menu
Saving A File
Save As
Sound File Formats
Embedded Summary Information



Save All
Use this command to save all the currently opened files.    You will be prompted for each unsaved file. If 
you hold the shift-key down when selecting this command, no prompts will be displayed.

                                                         
See also
File Menu



Save As
Use this command to save the current sample data in a different file and/or file format.    The Macintosh 
Resource (SND) format is not supported for saving. If you need to export sound files to a Macintosh, use 
the Macintosh AIFF format.

File Name
Type the name of the file in which you want to save the current sample.
Drives
Lists available drives. Select a new drive from this combo box.
Directories
Lists available directories. Select a new directory from this list box.
File Types
Select the type of file to which you would like to save.
Format
Shows the sample format in which the data will be saved. Samples are most often saved in the PCM 
format. However, other formats are often used for compression purposes. You can save files in a variety
of compressed formats including the Microsoft ADPCM format.
When saving as a Raw file, other options are available after choosing OK in this dialog box.
Attributes
Sample Rate, sample size, and stereo/mono. Here, you can change the sample size (8 or 16 bit) that 
the file will be saved as. You can also convert a file between mono and stereo formats. When you 
convert from mono to stereo, the data will be stored in both channels. When converting from stereo to 
mono, the data will be mixed to a single channel.
Rgns/Playlist Information 
Lists options for saving Regions/Playlist information. Options include saving in the .WAV file, saving to a
Sound Forge external playlist file, saving to a Session 8-compatible playlist file or not saving at all.
Save Summary Information in file
Check if you want Summary information (such as author and copyright) stored in the WAV file.
Save Sampler Information in WAV file
Check if you want Sampler Information (such as note assignment and loops) saved in the WAV file.

Only data formats supported by the selected File Type are listed in the Format drop down
list box. Other file types are available when saving a file as Raw data.

Shortcut
Alt+F2
F12

                                                         
See also
File Menu
Saving A File
Converting Files
Embedding Text in WAV Files
Sound File Formats
Embedded Summary Information



Save As Raw Data File
This dialog box is reached when you select Raw from the Format list in the Save dialog. Use this to save 
an opened file into a file format that is not one of the standard sound file formats supported by Sound 
Forge.

Name
This list of file formats contains preset versions of raw file storage formats commonly used by other 
applications. You can create a new file format by using the Save As button to save the current storage 
parameters.
Sample Type (8 Bit PCM, 16 Bit PCM, G.711 u-Law, G.711 A-Law)
Format used to store each sample.
Format (Unsigned, Signed, Sign bit)
Binary format of each sample. 
Channels (Mono/Stereo)
Number of channels, or tracks, stored in the file.
Byte Order (Little or Big Endian)
Order in which the high and low bytes of a 16-bit sample are stored. Little Endian (low, high) is used by 
Intel microprocessors, while Big Endian (high, low) is used by Motorola microprocessors.

                                                         
See also
File Menu
Saving A File



Video Save Options
This dialog is reached when you select Video for Windows (.avi) from the Save as type list in the Save As 
dialog. In this dialog, you can select which video streams you wish to save and edit the title, language, 
and priority of the saved streams.

Streams
Check the streams that you want to save. The black diamond next to each check box indicates 
currently opened streams.
Additional information is available by clicking on the + area to expand the list. This information can be 
edited by right-clicking on a field and selecting Edit.
Save Audio to New Stream
If this option is checked, the audio track currently open in Sound Forge will be saved to a newly created
stream.



Compression Options
This dialog is reached when you select Microsoft .AVI from the Format list in the Save As dialog and then 
press OK in the Video Save Options dialog.

Choose a Stream
Check the audio or video stream for which you want to set the compression formats.
Interleave Frames
When checked, selects how the audio and video streams will be interleaved. Interleaving the audio and 
video streams improves playback performance when using storage devices that are more efficient at 
providing data sequentially (such as CD-ROM disks). The Frames value indicates the interval between 
video and audio segments. The default is 1 for CD-ROMs, but can be increased for faster media.
Options
Press this button to view and/or edit the audio and video compression options for the selected stream.



Video Compression
This dialog is reached when you select Microsoft .AVI from the Format list in the Save As dialog, press 
OK in the Video Save Options dialog, and after selecting a stream pressing the Options button in the 
Video Compression dialog.

Compressor
Select a compression format from any of the installed .AVI compression schemes. Compression 
formats are available from different vendors (not from Sonic Foundry), and also come included with 
Windows.
If the file is already compressed, you should select No Recompression. This will be faster and will also 
avoid the loss of quality inherent in most recompression.
Compression Quality (0 to 100)
Determines the final output quality. Usually, higher quality (close to 100) means less compression and 
fewer visual artifacts.
Key Frames Every
Some compression formats are based on key frames (sometimes called temporal compression). A key 
frame is a frame which is usually less compressed. Compressed frames that follow a key frame are 
smaller but slower to draw. This option is only relevant to video streams.
A high number of key frames increases quality, but decreases compression. Also, if the number of key 
frames is very low, it will takes a long time to perform decompression when drawing the video strip or 
moving randomly through the file.
Data Rate (Kilobytes per second)
Determines the data rate which will be required to play the compressed stream in real time. Lower data 
rates are less demanding on computer systems than higher rates. If the data rate is too high for a 
certain computer (usually because of a bottleneck such as a slow CD-ROM, network, or hard drive) the 
quality begins to suffer and glitching can occur.
Configure
Press this button to set more detailed configuration parameters specific to the compression scheme 
being used. Not all compressors provide this options.
Preview
Press this button to view a preview of the final output.



Save .RA File
This dialog is reached when you select Real Audio (.ra) from the Save as type list in the Save dialog. This
feature is only available for Windows 95 and NT running in x86 processors.

Desired playback baud rate
Determines the data rate required to play back the file.
Stereo file conversion
Since RealAudio supports mono files only, when saving a stereo file you need to specify how to convert
from two to one channels.



Delete
Use this command to delete a sound file from your hard drive. When running the new Windows 95 shell, 
this function is not available. Instead, you can delete files from the File Open dialog.

File Name
Type the file name you want to delete or a *. and an extension to see a list of files with the 
corresponding extension in the current directory.
Files
Lists the files in the current directory of the type specified in the File Name box.
Drives
Lists available drives. Select a new drive from this combo box.
Directories
Lists available directories. Select a new directory from this list box.
File Types
Select the type of file you want to delete. This provides an easy way of setting the file extension.

                                                         
See also
File Menu



Properties
The Properties folders list attributes and information which is embedded in the currently active sound file. 
The available Properties folders are:

General 
Summary Info 
Format 
Video 
Display 

                                                         
See also
File Menu
Summary Information



General Properties
This folder contains technical information regarding the current sound file, including size, location, file type
and attributes of the file.

Microsoft .WAV files are composed of sections called RIFF chunks. These chunks contain the sound data 
plus other embedded information. If there are any non-standard chunks found in the current file, the junk, 
padding, and additional chunks fields will be checked. These chunks might be used by other sound 
utilities, or might just be garbage which can cause problems like glitching in some less intelligent 
programs.

                                                         
See also
File Menu
Properties



Summary Information Properties
This folder contains extra information that can be embedded in the sound file, about the sound file. It is 
only available in Microsoft .WAV files.

Title, Subject, Engineer, Comments
Commonly used fields you can quickly edit. To view and edit all other fields, press the Extended button.
Picture
Allows you to select an icon, bitmap or cursor to be attached to the current file.
Load
Sets all of the fields to the default values. The default values can be set in the Extended Summary  
dialog box.
Extended Summary
Allows you to view and edit all available summary fields.

Fields
To edit a field, you must first select it from the Fields list. The check appearing to the left of the 
type tells whether this field is currently enabled for saving to the WAV file. If the check is not 
shown, the field will not be written to saved files. To change the state of the check, click with the 
left mouse button in the area immediately to the left of the type or double click on the entry.
If the field for a type currently has no text associated with it the word (Empty) will appear to the 
right of the type in the list box.    Empty fields are not saved.
Contents
Shows the text associated with the selected field. The text can be changed by typing in this box.
Default
Sets the default fields to the current file's field information. Use this to save information which will
be used in a number of different files, like copyright and engineer information at your recording 
site. 
Load
Sets the current file's summary information fields to the default settings.

Shortcut
Double click on the right-most field of the Status Bar
                                                         
See also
File Menu
Summary Information Fields



Attach Picture
Use this dialog to select a bitmap (.bmp), cursor (.cur), or icon (.ico) to embed in the current sound file.
                                                         
See also
Summary Information Fields



Format Properties
Use this folder to change the data format of the current data window. This includes Sample rate, Sample 
size (bits per sample), and Stereo/Mono.

Sample Rate
The playback rate can be set from 2,000 Hz to 60,000 Hz by entering the rate you wish to use. You may
also select the most common sample rates by using the drop-down list. Note that this will not resample 
the sound file. If the playback rate is different from the originally recorded rate, the pitch will vary unless 
resampling is done.
Sample Size
Select 8-or 16-bit for the sample size.
Channels
Select Mono or Stereo for the number of channels.
Cursor Position
Displays the cursor position in the sound file using the current units.
Sample Value
Displays the sample value at the current cursor position in the sound file. For 16-bit audio, this value 
ranges from -32768 to 32767. For 8-bit audio, it ranges from -128 to 127.
Peak Data Ratio
Ratio at which the peak data is stored. This means that when zoomed out beyond 1:512, the peak file, 
instead of the entire file is scanned when drawing the waveform.
Sound Data Size
Amount of storage space being used by the sound data.
Video Source Format
Frame size (height, width, bits per pixel) and compression algorithm of the original .AVI file.
Video Decompression Format
Intermediate frame size (height, width, bits per pixel) and compression algorithm used by Sound Forge 
before displaying the video frames. The video decompression mode can be changed from the 
Performance page in the Preferences folder.
Undo buffers
Number of Undo buffers currently existing for the sound file and the amount of hard-drive space they 
consume.
Redo buffers
Number of Redo buffers currently existing for the sound file and the amount of hard-drive space they 
consume.

Shortcut
Alt+Enter

                                                         
See also
File Menu
Properties



Video Properties
This folder contains information specific to Microsoft .AVI files. If your sound file does not currently contain
any video, you can attach a video from an .AVI file by pressing the Attach button.

An .AVI file can contain multiple video and/or audio streams (or tracks). For example, you can include 
multiple audio tracks in different languages to go along with a video. When playing back, Microsoft's 
Media player detects what language the operating system is set to and plays the corresponding video 
stream.

Stream
Displays information about the video and/or audio streams present in the .AVI file, such as name, 
compression format, frame rate, and language.
The black diamond to the left of the streams indicate the active streams. You can view and edit 
additional information (stream name, language, and priority of the active audio stream) by clicking on 
the + sign to expand the list. Right-clicking on a field allows you to edit it.

Streams that are checked will be preserved when the file is next saved. Streams that are not checked will 
be deleted when the file is next saved.
                                                         
See also
File Menu
Properties



Display Properties
This folder allows you to change how the data window of the sound file appears on the Sound Forge 
workspace. Checking a box will display that item in the current sound file's data window. An unchecked 
item will not be displayed. 

To set the current settings as the default display for all sound files, simply check the Save as the default 
for all new windows check box.

If Data Window only is enabled, only the Waveform Display will show in each Data Window, with all other 
controls such as rulers and scrollbars disabled.

Shortcut
Edit Tool Selector Shortcut Menu 
                                                         
See also
File Menu
Properties



Send
Use this command to send the current sound file via electronic mail.

This option is only available in the 32-bit version of Sound Forge.

Sends a mail message with an attached sound file. Note that you must have electronic mail (email) 
capabilities to use this feature. When you select the Send command, your email program opens with a 
new message and embeds the active sound file from Sound Forge in the message. You then have the 
option of sending the new mail message to the desired recipient.

When a sound file is embedded into a mail message, the entire contents of the sound file are inserted into
the message. To do this requires that any modifications to a sound file be saved before the message can 
be sent. Sound Forge will prompt you to save the file if this is necessary.

Sound files are generally very large when compared to text files. An email message
containing an embedded sound file can take a considerable amount of time to send and

receive, especially if you are using a modem and not a high-speed network.

                                                         
See also
File Menu



Exit
Use this command to exit Sound Forge. You will be asked whether you would like to save any sound files 
you have modified during the editing session.

                                                         
See also
File Menu



Preset Save As
To save a preset, just enter the name of the preset and press OK.    If you select an already existing 
preset, you will be asked if you want to replace the existing preset with the current preset.      

The presets that come installed with Sound Forge cannot be replaced or deleted.



Temporary File Cleanup
If for some reason Sound Forge is terminated improperly    when Sound Forge or, most likely, another 
program crashes      all of the opened and unsaved sound files can be recovered excluding those opened 
in direct and read-only modes. Unless a file is opened in direct or read-only modes, a temporary file is 
created and any edits made are stored in this file. When an improper termination of the program occurs, 
these temporary files remain on your hard drive and can be reopened to recover any work done to the 
sound files before crashing. Also, the original sound files will remain unchanged until you save your work.

Crash Recovery
When starting the program, any temporary files detected in your temporary file directory will indicate that 
something went wrong. You have the option to delete these files if no important work has been done, or to
just ignore these files. Ignoring the files leaves them intact on your hard drive.

Recover
Use this to change the ending of all file names from FORGExxx.TMP to FORGExxx.WAV. You can then 
open these .WAV files using the File Open dialog. The files will be placed in the directory specified on 
the Storage page of the Preferences folder.
Delete
This command deletes all the temporary files regardless of selection in the drop-down list. Use this only
when you are sure that no important work is in the file.
Ignore

If you don't want to deal with the temporary files left over from an improper termination at this moment, 
use this command. However, it is recommended that you either rename the files and check their contents 
or delete them, since they are taking up valuable disk space.



Mono to Stereo
When converting a mono (single channel) file to a stereo (two channel) file,    you must specify    what 
channel or channels of the stereo file the mono data should go to.    This operation is not only used in file 
conversions, but also when mixing, pasting, or crossfading mono material into a stereo file.

Left Channel
The mono sound data is placed only on the left channel of the stereo file.

Right Channel
The mono sound data is placed only on the right channel of the stereo file.

Both Channels
The mono sound data is placed on both the right and left channels of the stereo file.



Stereo to Mono
When converting a stereo (two channel) file to a mono (one channel) file,    you must specify    what 
channel or channels of the stereo data should go to the mono file.    This operation is not only used in file 
conversions, but also when mixing, pasting, or crossfading stereo material into a mono file.

Left Channel
Only the left channel of the stereo file is used in the operation.

Right Channel
Only the right channel of the stereo file is used in the operation.

Mix Channels
The left and right channels are mixed together to perform the operation.



Preview Configuration
This dialog box allows you to set    preview preferences for sound processing operations.

Limit Previews to (1 - 30 seconds)
Determines the length of the wave data that will be processed for previewing.

Fade out last 10 milliseconds    (Of/Off)
Use this to fade the ends of the preview data to prevent clicks and pops.

Loop preview continuously      (On/Off)
When on, the preview data will loop infinitely when pressing the preview button in the processing 
function dialog box.

Default all previews to the current setting    (On/Off)
Use this to store the current preview settings to be used as defaults for all preview operations.    When 
Off, only the current preview will be affected by any changes made in this dialog box.

                                                         
See also
Previews



Attach video
This dialog box allows you to select an .AVI file from which a video stream will be attached to the current 
sound file.
                                                         
See also
Video Properties 
 



View Menu
Maximize Width 
Full Screen 
Toolbars 
Time Display 
Clipboard Contents 
Play Clipboard 
Zoom Level|Out Full 
Zoom Level|Selection 
Zoom Level|Window 
Zoom Time|In Full 
Zoom Time|Normal 
Zoom Time|Selection 
Zoom Time|Out Full 
Focus to Data Window 
Regions List 
Playlist 
Keyboard 
Mixer 
Time Display 
Video Preview 
Play Meters 
Loop Tuner 
Undo/Redo History 
Show Loop Tuner 



Maximize Width
This command stretches the active data window to fit between the extents of the Sound Forge window.

Shortcut
Control+Enter
Maximize Width button on lower-right hand side of the data window.

                                                         
See also
View Menu



Full Screen
This command super maximizes the Sound Forge workspace in your display. To return to the regular 
window display choose the Full Screen command again.



Toolbars
This command brings up the Toolbars tab in the Preferences folder and allows you to quickly bring up any
toolbars you would like on the Sound Forge workspace.



Clipboard Contents
Use this command to display information on the current contents of the clipboard. Information includes, 
size, sample rate, number of channels, and bits per sample. If no data is in the clipboard you will be 
notified with a message box.

                                                         
See also
View Menu



Play Clipboard
Use this command to hear the current contents of the clipboard. This command has no effect if there is no
data in the clipboard.

                                                         
See also
View Menu



Zoom Level|Out Full
Use this command to zoom out vertically to allow viewing of the entire amplitude range. This command 
also centers the centerline.



Zoom Level|Window
Use this command to zoom in or out vertically to the maximum zoom ratio that allows you to view the 
entire waveform on the waveform display. This command also moves the centerline if the maximum 
positive and negative peaks are different.



Zoom Level|Selection
Use this command to maximize a selected area both vertically and horizontally.

To zoom in and out vertically by small increments, you can use Shift+Up or Shift+Down
arrow keys or the Zoom In/Out buttons on the lower left-hand side of the data window.

Shortcut
Control+Up arrow (when a selection is active)
Level Ruler shortcut menu
Double-click on the Level Ruler



Zoom Time|In Full
Use this command to maximize the horizontal magnification to one sample per pixel on the screen. When 
you zoom in full, the entire waveform display length will span a very small amount of time, usually around 
20 milliseconds (depending on the sample rate and window size).

To zoom in and out by small increments, you can use the up and down arrow keys.

Shortcut
Control+Up arrow (when no selection is active)
Waveform Display Shortcut menu

                                                         
See also
View Menu



Zoom Time|Normal
Use this command to zoom out to the default zoom ratio preference setting. If the entire sound file can fit 
in the window at a closer magnification, zoom normal will only zoom out to that ratio.

To change the default for the Normal zoom ratio, go to the Display page in the Preferences folder.

Shortcut
Control+Down arrow
Waveform Display Shortcut menu

                                                         
See also
View Menu



Zoom Time|Out Full
Use this command to minimize the data magnification and if possible, fit the whole sample in the data 
window. To zoom in and out by small increments, you can use the up and down arrow keys.

Shortcut
Waveform Display Shortcut menu

                                                         
See also
View Menu
Magnification and Zooming



Zoom Time|Selection
Use this command to maximize a selected area in the data window.

The Zoom Selection command will calculate the maximum zoom factor for the size of a selection area, 
draw the data at this zoom factor, and center the selection in the data window.

To zoom in and out in time by small increments, you can use the up and down arrow
keys or the Zoom In/Out buttons on the lower right-hand side of the data window.

Shortcut
Control+Up arrow (when a selection is active)
Waveform Display shortcut menu

                                                         
See also
View Menu
Magnification and Zooming



Focus to Data Window
Use this function to return the screen focus to the sample data window. This is does the same operation 
as left-clicking anywhere on the data window.

Shortcut
Alt+0

                                                         
See also
Window Menu



Regions List
Use this to open or close the Regions List window. The Regions List contains all of the regions and 
markers that exist in the currently selected data window. To play a regions, press on the Play button to the
left of each region. Selecting a marker or region moves the cursor or selection in the data window.

Shortcut
Alt+1 to turn on or set focus.

                                                         
See also
Window Menu
The Playlist and Regions List



Playlist
Use this to open or close the Playlist window. The Playlist is used to arrange regions for playback. To re-
arrange regions, drag and drop them within the Playlist. Pressing the Play button to the left of each region
plays from that region onwards down the list.

Shortcut
Alt+2 to turn on or set focus.

                                                         
See also
Window Menu
The Playlist and Regions List



Keyboard
Use this to open or close the Keyboard window. The Keyboard allows you to send MIDI note on and off 
commands to your sound card or external sampler.

Shortcut
Alt+3 to turn on or set focus.

                                                         
See also
Window Menu
The Sonic Foundry MIDI Keyboard



Mixer
Use this to turn on or off the Mixer Window. The Mixer allows you to control the Wave (digital audio) and 
MIDI (synthesizer) output volume level of sound cards that support this feature. The    Auxiliary fader can 
be used to control a number of different parameters, such as CD-ROM output level or Recording Level. 
Not all sound cards support mixing control.

To select a device, right-click on Wave, MIDI or Aux.    You can then choose from a list of available devices
from the corresponding Shortcut menu. Grayed items represent devices that are present but do not 
support Mixer functionality.

Most sound cards contain custom mixer applications for controlling how a sound card behaves. These 
custom mixers are usually much better suited to setting levels on your sound card than Sound Forge's 
Mixer window, but are often not as convenient.

Shortcut
Alt+4 to turn on or set focus.

                                                         
See also
Window Menu



Time Display
Use this to open or close the Time Display window. The Time Display window displays the current cursor 
or play position.

Shortcut
Alt+5 to turn on or set focus.

                                                         
See also
Window Menu



Video Preview
Use this to turn on or off the Video Preview Window.

Shortcut
Alt+6 to turn on or set focus.

                                                         
See also
Window Menu



Play Meters
Use this to open or close the Play Meters window. The Play Meters display peak levels during playback.

Shortcut
Alt+7 to turn on or make active.



Undo/Redo History
Use this to open or close the Undo/Redo History window. This window will allow you to see all of your edit
operations. The most recently performed operations will be at the top of each list.

When you perform an edit operation on your sound file, such as when doing a Cut, the operation name 
appears at the top of the Undo list. When you undo the Cut, the operation disappears from the Undo list 
and appears in the Redo list.

You can audition various versions of undos and redos by pressing the Play button next to each. However, 
some Undo or Redo operations cannot be auditioned.

To undo or redo up to a certain operation, double-click on the operation in the Undo or Redo list. If you 
Undo an operation at the bottom of the list, all operations that followed (which are above in the list) will 
also be undone (this can take some time when working on large files). Redo works the same way.

Shortcut
Alt+8 to turn on or make active.



Loop Tuner
Use this to turn on and off the Loop Tuner window. The Loop Tuner shows the point where the end and 
beginning of the loop meet.

                                                         
See also
View Menu
Sample Tools

 



Special Menu
Transport 
Regions List 
Playlist 
Edit Sample 
Edit Frame Rate
Edit Tempo
Center Cursor
Drop Marker
Create Region 
Create Loop 
Mark In 
Mark Out 
Toggle Selection 
Undo/Redo History Clear 
Undo/Redo Clear All 
Rebuild Peak Data 



Transport
Record
Play All
Play
Pause
Stop
Start
Rewind
Forward
End
Play Normal Mode
Play Looped Mode
Play as Sample Mode

                                                         
See also
Special Menu



Record Video tutorial
Use this function to record to an existing or new data window.    If you have a file open in direct mode, 
Sound Forge defaults to recording to a new window. To record to the direct-opened file simply use the 
Window button (explained later).

The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities. To prevent accidentally recording over sound data, record into a new
or scratch data window and paste the takes you want to keep into the desired sound data

window.

The following is a list of all controls available in the record dialog.

New
This button allows you to create a new data window for recording.
Close
Press this button to exit record mode.
Remote
Press this button to enter Remote Recording mode. This mode will hide the main Sound Forge Window 
and show only the Record Remote dialog box (a condensed version of the Record dialog). This allows 
you to easily record while using other components of your system like a CD player, mixer, or sequencer.
Go To
Pressing this button displays the Go To dialog for selecting a Start position. This option is not available 
in Punch In mode.
Selection
Pressing this button displays the Set Selection dialog for selection a Region. This option is only 
available in Punch In mode.
Window
Pressing the window button allows you to select the data window into which you will record.
Mode
Selects the current recording mode. Modes are as follows:

Automatic Retake
This mode begins recording at the specified Start position and replaces any sound data that 
already exists after that position. When recording is stopped, the Start position is automatically 
rewound to the original starting position.
Multiple Takes with Regions
This mode begins recording at the specified Start position and replaces any sound data that 
already exists after that position. When recording is stopped, the Start position is set to ending 
position of the take. Additionally, a unique Region is created in the Regions List that marks the 
take. To review a take using the Play button, press the REW button to rewind the Start position to
the beginning of the take then press Play. Pressing the FWD button will set the Start position to 
the end of the take in preparation for the next take.
Multiple Takes (no Regions)
This mode is exactly the same as the Multiple Takes with Regions mode with the exception that 
no Regions are created for takes.
Punch In
This mode is used to record over the top of an existing region of sound. This allows you to record 
a portion of a previous take without recording a whole new file.

Start
Displays the position where recording will begin.
End
Displays the position where recording will end (this value is inclusive).



Length
Displays the length to record.
Input format
Use this to change how the Start, End, and Length values are entered and displayed as well as the 
display of Time Recorded and Time Left on Drive values.
Monitor (On/Off)
Select this checkbox to monitor the level of the input signal. This option can be enabled at any time. 
The meters light up as a function of the volume of the recording input. For best results the level should 
be somewhere in the yellow range with an occasional red. This button also activates the Peak and 
Margin values. The Peak value shows the maximum input level recorded since the last Reset was 
invoked. The Margin value shows the percentage the input level can be increased prior to clipping. If 
the Peak value reaches 100% (and the Margin value reaches 0%), clipping has occurred.
Reset
Resets the Peak and Margin values back to their initial states.
Prepare
Pressing the prepare button prepares your system for recording. This means that the record device is 
opened and all preparation that can be done prior to recording is completed. This allows the system to 
begin recording as quickly as possible after the Record button is pressed. You do not need to use the 
prepare button unless you are trying to begin recording immediately after pressing the Record button.
Record
Pressing the record button starts recording. If recording has been Prepared, then recording starts 
immediately. If recording has not been Prepared, Sound Forge attempts to start recording as quickly as 
possible; a small delay may occur.
Play
Pressing the play button allows you to hear a section of data over which you are going to record or 
which you have just recorded. This allows you to keep recording until you get the correct take.
Review pre/post-roll
These two edit boxes specify the amount of time which will be played prior to and after regions when 
reviewing a take.
The following commands and options affect the Record Meters display. The Record Meters options can 
be activated by right-clicking anywhere in this dialog or by Alt+Spacebar (Windows 95/Windows NT 4.0)
or Alt+- (Windows 3.x/Windows NT 3.51)
Advanced Options
The following options are available from the Record Shortcut menu, which is reached by right-clicking 
anywhere on the dialog.

Reset Clip
This function resets the clip indication on the Record Meters. After a clip occurs, the clip indication
will remain lit until the Reset Clip function is invoked. You can also click on the clip light or levels 
to clear it.
Resolution    (-24, -42, -60 -78 or -90 to 0 dB)
These settings display the minimum and maximum readings for the Record Meters. Changing the
resolution of the meters is helpful for metering sound files of varying dynamism.
Show Labels
This option turns on or off the markings on the Record Meters.
Hold Peaks
This option turns on or off the markings to indicate the highest peaks in the sound file.
Hold Valleys
This option turns on or off the markings to indicate the lowest peaks in the sound file.
Gap Detection (Ignore, Mark, Stop)
Sound Forge detects most gaps by noticing when it is not able to save wave data as fast as the 
record device produces it. However, it is still possible for very short gaps to occur because of 
conflicts between drivers. This sort of gap is usually quite short and either happens frequently or 



not at all. If your application has zero tolerance for gaps, we recommend that you monitor your 
first several recording sessions closely to determine if your system has this problem.
The Gap Detection switch can be reached by right-clicking anywhere in this dialog or in the 
System menu. It allows you to specify what action Sound Forge should take if it detects a high 
probability of a gap having occurred while recording.
Blinking Status (On/Off)
This option enables or disables blinking of the status indicator. It is reached by right-clicking 
anywhere in the Record dialog.
DC Adjust (On/Off)
Checking this before recording to enable automatic adjusting for any DC offset produced by your 
audio hardware during the record process.
Calibrate
When you press this button, Sound Forge will calculate the DC offset while monitoring incoming 
sound data. The numbers below show the value, in sample amplitude, of the adjustment. If you 
change sound cards or are recording from different digital sources or at different sample rates, it 
is suggested that you re-calibrate the DC Offset before recording.

Sync
Pressing this button brings up options for synching Sound Forge and external devices or software.

Shortcut
Control-R

                                                         
See also
Special Menu
Using Recording
Video tutorial



Record Sync
This dialog allows you to set parameters for input and output synchronization during recording.

Enable MTC/SMPTE Output Synchronization On/Off
Turn on to allow Sound Forge to generate MTC/SMPTE synchronization while recording.
Start  On/Off
When recording begins, Sound Forge will output SMPTE starting at this time.
Pre-roll  On/Off
Turn on to begin the SMPTE output at a time before recording.
Enable MTC/SMPTE Input Synchronization On/Off
Turn on to trigger Record of Sound Forge from incoming MTC/SMPTE synchronization.
Start On/Off
Turn on to specify an exact time when Sound Forge will kick into Record.
End On/Off
Turn on to specify an exact time when Sound Forge will kick out of Record.
Back
Push to switch the focus back to the main Record dialog.

                                                         
See also
Special Menu
Using Recording



Record to New
To record to a new window, choose the New button in the Record dialog. The New Window dialog will be 
presented allowing you to select the attributes for the new window. Holding the Shift key down when 
selecting the New button will bypass the New Window dialog and create a window using the last used 
attributes.

When in Direct mode, Sound Forge automatically creates a new file when you hit Record.

Shortcut
Control+Shift+R

See also
Special Menu
Recording basics



Record Remote Video tutorial
The Record Remote dialog is invoked by pressing the Remote button in the Record dialog box. It allows 
you to record to a data window while using other components of your system to generate audio. Note that
some options are not available in the Remote Record dialog that are available in the main Record dialog.

The System Menu (Alt+Spacebar) provides many of the options that are available in the main Record 
dialog such as New Window, Selection, Go To, etc.

The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities. To prevent accidentally recording over sound data, record into a new
or scratch data window and paste the takes you want to keep into the desired sound data

window.

The following is a list of all controls available in the record dialog.

Close
Press this button to exit record mode.
Un-Remote
Press this button to leave Remote Recording mode and return to Normal Recording mode.
Monitor (On/Off)
Select this checkbox to monitor the level of the input signal. This option can be enabled at any time. 
The meters light up as a function of the volume of the recording input. For best results the level should 
be somewhere in the yellow range with an occasional red. This button also activates the Peak and 
Margin values. The Peak value shows the maximum input level recorded since the last Reset was 
invoked. The Margin value shows the percentage the input level can be increased prior to clipping. If 
the Peak value reaches 100% (and the Margin value reaches 0%), clipping has occurred.
Prepare
Pressing the prepare button prepares your system for recording. This means that the record device is 
opened and all preparation that can be done prior to recording is completed. This allows the system to 
begin recording as quickly as possible after the Record button is pressed. You do not need to use the 
prepare button unless you are trying to begin recording immediately after pressing the Record button.
Record
Pressing the record button starts recording. If recording has been Prepared, then recording starts 
immediately. If recording has not been Prepared, Sound Forge attempts to start recording as quickly as 
possible; a small delay may occur.
Play
Pressing the play button allows you to hear a section of data over which you are going to record or 
which you have just recorded. This allows you to keep recording until you get the correct take.
RTZ
Return To Zero (RTZ) sets the Start position to the beginning of the sound data. This option is not 
available in Punch In mode.
REW
Rewind (REW) sets the Start position to the beginning of the most recent take. This option is not 
available in Punch In mode.
FWD
Forward (FWD) sets the Start position to the end of the most recent take. This option is not available in 
Punch In mode.
GTE
Go To End (GTE) sets the Start position to the end of the sound data. This option is not available in 
Punch In mode.

The following is a list of all extra System Menu (press Alt+Spacebar) commands available in the Record 



Remote dialog.

New Window
This option allows you to create a new data window for recording.
Go To
This option displays the Go To dialog for selecting a Start position. This option is not available in Punch 
In mode.
Selection
This option displays the Set Selection dialog for selecting a Region. This option is only available in 
Punch In mode.
Window
This option allows you to select the data window into which you will record.
Review Pre/Post-Roll
Enables the Review Pre/Post-Roll values that are entered in the main Record dialog.
Reset Monitor
Resets the Peak and Margin values back to their initial states.

                                                         
See also
Remote recording



Record Synchronization
Use this dialog to turn on and off record input and output synchronization.

When Output Synchronization is enabled, Sound Forge generates SMPTE/MTC to the output device 
selected in the MIDI/Sync Preferences. When you start recording, SMPTE output begins at the Start 
value. If Pre-Roll is selected, SMPTE output will begin before recording by the specified amount. For 
example, if the Start value is 00:00:30:00 and the Pre-Roll is 00:00:10:00, SMPTE will be generated 
starting at 00:00:20:00 and after 10 seconds (at 00:00:30:00) have elapsed, recording will commence.

When Input Synchronization is enabled, recording begins (is triggered) when the Start time is received 
from the current MIDI/Sync input device (see MIDI/Sync Preferences). Recording will then stop when the 
End time is reached.

Output Synchronization Start
Start time which will be generated when record begins.
Output Synchronization Pre-Roll
Time offset from the Start time at which SMPTE generation will begin.
Input Synchronization Start
Time at which recording will be begin.
Input Synchronization End
Time at which recording will end.

Tips
Make sure that MIDI Input and/or Output is enabled (under the Special menu) to allow MIDI/MTC to be 
received or generated by Sound Forge. Also, check to make sure that the input and output devices are 
specified correctly in the MIDI/Sync Preferences (File menu).



Select Record Window
Use this to select an open Data Window which will store the recorded data.



Play All
Use this function to play the entire sample file from beginning to end, regardless of cursor position, 
selection, or Playlist.

Shortcut
Shift+Spacebar

                                                         
See also
Special Menu



Play
Playback file in current playback mode (Normal Mode, Looped Mode, or Sample Mode)

Shortcut
Spacebar
Right-click on Overview

                                                         
See also
Special Menu



Pause
Stop playback and keep cursor at the stop point.

Shortcut
Shift+Spacebar
Enter
Right-click on Overview during playback

                                                         
See also
Special Menu



Stop
Stop playback and return the cursor to its position prior to playback.

Shortcut
Spacebar (during playback)

                                                         
See also
Special Menu



Go to Start
Moves the cursor to the start of the file.

Shortcut
Control+Home

                                                         
See also
Special Menu



Rewind
Pressing this button moves the cursor backwards, take by take, in the current sound file. 



Forward
Pressing this button moves the cursor forward, take by take, in the current sound file. 



Go to End
Moves the cursor to the end of the file.

Shortcut
Control+End

                                                         
See also
Special Menu



Play Normal Mode
Sets Playback mode to Normal Mode. When Play is selected while in this mode:

· If there is no selection, playback occurs from the cursor to end of file. 

· If there is a selection, playback occurs from the beginning of the selection to the end of the selection.

Shortcut
To switch between playback modes, use Control+Spacebar

                                                         
See also
Special Menu



Play Looped Mode
Sets Playback mode to Looped Mode. When Play is selected while in this mode:

· If there is no selection, the entire sample is played in an endless loop.

· If there is a selection, the selection is played in an endless loop.

Shortcut
To switch between playback modes, use Control+Spacebar

                                                         
See also
Special Menu



Play as Sample Mode
Sets Playback mode to Sample Mode. When Play is selected while in this mode, the file is played with 
the sustain and release loops repeating a set number of times. Use this to listen to a sample as it would 
sound when played by a sampler.

Shortcut
To switch between playback modes, use Control+Spacebar

                                                         
See also
Special Menu



Regions List
Add
Delete
Modify
Replicate
Split
Update
Clear
Markers to Regions
Open
Save As
Copy to Clipboard
                                                         
See also
Special Menu
The Playlist and Regions List



Add to Regions List
Use this function to add a selection to the Regions List.

Shortcut
Drag and drop selection to Regions List
Ruler Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Delete Region from Regions List
Use this function to delete a region from the Regions List.

Shortcut
In the Regions List, select a region and press Delete
Region Tag Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Edit Regions List
Use this function to modify a region in the Regions List.

Name
Name of the region, which can be up to 255 characters long.
Type (Marker/Region)
A Marker is a single point, a region is a start and end point, and has an associated length.
Start, End, Length, Input Format
Use to change the selection. Sound Forge automatically fills in the values depending on your selection 
or cursor position.
Trigger
Use if you want to trigger a region or marker using MIDI commands.
MIDI Note On - Play
The region will be played when the specified note on message is received and will play for the full 
length of the region.
MIDI Note On - Play / Note Off - Stop
The region will be played when the specified note on message is received and will stop when either the 
full region is played or the specified note off message is received.
MIDI Note On - Queue / Note Off - Play
The region will be queued for play when the specified note on message is received and will play when 
the corresponding note off message is received. This is used to reduce the time between receiving a 
trigger and playing a region.
Channel
Determines the MIDI input channel for triggering.
Note
Determines the MIDI note that will trigger region playback. This value can be entered as either a MIDI 
note value such as C5 or as a MIDI note number such as 60.
If you have the MIDI Input Sync/Trigger mode enabled while using this dialog box, you can auto fill the
Channel and Note values by pressing a key on your MIDI keyboard.

Shortcut
Region Tag Shortcut menu
Region List Shortcut menu
Press Enter when a region in the Regions List has focus
Double click on a region in the Regions List

                                                         
See also
Special Menu
Shortcut Menus
The Playlist and Regions List



Replicate Region in Regions List
Use this function to create a new copy of the marker/region.

Shortcut
Region List Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Split Region in Regions List
Use this function to split a region into two at the current cursor position.

Shortcut
Region List Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Update Region
Use this function to change the current marker/region location to match the current cursor/selection. 

Shortcut
Region Tag Shortcut menu
Region List Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Clear Regions List
Use this function to remove all markers/regions from the Regions List.

                                                         
See also
Special Menu



Markers to Regions
This function will take all of the markers in the Region List and convert them into regions using the data 
between each consecutive marker as the region boundary. 

                                                         
See also
Special Menu



Regions List|Open
This function allows the importing of another region/playlist file into the current sound file. This handy 
option offers the flexibility of having multiple playlists for the same sound file. 

Note: Opening a new regions/playlist will clear the present one. Make sure you have
saved the current regions/playlist before continuing.

                                                         
See also
Special Menu



Open Regions List and Playlist
This dialog allows you to select a Playlist file (.sfp), Session 8 file (.prm), or another Wave file (.wav) to 
import a Regions list and Playlist from.

                                                         
See also
Special Menu



Regions List|Save As
This function saves the current regions/playlist to an external regions/playlist file. This allows the ability to 
create multiple regions/playlists for a single sound file.

                                                         
See also
Special Menu



Save Regions List and Playlist
Use this dialog to save the Regions List and Playlist of the current sound file into a separate Playlist file 
(.sfp) or Session 8 file (.prm).

                                                         
See also
Special Menu



Copy Regions List to Clipboard
Use this function to copy the text of the Regions List onto the clipboard for use with a text editor. Excellent
for making a hard copy of the Regions List.

Shortcut
Region List Shortcut menu

                                                         
See also
Special Menu



Playlist
Add
Delete
Replicate
Edit
Clear
Stop Point
Pre-Roll on Playback
Copy to Clipboard
Open
Save As
Convert to File
                                                         
See also
Special Menu
The Playlist and Regions List



Add Section to Playlist
Use this function to add a region to the Playlist.

Shortcut
Drag and drop a region from the Regions List to the Playlist.
Playlist Shortcut menu

                                                         
See also
Special Menu



Delete Section from Playlist
Use this function to delete a region from the Playlist.

Shortcut
Press the Delete key when a region has focus in the Playlist.
Playlist Shortcut menu

                                                         
See also
Special Menu



Replicate Section in Playlist
Use this command to create a new copy of the region.

Shortcut
Playlist Shortcut menu

                                                         
See also
Special Menu



Clear Playlist
Use this function to remove all markers/regions from the Regions List.

                                                         
See also
Special Menu



Stop Point
Use this command to place a stop point on the region. Sound Forge stops playback within the Playlist 
whenever a stop point is reached.

Shortcut
Playlist Shortcut menu
* (asterisk) when a Playlist region has focus

                                                         
See also
Special Menu



Pre-Roll on Playback
When on, playback from the Playlist begins at the specified time prior to the selected start point in the 
Playlist. The amount of Pre-Roll time can also be set in the Playlist/Region List Preferences folder.

For example, say you have two regions, Region 1 and Region 2 in the Playlist. If you have the Pre-Roll 
time set to 0.5 seconds, when you start playback of the Playlist from Region 2, the last 0.5 seconds of 
Region 1 will be played back before starting with Region 2. This allows you to hear the transition between 
the two regions.

Shortcut
Playlist Shortcut menu
/ (backwards slash) when a Playlist region has focus

                                                         
See also
Special Menu



Open
This function allows the importing of another region/playlist file into the current sound file. This handy 
option offers the flexibility of having multiple playlists for the same sound file. 

Opening a new regions/playlist will clear the present one. Make sure you have saved the
current regions/playlist before continuing.

                                                         
See also
Special Menu



Save As
This function saves the current regions/playlist to an external regions/playlist file. This allows the ability to 
create multiple regions/playlists for a single sound file.

                                                         
See also
Special Menu



Copy Playlist Text to Clipboard
Use this command to copy the text of the Playlist onto the clipboard for use with a text editor.

Shortcut
Playlist Shortcut menu

See also
Special Menu



Convert to New
Use this command to create a new sound file which contains the regions arranged sequentially as 
specified in the Playlist. The new file will contain the exact sequence of regions you hear when playing 
from the Playlist.

Shortcut
Playlist Shortcut menu

                                                         
See also
Special Menu



Edit Playlist Section
Use this function to add or modify a region in the Playlist.

Name
The name of the region in the Playlist that is being modified
Play Count
The number of times the Playlist region will repeat before continuing on the next region in the play list. 
Setting this value to 0 will cause the region to be skipped during playback.
Trigger
The method with which the Playlist region will be invoked (triggered) when you have the MIDI Input 
Sync/Trigger mode enabled.
Channel
If the Playlist region is being triggered by a MIDI note, this will be the receive channel for that region.
Note
If the Playlist region is being triggered by a MIDI note, this is the MIDI note number that will trigger this 
Playlist region. This value can be entered as either a MIDI note value such as C5 or as a MIDI note 
number such as 60.
If you have the MIDI Input Sync/Trigger mode enabled while using this dialog box, you can auto fill the
Channel and Note values by pressing a key on your MIDI keyboard.
SMPTE
If the Playlist region is being triggered from a SMPTE time cue, this is the point in SMPTE time that will 
trigger the Playlist region.
Pre-roll playback
When checked sets the number of seconds of pre-roll from the end of the prior Playlist region that will 
be heard when starting the Playlist sequence from this Playlist region.

Shortcut
Playlist Shortcut menu
Double click on a region in the Playlist
Press Enter when a region in the Playlist has focus

                                                         
See also
Special Menu
The Playlist and Regions List



AVI Playlist Save As
Use this dialog to specify a name and directory for the new AVI file which will be created from the current 
Playlist arrangement.

                                                         
See also
Special Menu
Playlist|Convert to New



Edit Sample
Use this command to change sample parameters.

Sample Type (One Shot, Sustaining, Sustaining with Release)
Selecting one of these choices will determine how the sample is played back. 

One Shot The sample will play normally (as it appears) with no loops.
Sustaining The sample will repeat the sustain-loop region the specified number of times.
Sustaining with Release The sample will repeat the sustain-loop region, play the region 
between the sustain and release loop and then repeat the release-loop region.

Loop (Sustain, Release)
Use to select the loop currently being edited.
Loop Count (1-999, infinite)
Number of times that the sustain or release loop will be repeated before continuing playback. This 
information may or may not affect how your sampler plays the data. By specifying a finite loop count it is
easier to hear how transitions between loops and normal data will sound.
Start, End, Length, Input Format
Use to change the position and length of the loop.
MIDI Unity Note
This is the MIDI note that will cause a sampler to play the sample at the pitch (sample rate) it was 
originally recorded.
Fine Tune
Some samplers will utilize this information to adjust the pitch (sample rate) of the sample. Sound Forge 
does not fine-tune the sample itself when this option is utilized. This option is an information type setting
that will be transmitted to a sampler via a sample transfer procedure. A sampler such as the K2000 can 
use this information for its playback of the sample. The K2000 should accurately display this information
on Master/Sample/Misc. page, it appears as Pitch Adjust, just below Root Key Number. 
SMPTE Offset/Format
Some sampler editors store a SMPTE Offset value in the sample. Sound Forge ignores this offset 
value. If you want to add SMPTE Offset information to your sample, choose a SMPTE Format from the 
Format list and type in an offset value. Otherwise leave the Format option to No Offset.

Shortcut
Ruler Shortcut menu
Loop Tag Shortcut menu
Drag and drop a selection to the ruler to create a new loop

                                                         
See also
Special Menu
Sampler Tools



Edit Frame Rate
Use this command to change the Frames per second value used by Sound Forge for status information 
when using Absolute Frames or Time & Frames format. The included presets are there for your 
convenience. You can manually enter the frame rate below.

Set Frame Rate to:
Half NTSC video (14.985 fps)
This is one half of the standard rate for video broadcasts.
NTSC video (29.970 fps)
This is the standard rate for video broadcasts.
Red Book digital audio (75.000 fps)
When recorded to CD, the audio is divided into frames which occur at about every 8 ms. Thus, when 
editing a sound file that will end up in an audio CD, this format is useful for guaranteeing that the start 
and end of selected audio will exactly match with the final product. 
SMPTE Non-drop (29.970 fps)
This is the same as NTSC video.
Video for Windows Default (15.000 fps)
Default rate used by Video for Windows .AVI files.
Frames per Second (1 to 1000)
Number of frames per second used. You can select a pre-set from the list above or manually enter a 
value.

                                                         
See also
Special Menu



Edit Tempo
Use this command to automatically calculate the musical tempo (Beats per minute) from the current 
selection. 

To use the Edit Tempo function, first make a selection in the waveform display. The selection made should
be equal in size (or integer multiple) to the length of a beat or measure. The easiest way to tune a 
selection to be exactly one measure long is to play the selection looped and change the selection points 
until a constant downbeat is heard.

Sound Forge uses the current tempo to display measures in the Time Ruler and in the Auto Region tool.

Type (Beat/Measure)
Choose whether the current selection in the waveform display is one beat or one measure long.
Start, End, Length, Input Format
Determines the selection used to calculate the tempo.
Beats Per Measure (1 to 32)
Use to specify the number of beats in a measure when selecting a measure (e.g. 4 for most pop music 
out there). It can also be used to specify beats per selection length if the selection is larger than one 
measure.
Beats per Minute (1.0 to 1000.0)
Sound Forge calculates this tempo value depending on your selection length, selection type (Measures 
or Beats), and Beats per Measure. 

Note: The default tempo (Default: 120) can be changed on the Status page of the
Preferences folder. 

                                                         
See also
Special Menu



Center Cursor
Selecting this item will center the display so that the cursor appears in the center of the data window. This
item does not actually move the cursor to a new position in the data window, it simply redraws the display 
so that you will now see the areas of the sound file equally on either side of the cursor. If the cursor does 
not seem to center when selecting this, it is because the cursor is either very close to the beginning or 
end of the sound file, and therefore cannot be centered.

Tip: If you have a selection, you can switch the cursor between selection points using
Home and End. You can also switch the cursor between selection points by holding the

Control key while selecting the Go to Start or Go to End buttons in the Playbar or
Transport toolbar. 

Shortcut
. (period)
* (asterisk)

                                                         
See also
Special Menu



Drop Marker
The Drop Marker command is a way to mark positions in a sound file. You can drop a marker at the 
current cursor position while editing or on the fly during file playback. It is much easier to create a marker 
from the toolbar or by pressing 'M' on the keyboard rather than the menu (as this would be difficult to 
coordinate on the fly). Markers can be quickly selected from the list in the Go To dialog box located in the 
same menu/button bar. Also, markers are placed in the Regions List for quick playback.

There is usually a very small delay between the time when you select Drop Marker and
when the marker is actually created. Using the keyboard shortcut 'M' gives the fastest

response, and thus the highest accuracy. 

Depending on the sound card you are using, there might be an offset error between what you hear and 
where the cursor is at. To correct this, go into the Wave folder in the Preferences Folder and use the 
Position Bias to correct for the sound card driver's offset error. 

Some sound cards do not return position information to Sound Forge very efficiently. If the cursor moves 
in large chunks during playback, check the Interpolate position between buffers to allow Sound Forge to 
estimate where the sound card playback is occurring.

Shortcut
M
                                                         
See also
Special Menu
Using Markers



Create Region
Use this function to create a new region in the Regions List from the current selection.

Shortcut
R
                                                         
See also
Special Menu
The Playlist and Regions List



Create Sample Loop
Use this function to create a loop from the current selection.

Shortcut
L
                                                         
See also
Special Menu



Mark In
This item is similar to the Drop Marker function. It will allow you to mark the in point of a new selection 
while the sound file is playing back. You can also use this as a method of marking the in point of a new 
selection while editing by moving the cursor to where you want the selection to start. This is a good way 
to accurately set the start of a selection. For greatest accuracy you should use the keyboard shortcut key 
'[' when Marking In during playback.

Note: If the there is a discrepancy between what you hear and the cursor position on
screen, use the Play position bias or Interpolate play position for inaccurate devices
between fields options on the Wave page in the Preferences folder (Options menu).

Shortcut
[ (left square bracket)

                                                         
See also
Special Menu
Using Markers
Mark Out



Mark Out
Use this function to create a mark out point of a new selection. Mark In and Mark Out are used to 
determine a selection, and can be used during playback. For greatest accuracy you should use the 
keyboard shortcut key ']' when marking out during playback.

Note: If the there is a discrepancy between what you hear and the cursor position on
screen, use the Play position bias or Interpolate play position for inaccuracies between

fields options on the Wave in the Preferences folder (Options menu).

Shortcut
] (right square bracket)

                                                         
See also
Special Menu
Using Markers
Mark In



Toggle Selection
By using the S key (or this menu item), you can toggle back and forth between the last selection and last 
cursor position. For instance, you may be setting the cursor in various places while navigating throughout 
a sound file. If you then hit S, the last selected region will immediately return to the display. 

Shortcut
S
                                                         
See also
Special Menu



Undo/Redo History Clear
Use this function to erase the temporary files created in the undo history for the active file. These files do 
take up disk space, so you might want to periodically clear them when you are sure that you don't want to 
undo any of your previous changes. This function only affects the current sound file.

                                                         
See also
Special Menu



Undo/Redo Clear All
This command will clear the undo histories for all open sound files. Clear all affects all of the opened 
sound files. After doing this you will be unable to undo changes you have made to all modified sound files.

                                                         
See also
Special Menu



Rebuild Peak Data
This function recalculates the peak data file for the active data window. A peak data file is used in 
displaying a file's waveform without scanning the entire length of the file for the sample amplitudes. This 
makes screen redraws much faster.

If for some reason you believe that the waveform display is not accurately representing the sound file, you
can use this function to force Sound Forge to re-scan the entire file. However, under normal 
circumstances you should never have to do so since Sound Forge will always update the peak file after 
every edit operation and when loading a file.

                                                         
See also
Special Menu



Window Menu
New Window
Cascade 
Tile Horizontally 
Tile Vertically 
Arrange Icons 
Resore All 
Minimize All 
Close All 



New Window
Use this command to create a new data window. The new window will be given a generic name. This 
command uses the sound parameters from when the File New command was last used.

Shortcut
Control+Shift+N

See also
Window Menu



Cascade
Use this command to arrange the data windows so they overlap with the title bar of each window 
remaining visible.

Shortcut
Shift+F5

                                                         
See also
Window Menu



Tile Horizontally
Use this command to arrange the data windows side by side without them overlapping.

                                                         
See also
Window Menu



Tile Vertically
Use this command to arrange the data windows top to bottom without them overlapping.

Shortcut
Shift+F4

                                                         
See also
Window Menu



Arrange Icons
Use this command to arrange the minimized data icons in the Sound Forge workspace.

                                                         
See also
Window Menu



Minimize All
Use this command to minimize all open data windows in the Sound Forge workspace.

                                                         
See also
Window Menu



Restore All
Use this command to restore all minimized data windows in the Sound Forge workspace.

                                                         
See also
Window Menu



Close All
Use this command to close all open data windows in the Sound Forge workspace.

                                                         
See also
Window Menu



Go To Marker
Use this to move the cursor to a marker location.

Shortcut
Marker Tag Shortcut menu



Select Region
Use this to change the current selection to be equal to the region endpoints.

Shortcut
Region Tag Shortcut menu



Edit Marker or Region
Use this to edit a marker or region.

Shortcut
Region or Marker Tag Shortcut menu



Update Marker or Region
Use this to update the marker or region to the current cursor or selection point.

Shortcut
Region or Marker Tag Shortcut menu



Delete Marker or Region
Use this to remove a marker or region.

Shortcut
Region or Marker Tag Shortcut menu



Select Sample Loop
Use this to change the selection to be equal to the loop points.

Shortcut
Loop Tag Shortcut menu



Edit Sample Loop
Use this to edit the sample sustain or release loop.

Shortcut
Loop Tag Shortcut menu



Update Sample Loop
Use this to change a loop to the current selection.

Shortcut
Loop Tag Shortcut menu



Delete Sample Loop
Use this to delete a sample loop.

Shortcut
Loop Tag Shortcut menu

 



Edit Menu
Undo 
Redo 
Repeat
Cut 
Copy 
Copy Object Link
Paste 
Crossfade 
Overwrite 
Replicate 
Mix 
Paste to New 
Trim/Crop 
Clear/Delete 
Select All 
Preview Cut/Cursor
Pre-roll to Cursor 
Edit Tool 
Magnify Tool 
Pencil Tool
Go To 
Selection 
Undo All 
Disable Undo 



Undo
Use this command to undo the last edit operation. For instance, if you deleted a section of data by 
accident, simply choose the Undo option from the Edit menu to put the data back.

You can also undo operations from the Undo/Redo History Window.

Tips
When working on large files, it takes Sound Forge a longer period of time to create an undo buffer. To 
save time and file space, you can disable the undo. This is done by selecting the Disable Undo item 
under the Edit menu or from within most processing functions.

Shortcut
Control+Z
Alt+Backspace

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Redo
Use this command to re-perform an undone event. For instance, if you decide that you really did want to 
delete that selection of data, select Redo and the undo will be undone.

You can also redo operations from the Undo/Redo History Window.

Shortcut
Control+Shift+Z
                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Repeat
Use this command to repeat the last performed operation. This can be used with most processing 
functions.    The last dialog settings will be used unless you hold down the shift key, which allows you to 
change the operation's dialog parameters.

Shortcut
Control+Y to repeat last operation with the last used dialog box options
Control+Shift+Y allows you to change the dialog settings before repeating

                                                         
See also
Edit Menu
Processing Shortcuts



Cut
Use this command to remove selected sample data and put it onto the clipboard. This command has no 
effect if there is no selected data. Cutting sample data replaces the previous contents of the clipboard.    
To hear what the cut will sound like before without altering the data, use Preview Cut.

Cutting data from the beginning of a very large file will take a long time to process. This is because large 
amounts of data need to be moved. You can preview a cut by using the Preview Cut/Cursor function (Edit 
menu). Also, the Playlist can be used to make non-destructive cuts which are instantaneous.

Note: You cannot cut from a single channel in a stereo file since the two channels in a stereo file must 
always be equal in length. To shift a single channel in time, use the Delay/Echo|Simple function in the 
Effects menu. 

Shortcut
Control+X
Control+Del

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Copy
Use this command to copy selected sample data onto the clipboard. This command has no effect if there 
is no selected data.

Shortcut
Control+C
Control+Insert

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Copy Object Link
32 Bit Only: This option is only available in the 32 Bit version of Sound Forge.

Use this command to copy an object link for the active sound file onto the clipboard. You can then Paste 
(or Paste Special) the Link into another application (such as Microsoft Word or Write) that supports Object
Linking and Embedding (OLE). This feature is useful for embedding sound files in documents.

Object links are simply references to existing sound files on your hard disk or network server. If you 
embed an object link to a sound file in a document, the sound file is not actually inserted into the 
document, just a reference. Therefore, if you copy the document to another computer, any sound file(s) 
that are embedded will not be available on the other computer unless the sound file is stored on a 
common network server.

If you intend to share documents between computers that contain embedded sound files, it is suggested 
that you store all sound files on a network server and embed them using Universal Naming Convention 
(UNC) path names. For example, if your server and share name for sound files is \\myserver\sounds, then
open and embed all sound files using the UNC path (i.e. \\myserver\sounds\<directory and file name >).

If you are running Windows 95, UNC path names are extremely simple to use. Instead of using a drive 
letter when browsing in the File Open dialog, select Network Neighborhood in the Look In field and 
browse to the appropriate network server and share containing your sound files. This method of browsing 
uses UNC names exclusively.

For more information on Copy Object Link, and OLE support in general, refer to the Object Linking and 
Embedding (OLE) chapter in the Appendix.

                                                         
See also
Edit Menu



Paste
Use this command to insert a copy of the clipboard contents at the current insertion point. If there is a 
selection made, the Paste command deletes the selected data before inserting.

Note: This command has no effect if the clipboard is empty. Pasting data of different sample rates will 
cause the data in the clipboard to play at the same rate as the rate of the window in which the data is 
pasted. Pasting into a stereo file will insert data to both channels since the channels in a stereo file must 
always be equal in length.

Shortcut
Control+V
Shift+Insert
Drag and drop a selection to another data window + Alt.

Instead of using the Alt key while dropping, you can also hit the right mouse button while dragging. This 
toggles between Mix, Crossfade, and Paste drag and drop.

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo
Drag and Drop Operations



Crossfade (Paste Special)
Use this command to crossfade a copy of the clipboard contents with the sample data.    The crossfade 
start point is either the cursor point or the start or end of the selection in the destination file.

The crossfade operation is similar to a mix, except that you can apply a linear fade to the source and 
destination data.    It is commonly used as a transition between one sound segment to another.

When applying a crossfade, you often want to fade out (100 to 0%) the destination data and fade in the 
source (0 to 100%) data starting near the end of the destination file.    Linear fades are applied only to the 
area where the destination and source files overlap following the crossfade start point.    Any extra source 
data is appended at the end of the destination file.

Source Start/End Level (-Inf. to 0 dB)
Determines the linear fade applied to the source data before mixing with the destination.    A gain equal 
to the Source End Level is applied to the source data when appending to the end the source file.
Destination Start/End Level (-Inf. to 0 dB)
Determines the linear fade applied to the destination data. Any destination data following the crossfade 
end point is not affected.
Start crossfade at (Start of Selection, End of Selection)
If there is no selection in the destination data window, the linear fade starts at the insertion point. When 
there is a selection in the destination data window, the linear fade can begin at the start or end of the 
destination selection.

Note: Crossfading data of different sample rates will cause the data on the clipboard to play at the same 
rate as that in the current sample with which the data is crossfaded.    This command has no effect if the 
clipboard is empty.

When using drag and drop crossfading, make sure that the Control key is down when releasing the 
mouse button.    When dealing with mono and stereo data, crossfading will occur on the channel which the
selection is dropped to (Left, Right, or Both).

Shortcut
Control+F
Drag and drop a selection from the source to the destination Data Window while holding the Control key.   
Make sure that you don't start the drag with the Control key down, otherwise you will switch to Magnify 
Mode. The Control key must be down when you release (drop) the selection.

You can crossfade regions by dragging any region onto an open data window. The crossfade will occur at 
the current insertion point within the data window on which the data is dropped. The Crossfade operation 
is used rather than Mix when the Control key is held down while dragging. When dragging a single 
channel from a stereo file or a mono file onto a stereo file you can select whether the data is placed in the
left or right channel by the vertical position within the data window. A small L or R will appear next to the 
cursor when crossfading only to a left or right channel respectively.

                                                         
See also
Edit Menu
Drag and Drop Operations



Mix (Paste Special)
Use this command to mix a copy of the clipboard contents with the sample data. The mix start point is 
either the cursor point or the start or end of the selection in the destination Data Window.

Source Volume (-Inf. to 15 dB)
Gain applied to the source data before mixing with destination data.
Destination Volume (-Inf. to 15 dB)
Gain applied to the destination data before mixing with source data.
Invert Data (On/Off)
Use to invert the amplitude of the source or destination data.
Start Mix At (Start of Selection, End of Selection)
When there is a selection in the destination data window, you have the option of performing the mix 
starting at the beginning or end of the selection.    When no selection is present, the data is always 
mixed starting at the cursor position.
Apply destination volume to overlapping area only (On/Off)
When off, the Destination Volume gain is applied to the entire destination sound file.    Otherwise, the 
Destination Volume gain is applied to only where the destination and source data are mixed.
Pre-Post-fade destination edges (0 - 5 seconds/Off)
Use this to apply a fade to the destination data before and after the mixing region.    The Pre-fade time 
determines the fade time before the mix start, while the Post-fade time determines the fade-time after 
the mix end.
For example, when mixing vocals over a music track, you can have the music track fade before and 
after the region where vocals are mixed, so that the vocals are more pronounced. This technique is 
sometimes referred to as ducking.

Note: This command has no effect if the clipboard is empty. Mixing data of different sample rates will 
cause the data on the clipboard to play at the same rate as that in the current sample with which the data 
is mixed.

Shortcut
Control+M
Drag and drop a selection from the source to the destination data window.

                                                         
See also
Edit Menu
Drag and Drop Operations
Simple Mixing
Advanced Mixing Options



Overwrite (Paste Special)
Use this command to replace an area of sample data with the contents of the clipboard.

The Overwrite command replaces data using the following rules:

- If an area is selected which is greater than the length of the clipboard, the data from the beginning of
the selection is replaced for the length of the clipboard.

- If an area is selected which is less than or equal to the length of the clipboard, the data within the 
selection is replaced with the clipboard for the length of the selection.

The Overwrite command is useful when you are trying to replace silent sections of audio with background 
noise.

Shortcut
Control+H

                                                         
See also
Edit Menu



Replicate (Paste Special)
Use this command to copy multiple copies of the clipboard to the current data window.

The Replicate command will copy as many copies of the clipboard as will fit to a selected area. If no 
selection is currently made in the data window, the function will have no effect. 

Copy Partials
Selecting the Copy Partials button will fill the selected region completely, using a partial copy of the 
clipboard if needed.
Whole Copies
Selecting this option will use only whole copies of the clipboard, and will not fill the selected region 
completely if its length is not an exact multiple of the clipboard length.

Example:

1. Copy a 1 second sample onto the clipboard.
2. Insert a 5.5 second silence sample in the data wave form.
3. Select the 5.5 second area and select Replicate.
4. If you choose Whole Copies, 5 copies of the clipboard will be placed in the area the silence 

previously occupied and 0.5 seconds of silence will remain at the end.
5. If you choose Copy Partials, 5.5 copies of the clipboard will be placed in the data rather than just 5. 

No silence will remain.
The replicate command is useful when you are trying to replace silent sections of audio with background 
noise. It can also be used to introduce stuttering effects or echoes.

                                                         
See also
Edit Menu



Paste to New (Paste Special)
Use this command to create a new data window which contains the contents of the clipboard.

Shortcut
Control+E
Drag and drop a selection to the Sound Forge workspace to create a new file from the selection.

                                                         
See also
Edit Menu
Drag and Drop Operations



Trim/Crop
Use this command to remove all data from the sample except the selected data. This command has no 
effect if there is no selected data.

Trimming/Cropping sample data does not copy data onto the clipboard.

                                                         
See also
Edit Menu
Cropping data



Clear/Delete
Use this command to remove selected sample data without copying it onto the clipboard.

Note: You cannot clear data from a single channel in a stereo file since the two channels in a stereo file 
must always be equal in length. This command has no effect if there is no selected data.

Shortcut
Delete

                                                         
See also
Edit Menu



Select All
Use this command to select all data in the current data window.

Shortcut
Control+A
Control+Numpad 5
Double clicking the left mouse button in the Waveform Display will select all data.

                                                         
See also:
Edit Menu



Preview Cut/Cursor
Use this command to playback around a selected region. This lets you preview the result of a Cut or Clear
operation without altering the file. Go to the Previews page in the Preferences folder (File menu) to set the
amount of pre- and post-roll around the selection.

If there is no selection, the playback will pre- and post-roll around the cursor position.

                                                         
See also
Edit Menu



Pre-roll to Cursor
This command will play the data before the cursor position for the specified pre-roll length in the preview 
Preferences folder.

If a selection is made the pre-roll will occur for whichever end of the selection is active. To toggle between
ends of the selection use the Home and End keys. This function is invaluable when tweaking the end of a 
long selection and not needing to hear the entire thing.

Shortcut
Control+Shift-click on the Play Normal button
Control+Shift+K

                                                         
See also
Edit Menu



Edit Tool
Use this command to use the Edit Tool of Sound Forge. This is the typical editing mode used for selecting
and editing data.



Magnify Tool
Use this tool to zoom in to a particular region without losing your selection. While using the Magnify Tool, 
when you make a selection Sound Forge will draw a dotted rectangle around an area and will magnify the
area when the mouse button is released. 

There are three modes of operation for the Magnify Tool, and these can be chosen by toggle-clicking 
(refer to the Using Sound Forge section explanation of toggle-clicking) while the Magnify Tool is selected. 
These modes allow for Zoom Time only, Zoom Level only or a Time/ Zoom Level.

To return to the normal editing, choose the Edit Tool from the Edit menu.

Shortcut
While using any tool, if you hold the Control key down before making a selection with the mouse, you will 
switch to the Magnify Tool. This is handy for quickly magnifying a particular section of your sound file.

Data Magnify Mode
When you are in the data window this cursor shows that you can select an area to magnify. Dragging 
within the data window will draw a dotted rectangle which specifies the region of data to magnify.



Pencil Tool
Use this tool to edit the waveform by drawing on it. For example, if you have a glitch in the sound data, 
zoom in to the glitch and smoothly re-draw the waveform using the Pencil Tool. 

While holding down the left mouse button, you can also use the arrow keys to fine tune the pencil 
position.

The Pencil Tool is only available when operating at magnification levels between 1:1 and 1:16. To return 
to the normal editing mode, choose the Edit Tool from the Edit menu.

Data Pencil Mode
When you are in the data window this cursor shows that you can draw new audio data. Dragging within 
the data window will draw a new line which represents the new audio data. This is an easy way to 
remove glitches or pops within the audio data.



Go To
Use this command to set the cursor to a particular location in the sound file.

Go To
Provides preset locations to pick from.
Position (0 to Total length)
The position where the cursor will be moved can be specified here.
Input Format
Determines the input format that will be used to enter the position.

If you have a selection, you can switch the cursor between selection points with the ` key
(reverse quote, normally above Tab key). You can also switch the cursor between

selection points by holding the Control key while selecting the Go to Start or Go to End
buttons in the Playbar or Transport toolbar.

Shortcut
Control+G
F5
Waveform Display shortcut menu
Double-click on the selection start field in the playbar

                                                         
See also
Edit Menu
Shortcut Menus
Using Go To



Selection|Snap to Time
This command forces both edges of a selection to a whole time division as designated by the marks on 
the Time Ruler above the data window.

Shortcut
T

                                                         
See also
Edit Menu



Selection|Snap Edge to Time
This command forces the active edge of a selection to a whole time division as designated by the marks 
on the Time Ruler above the data window. The active edge of a selection is defined by the blinking cursor.

Shortcut
Shift+T

                                                         
See also
Edit Menu



Snap to Zero
This command forces both edges of a selection to the next zero-crossing of the waveform. The Editing 
tab in the Preferences folder allows you to choose whether this is a negative, positive or any zero-
crossing.

Shortcut
Z

                                                         
See also
Edit Menu



Snap Edge to Zero
This command forces the active edge of a selection to the next zero-crossing of the waveform. The active
edge of a selection is defined by the blinking cursor.

Shortcut
Shift+Z

See also
Edit Menu



Selection|Set
Use this command to change the start, end, length, or channel of the selection.

Selection
Provides preset regions to pick from.
Start (0 to Total Length)
The start point of the selection is specified here.
End (Start to End)
The end point of the selection is specified here.
Length (0 to Total Length)
The start point of the selection is specified here.
Channel (Left, Right, Both)
If the sound file is stereo, you can specify which channel of the data will be selected.
Input Format
Determines the input format that will be used to enter the Start, End, and Length.
Snap to Zero
Pushing this button snaps the current selection to the nearest zero-crossing.
Snap to Time
Pushing this button snaps the current selection to the nearest whole time, as defined by the major ticks 
on the Time Ruler.

Shortcut
Control+D
Waveform Display shortcut menu
Double-click on the selection length field in the playbar
                                                         
See also
Edit Menu
Shortcut Menus
Advanced Editing and Navigation



Undo All
Use this command to undo all operations performed on a file. Unless Undo was disabled at some point, 
this will return your file to its original state when opened. However, if you disable undo at any time, you 
might not be able to return to the files original state.

When not working in direct mode, you can simply close the file without saving changes to revert to the 
original file. However, when working in direct mode if you decide to not save the current changes, Sound 
Forge does an Undo All operation automatically before saving.



Disable Undo/Redo
Use this command to prevent Sound Forge from creating temporary files used for undoing operations. 
Since creating undo files takes time and disk space, it is sometimes more convenient to have the Disable 
Undo option on, especially when working with large files.

Remember to turn the Disable Undo feature off when you wish to be able to undo operations.

Since Sound Forge doesn't modify the original file unless the file is opened direct or read-
only, you can always recover it by re-opening it. However, saved changes are permanent.

Shortcut
Control+U

                                                         
See also
Edit Menu

 



Tips of the Day
Accurate play cursor position 
Attach a video to a sound file 
Auto-region 
Context-sensitive help 
Create a new file from the Playlist 
Digidesign's Session 8 
Direct file editing 
Docking a Toolbar 
Double-clicking with markers and regions 
Drag and Drop Mix, Crossfade, and Paste 
Dropping markers 
Edit boxes 
Faders and trackbars 
Filter out inaudible frequencies
Fine tuning a control 
Find the maximum level in a file 
Fine tuning a control 
Keyboard shortcuts 
Large Time Display 
Magnify Mode 
Making a selection during playback 
Marker Navigation 
Maximize the level of a sound file 
Mid-Side recording mix 
New file from selection 
Opening files 
Optimizing your system 
Pencil tool 
Play Loop mode 
Play meters 
Playing to the cursor 
Previewing a Cut 
Previewing a Loop transition 
Re-select the last selection 
Reactive Previews 
Regions List and Playlist drag and drop 
Repeating an operation 
Save multiple regions list for a file 
Saving a file in Real Audio format 
Scrolling with the Time Ruler 
Shortcut Menus 
Silky smooth fades 
Spinner Controls 
Stereo expansion 
Time and Level Zoom 
Toolbars 
Turn off Tip of the Day 
Undo/Redo History 
Vertical Zoom 
Workspaces 
Zero crossing 
Turn off Tip of the Day 



Turn off Tip of the Day Next 
To keep this window from popping up every time you run Sound Forge, go to the General Preferences 
page (Options menu) and uncheck Show Tip of the Day on open. While doing so, you will realize how 
many options and features Sound Forge has. You might then decide that if you learn a new trick from this 
Tip of the Day feature every time you run Sound Forge you'll save yourself valuable editing time.
List all Tips of the Day 



Optimizing your system Next      Prev 
Some suggestions concerning how to optimize your system to improve Sound Forge's performance are 
included in the Optimizing Sound Forge    section. 
List all Tips of the Day 



Direct file editing Next      Prev 
For very fast file opens and saves, opening files in Direct Mode allows you to work on the original file 
instead of a backup.
List all Tips of the Day 



Play meters Next      Prev 
The Play meters window is opened by selecting Play Meters from the View menu. A very fast and 
accurate playback meter is useful for maximizing dynamic range and achieving the hottest signal possible
without distortion. The meter will indicate if clipping ever occurs. It even works while previewing effects. 
Right click on the meter to change its range.
List all Tips of the Day 



Optimizing AVI performance Next      Prev 
For best AVI performance, make sure the AVI has been copied to your hard drive. CD-ROM's and network
drives are often too slow for Sound Forge to keep proper audio and video synchronization. For more 
details, see Optimizing Sound Forge.
List all Tips of the Day 



Level Zoom Next      Prev 
To view low-level sounds, zoom vertically by using the Level Zoom spinner on the lower left-hand corner 
of the Data Window or press Shift+Up/Down arrow keys. Once you're zoomed in, you can drag the Level 
Ruler up and down to change the zero line.
List all Tips of the Day 



Marker Navigation Next      Prev 
To move the cursor to the next maker or region, press Control+Left/Right Arrow keys. If you also hold 
down the Shift key, a precise selection can be made.
List all Tips of the Day 



Double-clicking with markers and regions Next      Prev 
Double-clicking on the Waveform Display between two markers selects the region between them. The 
same goes for double clicking inside regions and loops. Triple clicking or holding down the Control key 
while double clicking selects the entire file. Dragging the new selection extends the selection to the next 
marker, loop, or region.
List all Tips of the Day 



Workspaces Next      Prev 
You can group files that are commonly used together by saving Workspaces (File menu). A workspace file
contains all of the files currently open along with their position and size on the screen.
List all Tips of the Day 



Reactive Previews Next      Prev 
While previewing any processing, you can change any dialog parameter during playback and Sound 
Forge will automatically create a new preview.
List all Tips of the Day 



Toolbars Next      Prev 
Toolbar buttons exist for almost all functions. To view a list of all possible toolbars, select View|Toolbars. If 
you hold the cursor over a toolbar button, a floating ToolTip displays the button's function.
List all Tips of the Day 



Shortcut Menus Next      Prev 
Shortcut menus exist for almost every square inch of space in Sound Forge. To view a shortcut menu, 
move the cursor to any area and click the right mouse button. Press F1 while selecting any menu item for 
more information.
List all Tips of the Day 



Docking a Toolbar Next      Prev 
You can drag floating toolbars anywhere on the screen or dock them to any side. Double clicking on any 
toolbars free space switches it from being floating or docked. To keep a toolbar from docking, hold down 
the Control key while dragging it.
List all Tips of the Day 



Spinner Controls Next      Prev 
Instead of clicking on the upper or lower buttons on a spinner, you can also drag the center button to 
change the control's value. When you move the mouse slowly (or hold the Control key while dragging), 
the value will change in small increments.
List all Tips of the Day 



Edit boxes Next      Prev 
Any control which requires you to type a number can also be changed by using the Up/Down or Page 
Up/Page Down arrow keys. Holding down the Control key allows for larger increments or decrements.
List all Tips of the Day 



Faders and trackbars Next      Prev 
To fine tune a fader or trackbar value, hold down both the left and right mouse button while dragging the 
control. You can also use the Left/ Right arrow and Page Up/Down keys.
Double clicking on a control changes the value to its default state.
List all Tips of the Day 



Keyboard shortcuts Next      Prev 
Some of the most useful keyboard shortcuts include:

Spacebar Play/Stop
Enter Pause
M Drop Marker
R Create a region
C Center cursor on screen

List all Tips of the Day 



Opening files Next      Prev 
You can quickly open files by dragging them from any folder onto the Sound Forge desktop.
List all Tips of the Day 



Drag and Drop Mix, Crossfade, and Paste Next      Prev 
By dragging a selection from one open file to another, you can mix, crossfade or paste. To crossfade, hold
down the Control key before dropping. To paste, hold down the Alt key before dropping. If you have any 
markers or regions on the destination file, the cursor will snap to them when near the selection point.
List all Tips of the Day 



New file from selection Next      Prev 
To create a new copy of the current selection, simply drag it onto an open area of the Sound Forge 
desktop.
List all Tips of the Day 



Making a selection during playback Next      Prev 
To make a selection during playback, hit the [ key to set the start time and then the ] key to set the end 
time and make the selection. Hitting R will then create a region.
List all Tips of the Day 



Magnify Mode Next      Prev 
To quickly switch to Magnify Mode, hold down the Control key before making a selection. When you let go
of the mouse button, the selection will be magnified to fit the screen.
While in Magnify Mode and making a selection, toggle-clicking toggles between Horizontal Only, Vertical 
Only, and Horizontal and Vertical magnify modes.
List all Tips of the Day 



Re-select the last selection Next      Prev 
To re-select the last selection, press the S key. Press again to unselect the selection.
List all Tips of the Day 



Zero crossing Next      Prev 
When making selections, if Auto Snap to Zero is turned on (Options menu), the end points will snap to the
next position where the wave crosses the zero line. This helps prevent glitches when cutting, pasting and 
performing other audio processing operations.
List all Tips of the Day 



Regions List and Playlist drag and drop Next      Prev 
Adding a selected region to the Regions List can be done by dragging it from the Waveform Display into 
the Regions List. If you then want to add the region to the Playlist, drag it from the Regions list into the 
Playlist. (To open the Regions List, press Alt+1. To open the Playlist, press Alt+2.) You can also create a 
region and add it to the Playlist immediately by dragging a region directly from the Waveform Display into 
the Playlist.
List all Tips of the Day 



Time and Level Zoom Next      Prev 
To quickly zoom a selection both vertically and horizontally, double click on the Levels Ruler. Double 
clicking again zooms out to the default zoom ratios.
List all Tips of the Day 



Digidesign's Session 8 Next      Prev 
You can save files compatible with Digidesigns Session 8 by turning on Sector align data from the File 
Preferences (Options menu). Also, you can Import and Export Session 8 regions (Special|Regions List|
Open) to maintain regions edited in both Session 8 and Sound Forge.
List all Tips of the Day 



Dropping markers Next      Prev    
You can create markers by pressing M during playback. It is also possible to drop markers while recording
by pressing the drop marker button in the record dialog.
List all Tips of the Day 



Silky smooth fades Next      Prev 
The Graphic Fade dialog allows you to apply Dithering and Noise Shaping to fades to minimize 16-bit 
quantization noise.
List all Tips of the Day



Large Time Display Next      Prev 
If you'd like to see the current cursor or play position in a large display window, open the Time Display 
window from the View menu.
List all Tips of the Day 



Previewing a Cut Next      Prev 
To preview a cut operation, make a selection that you wish to delete and Control-click on the Play Normal 
button.
List all Tips of the Day 



Maximize the level of a sound file Next      Prev 
The Normalize dialog allows you to specify an amount for the peak amplitude or loudness of a sound file. 
You can use this to make all sound files equal in loudness.
List all Tips of the Day 



Previewing a Loop transition Next      Prev 
To preview a transition from the end to the beginning of a loop, make a selection that you wish to loop and
Control-click on the Play Looped button.
List all Tips of the Day 



Saving a file in RealAudio format Next      Prev 
The RealAudio file format allows you to broadcast speech in real time over the Internet. To save a file in 
the RealAudio format (.ra), simply select the RealAudio type from the Save As dialog.
List all Tips of the Day 



Playing to the cursor Next      Prev 
To play up to a cursor (with no selection), Control-click the Play Normal button. The pre-roll time used can
be changed in the Other Preferences folder (Options menu).
List all Tips of the Day 



Stereo expansion Next      Prev 
In the Pan/Expand dialog, you can widen the image of stereo files.
List all Tips of the Day 



Mid-Side recording mix Next      Prev 
You can mix the Mid and Side channels of a Mid-Size recording (MS) in the Pan/Expand dialog. This 
converts an MS recording into left and right channels.
List all Tips of the Day 



Pencil tool Next      Prev 
The Pencil Tool allows you to draw a waveform straight into the Waveform Display. This is commonly 
used for correcting glitches. To enable the Pencil Tool, zoom in greater than 1:16 and select Edit|Tool|
Pencil.
List all Tips of the Day 



Attach a video to a sound file Next      Prev 
To add a video to an open sound file, select the Video folder in File|Properties and press Attach video. 
You will then need to save the file as a Video for Windows AVI file.
List all Tips of the Day 



Repeating an operation Next      Prev 
To repeat the last operation, use Control+Y.
List all Tips of the Day 



Auto-region Next      Prev 
The Auto Region tool automatically creates regions for you based on sound levels or tempo.
List all Tips of the Day 



Find the maximum level in a file Next      Prev 
To find the maximum level in a file, use the Find largest peak option in the Find dialog, or use the 
Statistics function (Tools menu).
List all Tips of the Day 



Filter out inaudible frequencies Next      Prev 
Frequencies below 20 Hz are inaudible yet can exist in large volumes in sound file. These frequencies 
make your speaker and amplifier do unnecessary work and make sound editing more difficult. To remove 
very low frequencies, use the Paragraphic EQ's Low-Shelf filter.
List all Tips of the Day 



Save multiple regions lists for a file Next      Prev 
You can save the Regions List and Playlist as separate files (sfl). They can then be opened at any time 
and with any other file. Use the Special|Regions List|Open and Save As commands to import and export 
lists.
List all Tips of the Day 



Create a new file from the Playlist Next      Prev 
To save the audio (and video) sequence specified by the Playlist to a new file, use Special|Playlist|
Convert to New.
List all Tips of the Day 



Undo/Redo History Next      Prev 
The Undo/Redo History window (View menu) shows all of the operations that can be undone or redone. 
Double click on any listed operation to restore the sound file to a previous state.
List all Tips of the Day 



Fine tuning a control Next      Prev 
To fine-tune a slider, fader, or spinner, hold down both the right and left mouse button while dragging. 
Holding down the Control key while dragging works the same way.
List all Tips of the Day 



Scrolling with the Time Ruler Next      Prev 
To scroll the Waveform Display backwards or forwards in time, simply drag the Time Ruler above the 
waveform.
List all Tips of the Day 



Audio Event Locator Next      Prev 
The Audio Event Locator allows you to find audio events by clicking and dragging the mouse on the 
Overview (the thin strip above the Time Ruler). Similar to a scrub, playback follows mouse movement 
across the Overview and loops when the mouse is still. Releasing the mouse stops playback and centers 
the cursor on the last start position in the Waveform Display.
List all Tips of the Day 



Accurate play cursor position Next      Prev 
If the play cursor in the Waveform Display seems slightly unaligned with the wave graph, use the Play 
position bias option in the Wave Preferences folder (Options menu). This compensates for sound cards 
that report position information incorrectly.
List all Tips of the Day 



Context-sensitive help Next      Prev 
To get help on any main or pop-up menu item, select the item from the menu and press F1 while the 
menu is still up. Pressing the Help button or F1 while in any dialog will take you directly to the page in the 
Help file describing the dialog's function.
List all Tips of the Day 



Play Loop mode Prev 
To play in Loop Mode, press the Play Looped button . During playback, changing the cursor or 
selection by poking around the Waveform Display or using Views updates the play position immediately. 
This is very useful for tuning loops or selections and auditioning different parts of a file.
List all Tips of the Day 

 



Options Menu
Status Format 
Annotations 
Play Meters 
Time Display window 
Video Options 
Scroll Playback 
Scroll Smoothly 
Drag and Drop Snapping 
Lock Region Length 
Paste Events 
Auto Snap to Time 
Auto Snap to Zero Crossings 
Enable Sync Out 
Enable MIDI Input Sync/Trigger 
Pre-Queue SMPTE 
MIDI Triggers, dialog 
Preferences 



Status Format
Use this command to set the status format.    Possible formats are:

Samples
Time
Seconds
Time & Frames
Absolute Frames
Measures & Beats
SMPTE Drop
SMPTE Non-Drop
SMPTE EBU
SMPTE Film Sync

Shortcut
Playbar Selection Status Shortcut menu

                                                         
See also
Options Menu
Using Status Formats
Shortcut Menus
Status Preferences



Samples
Use this command to set the status format to samples. A sample is the smallest division of digitized 
sound. The number of samples per second is determined by the Sample Rate.
                                                         
See also
Options Menu
Using Status Formats
Status Formats



Time
Use this command to set the status format to Hour:Minutes:Seconds:Frames, with the frame rate 
adjustable from the Edit Frame Rate dialog under the Special menu. In this mode, the hour, minutes, and 
seconds are in real time, independent of the frame rate.

                                                         
See also
Options Menu
Using Status Formats
Status Formats



Seconds
Use this command to set the status format to show seconds with six decimal place precision.

                                                         
See also
Options Menu
Using Status Formats
Status Formats



Time & Frames
Use this command to set the status format to Hour:Minutes:Seconds:Frames, with the frame rate 
adjustable from the Edit Frame Rate dialog under the Special menu. In this mode, the hour, minutes, and 
seconds are in real time, independent of the frame rate.

                                                         
See also
Options Menu
Using Status Formats
Status Formats



Absolute Frames
Use this command to set the status format to show frames and fractions of a frame.

                                                         
See also
Options Menu
Using Status Formats
Status Formats



Measures & Beats
Use this command to set the status format to beats.
                                                         
See also
Options Menu
Using Status Formats
Status Formats



SMPTE Non-Drop
Use this command to set the status format to SMPTE Non-Drop (30 or 29.97 fps). The standard rate for 
SMPTE Non-Drop when synchronizing to video is 29.97. However, in music applications, a rate of 30.00 
is often used. You can enable using 30 instead of 29.97 under the Options menu on the MIDI/Sync page 
in the Preferences folder.

Note: When using a frame rate of 29.97, the time displayed will be different than real
world time because thirty frames are still used to measure one second (see the Appendix

section on SMPTE).

                                                         
See also
Options Menu
Using Status Formats
Status Formats



SMPTE Drop
Use this command to set the status format to SMPTE Drop (29.97 fps). Frames will be dropped at specific
points in time to ensure that the hours and minutes displayed stay synchronized to real world time (see 
the Appendix section on SMPTE).

                                                         
See also
Options Menu
Using Status Formats
Status Formats



SMPTE EBU
Use this command to set the status format to SMPTE EBU (25 fps). This is the standard rate used by 
European television.

                                                         
See also
Options Menu
Using Status Formats
Status Formats



SMPTE Film Sync
Use this command to set the status format to SMPTE Film Sync (24 fps), which is a common slower film 
rate.

                                                         
See also
Options Menu
Using Status Formats
Status Formats



Annotations
The names of markers, regions, and loops can be shown on the waveform display, along with dotted lines
which run the entire height of the window…all with your permission, of course.

Marker Names 
Marker Lines 
Region Names 
Region Lines 
Loop Names 
Loop Lines 



Annotations|Marker Names
Displays marker names on the waveform display.

                                                         
See also
Options Menu



Annotations|Marker Lines
Displays dotted lines on the waveform display showing where markers exist.

                                                         
See also
Options Menu



Annotations|Region Names
Displays region names on the waveform display.

                                                         
See also
Options Menu



Annotations|Region Lines
Displays dotted lines on the waveform display showing where regions exist.

                                                         
See also
Options Menu



Annotations|Loop Names
Displays loop names on the waveform display.

                                                         
See also
Options Menu



Annotations|Loop Lines
Displays dotted lines on the waveform display showing where loops exist.

                                                         
See also
Options Menu



Play Meters
The following commands and options affect the Play Meter display. The Play Meters can be turned on 
from the View menu.

Reset Clip 
Resolution 
Show Labels 
Hold Peaks 
Hold Valleys 
Always on Top 



Meters|Reset Clip
This function resets the clip indication on the Play or Record Meters. After a clip occurs, the clip indication
will remain lit until the Reset Clip function is invoked. You can also click on the clip light or levels to clear 
it.

                                                         
See also
Options Menu



Meters|Resolution
These settings display the minimum and maximum readings for the Play or Record Meters. Changing the 
resolution of the meters is helpful for metering sound files of varying dynamism.

-90 to 0 dB 
-78 to 0 dB 
-60 to 0 dB 
-42 to 0 dB 
-24 to 0 dB 
                                                         
See also
Options Menu



Meters|-90 to 0 dB
Determines the bottom-most level that will be displayed. A value of -90 dB is the absolute minimum peak 
value in 16-bit audio, corresponding to a sample value of +/- 1.



Meters|-78 to 0 dB
Determines the bottom-most level that will be displayed. A value of -78 dB (0.012%) will be the smallest 
value displayed.



Meters|-60 to 0 dB
Determines the bottom-most level that will be displayed. A value of -60 dB (0.1 %) will be the smallest 
value displayed.



Meters|-42 to 0 dB
Determines the bottom-most level that will be displayed. A value of -42 dB (0.8 %) will be the smallest 
value displayed.



Meters|-24 to 0 dB
Determines the bottom-most level that will be displayed. A value of -24 dB (0.6 %) will be the smallest 
value displayed.



Meters|Show Labels
This option turns on or off the markings on the Play or Record Meters.

                                                         
See also
Options Menu



Meters|Hold Peaks
This option turns on or off the markings to indicate the highest peaks in the sound file.

                                                         
See also
Options Menu



Meters|Hold Valleys
This option turns on or off the markings to indicate the lowest peaks in the sound file.

                                                         
See also
Options Menu



Meters|Always on Top
Turning this option on forces the Play Meters to always remain on top even when another window is 
dragged over them.

                                                         
See also
Options Menu



Time Display
Use this command to set the Time Display window format and update speed.
Possible formats are:

Position
Sync/Trigger Status
Playlist Position
Passive Update

                                                         
See also
Options Menu



Time Display|Position
Checking this option will display the current cursor position in the time display window. The format of the 
display will depend on the Status Format setting above.

                                                         
See also
Options Menu



Time Display|Sync/Trigger Status
Checking this option will display the Sync/Trigger Status in the Time Display window.

                                                         
See also
Options Menu



Time Display|Playlist Position
Checking this option will display the playlist position in the Time Display window. The format of the display
will depend on the Status Format setting above.

                                                         
See also
Options Menu



Time Display|Passive Update
Checking this option will reduce the overhead (processor time) needed to update the Time Display 
window. The smallest increments may not be exact but the major increments will stay perfectly locked. If 
you have a slower machine and are experiencing gaps in playback try checking this option.

                                                         
See also
Options Menu



Video Options
These options affect the Video Preview window.

Copy Current Frame 
White, Black or Default Background 
Animate Video Strip 
Number Frames  
Stretch to Window 
Integral Stretch 
Preserve Aspect 
Passive Update 



Video|Copy Current Frame
Enabling this option will copy the frame corresponding to the current cursor location to the clipboard.

                                                         
See also
Options Menu



Video|Default Background
This option selects the color used surrounding frames in the Video Preview and video strips. The default 
color can be chosen from the in the Options menu on the Preferences page.

                                                         
See also
Options Menu



Video|Black Background
This option selects the color used surrounding frames in the Video Preview and video strips.

                                                         
See also
Options Menu



Video|White Background
This option selects the color used surrounding frames in the Video Preview and video strips.

                                                         
See also
Options Menu



Video|Animate Video Strip
When this option is turned on, the video strip above the waveform display will come to life at the current 
cursor or play position. This feature is frame accurate, meaning that when you move the cursor, the 
correct frame corresponding to the cursor position will be displayed instead of the static overview frame.

When off, the video strip always shows the frame that corresponds to the left edge of each image in the 
video strip,

                                                         
See also
Options Menu



Video|Number Frames 
Turn this on to show the frame number at the bottom left-hand corner if the video windows.

                                                         
See also
Options Menu



Video|Stretch to Window
Turn this option on to cause each Video Preview frame to fit exactly into the Video Preview window. This 
mode is generally the slowest because resizing a frame by non-integral fractions requires many 
calculations.

                                                         
See also
Options Menu



Video|Integral Stretch
When this resize mode is enabled, the Video Preview frame will only be stretched by integral amounts. 
This is usually the fastest mode.

                                                         
See also
Options Menu



Video|Preserve Aspect
Check this re-size option when you want the original aspect ratio (horizontal vs. vertical size) of the video 
to be preserved. 

                                                         
See also
Options Menu



Video|Passive Update
Checking this option will reduce the overhead needed to update the Video Display window. When on, the 
Video Display will only be updated when the processor is idle, which in slower computers is much less 
frequent. This will help to keep the audio from skipping when a computer can't update video frames fast 
enough.

                                                         
See also
Options Menu



Scroll Playback
Checking this option makes the data window scroll automatically during playback. When the cursor 
moves off of the current window it will quickly scroll to show another full window of data.

Shortcut
F6

                                                         
See also
Options Menu



Scroll Smoothly
Checking this option changes the behavior of the playback auto-scroll. Rather than jumping a window at a
time, the cursor will slowly move back to the center and the wave data will scroll past it. This allows you to
always see in front of the sound data that is being played.

Shortcut
Shift+F6

                                                         
See also
Options Menu



Drag and Drop Snapping
This command toggles on and off the ability to snap to objects when dragging and dropping from window 
to window. With this on you can snap to major time ticks on the Time Ruler, markers and regions, .AVI 
video frames and cursor positions.

                                                         
See also
Options Menu



Lock Loop/Region Length
Use this to have the length of a region remain constant when changing the start or end time of a region or
loop.

Shortcut
Holding the Shift key down while dragging Ruler Tabs also locks the length of a region or loop.

                                                         
See also
Options Menu
Using the Loop Tuner



Paste Events
Enabling this operation will transfer any events such as regions and markers from the source to the 
destination sound files when pasting, mixing, or crossfading. This occurs when using drag and drop or the
clipboard.

If you are using another application to paste data into other than Sound Forge, these events may cause 
problems. Although a well-written application should ignore these events, if you are experiencing clicks at 
the beginning or end of the data you should disable this option.



Auto Snap to Time
When on, selections and cursor positions are always rounded to the nearest unit of time length.

See also
Options Menu



Auto Snap to Zero
When on, selections are always moved outward to the nearest zero crossing. This is useful for avoiding 
clicks and pops which often result when edits are made while the waveform has a high amplitude, causing
abrupt discontinuities in the waveform.

Shortcut
Control+B

                                                         
See also
Options Menu



MIDI Input Sync/Trigger
When MIDI Input Sync/Trigger is turned on, Sound Forge can be triggered from MIDI commands received
through the MIDI Input port. The MIDI Input port is specified on the MIDI/Sync  page in the Preferences 
folder (Options menu).

When this option is off, the MIDI triggers, Regions List triggers, and Playlist triggers specified will not be 
enabled. When this option is on, dialogs which specify MIDI triggers will also accept input from the MIDI 
Input port, allowing easy entry of MIDI Note and Controller values.

                                                         
See also
Options Menu
MIDI and SMPTE Synchronization



MIDI Output Sync
Selecting this item will enable Sound Forge to send MIDI time code out the MIDI Output port. The MIDI 
Output port is specified on the MIDI/Sync  page of the Preferences folder (Options menu). A SMPTE 
output offset can also be specified in the MIDI/Sync foler which tells Sound Forge what time to start 
outputting SMPTE from.

                                                         
See also
Options Menu
MIDI and SMPTE Synchronization



Pre-Queue for SMPTE/MTC
Selecting this item will make Sound Forge open the wave device and pre-load data of the next region to 
be played in the Playlist. This is a good measure to take to insure that audio will begin playing the 
moment the designated SMPTE time is detected by Sound Forge when synchronizing to MTC. This 
keeps the time between triggering and playback to a minimum.

This option is automatically disabled when any other audio command is used such as
Play, Stop, or Record.

                                                         
See also
Options Menu



MIDI Triggers Video tutorial
MIDI Triggers are used to control several Sound Forge functions using MIDI commands from external 
devices such as a MIDI keyboard or sequencer. Triggers can be either MIDI Note-On/Off or Controller 
commands. For Sound Forge to trigger, the MIDI Input Sync/Trigger option (Options menu) must be 
enabled.

Name
The name of the user defined MIDI Trigger setup. You can save the current configuration using the 
Save as button.
Event window 
The Event window displays the available trigger operations in Sound Forge and, if enabled, triggering 
information. Selecting an event allows you to edit its trigger information.

Event
The operation which will be performed by Sound Forge when a trigger is received.
Trigger
The specific note or controller that will evoke the event it is assigned to.
Channel
The MIDI channel the trigger is associated that will evoke the event.

Trigger (None, Note, Controller)
This is where you enter the above information upon selecting an Event in the Event window.

None
Used to select no MIDI trigger for the selected event.
Note
Determines the selected event will be triggered by a MIDI note.
Controller
Determines the selected event will be a MIDI controller.

Channel (1-16)
The channel the controller or trigger is assigned to.
Controller/Note (0-127)
The MIDI controller being assigned, if a controller is selected. The MIDI note if note is selected.
Value (0-127)
The value the controller must reach in order to evoke the event.
Enable MIDI Input Sync/Trigger (for training triggers) (On/Off)
If you have the MIDI Input Sync/Trigger mode enabled while in the MIDI Triggers dialog, you can auto 
fill the Channel, Note, and Controller values by pressing a key or controller on your MIDI Keyboard.

Note: MIDI Triggers are different from triggers in the Playlist and Regions List. When using triggers in the 
Playlist, Regions List, or MIDI Triggers, be aware that they can interact with each other to create 
unexpected results. Sound Forge first looks at the MIDI Triggers, then the Regions List, and then the 
Playlist when determining what to do when a MIDI command is detected.

If you have the MIDI Input Sync/Trigger mode enabled while in the MIDI Triggers dialog
box, you can auto fill the Channel, Note, and Controller values by pressing a key or

controller on your MIDI keyboard.

                                                         
See also
Options Menu



Preferences 
Many user-configurable options are available in the Preferences dialog. To select an item, simply click on 
the folder tab or use the Tab key to place the focus on the folder name and use the right or left arrow key 
to navigate through the folders. Options available in the Preference folder include:

General
Display
Editing
File
MIDI and Sync
Performance
Regions List and Playlist
Previews
Status
Toolbars
Wave Devices
Other Preferences
                                                         
See also
Options Menu



General Preferences
Use to select general user options.

Show a Tip of the Day on Startup Default: Checked
When this option is enabled, a handy Tip of the Day will appear every time you run Sound Forge.
Always Ask for Region, Marker, and Loop Names Default: Checked
When creating regions, markers, or loop points and this option is turned off, the Edit Region or Loop 
dialog will not automatically appear. A default name based on location will be used.
Open Default Workspace on Startup Default: Checked
If this option is enabled, Sound Forge will automatically open any files that were open when you last 
exited the program.
Open Drag and Drop Sound Files in Direct Mode Default: Unchecked
Any files opened by dragging them onto the Sound Forge desktop (from outside of the program) will be 
opened in direct mode when this option is enabled.
Open Command Line Sound Files in Direct Mode Default: Unchecked
When launching Sound Forge from the command line (DOS prompt), if this option is turned on any files 
in the command will be opened in direct mode. For example, if Sound Forge is being launched by 
another application (such as a multi-track editor), when this option is turned on Sound Forge will edit 
directly on the original file.
Default to Slow Scroll When Drag Selecting Default: Unchecked
In some very fast computers, automatic scrolling while selecting is too fast to use accurately. When this 
options is turned on, drag-selecting will cause a slow scroll.

Note: If you click the right mouse button while selecting, you can be toggle slow scroll on
or off.

Warn When Mix/Crossfade Rates Mismatch Default: Checked
Enabling this option tells Sound Forge to warn you with a dialog prior to mixing or crossfading data 
which has different sample rates. Mixing or Crossfading data of different sample rates may produce 
unintended sounding results.
Always Open Full-screen Default: Unchecked
Enabling this option forces Sound Forge to always open in full-screen mode. If this option is disabled 
Sound Forge opens in the size and position it was in when it was last closed.
Confirm on Close Default: Unchecked
Enabling this option forces Sound Forge to prompt you with a confirmation message box prior to exiting 
Sound Forge.
If you are a system administrator you may want to enable this option for users who are new to 
Windows, and who may double-click on the close box by accident.
Compatible Draw Mode (for Broken Video Drivers) Default: Unchecked
Because Sound Forge's drawing routines are highly optimized, they increase the chance of causing 
little-known video card problems to arise. Some video cards have bugs in their drivers which can make 
your system lock up when Sound Forge tries to draw a waveform. If you experience a system lockup 
frequently in Sound Forge, it is likely that your video card is causing this problem.
Compatible draw mode uses a different method of drawing the waveform which, although not as 
smooth, puts less stress on the video card. With some video cards, this mode actually increases the 
draw speed. However, more flashing can occur.
This problem is known to happen with ATI's Mach64 card when using High Color (16-bit) in Windows 
95.
Compatible Scroll Mode Default: Unchecked
When this mode is enabled, Sound Forge will use a less optimized method of scrolling the Waveform 
Display. In some instances, this can reduce interference problems between your audio and video card 
during Smooth Scroll playback.



Show a Textured Background on the Workspace Default: Checked
If this option is turned on, a stucco texture will be used for Sound Forge's application background.
Show Free Storage Space on Status Bar Default: Checked
When this options is turned on, the total amount of free disk space available on your specified 
temporary drive is displayed on the status bar.
Show Shuttle Controls on Data Window Transport Default: Unchecked
When enabled, Rewind and Forward buttons will appear on each Data Window's Transport.
Auto-power MIDI Keyboard Window Default: Checked
Enabling this option tells Sound Forge to open up the MIDI device assigned to the MIDI Keyboard (if it 
is not already open) when you press a key on the MIDI Keyboard. You may want to disable this option if
you are using the same MIDI output device for MIDI synchronization or for your sequencer. If this option
is disabled you need to press the On button on the Keyboard prior to using it to send notes.
Ignore Device Capabilities in Mixer Window Default: Unchecked
Normally, when Sound Forge loads audio devices found in the system, it checks to see if the drivers 
support volume control. Those devices which report that they do not support volume control are grayed 
in the mixer devices list. However, some devices do not report their capabilities correctly. If this option is
enabled Sound Forge will ignore the device capabilities and attempt to set the levels for any device you 
select in the Mixer window.
Show OLE Drag Source on Data Window Transport Default: Checked
When checked, the OLE Drag Source control is displayed on the right side of the status bar in all data 
windows. This provides a convenient method of creating Sound Forge audio objects that can be 
embedded into other documents. If you do not use this feature and want to reclaim the space for the 
status bar, simply uncheck this option.
Multiple select file open (Windows 3.x and NT) Default: Checked
When this option is checked you can select multiple files in the File Open dialog and Sound Forge will 
open all of them.
When running Windows NT, if this option is turned on you will not be able to use long file names. This is
a bug in the common dialogs in Windows NT. If you want to use long file names, turn this option off.
3D Dialog and display effects (Windows 3.x and NT) Default: Checked
This option is used to enable or disable the 3D look of dialogs.
Recently Used File List Default: Enabled (2 to 9)
This option allows you to set the number of recently used files which will appear in the File menu. If you 
do not wish to have any files listed in the File menu, uncheck the check box for this option.

                                                         
See also
Options Menu
Preferences



Display Preferences
Use to set your display preferences.

Max zoom ratio on open Default: 1:1,024
Specifies the maximum zoom magnification when loading a new sample file. This allows you to control 
the maximum data that will be shown in a data window when a file is loaded from the hard drive.    
Higher values show more data on initial file loading, which takes more time.
Wait cursor zoom ratio threshold Default: 1:32
Specifies the amount of zoom above which an hourglass cursor will be displayed between data window 
repaints. If the mouse cursor seems to flicker on and off a lot when redrawing wave data, you may want
to increase this value.
Show Axis in Waveform Display Default: On
Specifies whether the sample data window displays a set of horizontal axes indicating the volume of the
sample. Lines are drawn at volume levels of 0, 50, and 100% of the maximum value.
Color Preference for
The color preferences section allows you set a custom color for a variety of graphics within Sound 
Forge. Each graphic has a default color or you can set a custom color by checking the Custom box and
setting the component Red, Green, and Blue of each color.

Play Cursor
Specifies the color of the cursor which is drawn while playing a file.
Regions: Marker
Specifies the color used to display Marker tabs on the Data Window ruler.
Regions: Region
Specifies the color used to display Region tabs on the Data Window ruler.
Sample Loop: Sustaining
Specifies the color used to display Sustain loop tabs on the Data Window ruler.
Sample Loop: Release
Specifies the color used to display Release loop tabs on the Data Window ruler.
Wave Axis: Center
Specifies the colors used to draw the center line of the Wave Axis.
Wave Axis: Half
Specifies the color used to draw the line at half volume for the Wave Axis.
Wave Background
Specifies the colors used to draw the background of each Data Window.
Wave Data
Specifies the color used to draw the wave data in each Data Window.

                                                         
See also
Options Menu
Preferences



Editing Preferences
Use this to set preferences related to editing and undo operations.

Disable Triple-clicking to Select All Data Default: Off
Turn this option on if you don't want Sound Forge to select all sound data when you triple-click. You 
might want to turn this off if triple-clicks are constantly being falsely detected when you make a 
selection and then try to do a drag operation. Otherwise, lowering Window's double-click threshold time 
might help.
Snap to Zero-crossing Slope Default: Negative Slope
Specifies how zero-crossings are detected.

Negative Slope
Zero-crossings are detected only on a negative slope. 
Any Crossing
Zero-crossings are detected on both positive and negative slopes.
Positive Slope
Zero-crossings are detected only on a positive slope.

It is usually best to use either the Positive or Negative Slope setting for zero-crossings,
so that noticeable pops and clicks are not generated by cutting data when using Snap to

Zero.

Zero Cross Scan Time (0 to 1000 samples) Default: 1000 
Determines the maximum time that Sound Forge will search for the next zero-crossing.
Zero Cross Level Threshold (0 to 32,767) Default: 0 
Levels below this value will be considered a zero-crossing. This is useful if the file you are using has a 
DC offset, although a better idea would be to remove the DC offset.
Disable Auto-snapping Below 1:4 Zoom Ratios Default: Off
When this option is turned on, auto-snapping will not occur when you are zoomed in at 1:1 or 1:2. This 
is useful if you commonly zoom in full to tweak selection points manually yet still want to use auto-
snapping when zoomed out.
Limit Number of Undo Buffers To (0 to 999) Default: 100
If this is checked, it determines the maximum number of Undo operations that will be saved before they 
start to get deleted. Having many Undo operations available will use a lot of hard-disk space.
Limit Number of Redo Buffers To (0 to 999) Default: 100
If this is checked, it determines the maximum number of Redo operations that will be saved before they 
start to get deleted. Having many Redo operations available will use a lot of hard-disk space.
Default All Windows to Undo Disabled Default: Unchecked
Enabling this option will keep Sound Forge from creating undo buffers for any operation which modifies 
a sound file. You are still able to turn the undo creation on by using the Disable Undo command (Edit 
menu) for any window, but by default no undo buffers will be created.
Drag & Drop Auto Rise Delay (0.1 to 2.0 seconds) Default: 0.7
Determines the time necessary before a window underneath the cursor becomes active during drag 
and drop operations.

                                                         
See also
Options Menu
Preferences



File Preferences
Use this to set preferences related to opening and saving files.

Warn if Save Changes the Sound Data Default: Checked
When you save a sound file to a different format, such as doing 16 to 8-bit conversions or compressing 
audio, you will not hear the conversion's effect on the sound until you re-open the file. If this option is 
enabled, you will get a message warning of this.
Automatically Re-open Default: Unchecked
if Save Changes the Sound Data 
If this option is on, when you save a file to a different format Sound Forge will save the file and then re-
open it. This will happen when you change bit size, channels, or compression format and it will allow 
you to listen to any changes in sound quality.
Sector Align Data Default: Unchecked
for Digidesign's Session 8 .WAV Files 
This option is only necessary if you are using Sound Forge to modify files for use with Digidesign's 
Session 8. Enabling this option forces Sound Forge to align the data portion of .WAV files on a sector 
boundary, which is needed when using .WAV files with the Session 8.
Save .VOC Files Using Newest Format Default: Unchecked
(16-bit capable)
Prior to Creative Labs' boards supporting the playback of 16-bit data, VOC files had no way of storing 
16-bit audio data. With the addition of 16-bit playback sound boards to the Sound Blaster line of 
products, a newer version of the VOC file was created. With this option disabled Sound Forge will save 
all 8-bit files in the old format and all 16-bit files in the new format. With this option enabled it will save 
all files in the new format. Only enable this option if you have software which requires the new format 
for 8-bit data.
Open and Save Default: Off
with Sound Forge 3.0 Compatible Regions
Sound Forge 3.0 had a minor bug when opening and saving regions in which the total length was off by
one sample. Since we both opened and saved the files inconsistently with the published standard, it 
didn't affect anything. Sound Forge 4.0 fixes this problem, but in doing so this means that file created 
with Sound Forge 3.0 will have their region length display 1 sample smaller than before.
If this bothers you, turn this option on when opening a file saved in Sound Forge 3.0, turn it off, and 
then save the file. From there on after, the region lengths will not be off by one in Sound Forge 4.0 (but 
will be in 3.0!)
Default SDS Channel When Saving (1 to 16)Default: 1
Specifies the channel used in SDS packets when saving audio as an SDS file.
Default SDS Patch When Saving (0 to 127) Default: 0
Specifies the patch used in SDS packets when saving audio as an SDS file.
Default Dialogic .VOX Sample Rate for Open Default: 8,000 Hz
Specifies the default sample rate used when opening Dialogic .VOX sound files in Sound Forge. This 
option is necessary because Dialogic .VOX sound files do not contain this information. Typical settings 
for this option are 6,000 Hz and 8,000 Hz.
Associate Sound File Extensions
Pressing the Associate Sound File Extensions button from the File tab in the Preferences folder opens 
the Sound File Associations dialog. This dialog provides a method of associating audio files with Sound 
Forge. When a file is associated with Sound Forge, you can simply double-click on a sound file in the 
File Manager or the Windows 95 Explorer and it will open for editing.
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MIDI and Sync Preferences
Use to select MIDI and synchronization user options.

Output
Specifies the MIDI output device for synchronization.
This device is used to send SMPTE/MTC when MIDI Output Sync (Options menu) option is enabled.
Input
Specifies the MIDI input device for synchronization and triggering when the MIDI Input Sync/Trigger 
(Options menu) is enabled.
This device is the device through which Sound Forge will receive all MIDI triggering and 
synchronization input. This includes SMPTE/MTC, MIDI triggers, and Regions/Playlist triggers.
Use 30 Frames Per Second for SMPTE Non-Drop Default: Checked
Specifies whether all SMPTE Non-Drop calculations performed by Sound Forge use a frame rate of 30 
frames per second or 29.97 frames per second. You will only need to uncheck this option if you intend 
to work with video which expects true 29.97 fps SMPTE Non-Drop. Refer to the Appendix for a 
discussion of SMPTE issues.
Bound Record Time on SMPTE Record Sync Default: Checked
When this option is enabled, Sound Forge will not allow recording beyond the specified end time. This 
ensures that your record length is exact regardless of any inaccurate time code.
Use Internal Timer for SMPTE Generation Default: Checked
Specifies whether Sound Forge should use the internal timer for SMPTE generation rather than position
values reported by the sound card driver. Since many sound cards do not report their position 
accurately it is usually better to use the internal timer for SMPTE generation.
Internal Timer Resolution (2 - 32 milliseconds) Default: 4
Specifies the timer accuracy used for generating SMPTE when the Use Internal Timer for SMPTE 
generation option is enabled. The lower the resolution value, the more accurate the SMPTE generation 
will be. However lower values may also decrease system performance.
Use Free-wheel for SMPTE Loss Default: Off
Enabling this option makes Sound Forge stop playback if the incoming MIDI time code signal stops 
being received. Otherwise, when the time code stops, Sound Forge will continue to play until the user 
stops playback manually.

Free-wheel Time (0.0 to 20.0 seconds) Default: 1.000
When the time code stops being received, Sound Forge will continue to play for this amount of time 
before stopping. During this time, if time code is found again, playback will continue.
Free-wheel Slack (0.05 to 1.0 seconds) Default: 0.200 
This parameter controls how fast Sound Forge should expect time code updates before going into 
Free-wheel mode. If you have a fast machine, this value can be set to a lower value if you want 
Sound Forge to stop playback immediately when time code is interrupted.

Enable SMPTE Playback Offset Default: 00:00:00:00
When outputting MIDI time code during playback, you can specify a SMPTE offset that will be added to 
the time displayed in Sound Forge's play counter. For example, if you want Sound Forge to generate 
MIDI time code starting at 01:00:00:00, instead of inserting 1 hour of silence to your sound file, you can 
specify that amount in this field.
When using Record Sync, you'll often want to set this value to the Input Synchronization start time. 
Sound Forge's ruler and play counter will not display this offset.
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Performance Preferences
Use this to set preferences related to opening and saving files.

Temporary Storage Folder Default: C:\FORGE40\
The specified directory is used to store temporary files used by Sound Forge.
Sound Forge stores its temporary data in a temporary directory on your hard drive. Using temporary file
space allows you to edit very large files and keeps Sound Forge from eating up large portions of RAM 
on your computer. Your temporary directory must have enough space to handle the total size of all files 
you plan to edit at one time along with space for any clipboard data and undo buffers. 
If you change the Temporary storage folder, you will have to close Sound Forge for the change to take 
effect.
Free Storage Space in Selected Folder
Shows the amount of available disk space in the selected folder.
Video Decompression Mode Default: 8 bits always
Determines the bits per pixel (color resolution) which will be used by Sound Forge when it 
decompresses video frames before displaying. Note that when a high number of bits is used, the 
performance demands on your system are higher. The available modes are:

8 bits always
Sound Forge will always decompress the video to 8 bits per pixel (256 color).
Best for display
Sound Forge will decompress the video to the best format that matches your system's color 
capabilities.
Full decompress always
Sound Forge will always decompress the video to its original bits per pixel when displaying. This is 
useful if you want to ensure that the video frames you see contain all the color information stored in 
the file. Also, if you wanted to paste frames to the clipboard, this ensures maximum resolution.
Peak Ratio Default For New Sound Files Default: 1:256
When drawing the waveform display, Sound Forge will use a peak file instead of scanning all of the 
data when the zoom ratio is above this level. Lower values allow for faster scrolling at those ratios, 
but increases the peak file's size. For example, setting this value to 1:128 instead of 1:256 will make 
the peak file two times larger but will make scrolling at 1:128 faster and scrolling at 1:65536 or higher
ratios slower.
To calculate the size of the resulting peak files, you divide the size of the file by the Peak ratio. For 
example, a 100 MB sound file will need a 0.39 MB (100/256) peak file when using 1:256.
Wait Cursor Zoom Ratio Threshold Default: 1:512
Specifies the amount of zoom above which an hourglass cursor will be displayed between data 
window repaints. If the mouse cursor seems to flicker on and off a lot when redrawing wave data, 
you may want to increase this value. This value is ignored during playback.
Show the Position of the Playback Cursor Default: Checked
When this option is enabled, the Position field in the status bar will show the cursor position during 
playback. Disable this option if you have a very slow computer or video card.
Show the Record Counter While Recording Default: Checked
When this option is enabled, the record time will show in the Record dialog while recording. Disable 
this option if you have a very slow computer or video card.
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Regions List and Playlist Preferences
Use to select user options dealing with the Regions List and Playlist.

Regions List Display Format Default: Start and End
Specifies how the regions are displayed within the Regions List.

Start and End
Regions are displayed with the start and end time of each region.
Start and Length
Regions are displayed with the start time and length of each region.
Playlist Display Format Default: Start and End
Specifies how the regions are displayed within the Playlist.

Start Only
Regions are displayed with only the start time of each region.
Start and End
Regions are displayed with the start and end time of each region.
Start and Length
Regions are displayed with the start time and length of each region.
Sort the Regions List Alphabetically Default: Checked
Specifies whether regions are displayed in the Regions List in the order they were added or are sorted 
alphabetically.
Playlist Pre-roll (0.0 to 300.0 seconds) Default: 2.000 seconds
When playing entries in the Playlist, this value specifies the amount of pre-roll which will be used. This 
allows you to easily hear the transition from one region to another without having to play all the way 
through the first region.
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Preview Preferences
Preview preferences apply to all processing, effects, and tools which have the ability to play a preview. 
You can also modify preview options within any dialog which has preview by clicking on the system box of
the dialog and selecting the Preview Configuration option.

Limit Previews To (1 to 30 seconds) Default: 4 Seconds
Specifies the length of audio which will be used when generating a preview. Keeping this value small 
lowers the amount of time needed to generate a preview when tuning effects or process values.
Pre-roll (1 to 30 seconds) Default: Unchecked
When turned on, this determines how many seconds of unprocessed audio will be played before the 
processed selection. Use this to listen to the transition from unprocessed to processed data.
Post-roll (1 to 30 seconds) Default: Unchecked
When turned on, this determines how many seconds of unprocessed audio will be played after the 
processed selection. Use this to listen to the transition from processed to unprocessed data.
Fade Out Last 10 Milliseconds (snap/pop eliminator) Default: Checked
Enabling this option tells Sound Forge to fade out the last 10 milliseconds of a preview effect so that 
large pops are not heard at the end of a preview buffer. With this option disabled, a preview could end 
with a large data value which can cause an audible and annoying pop.
Loop Preview Continuously Default: Checked
Enabling this option causes preview buffers to loop infinitely rather than playing just a single time. This 
can be useful when listening to the difference between the original sound and the sound after an effect 
or process has been applied.
Reactive Previewing Default: Checked
Reactive Previewing is a preview mode in which any control changes in a dialog cause an automatic re-
calculation and playback of the preview buffer. This allows for immediate aural feedback on the affects 
of a change.
This option is very useful when using a fast computer, limiting previews to a short time, and not using 
very slow processing effects. You can temporarily disable Reactive Previewing in a dialog by holding 
down the Shift key while making parameter changes.
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Status Preferences
Use to select display status options.

Default SMPTE Format Default: Non-Drop 30 FPS
Specifies the SMPTE type used when selecting a SMPTE format option from the Status Bar shortcut 
menu.

Non-Drop 30 FPS
Calculates status values using a 30 frames per second SMPTE code.
Drop 29.97 FPS
Calculates status values using a 29.97 frames per second SMPTE code. This is accomplished by 
dropping two frames every minute except for minutes 00, 10, 20, 30, 40, and 50.
EBU 25 FPS
Calculates status values using a 25 frames per second SMPTE code. This format is the European 
Broadcast Union time code.
Film Sync 24 FPS
Calculates status values using a 24 frames per second SMPTE code. This format is for standard 24 
frames per second film media.

Default Time Format Default: Time
Specifies the time format (time or seconds) used when selecting the Time option from the Status Bar 
shortcut menu.
Default Frames Per Second (1 to 1,000) Default: 15.000
Specifies the default frame rate used to calculate frame values.
Frame values are useful when trying to synchronize sound with animation. Most animation players 
specify a playback frame rate at which video frames are shown to the user. If you are using an 
animation that has a frame rate of 15.0 frames per second, you would set the frame rate to 15.0. When 
status values are shown by Sound Forge they will be shown in values of frames. This allows you to find 
the frame to which a given point in the sound file corresponds.
Frame rates can be any value between 1.0 and 1,000.0 frames per second.
Default Beats Per Measure (1 to 32) Default: 4
Specifies the number of beats in each measure for displaying in measures and beats. For example 2/4 
time would have two beats per measure.
Default Beats Per Minute (1 to 1,000) Default: 120.000
Specifies the number of beats per minute, i.e. the tempo of a song for displaying lengths. For example, 
a tempo of 120 is 120 beats per minute.
RMS Level Scan Time (5 to 2,000 ms) Default: 50 
Specifies the amount of sound data surrounding the cursor used to calculate the RMS level in the 
Levels toolbar.
Peak Level Scan Time (5 to 2,000 ms) Default: 50 
Specified the amount of sound data surrounding the cursor used when searching for a peak level to 
display in the Levels toolbar.
Display Format for SMPTE Code Default: 00:00:00.00
Specifies how SMPTE values will be formatted for display by Sound Forge. Select one of the available 
preferences from the drop-down list.
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Toolbars Preferences
Use to select which toolbars are displayed on the main screen. A check before the toolbar means that the 
toolbar is turned on. The following toolbars are available:

Standard Default: Checked
Contains standard file, and edit operations.
Transport Default: Checked
Contains record and play operations.
Navigation Default: Unchecked
Contains operations for navigating within the data window. Some of the operations included are 
zooming, marking, moving the cursor, and moving to relevant points.
Views Default: Unchecked
Contains operations for storing and retrieving data window views.
Status/Selection Default: Unchecked
Contains operations to set the display Status Format as well as the Snap To operations.
Regions/Playlist Default: Checked
Contains the Regions/Playlist buttons as well as synchronization commands and synchronization status
boxes.
Process Default: Unchecked
Contains all processing operations.
Effects Default: Unchecked
Contains all effect operations.
Tools Default: Unchecked
Contains all tool operations.
Levels Default: Unchecked
Displays the left and right channel levels at the cursor in a variety of different formats.
Show Tooltips Default: Checked
The Show Tooltips check box turns on or off the help information box displayed next to the mouse when
it is held over certain items.
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Wave Devices Preferences
Use this folder to specify what wave devices Sound Forge should use for recording and playback. 

Note: The capabilities of these devices may limit you from playing some files.

Playback
Specifies the device to be used when playing sound data.
Selecting a mapper device such as the Wave Mapper or Microsoft Sound Mapper allows Windows to 
select an appropriate device to use for the current sound data.
Record
Specifies the device to be used when recording sound data.
Selecting a mapper device such as the Wave Mapper or Sound Mapper allows Windows to select an 
appropriate device to use for the current sound data.
Interpolate Position for Inaccurate Devices Default: Checked
Specifies whether Sound Forge should interpolate the position of the play position pointer during 
playback. If this option is not checked, Sound Forge relies on the device driver for the sound card to 
provide the correct position of the pointer during playback.
Many sound card drivers do not report their position accurately. If the play position pointer does not 
move smoothly you should enable this option. You may also want to contact your sound card 
manufacturer for updated drivers.
If your sound card driver does not have accurate position reporting, your Drop Marker and Mark In/Out 
positions will also be off when dropping markers while playing.
Position Bias (-64 to 64) Default: 0
Specifies an offset value which Sound Forge should add to the position values returned by the sound 
card wave driver during recording or playback.
Many sound card drivers do not report their position accurately. When you play sounds back, the 
position of the play pointer may seem to lag or precede the actual sound you are hearing. If this is the 
case, you may want to adjust this value. Most sound card drivers that report incorrect position give a 
value ahead of the actual sound.
To remove this bias, start with smaller values and work toward larger ones in increments of 4 (a value of
1 is equal to 512 bytes) until the play position pointer is accurate. Recommended settings are 4, 8, 16, 
and 32. These settings correspond to the typical bias values for these drivers of -2048, -4096, -8192 
and -16384 (negative multiples of 2048) bytes.    
If your sound card driver does not have accurate position reporting, your Drop Marker and            Mark 
In/Out positions will also be off when dropping markers while playing.

An inaccurate playback cursor is due to poorly written sound card      drivers. If you
experience this problem, call your sound card manufacturer and request that they get

their act together. 

Total Buffer Size (kilobytes) Default: 512
Select the amount of RAM you would like to use for buffering sounds during play and record. Using a 
large value can optimize performance at high sample rates but may also cause a slight delay starting 
playback.
Preload Size (kilobytes) Default: 0
Determines the total amount of wave data that will be queued to the sound driver before playback 
starts.
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Other Preferences
Use to select miscellaneous user options.

Play Looped Adjust Pre-roll (0.0 to 10.0 seconds) Default: 1.500 sec
Specifies the number of seconds that will be played before the loop end point when playing in Loop 
Preview mode. To play a loop in Loop Preview mode, control-click on the Play Looped button. This is 
useful when loop-tuning a long loop.
Audio Event Locator
The following settings control how the Audio Event Locator plays audio. To use the Audio Event 
Locator, click on the overview (above the waveform display) and drag the mouse. Playback is looped 
around the position until the mouse button is released.

Pre-roll (0.0 to 10.0 seconds) Default: 0.100 Second
Specifies the location where playback will begin prior to where the cursor is placed in the overview.
Loop Time (0.01 to 30. 0 seconds) Default: 1.000 Second
Determines the amount of time which will be looped during playback when using the Audio Event 
Locator.

Cut Preview Configuration
When using the Preview Cut function in the Edit menu, the Pre-roll and Post-roll times specify the 
amount of audio data that is played prior to and after the data which is to be cut.

Pre-roll (0.0 to 30.0 seconds) Default: 1.500 Second
Specifies the amount of data played prior to a cut region.
Post-roll (0.0 to 30.0 seconds) Default: 1.500 Second
Specifies the amount of data played after a cut region.

                                                         
See also
Options Menu
Preferences



File Associations
Pressing the Associate Sound File Extensions button from the File tab in the Preferences folder opens the
Sound File Associations dialog. This dialog provides a method of associating audio files with Sound 
Forge. When a file is associated with Sound Forge, you can simply double-click on a sound file in the File 
Manager or the Windows 95 Explorer and it will open for editing.

File Types to Associate
The list displayed contains all sound file formats that Sound Forge supports. If a sound file extension is 
associated with an application, then the name of the application is displayed on the right. If a sound file 
is associated with Sound Forge, then a check mark is placed in the box to the left of the item. To 
associate an item with Sound Forge, simply check the item and select OK.
File Association Details 
When a sound file extension is associated with Sound Forge, Windows will open Sound Forge to edit 
any files with the extension when selected. For example, if you double-click on a file with an extension 
that is associated with Sound Forge in the File Manager or the Windows 95 Explorer, Sound Forge will 
automatically run and the sound file will be opened for editing.
Select All
Pushing this button will select all sound files to be associated with Sound Forge.
Select None
Pushing this button will de-select all sound files so no files are associated with Sound Forge.
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Storage Directory
The selected directory will be used to store temporary files used by Sound Forge. It is reached from the 
Performance Preferences tab.
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